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CUSTOMER SOFTWARE LICENSE
THE LICENSE (USA)
Image Processing and Vision Company Limited (trading as
Improvision) (the "Licensor", which expression shall include
its subsidiaries, agents, successors and assigns) is

1. Acceptance of this LICENSE
The terms and conditions of this License are deemed to be
accepted:
(a) by the Licensor upon dispatch/delivery by the Licensor
of this package to the Licensee; and

authorized to license the software, documentation and any
fonts contained in this package (the "Software") and upon
opening the sealed package containing the Software, the
Licensee accepts a non-exclusive License to "Use" (as
hereinafter defined) the Software on a single computer

(b) by the Licensee by breaking the seal of this sealed
package containing the Software; or
(c) by the Licensee signing and returning the enclosed
warranty card.

system (the "System") for single use specified below upon
the terms and subject to the conditions contained
herein. The Licensee owns the media on which the
Software is recorded, but the Licensor retains title to the

2. Use of the Software
(a) For the purposes of this License "Use" shall mean and
include:

Software.
(i) utilization of the Software by copying, transmitting
This License entitles the Licensee to:
or loading the same into the temporary memory
(a) load, install and Use the Software contained in this

(RAM) or installing into the permanent memory (e.g.

package on one Central Processing Unit ("CPU") of the

hard disk, CD ROM or other storage device) of the

System (a separate LICENSE fee being required for

System for the processing of the System

each CPU upon which the Licensee wishes to use the

instructions or statements contained in such

Software)

Software;

(b) Use the Software in accordance with the provisions of
Section 2 of this License;
and, where the Licensee signs and returns the warranty
card enclosed with the Software, to:
(a) receive telephone technical support relating to the

(ii) copying the Software which is in machine-readable
form for Use by the Licensee on the System for the
purposes only of understanding the contents of
such machine-readable material and for back-up
provided that (A) no more than one (1) non-

Software during the Licensor's usual business hours,

transient copy will be in existence under this

within the period of the software maintenance

License at any one time without prior written

agreement;

consent from the Licensor or as otherwise

(b) receive information on upgraded versions of the
Software at such cost (if any) as may be notified to the
Licensee.

permitted by the applicable law, and (B) such
backup copy includes all copyright information
contained on the original;
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(iii) storing the whole or any part of the Software on the
System or other storage unit or disk; and
(iv) utilizing (but not copying) the instructional and/or
operational manuals relating to the Software.
(b) The Licensee acknowledges and accepts that the
Software is protected against unauthorized use by
means of a serial number.

within the number of days specified in the Licensor's
invoice unless otherwise agreed to in writing by the
Licensor.
(b) An additional License Fee is payable for each CPU of
the System upon which the Licensee wishes to Use the
Software. In the event that the Licensee's System is
inoperable, the Licensee shall be permitted to Use the
Software on a back-up system at no extra charge, until

(c) The Licensee shall also be permitted to Use the
the System is operational.
Software on a portable, lap-top or home computer
where the Software is permanently installed on the

4. Licensee's Undertakings

hard disk or other storage device of the System (but not

(a) The Licensee undertakes not to perform any of the acts

a file server) and the Licensee or its relevant employee

referred to in this sub-clause (a) except to the extent

as the case may be is the predominant user of the

and only to the extent required by the applicable law as

Software and such Use will not breach the concurrent

applied to the Licensee as a lawful user (i.e. a party

user limit where applicable.

with a right to use) of the Software and only then for the

(d) THE SOFTWARE IS NOT INTENDED FOR USE IN
THE OPERATION OF NUCLEAR FACILITIES,
AIRCRAFT NAVIGATION OR COMMUNICATION
SYSTEMS, OR AIR TRAFFIC CONTROL MACHINES

specific limited purpose stated in such applicable law or
hereunder.
The Licensee undertakes:
(i) not to copy the Software (other than for normal

IN WHICH CASE THE FAILURE OF THE SOFTWARE

System operation and as specified in Section 2

COULD LEAD TO DEATH, PERSONAL INJURY, OR

above) nor otherwise reproduce the same provided

SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE.

that the Licensee may copy the Software for back-

(e) The Licensee's rights under this License will terminate

up or archival purposes or incidentally, in the

automatically without notice from the Licensor if the

course of converting the Software in accordance

Licensee fails to comply with any term(s) of this

with Section 4(a)(iii) below;

License.

3. License Fee
(a) Where the License Fee has not been paid by the

(ii) not to translate, adapt, vary, or modify the Software
or its source or object code;
(iii) subject to subsection (iv) below, without the

Licensee at the time the Software is obtained from the

Licensor’s prior written consent, not to disassemble,

Licensor or its agent the License Fee will be payable

decompile, reverse engineer, modify, or create
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derivative works based on the Software in whole or
in part or transmit the Software over a network,
provided however that in the case of decompilation,
the Licensee may incidentally decompile the

(b) to maintain accurate and up-to-date records of the
number and location of all copies of the Software.
(c) to supervise and control Use of the Software in
accordance with the terms of this License.

Software only if it is essential to do so in order to
(d) to ensure that its employees, agents and other duly
achieve interoperability of the Software with
authorized parties who will use the Software (including
another software program (“Permitted
any transferee of the Software) are notified of this
Purpose”)and provided the information obtained by
License and the terms hereof prior to such use.
the Licensee during such decompilation is only
used for the Permitted Purpose and is not disclosed
or communicated to any third party to whom it is not

(e) to reproduce and include the copyright notice of the
Licensor or such other party as may be specified in or

necessary to disclose or communicate such

on the Software (the "Owner") on all and any copies,

information and it is not used to create any software

whether in whole or in part, in any form, including

which is substantially similar to the Software or the
expression of the Software nor used in any manner
which would be restricted by copyright.
(iv) It shall be a condition precedent to the
decompilation of the Software permitted in
accordance with the terms referred to in subsection

partial copies or modifications of the Software made
herein.
(f) not to provide or otherwise make available the Software
in whole or in part (including where applicable, but not
limited to program listings, object code and source
program listings, object code and source code), in any

(iii) above, that the Licensee shall have notified the

form to any person other than the Licensee's

Licensor in writing (a) that it wishes to perform the

employees or as specified in (d) above without prior

decompilation; (b) the purposes for which it wishes
to perform the decompilation; and (c) the

written consent from the Licensor.
(g) within 14 days after the date of termination or

information which it requires for such

discontinuance of this License for whatever reason, to

purposes. Only when the Licensor has either (a)

destroy the Software and all updates, upgrades or

not responded within a reasonable time or (b) has

copies, in whole and in part, in any form including

not offered to provide the Licensee with information

partial copies or modifications of the Software received

required under (c) above (for which the Licensor

from the Licensor or made in connection with this

may require payment) shall the Licensee be

License, and all documentation relating thereto and

permitted to continue with the decompilation.

certify in writing that the Licensee has complied with

The Licensee undertakes:

this subsection.
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5. Disclaimer of Warranty

TERMS OF THIS DISCLAIMER DO NOT AFFECT OR

The Licensee acknowledges and agrees that use of the

PREDJUDICE THE STATUTORY RIGHTS OF A

Software is at the Licensee's sole risk. The Software is

CONSUMER ACQUIRING LICENSOR PRODUCTS

provided "AS IS" and without warranty of any kind and the

OTHERWISE THAN IN THE ORDINARY COURSE OF

Licensor and Licensor's licensor(s) (for the purposes of

BUSINESS, NEITHER DO THEY LIMIT OR EXCLUDE

Sections 5 and 6, Licensor and Licensor's licensor(s) shall

ANY LIABILITY FOR DEATH OR PERSONAL INJURY

be collectively referred to as "Licensor") EXPRESSLY

CAUSED BY LICENSOR'S NEGLIGENCE.

DISCLAIM ALL WARRANTIES AND/OR CONDITIONS,

6. Licensor's Limitation of Liability

EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES AND/OR CONDITIONS
OF MERCHANTABILITY OR SATISFACTORY QUALITY
AND FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT OF THIRD PARTY RIGHTS. THE
LICENSOR DOES NOT WARRANT THAT THE
FUNCTIONS CONTAINED IN THE SOFTWARE WILL
MEET THE LICENSEE'S REQUIREMENTS, OR THAT
THE OPERATION OF THE SOFTWARE WILL BE
UNINTERRUPTED OR ERROR-FREE, OR THAT
DEFECTS IN THE SOFTWARE WILL BE
CORRECTED. FURTHERMORE, LICENSOR DOES NOT
WARRANT OR MAKE ANY REPRESENTATIONS
REGARDING THE USE OR THE RESULTS OF THE USE
OF THE SOFTWARE OR RELATED DOCUMENTATION
IN TERMS OF THEIR CORRECTNESS, RELIABILITY, OR
OTHERWISE. NO ORAL OR WRITTEN INFORMATION
OR ADVICE GIVEN BY THE LICENSOR OR A LICENSOR
AUTHORIZED REPRESENTATIVE SHALL CREATE A
WARRANTY OR IN ANY WAY INCREASE THE SCOPE
OF THIS WARRANTY. SHOULD THE SOFTWARE
PROVE DEFECTIVE, LICENSEE (AND NOT LICENSOR
OR A LICENSOR AUTHORIZED REPRESENTATIVE)
SHALL ASSUME THE ENTIRE COST OF ALL

THE LICENSOR SHALL NOT BE LIABLE TO THE
LICENSEE FOR ANY LOSS OR DAMAGE, EXCEPT AS
SPECIFICALLY SET FORTH IN THIS AGREEMENT,
ARISING DIRECTLY OR INDIRECTLY IN CONNECTION
WITH THIS LICENSE, THE SOFTWARE, ITS USE OR
OTHERWISE. NOTWITHSTANDING THE GENERALITY
OF THE FOREGOING, THE LICENSOR EXPRESSLY
EXCLUDES LIABILITY FOR NEGLIGENCE, INDIRECT,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL LOSS OR
DAMAGE WHICH MAY ARISE IN RESPECT OF THE
SOFTWARE, ITS USE, THE SYSTEM OR IN RESPECT
OF OTHER EQUIPMENT OR PROPERTY, OR FOR LOSS
OF PROFIT, BUSINESS, REVENUE, GOODWILL OR
ANTICIPATED SAVINGS. LIABILITY OF THE LICENSOR
AND ITS SUPPLIERS TO THE LICENSEE, IF ANY, FOR
BREACH OF WARRANTY ARISING OUT OF CONTRACT,
NEGLIGENCE OR STRICT LIABILITY IN TORT, OR ANY
OTHER CLAIM RELATING TO THIS LICENSE, OR IN
THE EVENT THAT ANY EXCLUSION CONTAINED IN
THIS LICENSE SHALL BE HELD TO BE INVALID FOR
ANY REASON AND THE LICENSOR BECOMES LIABLE
FOR LOSS OR DAMAGE, SHALL BE LIMITED TO FIFTY
DOLLARS ($50.00).

CORRECTION. SOME JURISDICTIONS DO NOT ALLOW

7. Copyrights Patents, Trade Marks and
Other Intellectual Property Rights

THE EXCLUSION OF IMPLIED WARRANTIES, SO THE

The Licensee acknowledges that any and all of the

ABOVE EXCLUSION MAY NOT APPLY TO YOU. THE

copyright, trade marks, trade names, patents and other

NECESSARY SERVICING, REPAIR OR
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intellectual property rights subsisting in or used in

(ii)

connection with the Software including all documentation

modify or amend the Software or infringing part
thereof so that the same becomes non-infringing;

and manuals relating thereto are and remain the sole

or

property of the Licensor and the Owner. The Licensee shall
not during or at any time after the expiration or termination

(iii) replace the Software or infringing part thereof by
other software of similar capability; or

of this License in any way question or dispute the
ownership by the Licensor and/or the Owner thereof.

8. Indemnity

(iv)

repay to the Licensee the License Fee or balance
thereof relating to the whole or the infringing part of
the Software.

(a) The Licensor agrees to indemnify and save harmless
and defend at its own expense the Licensee from and
against any and all claims of infringement of any patent,
trade mark, industrial design, copyright or other
proprietary right affecting the Software provided that (i)
the Licensee shall not have done, permitted or suffered

(c) The Licensor’s obligations under subsection (a) or (b)
above are expressly conditioned upon and subject to:
(i) the Licensor having sole control of the defense
and/or settlement of any such infringement claim;
(ii) the Licensee promptly notifying the Licensor in

to be done anything which was not expressly

writing of any claim specified in subsection (a)

authorized by this License or which may have been or

above that is made against the Licensee and

become an infringement of any such rights (including

providing the Licensor with the authority to proceed

but not limited to using the Software to perform the

as set forth in (i) above; and

Licensee's or other party's applications or using the

(iii) the Licensee providing the Licensor with all

Software in combination or merged with other software

information known to the Licensee relating to such

programs or devices) and (ii) the Licensee shall have

infringement claim and otherwise providing the

exercised a commercially reasonable standard of care

Licensor with such assistance as the Licensor may

in protecting the same; failing which, the Licensee shall

reasonably require to settle or oppose any such

indemnify the Licensor against all actions, proceeding

claims.

costs, claims and expenses incurred in respect thereof.
(b) In the event that any such infringement occurs or may

(d) The Licensor's liability under this clause shall, at the
Licensor's option, be limited to the License Fee, less an

occur, the Licensor may at its sole option and expense:

equitable proportion thereof, as relates to the period

(i) procure for the Licensee the right to continue using

prior to cessation of the use of the Software by the

the Software or infringing part thereof; or

Licensee because of such claims of infringement.
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9. Confidential Information
(a) All information, data, drawings, specifications,

(d) The Licensee may sell this License provided that:
(i) all copies of the Software held by the Licensee

documentation, software listings, source or object code

pursuant to this License shall either be destroyed

which the Licensor may have imparted and may from

or transferred to the Transferee on completion of
the sale;

time to time impart to the Licensee relating to the
Software (other than the ideas and principles which
underlie the Software) is proprietary and confidential.
The Licensee hereby agrees that it shall use the same

(ii)

the Licensee procures written agreement by the
Transferee accepting the terms of the License; and

(iii) the Licensee gives prior notice to the Licensor of

solely in accordance with the provisions of this License

the transfer and the identity and address of the

and that it shall not at any time during or for a period of

Transferee and receives Licensor’s prior written

six years after expiration or termination of this License,

consent.

disclose the same, whether directly or indirectly, to any

10. Force Majeure

third party without the Licensor's prior written consent.

The Licensor shall be under no liability to the Licensee in

(b) The Licensee further agrees that it shall not itself or
through any subsidiary, agent or third party use such

any way whatsoever for destruction, damage, delay or any
other matters of any nature whatsoever arising out of war,
rebellion, civil commotion, strikes, lock-outs or industrial

confidential information to copy, reproduce, translate,

disputes, fire, explosion, earthquakes, acts of God, flood,

adapt, vary, modify, decompile, disassemble or reverse

drought, bad weather or power outages; the unavailability

engineer the Software nor shall the Licensee lease,

of deliveries, supplies, software disks or other media or the

license, sub-license or otherwise deal with the Software

requisitioning or other act or order by any government

(other than by sale as specifically referred to in sub-

department, council or other constituted body.

clause (d) below) or any part or parts or variations,

11. Termination

modifications, copies, releases, versions or
enhancements thereof or have any software or other
program written or developed for itself based on any

(a) This License shall terminate and any and all rights
granted to the Licensee hereunder shall revest in the
Licensor:

confidential information supplied to it by the Licensor.
(i) upon thirty (30) days written notice in the event that
(c) The foregoing provisions shall not prevent the

Licensee or any of its directors, officers, employees

disclosure or use by the Licensee of any information

or agents is in breach of any term, condition or

which is or hereafter, through no fault of the Licensee,

provision of this License and fails to remedy such

becomes public knowledge or to the extent required by
law.

8 Improvision

breach (if capable of remedy) within such thirty (30)
days; and

Volocity User Guide

(ii) should the Licensee, its successors or permitted
assigns, suspend business, make an absolute
assignment of the bulk of its assets for the benefit

13. Waiver
Failure or neglect by either party to enforce at any time any
of the provisions hereof shall not be construed nor shall be
deemed to be a waiver of that party's rights hereunder nor

of creditors, consent to the appointment of a trustee,

in any way affect the validity of the whole or any part of this

custodian or receiver, or be declared insolvent or

License nor prejudice that party's rights to take subsequent

bankrupt; or if a trustee or custodian or receiver is

action.

appointed for the Licensee for a substantial part of
its property without its consent and is not

14. Headings
The headings of the terms and conditions herein contained

discharged within sixty (60) days of such

are inserted for convenience of reference only and are not

appointment, or if bankruptcy, reorganization,

intended to be part of or to affect the meaning or

rearrangement, insolvency or liquidation

interpretation of any of the terms and conditions of this

proceedings are instituted by or against the

License.

Licensee and are not dismissed within sixty (60)

15. Severability

days of the commencement thereof.

In the event that any of these terms and conditions or

(b) Upon termination, the Licensee shall pay to the Licensor
all costs and expenses, including legal and other fees

provisions shall be determined by any competent authority
to be invalid, unlawful or unenforceable to any extent, such
term, condition or provision shall to that extent be severed

incurred and all arrearages of fees, charges or other

from the remaining terms, conditions and provisions which

payments arising in respect of the Software, this

shall continue to be valid to the fullest extent permitted by

License or otherwise and shall comply with its

law.

undertaking specified in Section 4(g) above.
(c) Termination of this License shall be in addition to and

16. Law
The parties hereby agree that the License concluded

not in lieu of any rights and remedies the Licensor may

between them and constituted on these terms and

have under this License or under the applicable

conditions shall be construed in accordance with the law of

law. Notwithstanding the termination of this License,
the provisions of Sections 6, 7, 9 and 13 through 19
shall survive such termination.

12. Assignment

the State of Massachusetts without regard to its conflict of
laws principles.

17. Jurisdiction
In any legal action related to this License, the Licensee
agrees (a) to the exercise of jurisdiction over it by a state or

The Licensee shall not assign rent, lease, loan, sublicense,
distribute, or otherwise transfer all or any part of the
Software or this License without the prior written consent of

federal court in Boston, Massachusetts and (b) that all legal
actions relating to this License shall be instituted in one of
the courts specified in (a) above.

the Licensor, in accordance with Section 9(d) above.
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18.

Export Law Assurances

20.

Complete Agreement

The Licensee may not use or otherwise export or reexport

This License constitutes the entire agreement between the

the Software except as authorized by United States law

parties with respect to the use of the Software and

and laws of the jurisdiction in which the Software was

supersedes all prior or contemporaneous understandings

obtained. The Licensee agrees and certifies that (i) neither

regarding such subject matter. No amendment to or

the Software nor any related documentation or product

modification of this License will be binding unless in writing

thereof is intended to be shipped, transferred or reexported,

and signed by the Licensor.

directly or indirectly, into any country prohibited by the
United States Export Administration Act of 1979 and the
regulations thereunder, as amended, nor will be used for
any purpose prohibited by the Act, and (ii) that Licensee is
not located in, under control of, or a national or a resident
of a country on the U.S. Treasury Department's list of
Specially Designated Nationals or the U.S. Department of
Commerce's Table of Denial Orders. The Licensee agrees
to comply with all laws and regulations pertaining to the
export of the Software.

19.

Restricted Rights

If any Software or related documentation is to be used by
the United States government, it shall be provided with
“Restricted Rights.” Use, duplication or disclosure by the
government is subject to restrictions set forth in
subparagraph (C)(1)(ii) of the Department of Defense
Regulations Supplement (“DFARS”) 252.227-7013, Rights
in Technical Data and Computer Software (October 1988),
Federal Acquisition Regulation (“FAR”) 52.227-14, Rights in
Data-General, including Alternate III (June 1987), as
applicable, and FAR 52.227-19. Supplier: Image
Processing and Vision Company Limited, Viscount Centre
II, University of Warwick Science Park, Millburn Hill Road,
Coventry, CV4 7HS, England.
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THE LICENCE (EUROPE)

1. Acceptance of this Licence

Image Processing and Vision Company Limited (trading as

The terms and conditions of this Licence are deemed to be

Improvision) (the "Licensor" which expression shall include

accepted by the parties in any one of the following

its subsidiaries, agents, successors and assigns) is

circumstances:

authorised to license the software (the "Software")
contained in this package and upon opening the sealed

(a) by the Licensor upon dispatch/delivery by the Licensor

package the Licensee accepts a non-exclusive Licence to

of this package to the Licensee direct or to the

"Use" (as hereinafter defined) the Software on a single

Licensor's agent as the case may be;

computer system (the "System") for single use specified

(b) by the Licensee by breaking the seal of this sealed

below upon the terms and subject to the conditions
contained herein.
This Licence entitles the Licensee to:

package containing the Software;
(c) the Licensee signing and returning the enclosed
warranty card.

(a)

load, install and Use the Software contained in this

2. Use of the Software

package on one Central Processing Unit ("CPU") of the
System (a separate licence fee being required for each

(a) For the purposes of this Licence "Use" shall mean and

CPU upon which the Licensee wishes to use the

include:

Software);

(i) utilization of the Software by copying, transmitting

(b) Use the Software in accordance with the provisions of
Clause 2 of this Licence;

or loading the same into the temporary memory
(RAM) or installing into the permanent memory

and, where the Licensee signs and returns the warranty

(e.g. hard disk, CD ROM or other storage device) of

card enclosed with the Software, to:

the System for the processing of the System
instructions or statements contained in such

(a) receive telephone technical support relating to the
Software;
Software within the Licensor’s usual business hours,
within the period of the software maintenance
agreement;

(ii) copying the Software which is in machine-readable
form for Use by the Licensee on the System for the
purposes only of understanding the contents of

(b) receive information on upgraded versions of the
such machine-readable material and for back-up
Software at such cost (if any) as may be notified to the
provided that no more than three (3) non-transient
Licensee.
copies will be in existence under any Licence at
any one time without prior written consent from the
Licensor or as otherwise permitted by the
applicable law;
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(iii) storing the whole or any part of the Software on the
System or other storage unit or disk;

4. Licensee's Undertakings
(a) The Licensee undertakes not to perform any of the acts

(iv) utilizing (but not copying) the instructional and/or

referred to in this sub-clause (a) except to the extent

operational manuals relating to the Software.

and only to the extent permitted by the applicable law

(b) The Licensee acknowledges and accepts that the

to the Licensee as a lawful user (i.e. a party with a right

Software may be protected against unauthorised use

to use) of the Software and only then for the specific

by means of a dongle device.

limited purpose stated in such applicable law or

(c) The Licensee shall also be permitted to Use the
Software on a portable, lap-top or home computer

hereunder. The Licensee undertakes:
(i) not to copy the Software (other than for normal

where the Software is permanently installed on the

System operation and as specified in Clause 2

hard disk or other storage device of the System (but not

above) nor otherwise reproduce the same Provided

a file server) and the Licensee or its relevant employee

that the Licensee may copy the Software for back-

as the case may be is the predominant user of the

up purposes or incidentally, in the course of

Software and such Use will not breach the concurrent

converting the Software in accordance with 4(a)(iii)

user limit where applicable.

below;

3. Licence Fee

(ii) not to translate, adapt, vary, modify the Software;

(a) Where the Licence Fee has not been paid by the

(iii) subject to sub-clause (iv) below not to disassemble,

Licensee at the time the Software is obtained from the

decompile or reverse engineer the Software

Licensor or its agent the licence fee will be payable

Provided however that in the case of decompilation,

within the number of days specified in the Licensor’s

the Licensee may incidentally decompile the

invoice unless otherwise agreed in writing by the

Software only if it is essential so to do in order to

Licensor.

achieve interoperability of the Software with

(b) An additional Licence Fee is payable for each CPU of
the System upon which the Licensee wishes to Use the
Software. In the event that the Licensee's System is
inoperable or requires or is under repair, the Licensee
shall be permitted to Use the Software on a back-up
system at no extra charge, until the System is
operational.

another software program ("Permitted Purpose")
and provided the information obtained by the
Licensee during such decompilation is only used for
the Permitted Purpose and is not disclosed or
communicated to any third party whom it is not
necessary to disclose or communicate such
information without the Licensor's prior written
consent and is not used to create any software
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which is substantially similar to the expression of

whether in whole or in part, in any form, including

the Software nor used in any manner which would

partial copies or modifications of the Software made

be restricted by copyright.

herein.

(iv) It shall be a condition precedent to the

(f) not to provide or otherwise make available the Software

decompilation of the software permitted in

in whole or in part (including where applicable, but not

accordance with the terms referred to in sub-clause

limited to program listings, object code and source

(iii) above that the Licensee shall have notified the

program listings, object code and source code), in any

Licensor in writing (a) that it wishes to perform the

form to any person other than the Licensee's

decompilation (b) the purposes for which it wishes

employees or as specified in (d) above without prior

to perform the decompilation and (c) the

written consent from the Licensor.

information which it requires for such purposes.
Only when the Licensor has either (a) not

(g) within 14 days after the date of termination or
discontinuance of this Licence for whatever reason, to

responded within a reasonable time and (b) has not

destroy the Software and all updates, upgrades or

offered to provide the Licensee with the information

copies, in whole and in part, in any form including

required under (c ) above (for which the Licensee

partial copies or modifications of the Software received

may require payment) shall the Licensee be

from the Licensor or made in connection with this

permitted to continue with the decompilation.

Licence, and all documentation relating thereto.

The Licensee undertakes:
(b) to maintain accurate and up-to-date records of the
number and location of all copies of the Software.
(c) to supervise and control Use of the Software in
accordance with the terms of this Licence.

5. Warranty
THE LICENSEE ACKNOWLEDGES THAT SOFTWARE IN
GENERAL IS NOT ERROR-FREE AND AGREES THAT
THE EXISTENCE OF SUCH ERRORS SHALL NOT
CONSTITUTE A BREACH OF THIS LICENCE.

(d) to ensure that its employees, agents and other parties
IN THE EVENT THAT THE LICENSEE DISCOVERS A
who will use the Software (including any transferee of

MATERIAL ERROR WHICH SUBSTANTIALLY AFFECTS

the Software) are notified of this Licence and the terms

THE LICENSEE'S USE OF THE SAME AND NOTIFIES

hereof prior to such employee, agent or party using the

THE LICENSOR OF THE ERROR WITHIN 90 DAYS

same.

FROM THE DATE OF PAYMENT OF THE LICENCE FEE

(e) to reproduce and include the copyright notice of the

(THE "WARRANTY PERIOD") THE LICENSOR SHALL AT
ITS SOLE OPTION EITHER REFUND THE LICENCE FEE

Licensor or such other party as may be specified in or
on the Software (the "Owner") on all and any copies,

OR USE ALL REASONABLE ENDEAVOURS TO
CORRECT BY PATCH OR NEW RELEASE (AT ITS
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OPTION) THAT PART OF THE SOFTWARE WHICH

COST TO COMPLY WITH ANY SAFETY OR MISSION-

DOES NOT SO COMPLY PROVIDED THAT SUCH

CRITICAL REQUIREMENTS.

NON-COMPLIANCE HAS NOT BEEN CAUSED BY ANY
MODIFICATION, VARIATION OR ADDITION TO THE
SOFTWARE NOT PERFORMED BY THE LICENSOR OR
CAUSED BY ITS INCORRECT USE, ABUSE OR
CORRUPTION OF THE SOFTWARE.

ALTHOUGH THE LICENSOR DOES NOT WARRANT
THAT THE SOFTWARE SUPPLIED HEREUNDER SHALL
BE FREE FROM ALL KNOWN VIRUSES IT HAS USED
COMMERCIALLY REASONABLE EFFORTS TO CHECK
FOR THE MOST COMMONLY KNOWN VIRUSES PRIOR

THE LICENSOR’S WARRANTY IN RELATION TO THE

TO PACKAGING BUT THE LICENSEE IS SOLELY

FUNCTIONING OF THE SOFTWARE (INCLUDING A

RESPONSIBLE FOR VIRUS SCANNING THE

DONGLE, IF PROVIDED) ON ANY PARTICULAR

SOFTWARE.

SYSTEM ONLY APPLIES WHERE THE SYSTEM
COMPLIES WITH THE LICENSOR’S HARDWARE AND
SOFTWARE COMPATIBILITY LIST AS ISSUED FROM
TIME TO TIME
TO THE EXTENT PERMITTED BY THE APPLICABLE
LAW, AND SUBJECT TO CLAUSE 6 BELOW, THE
LICENSOR DISCLAIMS ALL OTHER WARRANTIES WITH
RESPECT TO THE SOFTWARE, EITHER EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR

THE LICENSOR WARRANTS THAT THERE ARE NO
DISABLING PROGRAMS OR DEVICES IN THE
SOFTWARE OTHER THAN THAT NECESSARY TO
DETECT THE PRESENCE OF AN APPROPRIATE
DONGLE (IF PROVIDED).
PROVIDED THAT ANY DONGLE PROVIDED HAS NOT
BEEN MAL-TREATED THE LICENSOR UNDERTAKES
THAT IN THE CASE OF THE FAILURE OF THE DONGLE
IT WILL, AT ITS OPTION, AND AT ANY TIME DURING
THE CURRENCY OF THIS LICENCE EITHER

FITNESS FOR ANY PARTICULAR PURPOSE.
THE LICENSEE ACKNOWLEDGES THAT THE
SOFTWARE IS NOT DESIGNED FOR USE IN MISSIONOR SAFETY-CRITICAL SITUATIONS. THE ALGORITHMS
UPON WHICH IT IS BASED INVOLVE STATISTICAL AND

(i) replace the dongle; or
(ii) replace the Software with a version of identical or
enhanced functionality but which is not protected by the
dongle device or is protected by an alternative dongle.

OTHER METHODS OF INTERPOLATION AND
EXTRAPOLATION AND VISUAL OR OTHER OUTPUT
WHICH IT MAY PRODUCE ARE THEREFORE LIABLE TO

6. Licensor's Liability

ARTEFACTS AND ERRORS INHERENT IN THE USE OF

(a) The Licensor shall not be liable to the Licensee for any

THESE TECHNIQUES. OUTPUT FROM THE SOFTWARE

loss or damage whatsoever or howsoever caused

SHOULD ALWAYS BE CONFIRMED AND VERIFIED IN
ACCORDANCE WITH RECOGNISED SCIENTIFIC AND
EXPERIMENTAL PRACTICE. THE LICENSOR MAY BE

arising directly or indirectly in connection with this
Licence, the Software, its use or otherwise, except to

PREPARED TO CREATE A SPECIALLY MODIFIED OR

the extent that such liability may not be lawfully

RE-WRITTEN VERSION OF THE SOFTWARE AT EXTRA

excluded under the applicable law.
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(b) Notwithstanding the generality of (a) above, the
Licensor expressly excludes liability for indirect, special,
incidental or consequential loss or damage which may

and manuals relating thereto are and remain the sole
property of the Licensor and/or the Owner. The Licensee
shall not during or at any time after the expiry or termination
of this Licence in any way question or dispute the

arise in respect of the Software, its use, the System or

ownership by the Licensor and/or the Owner thereof.

in respect of other equipment or property, or for loss of
profit, business, revenue, goodwill or anticipated
savings.
(c) In the event that any exclusion contained in this
Licence shall be held to be invalid for any reason and
the Licensor becomes liable for loss or damage that
may lawfully be limited, such liability shall be limited to
the licence fee paid by the Licensee for the Software.
The Licensor does not exclude liability for death or personal

8. Indemnity
(a) The Licensor agrees to indemnify and save harmless
and defend at its own expense the Licensee from and
against any and all claims of infringement of any patent,
trade mark, industrial design, copyright or other
proprietary right affecting the Software PROVIDED
THAT (i) the Licensee shall not have done, permitted or
suffered to be done anything which may have been or

injury to the extent only that the same arises as a result of

become an infringement of any such rights (including

the negligence of the Licensor, its employees, agents or

but not limited to using the Software to perform the

authorised representatives.

Licensee's or other party's applications or using the

Where the Software is to be used in any state of Australia

Software in combination or merged with other software

and it is determined by a competent authority that the law

programs or devices) and (ii) the Licensee shall have

of any such Australian state law apply to this licence,

exercised a reasonable standard of care in protecting

notwithstanding any other provisions contained herein,

the same; failing which, the Licensee shall indemnify

where any Act of Parliament implies any term into this

the Licensor against all actions, proceedings, costs,

Licence, and that Act avoids or prohibits provisions in a

claims and expenses incurred in respect thereof.

contract excluding or modifying such term, that term shall
be deemed to be included in this Licence, but the

(b) The Licensee undertakes that the Licensor shall be

Licensor's liability for breach of that term shall be limited in

given prompt notice of any claim specified in (a) above

one or more of the ways (at the Licensor's option) permitted

that is made against the Licensee and the Licensor

by section 68A(1) of the Trade Practices Act 1974 (Cth).

shall have the right to defend any such claims and

7. Copyright, Patents, Trade Marks and
Other Intellectual Property Rights

make settlements thereof at its own discretion and the

The Licensee acknowledges that any and all of the

may reasonably require to settle or oppose any such

copyright, trade marks, trade names, patents and other

Licensee shall give such assistance as the Licensor

claims.

intellectual property rights subsisting in or used or in
connection with the Software including all documentation
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(c) In the event that any such infringement occurs or may

(b) Subject only to the specific, limited provisions of Clause
4(a) above, the Licensee further agrees that it shall not

occur, the Licensor may at its sole option and expense:

itself or through any subsidiary, agent or third party use

(i) procure for the Licensee the right to continue using

such confidential information to copy, reproduce,

the Software or infringing part thereof; or

translate, adapt, vary, modify, decompile, disassemble
(ii) modify or amend the Software or infringing part
or reverse engineer the Software nor shall the Licensee
thereof so that the same becomes non-infringing; or
lease, licence, sub-licence or otherwise deal with the
(iii) replace the Software or infringing part thereof by

Software (other than by sale as specifically referred to

other software of similar capability; or

in sub-clause (d) below) or any part or parts or
variations, modifications, copies, releases, versions or

(iv) repay to the Licensee the Licence Fee or balance
thereof relating to the whole or the infringing part of

enhancements thereof or have any software or other

the Software.

program written or developed for itself based on any
confidential information supplied to it by the Licensor.

(d) The Licensor's liability under this clause shall, at the
Licensor's option, be limited to the Licence Fee less an
equitable proportion thereof as relates to the period

The foregoing provisions shall not prevent the disclosure or
use by the Licensee of any information which is or hereafter,
through no fault of the Licensee, becomes public

prior to cessation owing to infringement.

knowledge or to the extent permitted by law.
The Licensee shall be permitted to sell this licence

9. Confidential Information
(a) All information, data, drawings, specifications,

PROVIDED THAT:
(i) all copies of the Software held by the Licensee

documentation, software listings, source or object code

pursuant to this Licence shall either be destroyed or

which the Licensor may have imparted and may from

transferred to the Transferee on completion of the sale;

time to time impart to the Licensee relating to the
Software (other than the ideas and principles which

(ii) the Licensee procures that the Transferee accepts the
terms of the Licence;

underlie the Software) is proprietary and
confidential. The Licensee hereby agrees that it shall

(iii) the Licensee gives notice to the Licensor of the transfer
and the identity and address of the Transferee.

use the same solely in accordance with the provisions
of this Licence and that it shall not at any time during or

10.

for a period of six years after expiry or termination of

The Licensor shall be under no liability to the Licensee in

this Licence, disclose the same, whether directly or

respect of anything which, apart from this provision, may

indirectly, to any third party without the Licensor's prior

constitute breach of this Licence arising by reason of force

written consent.

majeure.
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11.

Termination

(a) In addition to provisions for termination as herein
provided, the Licensor may by notice in writing to the
Licensee terminate this Licence if the Licensee is in

14.

Headings

The headings of the terms and conditions herein contained
are inserted for convenience of reference only and are not
intended to be part of or to affect the meaning or
interpretation of any of the terms and conditions of this

breach of any term, condition or provision of this

Licence.

Licence or required by the applicable law and fails to
remedy such breach (if capable of remedy) within
30 days of having received written notice from the

15.

Severability

In the event that any of these terms and conditions or
provisions shall be determined by any competent authority

Licensor specifying such breach.
(b) Upon termination, the Licensee shall pay to the

to be invalid, unlawful or unenforceable to any extent, such
term, condition or provision shall to that extent be severed

Licensor all costs and expenses, including legal and

from the remaining terms, conditions and provisions which

other fees incurred and all arrears of fees, charges or

shall continue to be valid to the fullest extent permitted by

other payments arising in respect of the Software, this

law.

Licence or otherwise and shall comply with its

16.

Law

undertaking specified in Clause 4(g) above.

The parties hereby agree that the Licence concluded
between them and constituted on these terms and

(c) Termination, howsoever or whenever occasioned shall
be subject to any rights and remedies the Licensor may

conditions shall be construed in accordance with English
law.

have under this Licence or under the applicable law.

12.

Assignment

The Licensee shall not assign or otherwise transfer all or
any part of the Software or this Licence without the prior
written consent of the Licensor or in accordance with the
provisions of clause 9(d) above.

13.

Waiver

Failure or neglect by either party to enforce at any time any
of the provisions hereof shall not be construed nor shall be
deemed to be a waiver of that party's rights hereunder nor
in any way affect the validity of the whole or any part of this
Licence nor prejudice that party's rights to take subsequent
action.
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WHAT is Volocity?

What is Volocity?
Overview
Volocity is an innovative, high performance 3D imaging software product designed specifically for
Life Science research. It allows the scientist to visualize, explore and analyze multi-channel 3D
volumes over time, providing information that is difficult to obtain in any other way.
Volocity can be used for 2D imaging as well as 3D and 4D imaging and will accept image sequences
from confocal and wide field microscopes. The software consists of a core product and four unique,
totally integrated extension products that provide a full suite of tools for 3D image acquisition, volume
visualization, restoration, publication, and object classification, tracking and charting.
The Volocity products can be purchased individually or in combination, according to requirements. In
addition, a reduced version of the core, Volocity LE, is available to download free of charge from the
Improvision website.

Volocity Acquisition
Volocity Acquisition is designed specifically for high performance acquisition of time-resolved, multichannel 3D sequences. It supports a range of hardware suitable for 3D imaging, including wide field
microscopes, scientific grade digital cameras, fast focus drives and wavelength changers.

Volocity Quantitation
Volocity Quantitation is designed to identify, measure and track biological structures in 2D, 3D and
4D. This unique module incorporates innovative classification technology for rapid identification and
quantitation of populations of objects in 2D, 3D and 4D.

Volocity Restoration
Volocity Restoration includes restoration algorithms and measured or calculated PSF generation
options for confocal and wide field microscopes. The Volocity restoration algorithms are designed for
rapid, high-quality restoration of 4D and 3D volumes and for accurate comparison and quantitation of
time-resolved changes.

Volocity Visualization
Volocity Visualization provides an extensive range of visualization and publication features. The
Volocity 3D View enables the user to interactively explore a 3D rendered object. The user can, in real
time, rotate, zoom and animate the 3D object whilst simultaneously varying the contribution and
rendering mode for each channel. The user can also position the viewing point either outside or
inside the 3D object, and then watch as structures change and develop over time. Bookmarks may

November 2008 27

About this Manual

be used to store the position and appearance of the 3D volume and the movie interface may be used
to animate transitions between bookmarks.

About this Manual
This manual describes all the features of Volocity. The initial chapters describe the features that are
available to all users. Each product then has its own chapter, so that the reader can easily locate
relevant information. The manual is designed for users of both Mac and WINDOWS versions of
Volocity. The screenshot examples show the Mac interface. The screenshots often assume that all
features are enabled. If you do not have access to a command, it may belong to a product not
licensed on your system.

Technical Support
If you have any queries about installing and using Volocity, contact Improvision Support:

USA:
E-mail:

support@improvision.com

Telephone:

+1 (866) 310 0932

Europe and Rest of World:
E-mail:

support@improvision.com

Telephone:

+44 (0) 24 7669 8121

Web Page
You can also get additional information about Improvision and its products from the web page:
http://www.improvision.com/support

Information to Provide
When contacting Technical Support please be prepared to provide information about your system
including the dongle or serial number.
You may be asked to provide information about your computer hardware and from the Volocity
system Session Log, see page 35.
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Installation
Minimum System Requirements
The computer hardware market changes rapidly and, as a result, information about minimum and
recommended system requirements also changes. Please refer to the technical notes published on
the Support area of the Improvision web site, http://www.improvision.com, for the up-to-date
specifications.
Volocity is available for Windows and Mac. The exact specification for your computer depends on the
type of Volocity configuration that you intend to run. If you are running Volocity extension products
you will require a much higher specification than if you are using Volocity LE. Similarly, if you are
working with large volumes you will require a fast, powerful processor and the maximum possible
capacity of RAM for the machine.
Please note: Volocity 2.5 was the last version of the software to include support for the following
operating systems: Mac OS 9, Windows 98, Windows NT4 and Windows ME.
Note: A Volocity dongle will work with both Volocity for Macintosh and Volocity for Windows.

Installing Volocity (Single License)
To install Volocity LE you require an unlock code and a serial number. You obtain these when you
download Volocity LE from the website. This is all you need to install the software.
To use any of the chargeable products you must purchase a dongle, which is a security device that
will be registered for your required package. It must be plugged into an unused USB port. Software
for the full version of Volocity with chargeable products is also available on CD-ROM. Additional
functionality can be added later using a serial number provided when you purchase the product.
Please ensure that you read the accompanying license before installing the product.
Follow the instructions supplied with the web download or CD-ROM to install Volocity.

Installation for Server Systems
If you are using the Improvision License Server (ILS), you will first need to install and configure the
license server application on a machine with a static IP address that all client machines will be able
to access. See the “License Server User Guide” for complete instructions on how to do this.
Install Volocity on machines that will access the License Server as described in “Installing Volocity
(Single License)”. These client machines will not need their own dongle, they will obtain Volocity
licenses by connecting to the license server.
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Starting Volocity for the First Time

Starting Volocity for the First Time
n

Volocity LE requires a serial number and unlock code which you may obtain by registering on the
Improvision website.

n

If your license is on a dongle, ensure that the dongle is plugged in and the light inside the dongle
is illuminated. This indicates that the dongle drivers are correctly installed.

n

If your license will be obtained from the license server, make sure that you know the license
server IP address and port number. You will also need a user ID and, possibly, a password for
the license server. This is normally set up by the person who installs and manages the license
server.

1. Start Volocity.
On the Mac: Volocity is installed in the Applications folder. Start by double clicking on the icon.
On Windows: Volocity can be found by navigating through All Programs in the start menu.
2. If you have a dongle installed you should see no further messages, Volocity will run. If a licensing
message does appear, make sure the dongle is plugged in and click Retry.
To use a license server click Server… at the dialog shown and enter the details of the Improvision
License Server for which you have a user ID and password.
To use Volocity LE click Unlock... at the dialog shown and enter the serial number and unlock code.
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Changing Your License Server Password
1. When the Connect To Server dialog is shown click on the Change Password… button.

2. Enter the new password twice to confirm it and click OK.
You may also be required to change passwords, when a dialog to that effect is shown. This may be
to change a default password or at the request of the Improvision License Server administrator.

Switching from a License Server to Individual Licenses
Volocity LE: Start up Volocity whilst holding down the ‘Apple’ key (Mac OS) or the ‘R’ key (Windows)
to bring up the License dialog. Click Unlock… to enter the serial number and registration code for
your individual license.
Volocity: Plug a Volocity dongle (not an Improvision License Server dongle) into a free USB port on
the machine. Start Volocity. Volocity will recognize the presence of the dongle.

Switching from Individual Licenses to a License Server
Volocity LE: Start up Volocity whilst holding down the ‘Apple’ key (Mac OS) or the ‘R’ key (Windows)
to bring up the License dialog. Click Server… and enter the server IP address and port number.
Volocity: Remove the Volocity dongle from the USB port that it is connected to. Start up Volocity.
You will be shown the license dialog. Click Server… and enter the server IP address and port
number.

Preferences
The Preferences dialog allows you to customize various settings.
1. Mac OS X users select Preferences… from the Volocity menu. All other users select Preferences...
from the Edit menu.
2. Select the required preference by clicking on the icon in the left-hand pane.
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3. Make the required changes and click on Save (Mac) or OK (WINDOWS).
The Import preferences allow you to define how images will be imported and to either switch
thumbnails off or select the quality (Standard or Better).
The Confirmations preferences include settings for displaying hints and checking for software
updates. Click on Reset Hints if you want the hints to be displayed. Click on Automatically check
for software updates to ensure that you are informed when new software is available from
Improvision.
Other preferences are only applicable if you are running particular products and are described in
those chapters.

Imaging Computing Server
The Imaging Computing Server (ICS) is a software utility that distributes parts of a task between
multiple, similar processing units to accelerate processor intensive operations.
The ICS currently accelerates the following Volocity tasks:
n

Restoration

n

Ray tracing

n

Noise removal

n

4D measurements (excluding tracking)

See the separate ICS guide for more details about specifying and configuring hardware for the ICS.
To configure Volocity to use the ICS:
1. Start Volocity. Select Preferences… from the Edit menu (Windows) or the Volocity menu (Mac
OS). In the Preferences dialog select Servers.
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2. Click + to add a server. In the Add Server Dialog select Imaging Computing Server as the type.

3. Enter the details of the server and an appropriate user name and password for that server. You may
need to ask the administrator of the ICS for this information.
4. Click Options… to configure behavior of this computer with the ICS.
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Use the Imaging Computing Server will mean all operations that can be accelerated by the ICS will
be sent to the ICS. This computer will not share the processing.
Use the Imaging Computing Server and this computer will mean this computer is recruited as an
additional node for processing operations that can be accelerated by the ICS. Select this option only
if this computer is of comparable or higher specification to the node computers. A lower specification
computer will act as a bottleneck in the processing and slow the overall process down. A
comparable specification computer will increase the speed of processing. If there are already jobs
queued on the ICS progress will still be made on the local computer. This computer will only be used
as a node for processes started on this computer.
Process all operations on this computer will mean the ICS is not used.
Every process that can be accelerated by the ICS will require the data to be broken down into
jobs. The way the data is broken down i.e. the definition of a job varies depending on the supported
operation.

Iterative Restoration
1 job = 1 volume (1 channel, 1 timepoint)
Or
1 job = 1 block if Break image into blocks is enabled in the restoration dialog.
Block size is calculated using RAM /processor, determined using the total amount of RAM in all
nodes divided by the total number of processors in all nodes.

Remove Noise
Data is divided up by timepoints, channels and volumes calculated to utilize all processors
equally. Exact division will vary with data set.

Measurements
1 job = 1 timepoint
If tracking is included in a measurements protocol detecting and measuring objects in individual
timepoints will be distributed between the nodes but the tracking step, measuring over all timepoints,
will be sent to just one of the nodes.
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Ray Trace
At the start of ray tracing a copy of the entire data set is sent to each node, the client copy of Volocity
requests each tile of the scene as it builds it.

Session Log
The Session Log records information from when Volocity is started up until it is quit. Session logs
always display:
n

The version of Volocity that is being run

n

The build date of that version which will be on or before the SMA expiry date for the license

n

The serial number for that product

n

Information about the computer hardware on which Volocity is running

n

Any products that are loaded

n

Any error messages

Session logs provide valuable information to Improvision Technical Support engineers when
diagnosing hardware or software problems.
Show the Session Log by selecting Show Session Log from the Window menu.
Session logs may be saved by clicking on the save button or emailed directly from the Session Log
window.
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Pause log

Save log

E-mail log

Quitting Volocity
Select Quit Volocity from the Volocity menu (Mac) or Exit from the File menu (WINDOWS).
Volocity automatically saves all changes to a library before it quits.

Upgrades from the Website
For Mac OS or Windows simply download the latest installer from the Improvision website and
double click to start the installation process. To perform installations you will need an administrator
user name and password for the computer. Follow the instructions on screen and restart your
computer when requested.

Automatic Software Updates
Alternatively, use the Preferences dialog to enable automatic checking for software updates. Select
Confirmations and check the box next to Automatically check for software updates.
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The Improvision server is checked for a newer version on start up. In order to query the Improvision
server, the machine running the software must be connected to the Internet. When a later version is
detected a message similar to the following is displayed:

Click Download and download the installer for the application you wish to upgrade. Run the installer
and follow the instructions on screen.
Note: During the upgrade process, the installer will check that you have a valid Software
Maintenance Agreement. No information is sent to Improvision during this check, but the upgrade will
fail if you do not have one.
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Upgrading Applications on Client Machines for a License Server System
Upgrading an application served by the Improvision License Server is simple. All the information
relating to users, groups and configurations is stored on the server so there is no special process for
installation. See the instructions for Upgrades from the Website on page 36.

Activating Additional Products after Installation (Single License)
Note: This section is not relevant if your organization has a network license. Refer to the separate
“Improvision License Server User Guide” for instructions on adding licenses to a server.
If you purchase additional products to add to your original installation, you will receive an unlock
code which you must enter in the Unlock Codes dialog. You can do this at any time after installing
the software, as long as you have a valid dongle attached to your computer.
Note: If you are upgrading from Volocity LE, you will need to purchase a dongle. When you attach
the dongle and run Volocity, the purchased extension modules are automatically enabled.
1. Mac OS X users: Select Unlock Codes... from the Volocity menu.
Windows users: Select Unlock Codes... from the Help menu.
2. You now need to enter a Code for each additional product that you have purchased.

3. Enter the Code for the first product and click on Unlock. There is no need to specify which product is
being added and you can enter codes for products in any order.
4. Repeat step 3 for each product that you have purchased.
5. Quit and restart the software so that the unlock code can take effect.
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Getting Started
Overview
This chapter describes:
n

important concepts

n

what a library is

n

how to create libraries

n

how to open existing libraries

n

how to close libraries and windows

n

how to acquire and add images to a library

n

how to create an image sequence

n

how to create volumes

n

how to import items

n

supported file formats
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Important Concepts
n

Data is kept and organized in libraries. A library may contain many experiments and associated
information. See page 41.

n

Libraries are files which are created using the New option in the file menu. Existing libraries are
opened using Open from the File menu.

n

Libraries are databases, changes to databases are saved as they are made, there is no Save
command.

n

Image sequences organize images that represent channels, time and/or z slices. See page 53.

n

Data imported into Volocity have properties. Properties record information about the experiment
that acquired the information and affect how items are visualized or processed elsewhere in the
software. Properties may be searched for.

n

Image data is explored in different ways using views. When an item is opened in the library the
views are shown in tabs along the top of the window. See page 69.

n

Toolbars update when views change to show the appropriate tools. Tooltips, shown when the
cursor is moved over a tool, indicate the purpose of that tool.

n

View-specific menus with the same name as the view configure the appearance of the view and
access processing specific to that view. For example, when working with the Image View the
menu bar will show an Image menu.

n

Many menu commands have shortcut keys. If you look at the command in the menu, you will see
any shortcut keys to the right of the command name. WINDOWS users can use the standard
Windows shortcut; right click on the mouse, to display a list of valid menu commands.

n

Menu items open dialogs allowing data processing and image enhancement. Dialogs support
batch processing of many data sets with one command. See page 110.

n

Choose to apply a process to items from a group by selecting them, this highlights them in the
interface.
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What is a Library?
A library is the term given to the data storage format used by Volocity. A library must be created and
images added to it before they can be viewed in Volocity. A library must be opened for Volocity to
acquire data.
Libraries are based on a database structure and will store changes as they are made.

Creating Libraries
1. You can select Create a new library from the prompt shown when Volocity starts (unless you have
disabled it).
Or, once you are running the application, select New Library… from the File menu. (You can only
have one library open at a time. If you already have a library open, you will be prompted to close it
first.)
2. Use the dialog to name the library and choose a location to store it.

November 2008 41

Creating Libraries

On the Mac, a dialog similar to the following is displayed. Enter a Name for the library. The library
format is called Multi-file (version 2) with the extension .mvd2. Click on Save.

On Windows, a dialog similar to the following is displayed. Enter a File name for the library.

3. A library window is displayed. You are now ready to add items to the library.
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Library Format
The application creates libraries in a multi-file format, which handles large data sets well and gives
fast data access. When you create a multi-file library, it is created within a folder. This folder is
labeled with an icon and the name of the library.
Inside the folder are the library file and a data folder, which contains all the data required to view the
images and volumes kept in that library. Multi-file library files have the suffix .mvd2.

Mac OS X
A Volocity library appears in the Finder like this, with its name below it.

Opening this folder will reveal the .mvd2 file and the data folder.
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Windows
A Volocity library appears in Explorer like this

Opening this folder reveals the .mvd2 file and the data folder.

It is essential that the library file and data folder are kept together, which is why the application
creates them together in a separate folder.
The .mvd2 file describes how the data is to be read by Volocity. The data folder contains many files
none of which can be read by any application.
To open the library, you must first open this folder and locate the library file. If you want to move a
multi-file library to another location you must move the whole folder. If you only move the library file,
the application will not be able to display any of its contents.

Opening Libraries
Once you have created a library, you can either double click on the library icon to open it, or select
Open Library… from the File menu and choose the required library in the dialog. All libraries must
have a .mvd2 extension or they will not be visible in the file list.
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Only one library may be open at a time. If you already have a library open, the application will prompt
you to close it. Once the Library window is displayed, you can add new files to it, as described on
page 45.

Closing Windows and Libraries
The application conforms to the standard Mac and Windows conventions for closing windows.
On a Mac, close the current window by selecting Close from the File menu. If the current window is
the Library window, this command closes the library. You can also close any window by clicking on
the top left-hand corner of the window.
On Windows, close the library by selecting Close Library… from the File menu. Close the current
window(s) by selecting Close (or Close All) from the Window menu. You can also close any window
by clicking on the top right-hand corner of the window.

Acquiring Data
Data may be acquired during experiments using hardware for acquisition, that is, cameras and
devices for microscope automation. All hardware must be installed and configured before use. This is
described in full detail in “Volocity Acquisition Installation and Reference” starting on page 141. This
chapter describes how to:
n

Install and configure devices

n

Use the Video preview to work with devices

n

In the Video Preview use light paths to coordinate changes to devices to meet the requirements
of imaging modes

Once light paths have been configured they may be used in acquisition protocols. Acquisition
protocols allow different combinations of channels, focus movement and XY control to be used in
experiments that capture data.
Example Acquisition Protocols for a variety of different experiments are described in the section
starting on page 162.

Adding Data
Libraries can contain 2D and 3D images, which may be viewed in a number of different ways. The
way that you add items to the library depends upon the type of images and how you want to view
and work with them.
n

Acquisition from a camera adds images directly to image sequences. Image sequences are used
to work with time and/or channels

n

You can also drag and drop folders of images into an open Library window to add them to the
library
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n

If you are adding a series of slices from one object at one timepoint on one channel, import the
data as a folder of images and then create a volume as described in "Creating volumes." on page
54. For example, you may be creating a volume of data from which to measure a PSF (Volocity
Restoration only)

Note: You can also use the Import command from the File menu to add single, unrelated items.

Adding Images Using Drag and Drop
The easiest way of adding items to the library is to drag an item from the desktop and drop it onto the
Library window.
For ease of use when image sequences are required set the Import preference to create image
sequences rather than create folders of images. To do this, select Preferences... from the Edit menu
(Windows) or the Volocity menu (Mac OS).

In the following drag and drop example, an image sequence is created.
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Click once on the item to select it in the library. Available views on that data will be shown on the
right hand side. Double click to open the item in its own window. For more information about views
on data see page 69.

Drag and drop multiple folders or files to create multiple image sequences.
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If the item dragged is a folder, such as a series of slices for a volume, the application will scan the
contents of the folder and add all the files it recognizes to the library. Any hierarchy within the item
that you drag and drop onto the Library window is retained.
You can continue to drag as many folders or files as required onto the library, and you can add items
to any level of folder structure. The insertion is indicated by the creation of a space in the library or
the highlighting of the folder to which the item will be added. The amount of indentation indicates the
level at which an item is located within the library hierarchy.
If image data is recognized but metadata about timepoints, channels and slices per stack is absent
or not supported Volocity will add the images in a folder. These images may not have transferred
spatial calibration information, channel names or timestamps. You will need to create an image
sequence and add these files to it, specifying the image organization and entering calibration
information in the image sequence properties dialog.
Note: The only limit on library size is the hard disk space. However, it is usually more practical to
separate work into more manageable sets and create separate libraries for each one.
If you are adding a series of slices from one object at one time point in one channel, import the data
as a folder of images and then create a volume. For example creating a volume of data from which to
measure a PSF (Volocity restoration only).
Note: You can also use the Import command from the File menu to add single, unrelated items.

Working with a Columbus™ Server
Columbus™ is a convenient and easy-to-use solution for high volume data management, storage,
retrieval, visualization and protection of images and analyzed results. Columbus can import, export
and manage image formats from a wide variety of sources, providing a central repository and
solution for all your microscope imaging requirements.
For more information on the Columbus range of products from PerkinElmer see:
http://las.perkinelmer.com/Imaging/Products/HCS/Columbus.htm
Volocity interfaces with a Columbus server allowing download of files from the server and uploading
of files from Volocity to the server.
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Connecting to a Columbus Server
Start Volocity. Select Preferences… from the Edit menu (Windows) or the Volocity menu (Mac OS).
In the Preferences dialog select Servers.

Click + to define a server. In the Add Server dialog select Columbus Server as the type.

Enter the details of the server and an appropriate user name and password for that server. You may
need to ask the administrator of the Columbus Server or your network for this information.
Click OK to save these settings.
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Multiple Columbus servers may be connect to from one Volocity client. Add additional servers as
required.
When these preferences are saved the Columbus server will be available as an option in the library
view.

Click once on the server to open a view of the server data on the right hand side of the Library view.

Double click the server name to open the Columbus view in a separate window.
Data are added to a Volocity library from the Columbus server by dragging from the Columbus view
and dropping into the Library view.
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A space is created to show where the item will be added.
Data may also be dragged from the Columbus server to the desktop of the machine.
Data are added to the Columbus server from the Volocity library by dragging from the Library view
into the Columbus view. Files can only be added to the Columbus server if they follow the
convention of Projects and Datasets imposed by the Columbus server.
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An image or image sequence can only be added to a Dataset. A new Dataset may be created within
an existing Project by selecting the Project and clicking New Dataset in the tool bar. A new Project
may be created using the New Project button. Drag the image(s) over the Dataset folder until it is
highlighted
A folder of images or image sequences may be added to a Project by dragging the folder from the
library onto the Project.
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Creating an Image Sequence
An image sequence is a collection of images arranged by channel and timepoint. Multi-channel
and/or time-resolved data with one or more planes in z is best viewed using an image sequence.
Set the Import preference to Create image sequences to automatically make image sequences
when importing related data.
The Image Sequencer is a powerful tool for working with data related by time and/or channel. Once
you have created an image sequence, you will be able to interact with the data in a number of
different ways. See page 98.
There are rules about the type of data that may be made into an image sequence:
n

All images in a channel must have the same depth and color look-up table

n

The images must make up volumes that have identical X, Y and Z dimensions

To Create an Image Sequence Item:
1. Select Create New from the Actions menu.
2. Select Image Sequence to create a new image sequence item in the library.
3. The Image Sequence is selected in the library automatically.

4. Drag and drop all the data for an experiment into the open Image Sequence view. The dialog allows
you to specify the order that the images are in and therefore how they should be arranged in the final
sequence.
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Tabs in this window allow you to display different views of the data. You use the Image Sequence
tab to add items to the sequence; it provides an overview of each channel and timepoint.
Hold the cursor over an item in the Image Sequence view to show a tip that gives the timestamp,
channel and type.

Creating Volumes
A volume is the name for a 3-dimensional object within Volocity, it is made up of a stack of images.
If you are working with images from a single object at one timepoint or one channel, use the Make
Volumes command to create a volume. For example, once you have added an image sequence that
contains 2D images related in the Z-dimension, such as confocal microscope, wide field microscope
or magnetic resonance image stacks, you can use this command to create a volume within Volocity.
Note: If you are working with multi-channel or time-resolved data, the easiest way of doing this is to
use the Image Sequencer see page 53.
1. Select the item(s) in the library. From any folder or file containing many images you can select
individual images; for example, all the images belonging to a channel.
2. Select Make Volumes from the Tools menu.
3. The Windows version of the software always gives you the option of scaling down the source images
in the volume.
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Mac users should hold down the Alt key when selecting Make Volumes, if they want to apply scaling.

4. Enter scaling values as a percentage and click on Create. Volocity creates the volume and the
Library view now contains an image item for the 3D data.

Importing Items (File Menu)
To add single files to a library you can use the Import command.
1. Select Import… from the File menu to display a dialog similar to the following.
The import dialog in Mac OS X:

November 2008 55

Importing Items (File Menu)

The import dialog in Windows Vista:

2. Locate the required image. If it is in a folder, select the folder and click on Open to open it. Once you
have located and selected the image, click on Import to add it to the library.
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Supported File Formats
For reading, Volocity currently supports the following formats:
n

BioRad PIC

n

Windows BMP

n

Volocity Library Clipping

n

DeltaVision

n

ICS/IDS (Image Cytometry Format)

n

JPEG

n

Leica LIF (generated by Leica confocals)

n

Neurolucida Tracing XML format

n

Openlab LIFF

n

PerkinElmer AIC

n

Apple PICT

n

QuickTime Images (this includes formats such as Photoshop PSD and any other still image
format supported by QuickTime)

n

TIFF
n

Improvision TIFF extensions (metadata included in the ImageDescription tag)

n

Leica TIFF (generated by Leica confocals)

n

Olympus TIFF (generated by Olympus confocals)

n

PerkinElmer TIFF (generated by PerkinElmer UltraView systems)

n

GE TIFF (generated by GE Healthcare INCell 1000 systems)

n

OME TIFF (as described by the Open Microscopy Environment http://openmicroscopy.org )

n

Zeiss LSM (this is a TIFF variant)

n

MetaMorph STK (this is a TIFF variant)

n

Olympus OIF (this is a TIFF variant)

n

TILLVision

For writing, Volocity supports the following formats:
n

Windows BMP

n

Volocity Library Clipping

n

ICS/IDS (Image Cytometry Format)
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n

JPEG

n

Openlab LIFF

n

TIFF (with Improvision extensions)

n

OME-TIFF (2007 schema, as described by the Open Microscopy Environment
http://openmicroscopy.org)

n

TIFF for Publication

n

QuickTime Movies

n

AVI Movies

Volocity supports writing views as QuickTime movies and as AVI movies.
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Organizing Data in a Library
Overview
This chapter describes:
n

the library format

n

the library menu and toolbar

n

library thumbnails and icons

n

how to set item properties

n

how to create new folders

n

how to copy and move folders and items

n

how to find items

n

how to compact libraries
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Library Format
The application creates libraries in a multi-file format, which handles large data sets well and gives
fast data access. When you create a multi-file library, it is created within a folder. This folder is
labeled with an icon and the name of the library.
Inside the folder are the library file and a data folder, which contains all the data required to view the
images and volumes kept in that library. Multi-file library files have the suffix .mvd2.
It is essential that the library file and data folder are kept together, which is why the application
creates them together in a separate folder. To open the library, you must first open this folder and
locate the library file. If you want to move a multi-file library to another location you must move the
whole folder. If you only move the library file, the application will not be able to display any of its
contents.

Library View
The Library view shows you a list of all the items in your library. If there are sub-folders or single files
containing multiple images within your library, click on the arrow next to the folder/file thumbnail to
expand and contract the folder and view/hide the contents. See also page 70.

Each item has a name in bold text. This name may be changed to assist organization of data. Click
once on an item name to select the item then click again to open the text in a editable field to change
the name.

Library Menu
Whenever a Library view is active, the Library menu will be available.
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Small Thumbnails, Medium Thumbnails and Large Thumbnails set the size of image used to
represent an item in the library. Sort by allows library data to be organised by properties of the data.
Each item is listed with information to assist finding and organizing items. In the case of image
sequences this text describes the X, Y and Z dimensions in pixels followed by number of channels
and number of timepoints.

Show Data in the Library menu to display additional information such as the time the item was
added to the library or the item type.

November 2008 61

Library Thumbnails and Icons

Library Thumbnails and Icons
The item's thumbnail tells you what kind of item it is.
This is a folder or multi-layered file.
This is an Openlab LIFF file containing multiple images.
This is a thumbnail of the image, volume or image sequence. Data shown below the name
of the item, to the right of this icon indicates XY and Z pixel dimensions, channels and
timepoints.
This is a PSF (used with Volocity Restoration, see page 532, also the glossary).

This is a background correction, see page 119.
This is a registration correction, see page 124.
This is a spectral signature (only available with Acquisition), see page 280.
This is a Measurement item (only available with Quanitation), see page 458.
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Setting Item Properties (Edit menu)
Every item has a number of properties associated with it.
Some properties are fixed and are assigned by the system, such as the kind, time modified and date
modified. Others are user-defined, which provides you with a useful method of recording additional
data against an item by which you can also search for items. You can set properties on both 2D and
3D items.
The correct XYZ properties (in micrometers per pixel) are essential for generating correct scale bars,
calibrated measurements in Quantitation and the correct application of PSFs in Restoration. These
properties effectively set the calibration of the data.
The Volocity file filters read XYZ calibration information from supported file formats when they are
imported. Acquisition directly into the application will set the relevant properties automatically.
In the following example, we have set up properties for a single item. To change common properties
for several items at the same time, select the required items before selecting Properties… from the
Edit menu.
1. Select an item and then select Properties… from the Edit menu. We have selected an item called
"Neuron".
2. Enter properties as appropriate. Use commas to separate multiple entries, for example keywords.
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3. Click on Change.

Creating New Folders
Create folders to organise data within a library.
1. Select Create New from the Actions menu and then select Folder. This will create a new, untitled
folder as the last item in the library.
2. Drag and drop items into the new folder as required.

Copying and Moving Folders and Items
Copy Items Between Libraries
The most convenient way to move items between libraries is to use the Library Clipping export
format. Select the item in the open library, use the Export... command and select the Library
Clipping format. The Export command allows you to specify a unique name for the clipping file; it will
have an .acff suffix. See also page 135.
To copy the clipping file to a new library, open the library and drag and drop the clipping into the
library view. You can also use the Import... command to import the .acff file into the library. See
page 55.

Move Folders into Other Folders
Click on the folder and drag it to the required position in the library hierarchy.
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Move Items from One Folder into Another
You can move sub-folders and individual, unrelated image files, such as TIFF files. You cannot move
items from multi-layered files, such as Openlab LIFF files or multi-layered TIFF files, because the
relationship is set by the source data. Moving the item would change the way the original entry in the
library is linked to the source data. If you try to do this, you will be prompted to create a copy of the
item.

Copy Items from One Folder into Another
n

If you have tried to move an item from a multi-layered file, click Copy at the prompt.

n

Or select the item and use the Duplicate command in the Edit menu. This duplicates the item in
the same folder and you can drag and drop it into another folder.

n

On a Mac, hold down the Alt key as you drag the item into a different folder. A progress message
is displayed telling you that the application is copying the item into the folder.

n

On a WINDOWS, hold down the Ctrl key as you drag the item into a different folder. A progress
message is displayed telling you that the application is copying the item into the folder.

The copied item is automatically adopted into the library so you will be able to make changes to it
without changing the source data.

Finding Items (Edit menu)
The Find command allows you to quickly locate images within a library.
1. Select Find from the Edit menu.
2. Enter the search criteria, as appropriate. You will be able to select from a number of search criteria.

3. Click Find to display the Search Results window, which is displayed as a gallery of items. The
Results menu contains the same commands as the Gallery menu described on page 104.
4. Double click on the required item in the Search Results window to open it in a new window.
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5. If you want to enter multiple search criteria, select Find again and click on the More Choices button.

6. Enter as many search criteria as required and click on Find to display the search results.
Note: Find remembers the search criteria, so use the Fewer Choices button if you want to remove
search criteria that you have already set up.

Delete/Remove Items from a Library
Highlight the item(s) to be removed and select Remove Items from the Actions menu. Edit menu,
Undo command will reverse the last action including Remove Items. Items cannot be removed if they
are part of a linked file that is not adopted into the library.
To remove part of an item, for example a selected channel, an ROI (region of interest), a
measurement item row, select the part that is to be removed and use delete (Windows) or backspace
(Mac OS).
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Locating an Item (Actions menu)
The Show in Library (see page 104) and Reveal in Finder/Explorer commands in the Actions
menu allow you to quickly locate an image link in the library or the source data in the Finder (Mac) or
Explorer (WINDOWS).

Reveal in Finder/Explorer
This command works from a Library, Single Image or Gallery View and highlights the location of the
source data for the selected item in the Macintosh Finder or Windows Explorer. If the source data
has been removed from the hard disk, the application just displays the Finder or Explorer. If the
source data was on a removable medium, it prompts you to insert the relevant disk or medium.

Compacting Libraries
Even though libraries will increase in size under normal use, Volocity will always make best use of
available disk space. However, when moving or backing up libraries you may like to use the
Compact Library command. This optimizes the library size. Cached data includes stored rendering
settings, therefore, it may take longer to view data once the library has been compacted.
1. Select Compact Library… from the File menu.
2. Leave the checkbox selected to remove cached data and preferences. Then click on Compact.
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Views on Data
Overview
Once you have added data, you can view library items and items within an image sequence in a
number of different ways. Each type of view has its own window, menu and toolbar. View-specific
menus and toolbars contain commands that are particularly relevant to that view. The menu title
and/or contents will update according to the active view.
This chapter describes:
n

the Library View

n

item selection

n

the Image View

n

the Image Sequence view

n

the Voxel Spy palette

n

the Gallery View, menu and toolbar

n

the Notes tab

n

snapshots

n

how to show data

n

how to sort items
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Library View
The Library is your base for working in Volocity. Files imported or acquired are added to the
database and access to them is via the Library view.
You cannot capture an experiment using Volocity Acquisition without first opening a library.
Volocity opens first to an empty library view containing shortcuts to the common actions.

Video shortcuts are only available if the system is licensed for Volocity Acquistion, FRAP and Ratio.
Existing libraries and recent items can also be opened using the options in the File menu.
The Library View shows you a list of all the items in your library. If there are sub-folders or single files
containing multiple images within your library, click on the arrow next to the folder/file thumbnail to
expand and contract the folder and view/hide the contents.

Click on arrow to
expand/contract an
item
Click on a thumbnail
or item name to
select it. If you click
on the name whilst it
is highlightes you can
edit the text.
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Click and drag to
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A single click on an item listed in the library on the left will show a view or views on that item in the
area on the right.

The views and options that are available will depend on the nature of the data, particularly whether it
is 2D or 3D, and the Volocity products licensed on your system. See the sections on the Image view
(page 73) and the Visualization (page 335) and Quantitation (page 408) products for more details.
Double click on an item in the library to see it in its own window. Multiple views of the same item
may be shown.

How Do I Look at Items in the Library?
Click once on an item in the library list to view it in the single window layout.
Double click on an item to open the item in a separate window. Use the Window menu as necessary
to move between multiple open windows.
The window will have a toolbar and a number of tabs that allow you to display different views of the
image data. The type of item determines what tabs and tools are available.
n

If you click once on a single image or an image sequence, the item will be displayed in an Image
view (see below).

n

If you click once on a folder or multi-image file, you will display the contents in the Gallery view
(see page 104). If there are sub-folders, you can double click on those to view the contents in a
separate gallery window.

n

If you click once on a PSF, background correction, registration correction or spectral signature
you will display a view which contains the parameters used in creating that item which will confirm
its application to image data.
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Note: It is possible to open the same data in multiple separate windows. Double click on the item in
the library list and repeat until the required number of instances are open. This extremely useful
feature allows you to compare different views of the same data.

Selecting Items in the Library
You select items in the library in the same way that you select items in Macintosh Finder or Windows
Explorer.
n

Click on an item thumbnail or item name in the library list to select the item. A view of the item
will be shown to the right of the list.

n

To select a group of consecutive items, hold down the shift key and click on the first and last item
in the group. No view is shown for multiple items.

n

To select multiple items not in sequence, hold down the Apple key on the Mac or the Ctrl key on
Windows and click on the required items.

See “Organizing Data in a Library” on page 59 for more information about working with the Library
View.

Status Bar on Windows
The status bar is a standard Windows feature that appears in all views on the PC at the bottom righthand corner of the application window. This is also the first place that progress information is
displayed, even before a progress bar is posted to the screen. Error messages may also appear in
the status bar.
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Image View
When you single click on an image item in the library list or click on the Image tab within an item that
is already open, the data is displayed in an Image view. Whenever an Image view is displayed, the
Image menu is enabled and the toolbar updates to show tools that are appropriate for the image data.

Mode
Change the Mode to present the data in different ways. Modes available depend on the products
licensed and the nature of the data. For example 3D data may be viewed in XYZ, XY, XZ, YZ,
Extended Focus or 3D Planes. 2D data may only be viewed in XY.
If Volocity Visualization is enabled additional modes will be available.
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2D Items
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3D Items

In an image sequence, the view displays a brightest point merge of all the channels at the current
location in the object.
Extended Focus mode is of interest when working with 3D images. It displays a 3D image as a single
plane by making a brightest-point merge of all the Z-slices of a volume.
Change the Mode to Extended Focus. The XYZ view displays a single plane in each of the three
dimensions. The Extended Focus view displays a single image, which is a brightest-point merge of
all the Z-slices of a volume.
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Selections can be made within the volume, using the tools in the Image View toolbar, and
measurements can be made from these selections. Note that the volume and all selections made are
three-dimensional and have depth and volume.
Sequences with more than one timepoint may be exported as movies from the Extended Focus.
Choose File, Export… and the Export View as QuickTime/AVI movie option. The will make a
movie stepping through each timepoint in the Extended Focus mode. See page 140.
Use the channel controls to manipulate the individual channels and the time navigation to move
through timepoints.
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Channel Controls
In an image view the controls for working with the individual channels in a dataset are shown to the
right. If these are not visible select Image menu, Show Channels.

n

Turn channels on and off by clicking on the show/hide channel button

n

Target channels using the “Target” button. Some tools make different selections depending on
which channel is used as the basis for selection. For example, the magic wand tool (see page 81)
works on voxel intensity so the size and shape of the selection made by the tool can be very
different according to which channel is targeted when the selection is drawn. For more
information see page 415.

n

Increase or decrease the contribution of individual channels to the final image, using the slider
bar for the channel. This will make the channel appear brighter or darker in relation to the others.

Time Navigation
If the image sequence contains more than one timepoint the time navigation controls will be enabled.
Move through time resolved data in an image view using the time navigation controls across the
bottom of the view. If these controls are not visible select Show Time Navigation from the Image
view.
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Play the sequence back at a fixed rate (number of frames per second set by the slider) or real time
(for example 10x acquisition rate, again set by the slider).
Set the mode of playback by selecting Loop Sequence or Shuttle Sequence from the Image menu.
If, because of the size of the data or capabilities of the hardware each timepoint cannot be loaded at
the rate specified by the slider Skip Timepoints will miss out timepoints as necessary to maintain
the frame rate.
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Image Toolbar
Mode
Select the display mode for the image data. Modes available will depend on
the dimensions available in the data. 2D data can only be shown as an XY
Plane. 3D data may be shown as XYZ Planes, and any part of the XYZ Planes
view independently. Other modes may be available with additional products
such as Volocity Visualization.

Inspection Tool

Shortcut key I

Use the cross-hair tool to position the pointer on any of the planes and drag to
explore the Image view moving through the different parts of the slices. The
cross-hairs will be labelled with the current X,Y,Z coordinates. The Inspection
tool also operates in XY, YZ and XZ modes, moving in two axes simultaneously
to explore the data.

Note on the screen how the cross-hair colors are different for each plane and are also shown on the
3D preview in the top left-hand corner.

November 2008 79

Image View

XZ, green

YZ, blue

XY, red
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Zoom and Pan Tools

Shortcut key Z

Shortcut key H

Use the Magnifying tool to zoom in on a region of interest. Click with the tool to
zoom in. On a Mac, Alt-click zooms out again. On Windows, use Ctrl-click. On
a 3D Image View, the zoom command allows you to magnify any of the three
planes. If you zoom in on one of the planes, then all three planes will be
magnified to the same factor and the 3D cross-section has a fixed, relative
size.
On 2D Image and Movie Views, use the Hand tool to pan through a magnified
image. On 3D Image Views, use the Hand tool to pan the XYZ planes. Over
the 3D cross-section the cursor will always appear as a hand. Click and hold,
then spin and release to make the preview tumble. Use Alt-click (Mac) or Ctrlclick (WINDOWS) and drag to zoom the 3D cross-section.

Selection Tools
Use the Selection tools to draw regions of interest (ROIs) and lines on the image. Although the tools
are available with all versions of Volocity, they are mainly used for measuring with Volocity
Quantitation. Refer also to the chapter on "Volocity Quantitation" for worked examples using these
tools for measurements.

Shortcut key R

The Rectangular ROI selection tool is available for all image data. It allows you
to draw rectangles or squares.

Shortcut key S

The Lasso tool allows you to trace the outline of a selection. The Lasso tool
selects regions based upon the color similarities of adjacent pixels. The initial
point clicked sets the color to compare and the tool has the effect of shrinking
around the pixels that fall outside of the tolerance value.

The Elliptical ROI selection tool allows you to draw ovals or circles.
Shortcut key C

Shortcut key F

The Freehand tool is available for all image data. It allows you to make a
freehand selection of an area on the image.
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Shortcut key W

The Magic Wand tool is available for all image data. It allows you to select
regions based upon the color similarities of adjacent pixels. The initial point
clicked sets the color to compare. This tool has the effect of expanding
outwards from the original color.

The Line tool is available for all image data, but is of limited use without the
Volocity Quantitation functionality. Use it to add lines in the Image View. The
tool draws a straight line between points that you specify by holding down the
Shift key and clicking with the cursor. Line length and an intensity profile
overlay are shown on the image if set in the view options. You can have any
number of points in a single draw action, as long as you hold down the Shift
key. When you release the Shift key, Volocity assumes that the last click was
the end point. Click on the points within a line to move or delete.

Use the Point tool to count objects or features visible in the image.

Tips on Using the Selection Tools
Once you have selected an area, you can also use the Copy command from the Edit menu. Cut,
Paste and Clear commands are only active if the item is adopted (see page 110).
As long as the selection is still active, you can use the pointer to click in the selected area and drag it
to another part of the image.
The following key combinations also apply:
Macintosh
n

Control-drag on a selection centers the selection on the image.

n

Command-drag locks the dimensions, to make a square or circular selection rather than oblong
or oval.

n

Shift allows you to add to the ROI or draw multiple ROIs.

n

Shift + alt (option) allows you to subtract from the ROI or subtract the whole of the existing ROI
by drawing around it.

n

Alt (option) carries out an AND operation leaving only the intersection of the two ROIs.
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Windows
n

Shift allows you to add to the ROI or draw multiple ROIs.

n

Shift + ctrl allows you to subtract from the ROI or subtract the whole of the existing ROI by
drawing around it.

n

Ctrl carries out an AND operation leaving only the intersection of the two ROIs.

ROI Options
The ROI is shown as marching ants on the Image View with color projected onto the image to
highlight the area of interest. You can define the color and transparency used for the ROI.

Marching ants
outline the ROI

Color block
shows projection
of ROI on each
plane
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1. Select View Options… from the Image menu. Click the ROI tab.

2. Use the ROI color drop-down menu to select the required color and use the slider control to set the
ROI opacity.
3. Click on OK.

Image Menu
Whenever an Image View is active, there is an Image menu available in the menu bar. The menu
commands are appropriate to the type of image data. For example, some options are only shown for
3D images.
Mode sets the visualization for the view. The same options are available in a pop-up on the tool bar
and change the way that the image is displayed. For example a 3D image can be visualized as
planes in XZ, YZ and XY or just one of these at a time. Volocity Visualization adds options to this list.
Stereo is only applicable for an image being viewed in 3D rendering and therefore discussed in the
section on Volocity Visualization.
Show/Hide Channels, Bookmarks, Movie and Time Navigation will customize the Image view to
give maximum screen space to the image or to show additional interface that is used with the view.
Capture Snapshot is described on page 104, Create QTVR is available with Volocity Visualization
only and is described on page 355. These are both for creating output from the Image View that may
be shared with other people.
Loop Sequence, Shuttle Sequence and Skip Timepoints select the playback mode for time
resolved data. Use the Time Navigation controls to start and stop playback (see page 77).
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Next in the menu come a series of options which will apply overlays to the image or
change elements of the view. These are not permanent changes and the menu
item will change to the opposite to allow any change to be reversed.
Reset View will return the view to its default appearance.
Use the Smooth Zoom command to apply interpolation to the view to give better
quality when viewing zoomed images and automatically set the best quality for
printing.
If an image timestamp has been displayed using Show Time Absolute Times or
Relative Times will affect the format the timestamp is shown in.
When viewing the image view of an image sequence consisting of two or more
channels, the user can choose the method that is used to merge the two channels
for display from the Overlay channels using sub menu.
n

Brightest point: The brightest intensity in the source images is displayed.

n

Accumulate: The total intensity of the voxels in the source images is displayed.

n

Average: The average intensity of the source images is displayed.

Show Time
The timestamp of an image in an image sequence can be shown when viewing the Image View.
n

Select Show Time or Hide Time in the Image menu to toggle the timestamp on or off.

n

Select Absolute Times or Relative Times to choose the style of timestamp to be displayed.

n

Select Image menu, View Options… On the General tab use Frame time color to change the
color of the timestamp.

Showing Color Reference
On all Image Views, apart from millions of colors images, you can display a legend that shows the
colors in the image and the values they represent.
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To display this legend, select Show Color Reference from the Image menu.

Color
reference

The color reference may be moved to any corner of the XY area of the image view.
Note: There is a separate color reference for each visible channel. Therefore, if multiple channels
are shown in the channel controls, multiple legends will be displayed. Hide unwanted color
references by hiding the channels from which they are derived on the channel controls
Select Image menu, View Options… and the Color Reference tab choose how the color reference
is displayed.
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Showing Scale on Images
Whenever an Image View is active, you will also be able to display scaling information. Select Show
Scale from the Image menu to activate this feature.

Use View
Options…
Scale tab to
show/hide
labels

n

The scale displayed will depend on the properties set for the size of voxels in the X,Y and Z
dimensions. Choose Properties... from the Edit menu to check these values and ensure the
correct scale is displayed.

n

Use View Options... and the Scale tab from the Image menu to change how scale is displayed.

n

Move the scale to any of the four corners of the image by dragging it.

n

Extend or shorten the scale bar by clicking and dragging one end of it.

Showing Line Profile on Images
Draw a line across the image to show an overlay displaying the intensities along that line. A different
overlay is added for each line drawn and the intensities for different channels are shown in the
respective colors of the channels.
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The colored band at the top of each profile reflects the color of the line. Note that the line may be
positioned anywhere in 3D space using the XYZ mode of the Image view.
If the line profile is not visible turn it on in the General tab of the View Options dialog.
Capture snapshot (see page 104) will create a snapshot with the currently active line profiles
captured to the right of the image.

View Options
The View Options… dialog is available in the Image menu. This is a tabbed dialog with options for:
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n

General: showing the length of lines drawn using the line tool, showing the line profile and
the color of image timestamps shown on the Image view

n

Color Reference: to change the nature of the color reference overlay, its orientation, color
and caption

n

Scale: to change the style, color and labeling of the scale bar overlay

n

ROI: to change the appearance of ROIs in the image view
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Bookmarks
Bookmarks record information about the position and appearance of the data in the Image view
allowing a way of viewing image data to be reproduced and compared.
Bookmarks are stored in a panel to the left of the image data. If this panel is not already visible
select Image menu, Show Bookmarks. When the view appears as required select Image menu,
Add Bookmark. Settings controlled by the channel controls or the tools for positioning items will be
stored in the bookmark. Overlays turned on or off by items in the Image menu e.g. scale and time
are not stored by bookmarks.

To Use a Bookmark
Double click on the thumbnail of a bookmark in the bookmark pane to use the settings of that
bookmark to change the position and appearance of the Image view to those stored by the bookmark.
Alternatively use Next Bookmark or Previous Bookmark in the Image menu to step through
bookmarks in the order in which they were created.
To Edit a Bookmark
Select the bookmark in the bookmark pane, the borders of the bookmark will become highlighted.
Select Image menu, Edit Bookmark.
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A dialog is opened showing the states of the view that are being stored.
Uncheck a state and that part of the bookmark setting will not be applied to the Image View when the
bookmark is used.
Check the state again and the setting(s) stored when the bookmark was created will be applied when
the bookmark is used.
To Move a Bookmark
To use the settings of one Image view with another data sets so that the two data sets may be
compared, move the bookmark from the first Image view to the second.
With both data sets open in the image view with the bookmark pane visible drag the bookmark from
one to the other.
The bookmark thumbnail will update the first time it is used with the new dataset.
To Delete a Bookmark
Select the bookmark in the bookmark pane, the borders of the bookmark will become highlighted.
Use the Delete (Windows) or Backspace (Mac OS) keys to delete the bookmark.

Movies
You can animate an Image View using bookmarks and the movie interface in the Image View.
Bookmarks are the starting point for making movies in this way. The movie will be an animation of
the transition between the appearance of the volume in one bookmark and its appearance in the next
bookmark. Each transition takes place over a number of frames determined by you. Select Show
Bookmarks from the Image menu to view the bookmarks pane.
1. Choose Show Movie from the Image menu. The movie pane will appear at the bottom of the screen.
2. Drag a bookmark thumbnail from the bookmark pane to the movie pane. The movie pane will be
highlighted when the bookmark is in position. Drop the bookmark at this point to create a keyframe
in the movie. By default this keyframe will be 10 frames long. Keyframe length may be changed by
clicking and dragging the end of the keyframe.
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3. Drag a second bookmark into the movie pane. When the movie plays, the volume will be gradually
changed in appearance from the first bookmark to the second, this transition taking as long as the
number of frames over which the first keyframe extends.
4. Continue dragging bookmarks in to the movie pane to make a series of keyframes/transitions.
5. To include switching between timepoints in a movie made for a time resolved sequence select Add
Timepoint Sequence... from the Movie menu. Configure the dialog so that the timepoints are
changed in the way and at the rate required.
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This will add a time bar to the movie which can be configured to last any number of frames, switching
between timepoints backwards or forwards and even switching between a subset of timepoints.
More than one timepoint sequence may be added to a movie to achieve the behavior desired.
2. Delete a keyframe or timepoint sequence from the movie by clicking on it once to select it then using
the Delete key (Windows) or the Backspace key (MacOS). Change the length of keyframes by
clicking on and dragging one end of the bar.
3. Preview the movie on the current Image View using the controls at the bottom of the movie pane.
4. Generate the frames of the movie as an image sequence in preparation for export. Select Movie
menu and Make Movie.
Controls related to the Movie under creation will be in the Movie menu.
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Edit Keyframe
Double click on a keyframe or select Edit Keyframe... from the Movie menu to access the Edit
Keyframe dialog.

This dialog allows configuration of the length of the keyframe or transition and also selection of the
bookmark properties which are used in that transition. It is, therefore, possible to use only the
positional information and not the rendering settings stored with a keyframe.
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Edit Timepoint Sequence
Double click on a timepoint sequence or select Edit Timepoint Sequence... from the Movie menu to
access the Edit Timepoint Sequence dialog.

Adjust the number of frames over which the timepoints will be played through, switch between
timepoints backwards or forwards.
You can also use this dialog to configure a timepoint sequence to switch between a subset (or range)
of timepoints. Additional timepoint sequences may be added to the movie to switch through
remaining timepoints.
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Resize Movie
Select Resize Movie... from the Movie menu to easily change the length of the movie. Movie length
may be changed to a percentage of its original length, to a fixed number of frames or to last a known
length of time when played at a known frame rate.

Clear Movie
Select Clear Movie from the Movie menu to delete all the keyframes and timepoint sequences of a
movie.
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Save and Restore Movie
Save the movie keyframes by selecting Save Movie... from the Movie menu. Give the movie a name
and click Save. This will store the movie as a preference within the system.
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Once saved movies may be used with a data set by viewing the Image View and selecting Restore
Movie... from the Movie menu.

Exporting a Movie
Once a movie is created you may wish to generate the frames of the movie for the current Image
View to then be able to export them. Also, it may be relevant to save this movie for future use and for
use with different data sets.
Make Movie
Select Make Movie… from the Movie menu to create the movie frames and add them to the library.
The Make Movie dialog allows the X and Y pixel dimensions of the movie frames to be set. Choose
dimension and click Make Movie or accept the last used dimensions by pressing the Return key. A
new image sequence will be added to the library. The name is the same as the source data with
“Movie” appended.
This image sequence may be exported as a movie file (QuickTime or AVI) by selecting it and
choosing Export... from the File menu.
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Image Sequence View
Image sequences are collections of images arranged by channel and timepoint. Multi-channel and/or
time-resolved data with one or more planes in z is best viewed using an image sequence.
Image sequences are created when the data is added to a library or by dragging all the related
images onto a new Image Sequence View.
The Image Sequence View shows the brightest point merge of data for each channel and timepoint
as thumbnails. The header information shows the XYZ dimensions of the source image data and the
number of channels and timepoints in the sequence.
1. Click on the title bar of any channel or timepoint to select it.
2. Hold the cursor over an item in the Image Sequence View to show a tip that gives the timestamp,
channel and type.
Note the time
stamp at the
top of each
timepoint.
Channels are
arranged
vertically.
Timepoints
run
horizontally.

n

To remove a channel or timepoint select it and either choose Clear from the Edit menu or use the
backspace (Mac OS) or delete (Windows) keys.

n

Double click on any channel titlebar to rename it. Type in a new name and click on Change.
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Image Sequence Timeline View (not available in Volocity LE)
The Timeline View provides a way of viewing time-resolved image sequences. Buttons control the
mode of the view.
Switch to thumbnail view.
Switch to timeline view.
Each row in the timeline view represents a channel in the image sequence. At the left of the row is a
thumbnail image of the current time point. To the right of this thumbnail is a “timeline”. On the
timeline a vertical red bar signifies the current time point.

Thumbnail
image of
current
timepoint

Drag the red bar to change the current timepoint.

Image Sequence View Zoom
The Timeline View can be zoomed to view more or less of the sequence in the window. This is done
using the three buttons at the top of the Image Sequence View: Zoom In, Zoom Out, and Zoom to
Fit.
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Relative and Absolute Times
Thumbnails in the Image Sequence View are labeled with a timepoint number and timestamp. The
display of these timestamps can be altered to show:
n

Absolute Times: the timestamp given to the volume or the image, or

n

Relative Times: when timepoint one is designated as time zero and all other times are displayed
relative to that.

Use the appropriate option in the Sequence menu to choose which time is shown.

Merge Channels
This command creates merges the selected channels in an Image Sequence to generate a new
merged channel with the same X,Y and Z dimensions as the original. Three different types of merge
are available:
n

Brightest point – the brightest voxel at each location is taken to make up the merged channel

n

Accumulate – the sum of the intensities of all the voxels at each location is taken to make up the
merged channel

n

Average – the average of the intensities at each location makes up the merged channel

1. Select two or more channels in an image sequence and select Merge Channels from the Sequence
menu.
2. A new channel will be created in the sequence. The new channel will have the same dimensions as
all other channels in the sequence, and the previously selected channels remain unaltered. The new
channel will be named “Merged Channel”.

Copy Timepoints to a New Sequence
Create a copy of part of an image sequence by dragging the portion required into the library.
1. Select the timepoints that you wish to copy, using the Timeline View, as described above.
2. Click and hold the mouse button on the column header of one of the selected columns.
3. Drag the selected timepoints out of the sequence and into the library.
4. A new image sequence will be created containing the selected timepoints. The new image sequence
is named appropriately to indicate which timepoints were selected.
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Resample Timepoints
This command allows the image sequence to be resampled according to a desired frequency of
timepoints. This will reduce the number of timepoints in the sequence and therefore its size. A
reduced number of timepoints may assist analysis of a time-resolved sequence.
1. Select Resample Timepoints… from the Sequence menu.

2. Set the new frequency for the sequence.
3. Check Output to a new sequence if the results are to be used to create a new image sequence; it
will have “(resampled)” appended to the name.
4. Click OK.
Note: If timepoints in the image sequence are already at or below the selected frame rate,
Resample Timepoints… will make no change.

Set Timepoints
It is possible to manually change timestamps for the timepoints of an image sequence to achieve a
new, constant rate.
1. Select the Sequence menu, Set Timepoints.

2. Set the new time interval to be used for the entire image sequence.
3. Click OK.
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Compress Channels
This option allows you to compress channels within image sequences, which will reduce the file size
of libraries containing large image sequences.
Note: Only image sequences created in version 2.5 or higher may be compressed.
1. View an image sequence and select the channels to be compressed.
2. Select Compress Channels from the Sequence menu.
3. Select the compression type, and the codec (the encoding to use) for that compression type from
the drop-down menus. When using the compression type, QuickTime, the codec drop-down will offer
all installed QuickTime codecs.

Lossless compression means that no data is lost from the image. The data compressed in this way
will remain effectively unaltered. The Better Compression codec will result in smaller file sizes,
while the Faster Compression codec will result in less delay when opening image sequences.
When compressing 8-bit channels, QuickTime compression is available. Not all QuickTime codecs
are lossless, which means that data may be slightly altered after compression; however, it will
usually result in an efficient and fast data compression of large sequences. When using QuickTime
compression, use the slider bar on the dialog to choose a compromise between Smaller File size or
a Better Image with less data loss. Using lossy compression on a data set will affect the results of
measurements, deconvolution, and other processing, therefore it is not recommended for data that is
to be processed further.
4. Click OK.
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Voxel Spy Palette
The Voxel Spy palette may be used on any Image View. For the voxel under the cursor and for each
channel, it shows:
n

The X, Y and Z co-ordinates.

n

The color according to the active look up table.

n

Value(s).

If the Voxel Spy palette is not already visible on the screen select Window menu, Show Palette
Position the cursor on the Image View at the point of interest.
Click on the preview area in the palette to zoom in and out on the voxel.

Click on preview to
zoom in and out

XYZ co-ordinates and
µm according to XYZ
properties

Value of voxel

Note: Values shown for voxels are typically intensity values but may represent other properties
depending on the source of the channel.
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Gallery View
The contents of folders are shown in Gallery views.
Use the Gallery view to see the contents of a folder and select an individual item.

Click once on a folder to show the Gallery view.
Double click on an item to open it in a separate window.
Change the size of the thumbnail displayed here using the options in the Gallery menu.

Show in Library
If you have a single image displayed in the active window or a single image selected in a Gallery
View, this command highlights the image in the library structure. From a Gallery View (with no
images selected), it highlights the folder or multi-layered file in the library structure.

Notes View
For all items in a library, there is a Notes View. You can add notes to any library item and view or edit
the notes at any time. To add or edit notes, just select the Notes View and type in the text. You can
use the Copy and Paste commands from the Edit menu and you can also print the notes, using the
Print command from the File menu.

Capture Snapshot Command (View-Specific menu)
A view-specific menu is one which activates only when the view is shown. So the image menu is
visible in the menu bar when the Image view is active.
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Capture Snapshot in the allows you to capture 2D snapshots of even 3D data that you can then
print.

Use the options to create the snapshot suitable for the use in mind.
When used with the Image View, Capture Snapshot captures a 2D snapshot of the data.
The Capture Snapshot command also captures any scale information, lines or ROIs that are
displayed on the active view.
The snapshot will be added to the library and may be opened in the same way as any other image in
Volocity. Select the image and File menu, Export… to export the snapshot from Volocity.
Volocity Visualization users only
When used with the 3D rendering modes of the Image view, Capture Snapshot creates a single 2D
image and adds it as a new image to the library. If you want to publish a volume and preserve the 3D
effect, use the Create QTVR Movie… command from the Tools menu.

Show Data Library menu
You can select an additional item of information, to be shown as a third line of text below the item
name.
1. Select Show Data from the view-specific menu.
2. Select a property from the drop-down menu.
3. The additional data is displayed.

Sort Items Library menu
You can sort items in a number of different ways.
1. Select Sort By from the view-specific menu.
2. Select a property or image brightness or color as the sort criterion.
3. A progress meter is displayed briefly as the application sorts the images and rearranges them.
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Docking Palettes (Windows Only)

On Windows use the options Sort Ascending, Sort Descending and Sort Recursively to change the
sort behavior. On Mac OS change the sort behavior by using keys to change the menu. Default sort is
ascending; hold the Alt key to reverse (descending) sort; hold the Shift key for recursive sort and hold Alt
+ Shift for reverse recursive sort.

Docking Palettes (Windows Only)
The Voxel Spy Palette may be docked to the left or right-hand edge of the application window. Drag
the palette to one side of the application window and release it when the outline of the palette
changes. In the example below the Voxel Spy palette is dragged to the right and will dock to the right
hand side of the application window when the mouse is released.
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Open views will be sized accordingly. Drag the palette back onto the main window to release it.
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Docking Palettes (Windows Only)
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Manipulating Data
Overview
The actions described in this chapter are applicable to both 2D and 3D image data. The commands
are ordered alphabetically.
n

Undoing Commands

n

Batch Processing

n

Adopting Items (Actions menu)

n

Applying and Uses of Auto Contrast (Tools menu)

n

Changing Color Depth (Tools menu)

n

Changing Colors (Tools menu)

n

Changing Size (Tools menu)

n

Cloaking Items (Actions menu)

n

Color Balance (Tools menu) (Not available in Volocity LE)

n

Contrast Enhancement (Tools menu) (Not available in Volocity LE)

n

Creating Background Corrections (Actions Menu)

n

Correcting Background (Tools menu)

n

Creating Registration Corrections (Actions menu)

n

Correcting Registration (Tools menu)

n

Cropping Items (Actions menu)

n

Merge Planes (Actions Menu)

n

Removing Noise (Tools menu)

n

Splitting Multi-Colored Items (Actions menu)

n

Splitting Volumes (Tools menu)
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Undoing Commands

Undoing Commands
The Edit menu has an Undo command that allows you to undo the most recent actions. It supports
multiple undo actions, starting with the most recent and working backwards in sequence.

Batch Processing
Most image processing and enhancement tasks may be applied to batches of image sequences.
Typically, the user will select a series of image sequences in the Library view and the dialog for the
process concerned will present a list of unique channel names against which the user selects a
process. If channels or items are selected, the option to change selected items will be presented.

Adopting Items (Actions menu)
Permanent changes to data may only be made if that data is saved in the library rather than linked to
a source file which remains outside the library. Permanent changes include changing data size,
cropping data and many image processing tools. Changing a file so that it is part of the library is
called adopting. Adopting increases the library file size.
1. Select the required item(s) in the Library or Gallery window.
2. Select Adopt Items from the Actions menu. The application searches for the source item(s). If they
are not on the hard disk, it will prompt for the removable medium. It will be unable to adopt an item
that was once on the hard disk but has since been deleted or moved.

Applying Auto Contrast (Tools menu)
Auto Contrast automatically sets the black and white points of the display image.
Auto Contrast finds the brightest and darkest pixels or voxels in an item and modifies the lookup
table (LUT) so that the brightest point is at the maximum display value, the darkest point is at the
minimum display value and all others are adjusted according to a linear best fit. The underlying
intensity values within the data are not changed.
1. Select the required item(s). Multiple image sequences can be processed at once.
2. Select Auto Contrast from the Tools menu.
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3. The Auto Contrast dialog will offer a list of available channels. Selected channels, if applicable, or all
channels may be adjusted.

4. Choose the appropriate option depending on how data will be compared. The dialog explains the
options.
To manually adjust:
n

Black and white points: use Contrast Enhancement, see page 116.

n

Gamma: use Contrast Enhancement, see page 116.

n

Red, green and blue contributions in color images: use Color Balance, see page 115.
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Changing Color Depth (Tools menu)

Uses for Auto Contrast
Auto Contrast provides a tool to adjust the LUT on imported data that appears extremely dark or
completely black due to a mismatch between LUTs from different software applications.
Auto Contrast can be applied to any item. However, as the contrast achieved depends on the
brightest point in each item, the result of applying Auto Contrast to a series of 2D sections (many
separate items) will be very different from the result of applying it to a volume (one single item) made
from them. In most cases you will want to reapply Auto Contrast after making a volume or image
sequence so that the whole data set is treated in the same way.
When working with Auto Contrast, it is important to note that a single voxel that is very much brighter
than any other will be enough to set the brightest level. This can lead to Auto Contrast causing no
apparent change to data.

Changing Color Depth (Tools menu)
Changing color depth changes the nature of the data and information will be lost. It is not a common
image processing operation.
1. Select the required item(s.) Multiple image sequences may be processed at once, simply select them
in the library. Select Change Color Depth… from the Tools menu.
2. Click on the drop-down menu and select the required color depth.

3. Click on Change.
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Changing Colors (Tools menu)
This command allows you to apply a different color lookup table to images, it does not change any
underlying data. Multiple items may be changed in a batch by selecting them all in the library view.
1. Select the required item(s) and select Change Colors… from the Tools menu.

2. Select the channel or channels to change
3. Click on the appropriate grayscale or RGB color. You can also click on This color and select a color
from the drop-down menu, enter a wavelength value or apply a Rainbow LUT.
4. Click on Change.
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Changing Size (Tools menu)
Use Change Size to scale data, changing the spatial resolution of the data and preserving the field
of view.
With 3D image data you can change the size of a volume in all axes, which uses less memory and
saves time for some processes.
Where resolution of data is important, for example when performing measurements or restoration it is
preferable to preserve resolution and crop data instead, using the Crop to Selection command in
the Actions menu.
To scale data when making single volumes see page 54.
The following example illustrates how to change the size of 3D items (the process is the same for 2D
items, but step 3 is not required).
1. Select the required item(s) and select Change Size… from the Tools menu.

2. Enter a scaling factor.
3. For 3D images only, enter a scaling value as a percentage. The X and Y dimensions are scaled
automatically, but you can choose how you want to change the Z size of the volume.
4. Select Resizing the volume in Z to change the amount of data in the volume by discarding some of
the z slice data. This command changes the number of frames in z.
5. If the volume is short of z data, select Changing the Z calibration to retain all of the data but
recalibrate the volume in z. This command does not change the data. It maintains calibration, which
is taken into account in other processes.
6. Click on Change.
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Cloaking Items (Actions menu)
Temporarily hide an image to prevent inclusion in an image sequence by cloaking it.
1. Select the item(s) that you wish to hide in the Library.
2. Select Cloak from the Actions menu.
3. To Uncloak the item select it again and choose UnCloak from the Actions menu.

Color Balance (Tools menu) (Not Available in Volocity LE)
Color Balance is a dialog that allows the user to adjust the contributions of red, green and blue in a
color image.
1. Select the item(s) to be adjusted in the library.
2. Select Color Balance... from the Tools menu.

n

If multiple 2D images are selected, the preview shows the first in the list; the same contrast
enhancement settings are applied to all images.

n

If multiple 3D volumes are selected, the preview shows a brightest point merge of the first in the
list; the same contrast enhancement settings are applied to all images.

n

If multiple image sequences are selected, the preview shows the first of the selected sequences.
Only one channel at a time is previewed as a brightest point merge. The drop-down at the top of
the screen shows a list of the unique channel names detected in the selected sequences.
Controls under the preview allow navigation to different timepoints.

4. Use the sliders to increase or decrease the contribution of the colors to the final image.
5. Adjust one channel at a time; clicking Apply will change the selected channel but keep the dialog
open allowing more changes to be made. Only one channel at a time may be enhanced but channels
with the same name in multiple sequences may be enhanced in a batch.
6. Click Change to apply the last change and close the dialog
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Contrast Enhancement (Tools menu) (Not available in Volocity LE)

Contrast Enhancement (Tools menu) (Not available in Volocity LE)
Contrast Enhancement is a dialog that allows the user to manually set the black and white points of
the display lookup table for an image, thus changing the contrast. It also allows gamma adjustment
which will set a non-linear distribution of that lookup table between the black and white points.
1. Select the required item(s) in the library. If working with an image sequence, select the channel to be
enhanced.
2. Select Contrast Enhancement… from the Tools menu.

n

If multiple 2D images are selected, the preview shows the first in the list; the same contrast
enhancement settings are applied to all images.

n

If multiple 3D volumes are selected, the preview shows a brightest point merge of the first in the
list; the same contrast enhancement settings are applied to all images.

n

If multiple image sequences are selected, the preview shows a brightest point merge of the first
channel in the first sequence. A drop-down at the top of the screen shows a list of unique channel
names detected in the selected sequences. Controls under the preview allow navigation to
different timepoints, if applicable.

116 Improvision

MANIPULATING Data

The red line across the histogram shows the current relationship between the input intensity values
(X-axis) and the output LUT (Y-axis).

Use the control points (red squares on the red line) to move the black, white and gamma points.

n

Change the Y-axis of the histogram to see detail more clearly, cycling through four possible
resolutions; linear, log, base 10 and base 100. To do this:
WINDOWS: Ctrl-click in the histogram area
Mac: Alt-click in the histogram area
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3. Click Apply to enhance all the channels with the selected name and leave the dialog open so that
other channels may be enhanced.
Calculate black and white points based on the darkest and brightest intensities in the data set by
clicking on the Calculate button. For time series data choose to set these using just the current
timepoint.
Note: The controls on the Contrast Enhancement dialog cannot be used on data sets that have been
colored with rainbow colors, see page 113.
4. Once you are satisfied with the adjustments in the preview area, click on Enhance.
To adjust contribution of red, green and blue in a color image use Color Balance, see page 115.

Background Corrections
In order to perform accurate analysis of your images or to improve their appearance, you may need
to perform Background correction. Background corrections include dark current correction,
background subtraction, shading correction or offset application. Bright or dark reference images
may be required for your correction.
Shading
Shading defects can be introduced into images by poorly aligned light sources, stray light and dirt in
the light path.
Shading artefacts are corrected by including division of a bright reference image in your background
correction. A suitable bright reference image for fluorescence images can be acquired from an
illuminated, uniformly fluorescent sample. A bright reference image for bright field images can be
acquired from a blank field (with no specimen present), which has been slightly defocused.
Dark Current, DC Offset.
Ideally, acquiring images from a digital camera in complete darkness would result in images with
gray levels close to zero. However, this is not the case. A combination of factors including dark
current and DC offset will result in gray levels 10s or 100s of levels from zero. These offset values
are present in all images acquired with digital cameras.
This is of no consequence for purely observational experiments when only the appearance, position
or size of structures is of interest. However, when the intensity of objects is of interest these factors
introduce error to all measurements made. The margin of error is small compared to the intensity of
very bright objects, however, it becomes increasingly significant the fainter objects of interest
become.
A background correction that subtracts a “dark reference” image from all images corrects this
problem, increasing the accuracy of all intensity measurements made. “Dark reference” images are
acquired by blocking all light from the camera and acquiring an image. Ideally, the exposure time of
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the “dark reference” should be the same as the exposure time of the experimental images to be
corrected.
A background correction that subtracts a fixed value from all images could also be used to correct
this problem, but this is likely to be less accurate than using a dark reference image.
Background (fluorescence)
Further error can be introduced into intensity measurements by the presence of background
fluorescence in a sample. This can be corrected by building a background correction that subtracts a
“dark reference” image from all images. In this case the dark reference should be acquired from an
illuminated area of your sample in an area in which no cells (or debris) are present. Again, the
exposure time of the “dark reference” should match the exposure time of the experimental images to
be corrected. A “dark reference” image acquired under these circumstances would correct
background fluorescence in addition to dark current and DC offset.
Defects that can be corrected are summarized in the table below:
Defect

Correction

Image Required for correction

Shading
(fluorescence)

Division with a bright
reference

Illuminated uniformly fluorescent slide

Shading (bright
field)

Division with a bright
reference

Slightly-defocused bright field image (with no
specimen present)

Dark current, DC
offset

Subtraction of dark
reference

Image acquired with light to camera blocked

Dark current, DC
offset

Subtraction of a fixed value None, set a negative offset in the correction (this
from every pixel
correction is less accurate than subtraction of a
dark reference image)

Background
(fluorescence)

Subtraction of a
background image as a
dark reference

Illuminated sample with no cells in the field of
view

Creating Background Corrections (Actions Menu)
You should acquire or add bright and/or dark reference images to your library before you build
background corrections. Bright and dark reference images should be the same dimensions in X and
Y, and the same depth as your images to be corrected.
1. Select Create New from the Actions menu.
2. Select Background Correction… to create a new background correction item in the library.
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7. The Create Background Correction dialog opens.

You can use the dialog to create a variety of corrections. As you build your correction, it is
summarized at the bottom of the dialog. When you first open the dialog the summary reads
“corrected image=image” to reflect that you have yet to specify any corrections.
You may apply as many or as few elements of the equation as you wish in your corrections,
depending on what you wish to correct for and how accurately you wish to do so.
Volocity uses the following equation when building background corrections:Corrected Image = Scaling Factor x ((Raw Image - Dark Reference + Offset)/(Bright Reference -Dark Reference))

Bright Reference Images
If you wish to divide your raw images by a bright reference image, select a bright reference image
from the drop-down menu. All of the images in the library will be displayed in the list. The degree of
shading in the bright reference is displayed in the dialog using the formula:
Shading = (Intensity max – Intensity min / Intensity max) x 100%).
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If you select a bright reference image, your corrected image will be multiplied by a scaling factor to
bring its gray levels into a convenient range. The scaling factor is the brightest pixel value in the
bright reference image (after subtraction of the dark reference image, if selected).

Dark Reference Images
To subtract a dark reference image from your raw images, and bright reference images if you have
selected one, select an image from the dark reference drop-down menu. All of the images in the
library are listed in the drop-down menu.
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Offsets
To apply an offset to your images, enter a positive or negative value into the offset field of the
dialog. Positive values will be added to raw images, negative values will be subtracted.
When you have built a satisfactory background correction, select Create. A new background
correction item is added to the library.

Background correction items can be exported from libraries as library clippings and imported into
other libraries.

Inspecting Background Corrections
Select a background correction item in the library to inspect it. The background correction will open
and you can review the names and thumbnails of images that were selected as either bright or dark
reference images, as well as a summary of the background correction that will be applied.

Correcting Background (Tools menu)
In order to perform accurate analysis of your images or to improve their appearance, you may need
to perform Background correction. Background corrections include dark current correction,
background subtraction, shading correction or offset application. Bright or dark reference images
may be required for your correction.
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For further information on background correction and the images required please see page 118.
To use the Correct Background... command the library must contain appropriate background
correction items (see page 118).
1. Select any images or image sequences that you wish to background correct.
2. Select Correct Background… from the Tools menu. The Background Correction dialog opens.

3. Volocity will attempt to match the names of the background correction items in your library to the
names of the channels in your selected images or image sequences. If you have many correction
items in your library, you may need to manually select the background correction by clicking on the
drop-down menu for each channel and making a more appropriate selection.
4. Click Correct.
Background corrections can be applied to 3D image sequences in the same way that they are
applied to 2D datasets. The same background correction will be applied to each plane of your
volume.

n

For image sequences: Volocity will create new background corrected channels in image
sequences in which your background corrections have been applied.

n

For images: background corrected images will be placed beneath the original images in the
library.
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Creating Registration Corrections (Actions menu)
“Registration Corrections” are items that record the degree by which channels need to be moved in
X,Y and Z in order to bring them into perfect register. Once Registration Corrections have been
generated they can be applied to image sequences indefinitely, provided that the degree of shift
between channels remains constant.
We recommend that you first acquire an image sequence of a fluorescent bead set from which
registration shifts can be accurately calculated. You should acquire a multi-channel image sequence
and ensure that you acquire every channel and every magnification with which you intend to work in
your experiments. If you intend to do 3D work, you should acquire 3D image sequences of the beads
so that you can detect and correct any registration problems in the Z axis.
1. Select the image sequence on which you wish to base your corrections in the library.
2. Select Create New from the Actions menu.
3. Select Registration Correction…
The Create Registration Correction dialog opens.

4. Enter a name for your registration correction.
5. Volocity will automatically select an anchor channel, this is the channel relative to which the
remaining channels will be shifted. If you wish to use another channel as the anchor, select one from
the drop-down menu.
6. To manually create registration corrections go to step 7. To automatically create registration
corrections go to step 14.
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Manual Creation of Registration Corrections
7. Select one of the remaining channels from the list to see its position relative to the anchor channel.
8. Change the View displayed in the preview from XY to XZ or YZ by selecting the appropriate radio
button, and change the magnification of the preview by dragging the magnification slider.
9. Change the position of the currently displayed plane by either dragging the current plane arrow on
the depth control or by clicking anywhere on the depth control.
10. Move the currently selected channel relative to the anchor channel by clicking on the four direction
arrows, which will move the selected channel relative to the anchor channel. Move the channel so
that it is in perfect register with the anchor channel in the X, Y and Z planes.
11. When you are satisfied that your channel is in perfect register with the anchor, select your next
channel and repeat the process.
12. Ensure that all your channels are correctly registered with the anchor. Ensure that you have checked
all channels and all views. Registration Corrections are likely to be applied to many image
sequences so accuracy at this stage is essential.
13. Click Create.

Automated Creation of Registration Corrections
14. To make Volocity attempt to automatically place each channel in register with the anchor channel,
click Auto.
15. A progress bar is displayed as Volocity calculates the degree of shift between each of the channels.
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16. Volocity displays the number of pixels by which each channel has been shifted in X, Y and Z in order
to place it in perfect register with the anchor channel.

17. To check the correction of a channel, select the channel from the list. Volocity will display only that
channel and the anchor channel in the preview.
18. Manually edit the position of a channel relative to the anchor channel by clicking on the four direction
arrows.
19. When you are satisfied that the corrections are accurate, click Create.
Registration correction items can be exported from libraries as library clippings and imported to new
libraries, so you should not have to repeat the process of generating registration corrections.

Inspecting Registration Corrections
Volocity adds registration corrections to the library. Corrections made at the same time are placed in
a folder. The folder and the corrections have the name that was entered in the Create Registration
dialog.
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You can inspect registration corrections by double clicking on the associated item in the library. You
can check the anchor channel and the relative pixel shift associated with each correction.

Correcting Registration (Tools menu)
When working with multi-channel image sequences you may find that channels are not always
aligned with each other in perfect register. Channels may be shifted in the X, Y, or Z (or a
combination of) planes relative to each other. Often this problem can be corrected by making
improvements to your acquisition hardware such as purchasing shift-free fluorescence filter
sets. Should this prove impractical you can use Volocity to correct registration problems.
To use the Correct Registration... command the library must contain the appropriate registration
corrections. See page 124.
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Correcting Registration (Tools menu)

To apply registration corrections to image sequences:
1. Select the relevant image sequences in the library.
2. Select Correct Registration… from the Tools menu.
3. The registration correction dialog will open.

4. Volocity will attempt to match the names of the registration correction items in your library to the
names of the channels in your selected image sequences. If you have many correction items in your
library you may need to manually select the registration correction by clicking on the drop-down
menu for each channel and making a more appropriate selection.

5. We recommend that you avoid mixing corrections that were generated at different times. Volocity will
warn you if you choose to do this.
6. When you are satisfied that each of your channels is paired with the appropriate correction item, click
Correct.
7. Volocity will create new image sequences in which your registration corrections have been applied.
Each sequence will have the original name with the suffix (registration corrected).
Any areas in registration corrected sequences for which Volocity does not have data from all the
channels in the sequence are cropped from the sequence, so registration corrected image
sequences always have slightly smaller dimensions than the originals.
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Correcting Photobleaching (Tools menu)
The Volocity photobleaching correction tool corrects for photobleaching by applying correction
factors to images to maintain intensities that are reduced by photobleaching during the course of an
image sequence.
There are two methods of applying photobleaching correction. Apply whichever is appropriate for
your experiment.
n

Based on a region of interest. To apply a correction based on a region of interest you must have
your image sequence open in the Image view. Select an ROI and then select Correct
Photobleaching… from the Tools menu. Make sure that you select the appropriate channel for
correction.

The mean intensity of the ROI in the first timepoint is determined, ignoring black voxels and
saturated voxels. Every voxel in every other timepoint is then multiplied by the correction factor
necessary to maintain the same mean intensity within the ROI across all timepoints. Each channel is
handled separately with the relevant correction factors.
n

Based on the whole image. Select Correct Photobleaching… from the Tools menu. Make sure
that you select the appropriate channel for correction.

The mean intensity of the channel in the first timepoint is determined, ignoring black voxels and
saturated voxels. Every voxel in every other timepoint is then multiplied by the correction factor
necessary to maintain the same mean intensity across all timepoints.

Photobleaching correction based on the whole image supports batch processing. To batch process
several images sequences, select them in your library before selecting Correct Photobleaching…
from the Tools menu.
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Cropping Items (Actions menu)
Cropping data to a selection reduces the physical size and therefore the file size of an item in the
library. Cropping a dataset means information outside the selection is lost but the spatial resolution of
the remaining data remains the same.
1. In the Image window, use one of the selection tools to outline the ROI (region of interest). See page
81 for more information about using Selection tools
2. Select Crop to Selection from the Actions menu.
In a 2D Image, this crops to the selected area. In a Movie window, this crops all frames to the
selected area. In a 3D Image, this crops all Z slices. In an Image Sequence, this crops the XY
dimensions of all Z slices in all channels in all timepoints.

Crop to Selection will create a new item in the library unless the corresponding key combination is
used. Hold down the Alt key (Mac OS) or the Ctrl key (Windows) to change the Actions menu item to
Crop to Selection in Place.
Change resolution and reduce the file size of data sets while preserving the field of view using the
Change size command (see page 114).
Make volumes of the required resolution using scale data when making single volumes (see page
54).
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Illumination Correction (Tools menu)
Minor anomalies in excitation light intensity over time, such as lamp flicker, can lead to inconsistently
bright or dark layers through a volume. The flicker may not be apparent during inspection of the raw
data but may be more noticeable if data is visualised in 3D or processed using restoration tools.
Select the required image(s) or image sequence(s) and select Correct Illumination from the Tools
menu. The process is applied immediately, there is no dialog shown.
Correct Illumination operates within each individual volume and bases any intensity correction solely
on the trends shown within that volume. It does not normalize time resolved data to account for
bleaching and cannot correct severe problems with lighting during the experiment. Ideally, lamp
flicker should be avoided by using a stable light source.

Merge Planes (Actions Menu)
Merging planes creates a brightest point merge of 3-dimensional data to create a 2-dimensional
image. It effects a permanent change to the data set by creating a copy of the original data.
It may be used to reduce data size or simplify movie playback.
1. Select the item(s) which are to be merged from 3-dimensional to 2-dimensional.
2. Select Merge Planes from the Actions menu.
3. A new item is created in the library. It has the same name as the old item with “(merged)” appended.
The actual number of channels and timepoints in the image is not altered, but the image at each
timepoint will be two-dimensional.
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Note: Unlike the Extended Focus view described on page Error! Bookmark not defined., which
creates a brightest-point merge of all the Z-slices in a volume, Merge Planes does actually create a
two-dimensional image, and any selections and measurements performed on this image will be twodimensional.

Removing Noise (Tools menu)
The application provides a number of median filters that can be applied to remove noise from an
image. These filters range from fine to very coarse offering an increasing size of filter matrix and
degree of filtering.
1. Select the required item(s) and select Remove Noise… from the Tools menu. Multiple image
sequences may be selected for processing at once.
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2. Select All Channels or the channel name to be adjusted. Click on the drop-down menu and select the
required filter.
Fine = 3x3(x3)
Medium = 5x5(x5)
Coarse = 7x7(x7)
Very coarse = 9x9(x9)

3. Click on Change. This command may take some time to complete if you have selected a large
number of items.

Splitting Multi-Colored Items (Actions menu)
If you have a multi-colored item, you can split it into its three channels. Select the required item(s)
and select Split RGB from the Actions menu.

Splitting Volumes (Tools menu)
You can split a volume from the library or from any of the Image views. This converts the volume into
a layered format to produce a stack of two-dimensional images.
1. Select the volume(s) and select Split Volumes from the Tools menu.
2. At the prompt choose how you want the volume to be split. You can separate the images into folders
where channels and timepoints will be separated, or put all images into a single folder, in which case
you will also need to specify Order by criteria from the drop-down menu.

November 2008 133

Splice Sequences (Actions menu)

3. Volocity creates new folder item(s) in the library containing stack(s) of 2D images.

Splice Sequences (Actions menu)
Splice Sequences will add sequences together to make one sequence where the number of
timepoints is the sum of all the timepoints in all the selected sequences. Sequences to be spliced
must have the same X, Y, and Z dimensions. Sequences will keep their original timestamps where
possible. Sequences of different color depths will be changed to have the color depth of the first
selected sequence.

Tile Sequences (Actions menu)
Tile sequence will automatically arrange the selected sequences in a grid in a new sequence.
Sequences need not be of the same dimensions in X, Y, Z or time but the new sequence will be
padded with black space where necessary. If the original sequences are of different depths the
resultant tiled sequence will be millions of colors. The resultant, tiled sequence is given the
timestamps of the first sequence in the selection.
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Printing and Exporting Data
Overview
This chapter describes how to:
n

Print from the application.

n

Export items.

Printing from the Application (File menu)
You can print the contents of the active window. This may be the Library View, a Single Image View
or a Gallery View, as appropriate. Although print commands are available from the 3D Views, they
are not useful for publishing volumes—you can use the Capture Snapshot command from the
Image menu to create 2D images of the 3D View that you can print (see page 104).
The dialogs for print and page setup commands vary according to the type of printer that you are
using.
1. Click with the cursor in the window that you want to print.
2. Use the view-specific menu options, as appropriate to control how the image appears.
3. Select Print from the File menu, or from the Print Preview window, if that is displayed.

Print Preview
If you want to check the result before printing, select Print Preview from the File menu. You can
usually access the Page Setup and Print commands directly from the preview.

Page/Print Setup
1. Click on Page Setup... in the File menu (Mac). Click on Print Setup... in the File menu
(WINDOWS).
2. The Setup dialog varies, depending upon which printer you are using. Amend the settings, as
appropriate, and click on OK.

Exporting Items (File menu)
The Export command allows you to export an item from the library as any of a variety of formats. You
can also use it to copy files between libraries.
1. Select the required items in the library or switch to the appropriate view.
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2. Select Export... from the File menu.

3. Change the file name, if required, and select a folder for the exported file(s).
4. Select the Format from the pop up. Some file formats have an Options... button which allows
configuration of the setting relevant to that format. If multiple items are selected for export the Export
file dialog will show a Naming… button allowing you to define how the individual files will be named.
Set the options, as appropriate, and click OK.
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5. Click on Export.
The export options depend on the view open and the product being used:
n

Export single images to create single images in formats such as TIFF or JPEG. Select multiple
single images to export all the images as the same format in one step.

n

Exporting a folder of images will make a multi-layered item such as a QuickTime movie or a
multilayered TIFF.

n

Export volumes and image sequences to export the item as a multi-layered file: Openlab LIFF,
Openlab Raw, QuickTime movie or TIFF. The order of layers in the exported file will be z-slices
then channels then time.

n

When working with an image sequence which contains time resolved data, selecting export from
an Image (Extended Focus) or 3D View, offers the ability to export the view as a movie which will
make a simple movie of that view stepping through timepoints.

n

Quantitation: Export Measurements as tab delimited or comma separated text.

n

Use the library clipping format to move any library item easily between libraries.

Volocity LE does not allow the creation of QuickTime or AVI movies.
It is also possible to export settings from many parts of the software. Users of Volocity Acquisition
are able to export acquisition protocols. Users of Volocity Quantitation are able to export
measurement protocols. Users of Volocity Visualization are able to export movies. In the dialog
where these settings are saved there will be an Export... option allowing users to save their settings.
For the latest information on supported file formats, please look at the Release Notes on
Improvision's Support web pages at http://www.improvision.com.
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Export as AVI Movie for Windows Only (Not available in Volocity LE)
Windows users have an additional movie format available for export, the AVI format.
1. Select a folder of images in the Library view.
2. Select Export… from the File menu.
3. Enter the file name and select a location for the completed movie.
4. Choose AVI Movie from the Format drop-down and click Export.

Export as QuickTime Movie (Not available in Volocity LE)
This option allows you to export a QuickTime movie with a frame rate based on the timestamps of
the original files.
1. Select a folder of images in the Library view.
2. Select Export... from the File menu.
3. Choose a name for the movie file.
4. Select QuickTime Movie from the Format: drop-down menu and click on Options…

5. Select the Compression codec that should be used. The Compressor type and the bias towards a
Smaller File or Better Quality Image will affect the size and quality of the file created. This is a
subjective decision, however, we suggest that Apple Animation or the Sorenson compression may
provide a good balance between quality and file size.
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6. Select the timing required for the finished movie and click OK.
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Export View as QuickTime or AVI Movie (Not available in Volocity LE)
When working with an image sequence which contains two or more timepoints and viewing the
Image View, it is possible to make a simple QuickTime or AVI (Windows only) movie from that view.
Note: If each timepoint contains more than one plane in z, use the Extended Focus view.
1. Configure the view, as required with scale bars, selections, and so on.
2. Select Export from the File menu, change the file name, if required, and select a folder for the
exported movie. Select View as QuickTime movie.

The QuickTime Movie format provides additional export options. Click on Options… and select the
compression codec and quality, and the timing required for the finished movie, then click OK.

3. Click Export. The movie will be made by stepping through each of the timepoints.

140 Improvision

VOLOCITY Acquisition Installation and Reference

Volocity Acquisition Installation and Reference
Overview
Volocity Acquisition is designed specifically for high performance acquisition of time-resolved, multichannel 3D sequences. It supports a range of hardware suitable for 3D imaging, including wide field
microscopes, scientific grade digital cameras, fast focus drives and wavelength changers.
It is very important to install and configure acquisition devices correctly before you start capturing
images. This chapter describes how to:
n

Install and configure devices

n

Use device controls

n

Calibrate objective lenses

n

Measure device latencies

n

Configure the Light Path Manager

n

Use the Video Preview window

n

Carry out fast restoration

n

Set up and use the PerkinElmer UltraVIEW

n

Set up and use the OptiGrid

n

Set up and use a motorized XY stage for multi-point acquisition.

n

Perform FRAP and FRAP related experiments with the FRAP plug-in

n

Perform Ratiometric experiments with the Ratio plug-in

®

®

Please refer to “Volocity Acquisition Worked Examples” on page 162 for comprehensive instructions
on carrying out single-point and multi-point acquisition and information about setting up specific
acquisition protocols.
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Installing and Configuring Devices
1. Install your camera driver and camera (and frame grabber card, if applicable) according to the
manufacturer’s instructions.
2. Connect any further hardware (such as microscope, Piezo focus drive, OptiGrid®, etc.) to your
computer via the appropriate port. Serial devices can be connected directly to serial ports (COM
ports) on your computer, if you have them, or via a USB serial adaptor.
Note: After installing a USB serial adaptor or a major upgrade to the operating system, make sure
the drivers for the adaptor are installed before connecting the serial devices.
3. Ensure that all your hardware is switched on.

Setting Preferences
1. Start the application and select Preferences... from the Edit menu (Windows) or the Volocity menu
(Mac OS).
2. If you have connected serial devices to your computer, you must configure the serial ports. Click on
the Serial Ports icon in the left-hand panel. If you have no serial devices connected, go to step 4.
3. For each serial port identified on the system select the appropriate type of device that is connected.
For ports to which nothing is connected select “None”.
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4. Click on the Devices icon in the left-hand panel.

5. A list of devices that have been correctly connected to your computer will appear in the right hand
panel. Each device has a subset of device controls that are listed beneath the device.
To appear in the list:
n

Cameras and USB devices must be correctly connected to your computer and switched on
before starting Volocity.

n

Serial devices must be correctly connected to your computer, switched on, and the appropriate
serial port must be selected in the Preferences (see step 3).

6. Carefully review all of the devices listed in the preferences; make sure that you scroll to the bottom of
the list so that no devices are overlooked. If a device has an Options... button, you must click on the
button to review the settings in the device’s setup dialog. If necessary, you should edit the device’s
setup dialog. Failure to review and edit the dialog may result in difficulty using hardware. This may be
due to incorrect labeling of devices, or because Volocity has not been given the information it
requires to move the hardware accurately. See “Reviewing and Editing Setup Dialogs” below for
some examples.
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7. Select Video Preview from the Library View or Show Video Preview from the Window menu. The
devices and device controls that were selected in the Preferences are displayed on the right-hand
side of the Video Preview window.
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Reviewing and Editing Setup Dialogs
Some devices may require only a single value to be entered into a text field. Some motorized stages,
for example, will require that you enter the correct step size for the stage.

Other devices may require more information to complete the Setup dialog, which should be
completed in steps. For example, when completing the dialog for a filter wheel or fluo turret:
1. Select the filter type for each filter position from the drop-down menus.
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2. Enter details of the filters in the text fields.

3. Name the filter in the description field.

Provided that you carefully review and edit each of your device’s setup dialogs, each of your devices
can be used easily and accurately with Volocity. Remember to select appropriate options from dropdown menus and to carefully enter accurate information into text fields.

Device Controls
Using Device Controls
Each device that you control with Volocity will have one or more controls with which you can interact.
Volocity is compatible with several classes of devices from a number of manufacturers, so the
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number and types of control present for each of your devices will vary. The list of controls below is
general, different controls may be present on your system.
To determine to which device a control belongs, move the cursor over the icon to the left of the
control. The device name will be displayed in the tooltip.

Many devices can be controlled from elsewhere, such as the microscope stand or the control box. In
most cases, if you change the state or position of a device from elsewhere, the change will be
displayed on the device’s control in Volocity.
Double clicking a control’s icon is a shortcut to the control’s setup dialog.
Button Arrays

Each button in an array represents a different position for the device, for example different filter
positions in a filter wheel. The button representing the current position of the device is shaded. Hold
the cursor over a button to display a tooltip with a description of its position. Click on the button to
move the device to that position. Filter wheels, fluo turrets, objective nosepieces and the light path
manager are controlled by button arrays.
Checkboxes

Checkboxes allow you to control devices that only have two states, on and off. When checkboxes
are selected the device is on, when deselected the device is off. Auto Contrast and Fast Restoration
are examples of devices controlled with checkboxes.
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Digital Displays

Digital displays show the current value of a device as a number, usually representing the device’s
current position.
Exposure Controls

The exposure control determines the length of time over which your camera will acquire an image.
The hours, minutes, seconds and milliseconds components of the time are separated for clarity. To
adjust the time click in one of the number fields and edit the number; you must click in another field
or press the Return key for your change to take effect. You can also drag the exposure slider to
make quick changes, the exposure time will automatically update. Use the drop-down menu to
change the range.
If you click the Auto exposure button, AE, exposure time will be automatically set.
Focus Controls

Focus controls display the current position of focus drives as a numeric value. As you change the
position of the focus drive from the microscope stand the value will be updated.
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Select the focus drive menu button to display the following options:
Set Zero

Sets the current position of the focus drive to 0µm.

Set Top

Sets the current position of the focus drive as the upper mark in
the focus range. This range will be used during acquisition of 3D
datasets.

Set Bottom

Sets the current position of the focus drive as the lower mark in
the focus range. This range will be used during acquisition of 3D
datasets.

Reset Top/Bottom

Resets the focus drive upper and lower marks to the default
values of +50µm and –50µm respectively.

Move to Zero

Moves the focus drive from the current position to 0µm.

Move to Top

Moves the focus drive from the current position to the upper
mark.

Move to Bottom

Moves the focus drive from the current position to the lower
mark.

Move to Hard Center

Moves a piezo focus drive to the centre of its range of travel. This
option is not available for non-piezo focus drives.

Move To…

Opens a dialog that allows you to enter the position to which the
focus drive will move.

Set Top To…

Opens a dialog that allows you to enter the position to which the
upper mark will be set.

Set Bottom To…

Opens a dialog that allows you to enter the position to which the
lower mark will be set.

Auto-Focus

Initiates the Auto-Focus function of Volocity. Volocity will move
the focus within the Auto-Focus limits to the position in which it
detects the most in-focus information.

Set Auto-Focus
Limits…

Opens a dialog in which you can set the Auto-Focus limits.
Volocity will not move beyond the limits when executing the AutoFocus function.
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Grid Controls

There are three grid controls. From left to right:
n

Grid Off: Switches the grid off. There is a stationary grid pattern on the Video Preview and from
the ocular lenses of the microscope.

n

Grid Confocal: Activates the grid. There is a confocal image on the Video Preview and a moving
grid pattern from the ocular lenses of the microscope.

n

Grid Wide Field: Activates the grid. There is a wide field image (without grid lines) on the Video
Preview and a moving grid pattern from the ocular lenses of the microscope.

Numeric Spin Controls

Numeric spin controls allow you to quickly increment or decrement the current value of the control by
clicking on the arrows next to the number display. Camera binning is an example of a device
controlled with a numeric spin control.
Drop-down Menus

Drop-down menus allow you to select from a number of options for a device. Click on the drop-down
menu to see all of the options, and select the option you require. Camera depth and grid quality are
examples of devices controlled with drop-down menus.
Shutters

Click directly on the shutter icon to change its state. Solid indicates shutter closed. White indicates
shutter open.
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Sliders

Sliders allow you to quickly set a device control anywhere between its maximum and minimum
values. Hold the cursor directly over the slider to display a tooltip showing the current value of the
control. Camera gain and offset are examples of devices controlled by sliders.

Calibrating Objective Lenses
In order to ensure that the data acquired with your Acquisition system is correctly calibrated in X and
Y, each objective lens on the microscope should be calibrated for any camera on the system using
lens a stage graticule.
1. Place the graticule slide on the stage and focus on the scale divisions.
2. Select the Calibration tool from the toolbar.

3. Draw a line of known length on your Video Preview. Click and hold your mouse to start the line, drag
the mouse to the endpoint of your line and release the mouse button.
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Calibrating Objective Lenses

4. Remember to draw from the left of your start division to the left of your end division, and make the
line as long as possible to minimize the effect of drawing errors.

5. Select Calibrate... from the Video menu or double click on the Calibration tool to open the calibrate
window.
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6. Enter line length in µm and click Calibrate.
To confirm that your objective lens has been correctly calibrated, select Show Scale from the Video
menu. You can then compare your scale bar to the calibration divisions.
Repeat this process for every objective lens on your microscope. The calibration is stored with the
objective position and will be recalled when a lens is selected.
7. Repeat this process for any additional camera on your system. The correct set of calibrations for the
objective lenses will be restored when the camera is selected.
If you already know how many µm/pixel your camera has for your current objective lens, double click
on the calibrate tool without first drawing a calibration line on the video preview. You will be able to
enter the µm/pixel value directly into the Calibrate window. You should repeat this for each lens.

Measuring Device Latencies
You should use this option when you first install and configure Volocity and also whenever you attach
new equipment or use different equipment. Volocity will measure the latencies of all computercontrolled hardware on your system, which will allow Volocity to make intelligent decisions about
closing shutters during acquisition.
1. Select Measure Device Latencies from the Video menu to display the following prompt.

2. Check that there are no samples and that your microscope is in a safe position (for example, check
that your objectives will not collide with your stage if your objective turret is moved). Click Continue.
When you have completed these steps your Acquisition system will be correctly configured and
ready to use.
Note: The latency measurements are noted in the Session Log. If you wish to know them, view the
Session Log at the time of measurement. See page 35.
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Light Paths
Configuring the Light Path Manager
The Light Path Manager is above the device controls in the Video Preview window and allows you to
configure up to nine different light paths and store them for future use.

The Light Path Manager allows you to record the correct positions of all your automated hardware for
each of your fluorescence filter combinations, as well as transmitted light paths. This greatly
simplifies the use of your system and allows you to easily restore the correct light path manually
(using the Video Preview window) or during acquisition. You can record the positions or settings of
as many or as few devices as you require. For example, you may keep your light path simple and
include the positions of only wavelength changing devices and shutters. Under some circumstances
you may add other settings to the light path, such as your camera exposure or gain.
1. Configure your hardware for a particular light path. For example, if you are setting a fluorescence
light path and you are using an excitation filter wheel and a microscope fluo turret, ensure that they
are in the correct positions for your fluorescence filter set of interest.
2. Double click on an unused light path manager button. The Light Path Properties window opens.
From the Devices list select those devices that you wish to include in the light path. Select the
appropriate shutter positions for your light path from the drop-down menus in the Shutters list.
3. Provide a Name for the light path and select a Color. The color will be used for the light path button,
and to color channels acquired using the light path. If you are setting a transmitted light path, the
color should be white. The Summary box provides a useful textual description of the settings that
you have included in the light path.
4. If the light path requires changes in the microscope setup that are not controlled by Volocity, for
example moving a manual filter changer, check the box for Requires manual intervention. A
message will be shown each time the light path is called prompting you to make the manual change.
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In the following example we have set up the light path for a DAPI channel. We have saved the
current positions of the Fluo Turret and Sutter DG4 Filter Changer in the light path. The Fluo Shutter
and Sutter DG4 Shutter will be opened whenever the light path is restored.

5. Click Save.
6. Set up a separate light path for each fluorescence filter and transmitted light path that you will use on
your system.
Note: c
Once you have configured your light paths, we strongly recommend that you hide the individual
devices included in the light paths from the Video Preview. You should control these devices only
with the Light Path Manager. This will make the system easier to use and make the Video Preview
less cluttered.
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In our example we have deselected the Fluo Turret, Fluo Shutter, Sutter DG4 Filter changer and the
Sutter DG4 Shutter in the Devices preferences. The devices are still active, but we will use the Light
Path Manager to control them.

Editing Light Path Settings
You can easily edit a light path, for example if you want to use the same device settings but with a
different camera exposure.
1. Select the light path and change the camera settings on the Video Preview window.
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2. Click and hold (Macintosh) or right-click (Windows) on the light path and select:
n

Overwrite to change the recorded settings to the current settings.

n

Edit… to open the Light Path Properties window. Select the additional devices from the Devices
list and select Save, if you wish to add the positions or settings of additional devices to the light
path.

The Video Preview Window
Open an existing library or create a new library and select Show Video Preview from the Window
menu.

timing
feedback
video
feedback

light path
manager
video
preview
image

video
controls

use the
zoom tool
to zoom in
and out

shortcut
key = Z

click and
drag to
resize
window

.
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The Video Preview Window

Camera Selection
When multiple cameras are correctly installed and powered select the camera to be used for imaging
from the Video menu. Any calibrations stored for the camera will be restored when the camera is
chosen.

Acquiring Images
Create light paths to control the devices necessary to image in different channels and an acquisition
protocol to manage an experiment.

Contrast Enhancement
Enhance contrast in the live video to reveal detail captured by the camera but not shown by the
default display contrast. Check Auto Contrast on the video controls to apply an automatic contrast
setting which will adjust the black and white level of the display to the darkest and brightest captured
intensity respectively.
Alternatively manually set black and white levels of the video preview using the live enhancement
tool.
Select the live enhancement tool from the toolbar. A histogram of the grey
levels in the preview is displayed. To adjust the white level click and drag the
cursor anywhere in the preview pane to the left (to decrease) or to the right (to
increase). To adjust the black level, hold down Ctrl and click and drag the
cursor anywhere in the preview pane down (to decrease) or up (to increase).
Move the cursor slowly for finer control. Double click the icon in the tool bar to
reset the contrast enhancement. Select another tool from the tool bar to hide
the display.
When contrast enhancement is being applied an indication will be shown in the top left of the video
preview image.
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Zooming the Video Preview
The Video Preview can be zoomed in or out. Select the Zoom tool and click on the Video Preview
to zoom in. Click and hold the Ctrl key (Windows) or the Alt key (Macintosh) to zoom out.
A zoomed window can be scrolled from left to right or up and down using either the scroll bars or
the window panning tool.

Setting CCD Active Area
Some combinations of optical components do not generate an image to fill the full CCD of the
camera leaving margins around the images. To avoid storing these set the CCD active area to
exclude them.
Select CCD Active Area... from the Video menu.

Set margins to exclude or set the active area to the dimensions and position of an ROI which can be
drawn on the video preview before selecting this dialog.

Cropping the Video Preview
The Video Preview can be cropped, so that smaller images will be acquired by Volocity. With
some cameras cropping will provide a speed advantage. This is also known as a sub array
acquisition.
n

To crop the preview select the Crop tool, click and drag a crop boundary on the Video
Preview. Everything that you include within your crop boundary will continue to be updated on
the Video Preview, everything outside the boundary is not updated. You can also crop the Video
Preview to preset sizes by selecting Crop Video from the Video menu and selecting one of the
options.

n

To restore the full resolution Video Preview, select the crop tool and click anywhere outside the
crop boundary.
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Selecting an ROI on the Video Preview
An ROI can be drawn on the Video Preview. With an ROI on the preview, only the area
within the ROI will be used for the video feedback panel.

To draw a region of interest on the Video Preview, select the ROI tool, click and drag your region of
interest.

Centering an XY Stage
On a system that includes a motorized XY stage the centering tool will move the XY stage
so that the point that the tool clicks on within the Video Preview is centered in the field of
view.
The stage and the objective must be calibrated for this tool to work correctly. For more information on
use of a motorized stage see page 241.
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Video Feedback Panel
Information on the gray levels in your Video Preview can be found in the Video Feedback panel, in
the top right of the Video Preview window. The information can be displayed in four different modes,
numbers, histogram, bar and Max Intensity graph mode.
To toggle between the four modes, click on the Video Feedback panel.
Numbers mode

The Video Feedback panel displays the minimum and maximum
gray level in the Video Preview, and the signal to noise ratio.

Histogram mode

The Video Feedback panel displays the distribution of gray levels
in the Video Preview. The minimum gray level is displayed on the
left of the histogram, the maximum gray level (which depends
upon the bit depth of your camera) is displayed to the right of the
histogram.

Bar mode

The Video Feedback panel shows the range of gray levels in the
Video Preview. The length of the bar indicates how much of your
camera’s dynamic range you are currently using. The longer the
bar, the better your signal to noise ratio.

Max Intensity graph mode

The Video Feedback panel shows the maximum intensity of gray
levels in the Video Preview or ROI over time. An update is made for
each frame.

If you have a color camera, you will see feedback for each of the three channels of your camera in
addition to a luminance channel.
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Acquisition Setup Dialog
The following steps describe all options available during single-point acquisitions.
You only need to set up those steps that are appropriate for your acquisition protocol.
1. If you wish to capture a single plane only, ignore the focus drive options and go to step 3. If you wish
to capture a number of Z sections within your specimen, you will need to set the range through which
the focus drive will move in the focus interface in the Video Preview.

First, move to the midpoint of your specimen using the focus
control of your microscope.
Select Set Zero from the focus drive drop-down menu on the
Video Preview window.
Move to the lower limit of your specimen using your
microscope focus drive and select Set Bottom from the
focus drive drop-down menu.
Move to the upper limit of your specimen using your
microscope focus drive and select Set Top from the focus
drive drop-down menu.

2. Select Acquisition Setup… from the Video menu.
Or double-click on the acquisition protocol feedback display on the Video Preview window.
acquisition protocol feedback display
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3. Enter a Title, User Name and Description. The Title will be used to name the images that you
acquire; both the User Name and Description will be stored with the properties of the image.
Complete the dialog by selecting the appropriate settings for your acquisition protocol.
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4. Change channels using light paths
If you wish to acquire a multi-channel sequence check the Change channels using light paths box.

click to add channel
click to remove channel
click to set timing
click to select light path

Add or remove channels using the “+” and “-” buttons and select the correct light path for each
channel by clicking on the drop-down menus.
If you wish to acquire a channel at a rate different to other channels (for example, you may wish to
acquire a fluorescence or brightfield reference image periodically), click on the timing icon. The
Channel Timing dialog opens. Select the Acquire a new frame for this channel every: option, and
enter the new frame rate.

A warning symbol is displayed on the Acquisition Setup dialog next to the channels that will not be
captured at the normal rate.
During timepoints in which a channel is not acquired the last timepoint that was acquired will be
duplicated.
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Auto-Exposure
If you wish Volocity to perform an Auto-Exposure for each channel, check the Use Auto-Exposure
for each channel box. With this option selected, Volocity will perform an Auto-Exposure at the
midpoint of your specimen for each of your channels before starting the acquisition.
Changing the exposure between channels reduces the speed of the acquisition protocol and should
be avoided for speed-critical acquisition. Often a compromise exposure that is adequate for all
channels can be found.
5. Change focus using
If you are acquiring multiple Z sections, select the appropriate device from the Change focus using
drop-down menu and enter either the Z spacing that you require or the number of slices that you
require.

Using the Z spacing option Volocity will calculate the number of slices required to move through the
range between the top and bottom positions as configured in the Video Preview. If the Z spacing is
not a factor of the range, an additional slice will be captured.
Using the number of slices option Volocity will calculate the spacing between slices required to
capture that number of slices within the range between top and bottom.
The scan direction option allows you to select between:
n

Up: This is the recommended option; it moves the focus device against gravity for the most
accurate positioning.

n

Down: This option moves the focus device with gravity.

n

Bi-Directional: This option alternates the up and down direction of focus movement. This may
minimize disturbance of the system by avoiding the relatively large movement otherwise required
to return the focus to its starting position.

6. Auto-focus using
Select a focus device to use for auto-focus during the experiment.
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Auto-focus operates by seeking the highest contrast image when sampling within a range in the zaxis. This range is set in the focus drive settings on the Video Preview window.

Using auto-focus will reduce the speed of acquisition by the time taken to determine the best plane to
image.
Choose the frequency to apply auto-focus by configuring the timing options.

If you are using auto-focus and planning to acquire a Z stack around the position determined by the
auto-focus, the setting of top and bottom positions in the focus drive settings become vitally
important. Each of your acquisition points will be treated as zero, regardless of its actual Z value. So
the distance between zero and your top and bottom position will be the same as the distances
between each of your points and their top and bottom positions (see the tables below for
examples). You can quickly check what values are set for top and bottom by inspecting the focus
drive tool tip.
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Top and Bottom marks with top set to 5 and bottom set to -5
Position (Z) of
acquisition point
(µm)

Bottom mark
for acquisition
(µm)

Top mark for
acquisition
(µm)

0

-5

5

10

5

15

20

15

25

30

25

35

Top and Bottom marks with top set to 10 and bottom set to –10.
Position (Z) of
acquisition point
(µm)

Bottom mark
for acquisition
(µm)

Top mark for
acquisition (µm)

0

-10

10

10

0

20

20

10

30

30

20

40

If you wish to change the top and bottom positions, use the commands in the focus drive drop-down
menu, as described in step 2 of this section.
Note: You should avoid re-setting the zero value of your focus drive after setting your acquisition
points. If you do so, you will invalidate the Z coordinates stored with each point.
7. Change XY using
Set to None for single-point acquisition.

8. Timelapse
Set the frequency between timepoints by configuring timelapse settings.
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n

Set manually Use the setting on the Video Preview (see below)

n

Use Set the interval between timepoints.

n

Variable Click on the clock icon and add different phases using the “+” button. Define the length
of each phase and the timelapse interval to use during that phase. To pause acquisition select 0
timepoints per second for the required time.

8. Duration

If you wish to acquire multiple timepoints, select either Until stop is clicked (Volocity will acquire
data until it is manually stopped) or select For, enter a number into the text field and select either
“timepoints”, “ms”, “seconds”, “minutes” or “hours” from the drop-down menu.
If you wish to acquire a single timepoint, select For, enter “1” into the text field, and select
“timepoints” from the drop-down menu.
9. Order channels and Z sections by
If you are acquiring both multiple channels and multiple Z sections you must decide in which order
Volocity will acquire your images.

There are two options in the Order channels and Z sections by drop-down menu.
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The Channels first then Z option acquires all channels at each Z section before the Z section is
changed. This option has the advantage of acquiring all channels at precisely the same Z section,
but may be slow with a slow wavelength changing device.
The Z first then Channels option acquires all Z sections for each channel before the channel is
changed. This option has the disadvantage of introducing potential inaccuracies in Z positions
(depending upon the reproducibility of your focus drive), but it does allow acquisition protocols to be
conducted at high speed, even with relatively slow wavelength changing devices.
10. Manage shutters for

These options determine how Volocity will manage the shutters between channels and timepoints.
Volocity uses the latency threshold measurements for each device in the light path to determine how
it will control the shutter. You must have measured your device latencies for this option to work
effectively, see page 153.
11. When you have set up the necessary acquisition parameters, click OK.
12. With your specimen in focus ensure that the light path is directed to your camera. You should see
your specimen in the Video Preview. Adjust the camera controls until you are happy with your image.
A good starting point is to select the Auto-Exposure (AE) button (if this feature is supported by your
camera); Volocity will automatically adjust the exposure of your camera. Fine adjustments of both the
exposure and other camera controls can then be made.

13. Click the appropriate Capture button on the Video Preview window.

The image is given the name that you entered in the acquisition Setup window followed by a number.
All images and image sequences acquired by Volocity are automatically saved to your hard disk.
14. You can change the timelapse option at any time during an acquisition. If you wish to acquire only a
single timepoint, you can ignore the timelapse options.
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For example, to acquire one timepoint every 10 seconds, select Seconds per Timepoint from the
drop-down menu, and enter 10 into the text field.

If you wish to acquire images at the fastest possible rate, select Maximum Speed, Volocity will then
acquire the images at the fastest rate supported by your hardware.
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Saving Acquisition Protocol Settings
1. Click Save…on the Acquisition Setup dialog

2. Enter a descriptive name for your acquisition protocol and click Save.

Note: You can also use this dialog to export settings, for example, if you wish to share those settings
with a colleague.
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Restoring Acquisition Protocol Settings
1. Click on Restore… on the Acquisition Setup window to display a list of saved acquisition protocols.

2. Select the protocol that you wish to restore and click Restore.

Capturing Image Sequences
Click the capture button to acquire an image sequence using the current acquisition protocol.
Once capture has started a red dot is shown on the Video Preview and the capture button changes
to a stop button.
Click the capture button to acquire an image sequence using the current acquisition
protocol.
Once capture has started a red dot is shown on the Video Preview and the capture
button changes to a stop button.
Note: The shortcut key F6 starts/stops the acquisition.
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If you have configured your acquisition protocol to acquire a fixed number of timepoints, the protocol
will stop when the correct number of timepoints has been acquired. If you wish to stop the protocol
before the end is reached, or if you have chosen the Capture until stop is pressed option, you
must click the Stop icon on the Video Preview window.
You may re-run your acquisition protocol by selecting the Capture icon as many times as you wish.

Pause Acquisition while Capturing
You may pause acquisition by selecting the pause button during acquisition of an image
sequence.
Any timepoints that have been partially acquired when you select pause will be completed before the
acquisition is paused. Once partially acquired timepoints are completed no further acquisition will
take place until the acquisition is resumed.
While acquisition is paused the pause button is highlighted and the red record icon in the top left
corner of the Video Preview window changes to a gray pause icon.
n

To resume acquisition click on the highlighted pause button.

n

To stop acquisition whilst paused click on the capture/stop button.

If a timepoint is overdue when you resume acquisition, it will be acquired immediately and at the time
intervals that you have specified in the time-lapse options thereafter.

Freeze the Video Preview
Freeze the image being shown in the Video Preview. This has two effects:
n

When viewing a live image, an acquisition protocol is not running. Freezing the preview will leave
the last captured frame visible on the screen but will close any shutters associated with the
current light path. This allows an image to be viewed and evaluated without exposing the sample
to further illumination light.

n

When an acquisition protocol is running, freezing the preview will not affect any of the settings
controlled by the protocol but the preview will not update with each captured frame. This
maximizes the resources available to the acquisition and can improve performance.

While the Video Preview is frozen, the snowflake icon and the text “Preview frozen” will be shown in
the top left-hand corner.
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Acquisition Feedback
The acquisition protocol feedback panel provides a graphical summary of the current acquisition
protocol. Double clicking on the acquisition protocol feedback panel opens the acquisition setup
dialog.
Multiple timepoints

Multiple timepoints and multiple Z sections

Multiple timepoints, multiple Z sections, and multiple channels

A more detailed summary is displayed in the acquisition feedback panel tooltip (move the cursor over
the LCD display to see the tooltip).

Click on the number in the timing feedback panel to toggle between the feedback modes. The
display changes to show:

the elapsed time

the number of elapsed timepoints

the remaining time
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the number of remaining timepoints

the time until the next timepoint

Note: If Capture until stop is clicked was selected in the Acquisition Setup window, the
Remaining option will display the approximate time or timepoints remaining until your hard disk is full.

Events and Logs
If something happens while observing acquisition that you wish to record, click on the Event flag.
click to record event during acquisition

Note: The shortcut key F7 creates an event.
Enter the appropriate text to identify the event and click Create.

The text will be stored in the Experiment Log of the image sequence.
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All of the image sequences that you acquire with Volocity Acquisition will have an Experiment Log
View, which can be displayed by selecting the Experiment Log tab.
The settings that were used for acquisition and any events that you recorded during acquisition are
recorded in the Experiment Log.

PerkinElmer UltraVIEW®
The UltraVIEW VoX is a complete system for live cell imaging using the CSU-X1 spinning disk head
from Yokogawa®.
The system consists of:
n

CSU-X1 spinning disk

n

Emission filter wheel

n

Modular laser system
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n

Piezo focus

n

CCD camera

n

Brightfield shutter

n

ProSync™ control box

Optional accessories include the PhotoKinesis™ accessory and a motorized XY stage.

How does the spinning disk illumination work?
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Configuring the UltraVIEW in Preferences
For the hardware of the spinning disk device to be correctly identified and controlled in Volocity it
must be configured in the preferences. There are two devices which communicate with Volocity via
serial ports: UltraVIEW Dichroic (within the CSU head) and the UltraVIEW ProScan™ II Controller.
The following information assumes the hardware has been installed and aligned by a qualified
PerkinElmer service engineer. These settings will also have been configured at installation but are
provided here for reference.
1. Select Preferences from the Edit menu (Windows) or the Volocity menu (Mac OS). Choose Serial
Ports from the list. The serial ports detected on the system will be listed and to connect a device in
Volocity its name must be selected against the port to which it is physically connected.

9. Scroll to the Devices pane and select the controls to be displayed in the Video Controls panel.
Devices unchecked in this list will not be seen in the Video Controls panel and therefore cannot be
controlled from that view.
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10. Next to the UltraVIEW item click Options... to configure the lasers present on the system. Select the
UltraVIEW model from the list. Laser lines are not automatically detected.

Check the box next to laser line(s) that are present on your system. The 488 nm laser is standard on
all systems; therefore, this option will be checked and cannot be changed.
11. Next to the UltraVIEW Focus Drive item click Options... to configure the range of travel for the piezo
focus drive.

For the objective piezo drive this distance is 100 micrometers. For the stage insert this distance will
be 200 micrometers or 400 micrometers. Check the specification of your particular system.
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If the microscope focus is also controlled by Volocity it will have its own
entry under the heading of the microscope. The piezo focus drive will be
the fastest to use in experiments but the microscope focus might have a
greater range of travel. Where both are available either may be chosen to
acquire stacks in the Acquisition Setup dialog, which is used to configure
the experiment. See “ Ratio Acquisition
Volocity Ratiometric Acquisition is designed specifically for online ratiometric imaging. The
Ratiometric Acquisition functionality is provided by the Ratiometric plug-in. This is an additional
module available for purchase and extends the functionality of Volocity Acquisition to add features
specifically for online Ratiometric Acquisition. The ratio is always calculated as Channel A/ Channel
B and therefore it is important to specify the channels correctly in the Ratiometric dialog.
The Ratiometric plug-in requires both Volocity Acquisition and Volocity Quantitation to be installed to
function. Ratio acquisition is followed by generation of a measurement item, measuring all active
regions of interest in the experiment.

Preparing a Ratio Experiment
Ratiometric Acquisition is a plug-in to Volocity Acquisition. If you are not yet familiar with Volocity
Acquisition please refer to ‘Volocity Acquisition Installation and Reference’ on page 141.
Before starting a Ratiometric experiment:
1. Install and configure all devices that are required for Ratiometric acquisition.
2. Calibrate each objective lens, if they are not already calibrated
3. Mount your sample and view using your low intensity light source.
4. Select Ratiometric Preview from the Library view or Show Ratiometric Preview from the Window
menu.
5. Configure any light paths that you require for Ratiometric acquisition. You will need one light path for
Channel A and another for Channel B.
6. Configure any additional light paths you will need to image during the experiment.
7. To populate the background Subtract field for Channel A draw a ROI in the backround of the live
preview image of select Channel A and click the Get from ROI button next to the subtract field for
Channel A.
8. Similarly for Channel B draw an ROI in the background of the live preview image of Channel B and
click the Get from ROI icon next to the subtract field for Channel B.
9. Set the threshold values to ensure a black background.
10. Set Rmin/ Rmax to expected or known values for the experiment.
These settings will be used for this experiment but data acquired using the ratio acquisition may also
be reprocessed using the Ratio dialog in Volocity Quantitation.

180 Improvision

VOLOCITY Acquisition Installation and Reference

After performing several experiments you may determine values for Rmin and Rmax which you use
for all experiments allowing them to be visually compared and avoiding the need for post processing.
11. Configure any additional light paths you will need to image during the experiment.
12. Create an acquisition protocol.
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The Ratio Preview
This section describes features that are specific to the Ratiometric Preview window. Details of more
controls that are common to the Ratiometric preview and the Video preview are described in the
section on the Video preview on page 157.
To display the Ratiometric preview select Show Ratiometric Preview from the Window menu. The
devices and device controls that were selected in the preferences are displayed on the right-hand
side of the Ratiometric Preview window.
Features that are specific to the Ratiometric Preview Window include:
n

Ability to display 2 captured channels and 2 calculated channels simultaneously in a 4 panel
preview

n

Ratiometric Preview mode selection buttons

n

Ratiometric Acquisition controls in addition to standard Video Preview device controls

n

The Live ratio plot
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Preview Mode
The ratiometric preview mode selection buttons allow live previews of Channels A, B, the Ratio A/B
Channel or the Intensity Modulated Display (IMD) channel, to be displayed either sequentially or
simultaneously in a four panel preview using the ‘Multiview’ selection button.

Selection of the IMD button generates an intensity modulated channel of A/B. Click and hold the
button to choose the modulator image from which the IMD channel is derived.

November 2008 183

If the microscope focus is also controlled by Volocity it will have its own entry under the heading of the microscope.
The piezo focus drive will be the fastest to use in experiments but the microscope focus might have a greater range
of travel. Where both

Ratiometric Acquisition Controls
The ratiometric aquisition setup pane contains dropdown menus for the selection of the correct light
paths to be used for Channel A and B.

A constant background value may be subtracted from each voxel in every image of Channel A and/or
Channel B. This can be done by either entering a value in the Subtract field or drawing an ROI on
the appropriate image and clicking the get from ROI tool next to the Subtract field. Volocity will use
the mean intensity from that ROI for each channel as the value to subtract.
Thresholding allows the removal of unwanted signals setting a ratio value to 0 when one of the
source voxels has an intensity value at or below the threshold. Threshold values can be set for
Channels A and /or Channel B by entering a value in the Threshold field.
The Ratio value range can be set by entering values in the Rmin and Rmax fields. These set the
range over which the rainbow look up table for the image will be spread.

Live plot
The live ratio plot can show the mean intensity values of ROIs (or the mean intensity of the whole
image if no ROIs are present) of either Channel A, Channel B and the ratio plot A/B if these
respective channels are being previewed. The plots can be shown if the respective channels are
being previewed whether sequentially or simultaneously as in multi-view mode. The mean intensities
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of Channel A and Channel B and the ratio plot can also be shown in the live plot when the IMD
channel is being previewed.

During live preview and acquisition you can choose to hide or show the plots using the toggle buttons
to the left of the live plot panel.

For easy identification during live preview the plots are color-coded as follows:
n

Mean intensity Channel A- same color as configured in the light path setup for Channel

n

Mean Intensity Channel B- same color as configured in the light path setup for Channel

n

Ratio Plot- black line

n

Intensity plot lines are dashed and ratio plot lines are solid

The x axis of the live plot will rescale to ensure the full course of the experiment is displayed.

November 2008 185

If the microscope focus is also controlled by Volocity it will have its own entry under the heading of the microscope.
The piezo focus drive will be the fastest to use in experiments but the microscope focus might have a greater range
of travel. Where both

Creating a Ratio Acquisition Protocol
1. Select Acquisition Setup… from the Ratio menu.

2. The Ratio Setup dialog opens.

3. If you want to acquire the ratio channel and /or IMD channel tick the appropriate channel check
boxes. You cannot collect an IMD channel without capturing the ratiometric channel.
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4. If you want to acquire any additional channels tick the Capture additional channels check box and
use the drop-down menu to select the additional light paths to be captured.

If you would like to acquire more than one additional channel click on the ‘+’ button and add more
light paths.
5. If you want Volocity to set the exposure for each of your light paths check Use auto exposure for
each channel.

6. To acquire multiple timepoints, select either the Until stop is clicked where Volocity acquires data
until it is manually stopped, or enter a number in the text field and select either ‘timepoints’, ‘ms’,
‘seconds’, ‘minutes’ or ‘hours’ from the drop-down menu.

7. Select a shutter management option from the Manage shutters for drop down menu.
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8. When you are happy with the ratio acquisition protocol click OK.
9. Click on the Capture video control in the Ratio preview to apply the acquisition protocol that you have
just set up.
Note: A Volocity library must be open to store the image sequences that are acquired.
Volocity will acquire the appropriate images, freeze the Video Preview so that the last frame acquired
is held on the screen, and then automatically start generating a measurements item. See Viewing
Results on page 277.

Events and Logs
If you would like to record events to an image sequence during acquisition (e.g. time of the addition
of a drug) click on either the Event flag or press the F7 shortcut key.

Enter the appropriate text to identify the event and click OK.
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The events are marked on the live plot in numerical order. The text is recorded in the chart view of
the measurements item created by the ratio acquisition and in the Experiment Log view.

.

Viewing Results
A ratiometric measurement item is automatically generated at the end of acquisition. This appears in
the library directly below the new image sequence. This records values of ROIs for each channel
during acquisition so that you do not need to re-analyze your data after acquisition.
When the measurement item is opened, the default view will be the ‘Chart View’. The Raw and
Analysis views are also accessible from the tabs next to the Chart View tab.
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For more information about Measurement Items and making measurements using Volocity
Quantitation see the chapter on Volocity Quantitation starting on page 408.

Reanalyzing Ratio Experiments
The analysis carried out as part of the ratio acquisition is not the only choice for final output. Ratio
images created during the acquisition may be measured using any of the tools available in Volocity
Quantitation. The raw A and B images may even be re-ratioed using the offline ratio tools. See
page 519.

Live Fast Restoration
Volocity Acquisition supports Fast Restoration deconvolution. This option is available in the Video
Preview window if you have purchased the Volocity Restoration extension product.
Fast Restoration should only be used with single plane acquisition protocols. If you have multiple
planes, you should capture them first and deconvolve them later using Volocity Restoration.
Important: You must create or import a PSF for each channel that will be captured before you can
set up the acquisition.
1. Make sure that Fast Restoration is selected in the Devices Preferences window.

2. You can configure the settings from the Options… button or by double clicking on the Fast
Restoration icon on the Video Preview window.
3. Ensure that you have the correct PSFs for the channels that you wish to acquire in your Volocity
library.
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4. Double click on the Fast Restoration icon.

The Fast Restoration dialog opens.

5. Select a PSF for each channel that will be captured from the drop-down menus.
6. Decide on the number of neighboring slices that will be included in the restoration algorithm and
enter the value in Capture this many slices above and below field. The more neighboring slices
you include, the longer the process will take.
7. Select the appropriate focus drive from the Change focus using drop-down menu.
8. Enter an appropriate value for Use this Z spacing.
9. Select the appropriate option for Generate result using.

Center Image displays only the deconvolved center image.
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Extended focus creates a single image by making a brightest-point merge of all the deconvolved Zslices of a volume.
10. Click OK.
11. Check the Fast Restoration box on the Video Preview window. The first time you do this after
configuring the settings can take some time as Volocity applies the algorithm and generates the
deconvolved image.

Spectral Separation
Overview
Spectral separation is a technology that allows the separation of images containing data from more
than one fluorophore into channels that contain data from only a single fluorophore. In order to
achieve this separation or “un-mixing”, sample images must be acquired at a minimum of two
different wavelengths. Color cameras lend themselves naturally to this multiple wavelength sampling
because they simultaneously sample at three different wavelengths (red, green and blue). However,
multiple wavelengths can just as effectively be acquired using monochrome cameras and
wavelength changing devices such as filter wheels.

Why Separate Color Images?
Acquiring a single color channel instead of separate blue, green and red channels is an effective
means of reducing acquisition time. You may still wish to analyse each of the fluorophores in your
experiment in a single monochrome channel. Spectral separation will allow you to acquire the data
for up to three fluorophores into a single color channel and separate each fluorophore into its own
monochrome channel post-acquisition.

Why Separate Monochrome Images?
Spectral separation can be used to un-mix the contribution of spectrally overlapping fluorophores
from a series of grayscale images sampled at different wavelengths (lambda stacks). You can
therefore improve the separation of dyes that you have found difficult to separate adequately by
more conventional means using filter sets.
Lambda stacks can be composed of a series of images in which the excitation wavelength is
constant and the emission wavelength is changed, reflecting the shape of the emission wavelengths
of fluorophores. Alternatively, the emission wavelength can be constant and the excitation
wavelength changed, reflecting the shape of the excitation wavelengths of fluorophores. It may also
be possible to successfully un-mix fluorophores from Lambda stacks in which both excitation and
emission wavelengths are varied.
There should be a minimum of two channels in a Lambda stack. The maximum number of
fluorophores that can be separated from a lambda stack is equal to the number of images in the
lambda stack.
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Creating Spectral Signatures from Color Images
In order to accurately separate your fluorophores into individual channels you must first create
accurate spectral signatures. A spectral signature allows Volocity to calculate how a sample of only a
single fluorophore contributes to the red, green and blue elements of color images.
To generate a spectral signature:
n

First prepare a sample that contains only a single fluorophore.

n

Acquire an image or image sequence of the sample.

n

Open your image or image sequence in the Image View and select a region brightly stained with
your fluorophore with a region of interest tool, such as the magic wand tool. You should ensure
that no pixels in this region are saturated.

1. Select Create New from the Actions menu.
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2. Select Spectral Signature…

3. The Create Spectral Signature dialog opens.

4. Volocity will assign a sample color and perceived peak wavelength to your new spectral
signature. Give the spectral signature a meaningful name and click OK to create the signature.
5. Spectral signatures are added to your library.

6. You may inspect a spectral signature by double clicking on its library item.

You should make a spectral signature for each of the fluorophores that you wish to include in your
experiments. You can un-mix up to three fluorophores in each experiment.
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Creating Spectral Signatures from Monochrome Images
Successful spectral separation is dependent on the creation of accurate spectral signatures. A
spectral signature allows Volocity to calculate how a single fluorophore contributes to each point of a
lambda stack.
To generate a spectral signature:
n

First prepare a sample that contains only a single fluorophore.

n

Acquire a lambda stack of the specimen into an image sequence.

n

Open your image or image sequence in the Image View and select a region brightly stained with
your fluorophore with a region of interest tool, such as the magic wand tool. You should ensure
that no pixels in this region are saturated.

1. Select Create New from the Actions menu.
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2. Select Spectral Signature…

3. The Create Spectral Signature dialog opens.

4. Enter a name for your spectral signature and click OK.
5. Spectral signatures are added to your library.

6. You may inspect a spectral signature by double clicking on the library item.
You should make a spectral signature for each of the fluorophores that you wish to include in your
experiments.
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Separating Color Images
In order to accurately separate each of the channels from your color image, Volocity will need to
calculate the contribution made by background. This can be done automatically or you can select a
region of interest that contains only background. Volocity can calculate the background directly from
this region of interest or you can create a background spectral signature, which you may re-use if
your background is consistent between multiple image sequences. To make a background spectral
signature:
n

With your region of interest selected, select Create New then Spectral Signature… from the
Actions menu.

n

Give the background spectral signature a name and click OK.

1. Select an image or image sequence of a multiply (two or three fluorophores) labeled color specimen.
2. Select Separate Spectra… from the Tools menu.

3. In the Separate Spectra dialog select the spectral signatures of the fluorophores in your color image
from the drop-down menus. Each of the spectral signatures in your library will be listed in the dropdown menus.
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4. Select one of the Calculate background from radio buttons.
n

If you want Volocity to automatically calculate the background, select the Default background
radio button.

n

If you have made a background spectral signature, select the This spectrum radio button and
select your spectral signature from the drop-down menu.

n

If you have specified a region of interest containing only background, choose the Current
Selection radio button. If your image sequence is time resolved, the background will be
calculated from the first timepoint only unless you select the Recalculate for each timepoint
checkbox.

When you select Recalculate for each timepoint the background is recalculated for every timepoint
from the same region of interest. You must be certain that your region of interest always contains
only background (and that no objects of interest stray into your region during the course of the time
series).
5. Click Separate.
New channels based on your selected spectral signatures will be added to your image
sequence. The new channels are monochrome and are colored based on the color of the spectral
signature from which they were derived.
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If you un-mix a color image, new monochrome images will be added to a folder of images beneath
your original image.

Separating Monochrome Images (Lambda Stacks)
Acquire lambda stacks of specimens labelled with the combination of fluorophores that you wish to
separate. You must acquire your experimental specimens at exactly the same wavelengths and
relative exposures as your spectral signatures.
In order to accurately separate each fluorophore into its own channel from your lambda stacks,
Volocity will need to calculate the contribution made by background. This can be done automatically
or you can select a region of interest that contains only background. Volocity can calculate the
background directly from this region of interest or you can create a background spectral signature,
which you may re-use if your background is consistent between image sequences. To make a
background spectral signature:
n

With your region of interest selected, select Create New then Spectral Signature… from the
Actions menu.

n

Give the background spectral signature a name and select OK.

1. Open an image sequence in the image view.
2. Select Separate Spectra… from the Tools menu.
3. In the Separate Spectra dialog select the spectral signatures from the drop-down menus of the
fluorophores that you wish to un-mix from your lambda stacks.
n

The number of drop-down menus will be equal to the number of images in your lambda stacks.
November 2008 199

Spectral Separation

n

Each menu contains a list of all the spectral signatures in your library that were derived from
lambda stacks containing the same number of images as the image sequence that you wish to
un-mix.

n

If you have over-sampled (i.e. the number of images in each lambda stack is greater than the
number of fluorophores in your experiment) then you may leave some of the drop-down menus
as the default (No spectrum).

4. Select one of the Calculate background from radio buttons.
n

If you want Volocity to automatically calculate the background, select the Default background
radio button.

n

If you have made a background spectral signature select the This spectrum radio button and
select your spectral signature from the drop-down menu.

n

If you have a region of interest containing only background selected (in the image view) choose
the Current Selection radio button. If your image sequence is time resolved the background will
be calculated from the first timepoint only unless you select the Recalculate for each timepoint
checkbox.

n

When you select the Recalculate for each timepoint, the background will be recalculated for
every timepoint from the same region of interest. You must be certain that your region of interest
always contains only background (and that no objects of interest stray into your region during the
course of the time series).
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5. Click Separate.
New channels, based on your selected spectral signatures, will be added to your image
sequence. The new channels will contain only information from a single fluorophore.

November 2008 201

VOLOCITY Acquisition Installation and Reference

OptiGrid ®
®

The OptiGrid is an optical sectioning technology that, when combined with image analysis software,
confers confocal capabilities to wide field microscopes.
®

The OptiGrid consists of two pieces of additional hardware:
®

n

The OptiGrid paddle, which is inserted into the microscope’s fieldstop location and is connected
to

n

The OptiGrid controller box

®

®

The OptiGrid is based on a technique called “Structured Light” (Neil et al 97).
This technique modifies the illumination system of a microscope to project a grid pattern onto the
specimen. The grid is moved into three different positions, and an image is acquired at each position.
An algorithm is then used to produce a single, derivative, confocal image from which the grid pattern
has been removed.
The algorithm takes advantage of the fact that in-focus information changes as the grid moves, whilst
out-of-focus information remains constant. Therefore, if information does not change between
images, it is out of focus and can be removed from the final image.
Please see the appendix on page 553 for more information about the algorithm and related
publications.
®

OptiGrid Models
With some models of microscope, chromatic aberration problems have made it difficult or impossible
®
to place the grid pattern in common focus for all excitation wavelengths in use. With earlier OptiGrid
models, this restricted the range of excitation wavelengths that could be used together to acquire
®
image sequences, and created a need for manual refocusing of the OptiGrid .
®

®

The second-generation OptiGrid , sometimes referred to as the ‘Focusing OptiGrid ’, incorporates a
motor that enables it to be moved axially into different focal positions in the light path of the
microscope. Once the correct focal position for an excitation wavelength is established it can be
consistently and automatically restored. This extends the range of excitation wavelengths that can be
sequentially acquired into a single image sequence.
®

All OptiGrid models are supported in versions 4.1 or higher for Mac OS X and Windows.
®

You need a free USB port in order to run an OptiGrid .
®

Note: Manual focus models of the OptiGrid are connected via the Improvision Acquisition Hub.
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Motorized Focus Model
®

This section describes how to connect the OptiGrid model that includes motorized focus control.
®

The following components are supplied with your OptiGrid and are required for installation:
®

n

OptiGrid paddle

n

OptiGrid controller box

n

USB cable

n

Focus motor cable

n

High voltage cable

®

®

®

1. The OptiGrid controller box has a high-voltage output. The OptiGrid controller box must be
®
switched off before you connect the OptiGrid paddle using the power switch which is on the front of
the controller box.
®

2. Connect one end of the high voltage cable to the OptiGrid paddle and the other end to the Hi
®
Voltage Output connector on the rear of the OptiGrid controller box.
3. Connect one end of the focus motor cable to the OptiGrid®® paddle and the other end to the
®
MOTOR connector on the rear of the OptiGrid controller box.
®

4. Connect one end of the USB cable to the USB connector on the rear of the OptiGrid controller box
and the other end to a spare USB port on your computer.

5. If you have a field stop (field diaphragm) installed in you microscope, remove it from the field stop
port.
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®

®

6. Install your OptiGrid in the field stop port. Your OptiGrid “In” position can be found by pushing the
®
®
OptiGrid into the field stop port until the “clickstop” engages. In this position the OptiGrid should be
visible in the ocular lenses or with the camera when fluorescence images are observed. The “Out”
®
position can be found by withdrawing the OptiGrid from the field stop port (disengaging the
“clickstop”) until the grid is no longer in the light path, and no elements of the grid housing are in the
®
light path. In this position the OptiGrid can be left in the field stop port.

®

7. Switch on the OptiGrid controller box and start Volocity. The message “Connected to Volocity” will
®
be displayed on the OptiGrid controller LCD display.
®

8. You must now set up the OptiGrid for use with Volocity. This requires you to set up the Device
®
Preferences in Volocity and calibrate the OptiGrid . See page 297.
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Manual Focus Model
®

The manual focus model of the OptiGrid is connected via the Improvision Acquisition Hub to the
computer system that is running Volocity.
The following components are required for installation:
®

n

OptiGrid paddle

n

OptiGrid controller box

n

Improvision Acquisition Hub

n

Blue BNC-RF cable

®

®

®

1. The OptiGrid controller box has a high-voltage output. The Acquisition Hub and the OptiGrid
®
controller box must both be switched off before you connect the OptiGrid paddle using the power
®
switch is on the front of the Acquisition Hub and the OptiGrid controller box.
®

®

2. Connect the OptiGrid paddle to the OUT HI VOLT connector on the rear of the OptiGrid controller
box.
®

3. Connect the BNC-RF cable to the INPUT connector on the rear of the OptiGrid controller box and
®
connect the other end of the BNC-RF cable to the OPTIGRID port on the rear of the Acquisition Hub.

®

Note: this cable will fit if connected the wrong way around, but the OptiGrid will only work if the
cable is connected in the orientation shown below.

November 2008 207

Connecting the OptiGrid®

4. If you have a field stop (field diaphragm) installed in you microscope, remove it from the field stop
port.

®

®

5. Install your OptiGrid in the field stop port. Your OptiGrid “In” position can be found by pushing the
®
®
OptiGrid into the field stop port until the “clickstop” engages. In this position the OptiGrid should be
visible in the ocular lenses or with the camera when fluorescence images are observed. The “Out”
®
position can be found by withdrawing the OptiGrid from the field stop port (disengaging the
“clickstop”) until the grid is no longer in the light path, and no elements of the grid housing are in the
®
light path. In this position the OptiGrid can be left in the field stop port.

®

7. Switch on the Acquisition Hub and the OptiGrid controller box. The USB, PWR and RDY lights on
®
the Acquisition Hub and the red light on the front of the OptiGrid controller should all be illuminated.
®

NOTE: If the LEDs on the Acquisition Hub or OptiGrid controller fail to illuminate, check the cabling
and make sure that none of the connecting pins are bent. For further information, see page 301.
®

8. You must now set up the OptiGrid for use with Volocity. This requires you to set up the device
®
preferences in Volocity and calibrate the OptiGrid . See page 11.
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Setting Volocity Preferences
1. Open the Volocity application.
2. Select Preferences... from the Edit menu (Windows) or the Volocity menu (Macintosh).
3. Click on the Devices icon in the left-hand panel. A list of devices that have been correctly connected
to your computer will appear in the right-hand panel. Each device has a subset of device controls
that are listed beneath the device.
®

Motorized Focus OptiGrid Models
®

Scroll through the list of devices until you find the Qioptiq OptiGrid Controller.
®

Check the box next to the Qioptiq OptiGrid Controller, check the boxes for all of its associated
devices.
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®

Manual Focus OptiGrid Models
Scroll through the list of devices until you find the Improvision Acquisition Hub.
Check the box next to the Improvision Acquisition Hub, check the box next to the Grid Calibrator.

Calibrating the OptiGrid ®
It is important to focus the grid manually the first time that you calibrate. The information in this
®
section applies to all OptiGrid models.
®

In order to calibrate the OptiGrid you must have a uniformly fluorescent sample against which the
grid can be imaged. Sealing a small amount of fluorescent ink between a slide and a cover slip can
make an ideal calibration slide. Highlighter pens are an excellent source of such ink. Alternatively,
you can use the Qioptiq calibration slide.

Calibration process
1. Open Volocity and select Show Video Preview from the Window menu.
2. Mount the calibration slide on the microscope and select an appropriate fluorescence filter. For
example, blue excitation and green emission works well with yellow ink.
3. Expose the calibration slide to the fluorescent light source. Calibration can be done with any lens but
you will get better grid contrast with low power lenses.
4. Use the microscope focus drive to focus on the fluorescent material. Air bubbles or the edge of the
“inked” area make good reference points.
5. Move to a field of view that is uniformly filled with fluorescent material.
®

6. Move the OptiGrid to the “in” position in the microscope’s fieldstop location.
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7. Adjust the aperture diaphragm on the microscope to improve the contrast if necessary.
8. Direct all light to your camera and, if your camera supports it, select Auto-Exposure from the Video
Preview controls (or the AE button).

Note: If the exposure is low (<20ms), you may see grid lines in your grid confocal images due to
lamp flicker. Avoid low exposures by reducing lamp intensity or using neutral density filters.
®

9. Use the grid focus control to adjust the position of the OptiGrid until the image of the grid is
maximally focused against the fluorescent material on the Video Preview.

®

NOTE: With manual focus model of the OptiGrid you must use the “hex wrench” focusing tool to
focus the grid. Insert the hex wrench in the middle of the three holes visible on the side of the
®
®
OptiGrid until it engages. Twisting the hex wrench tool changes the focal position of the OptiGrid .
®
Avoid using excessive force when focusing the OptiGrid as you can damage the grid focus
mechanism when the grid has reached the limit of its movement. If resistance is met you are likely to
have reached the focus limit and should twist the hex wrench tool in the opposite direction.
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10. It is important that the focus is consistent across the grid, see page 314.

11. Select Calibrate Confocal Grid… from the Video menu. A progress bar is displayed as the
®
OptiGrid is calibrated; this may take several minutes.

12. The calibration of the grid is now complete and the calibration slide can be removed and replaced
with the specimen that you wish to image.
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®

OptiGrid Installation and Calibration Troubleshooting
During calibration, you require an image where the focus is consistent across the grid. Here are
examples of good and poor grid images. Note the high grid contrast in the good image:

Good grid image

Poor grid image

If you are unable to focus your grid against your calibration slide, despite moving the grid through its
full focus range, check the manufacturer of you fluorescence filter set. Filters manufactured by
®
Semrock do not work with the OptiGrid and should be avoided.

Insufficient contrast warning or error 13901 during calibration (all models)
These errors indicate that the grid is not consistently in focus or that the grid contrast is not high
enough for imaging. To rectify this, follow these steps:
1. Ensure that the grid paddle is in the light path.
2. Turn off “Auto Contrast” if your camera supports this function. “Auto Contrast” can lead you to believe
that grid contrast is better than it actually is.
3. Use the microscope focus drive to focus on the calibration slide.
®

®

4. Adjust the focus of the OptiGrid , using the Grid Focus Control (motorized focus OptiGrid ) or the
®
hex wrench tool (manually focusing OptiGrid ).
It is important that the focus is consistent across the grid; use the focus adjustment to position the
grid such that contrast is as consistent as possible.
5. Repeat steps 2 and 3 to maximize the grid contrast. It can help to use the numerical readout of the
minimum and maximum pixel values in the “Video Preview” window to do this. See page 157.
6. Closing the aperture diaphragm will improve grid contrast.
7. Reducing the excitation light intensity and increasing the camera exposure time may improve
contrast.
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8. Different objectives may give better contrast. Calibration is best performed with a good-quality PlanApochromat air objective.

Grid does not move during calibration (all models)
During calibration the grid should move, first slowly in one direction, then more quickly in different
directions. If the grid does not move or the calibration fails with error 13902, follow these steps.
®

Motorized Focus OptiGrid Models
®

®

1. Switch off the OptiGrid controller. The OptiGrid controller must be switched off while connecting
and disconnecting cables because it has a high-voltage output.
®

2. Check that the cables are connected correctly. The OptiGrid paddle should be connected to the
®
OptiGrid controller via two cables; one to the Hi Voltage Output connector and the other to the
®
MOTOR connector on the OptiGrid controller. The host computer should be connected to the
®
OptiGrid controller via a USB cable to the USB connector.
3. Check both ends of the high-voltage cable and make sure that no pins are bent on the connectors. If
a pin is bent, carefully bend it back into position with a small screwdriver.
®

Manual Focus OptiGrid Models
®

®

1. Switch off the OptiGrid controller and the Acquisition Hub. The OptiGrid controller must be
switched off while connecting and disconnecting cables as it has a high-voltage output.
®

2. Check cables are connected correctly. The OptiGrid paddle (or microscope connection) should be
®
®
connected to the “hi volt” output of the black OptiGrid controller. The “input” on the OptiGrid
®
controller should be connected to the “OptiGrid ” port on the Acquisition Hub with the blue cable.
Note that the blue cable is not a standard BNC-BNC cable; it is a BNC-RF cable. A standard BNCBNC cable may physically fit, but will not work.
3. Check that no pins are bent on the high-voltage output of the OptiGrid® controller. There should be
®
four pins, two in the OptiGrid controller socket and two in the grey paddle cable. If a pin is bent,
carefully bend it back into position with a small screwdriver.

There are four pins, two on each side of the connector
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®

4. Check that no pins are bent on the low-voltage input of the OptiGrid controller. There should be two
®
pins, one in the blue cable and one in the OptiGrid controller socket. If a pin is bent, carefully bend it
back into position with a small screwdriver.

There are pins on both sides of the connector – the ones in this picture are OK.

5. Check that the pin is not bent at the Acquisition Hub end of the blue BNC-RF cable.

®

6. Check that the “OptiGrid ” socket on the Acquisition Hub is not damaged – it is possible for the
central part of the socket to get distorted if the pin in the blue cable is not central. If the socket is
damaged, it is normally possible to repair it using a pin to tease the metal parts of the socket back
into place.

®

This OptiGrid socket has been slightly damaged and the metal parts teased back into place.
Compare with the Piezo Z socket on the left.
®

7. Switch on both the Acquisition Hub and OptiGrid controller. The USB, PWR and RDY lights on the
®
Acquisition Hub and the red light on the front of the OptiGrid controller should all be illuminated.
8. Retry calibration. If calibration fails again, contact Improvision or the Improvision dealer that supplied
®
your OptiGrid .
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Using the OptiGrid ®
®

Once you have calibrated the OptiGrid , you are ready to use it for acquisition. If you intend to
acquire multi-channel image sequences you may need to ensure that the grid is correctly focused for
each of your excitation wavelengths. The worked examples in this chapter illustrate this process.

Grid controls

®

All versions of the OptiGrid have the grid mode controls. The focus and auto-focus controls are not
®
available with manual focus models of the OptiGrid .

Auto focus
Click Grid AF to allow Volocity to auto focus the grid for you. Volocity will test a number of grid focus
positions until it finds the position in which grid confocal images with the best contrast are generated.
Auto focus will only work after your grid has been calibrated for the first time and provided you have
a specimen mounted and in focus.

Focus
Use this control to adjust the focus position of the grid. You can use this control as an alternative to
Grid AF, or to fine tune the result of Grid AF.
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Grid modes
There are three grid mode controls. From left to right:

n

Grid Off: Switches the grid off. There is a stationary grid pattern on the Video Preview and from
the ocular lenses of the microscope.
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n
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Grid Confocal: Activates the grid. There is a confocal image on the Video Preview and a moving
grid pattern from the ocular lenses of the microscope.
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n

Grid Wide Field: Activates the grid. There is a wide field image (without grid lines) on the Video
Preview and a moving grid pattern from the ocular lenses of the microscope.

Single-channel grid confocal images
1. Open Volocity and select Show Video Preview from the Window menu.
2. Mount your specimen slide on the microscope stage and select an appropriate fluorescence filter set.
3. Expose the specimen slide to the light source and select a suitably powered lens.
4. Move to the field of view that interests you.
®

5. Ensure that the OptiGrid is in the “in” position in the microscope’s fieldstop location.
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6. Direct all light to your camera and, if your camera supports it, select Auto-Exposure from the Video
Preview controls (or the AE button).

7. Set the Grid activation control in the Video Preview to Off. You should see clear horizontal lines
superimposed on your specimen.
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®

8. Click Grid AF to focus the OptiGrid automatically. Alternatively, use the grid Focus control to focus
®
the OptiGrid .

®

NOTE: With the manual focus model of the OptiGrid you must use the “hex wrench” focusing tool to
focus the grid. Insert the hex wrench in the middle of the three holes visible on the side of the
®
®
OptiGrid until it engages. Twisting the hex wrench tool changes the focal position of the OptiGrid .
Avoid using excessive force when focusing the OptiGrid® as you can damage the grid focus
mechanism when the grid has reached the limit of its movement. If resistance is met, you are likely to
have reached the focus limit and should twist the hex wrench tool in the opposite direction.
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Note: You can also adjust the grid position whilst the grid is in “Grid Confocal” mode. As you move
the grid, the signal-to-noise ratio of the grid confocal image will improve if the grid’s focus is improved.
9. Set the Grid activation control to “Grid Confocal”.
10. Change the slide or mount the slide in the first place.
11. You are now ready to acquire grid confocal images or image sequences.
®

After acquisition, remember to move the OptiGrid out of the microscope’s lightpath or ensure that
the shutter is closed. If a light source is left on with the grid inserted but not moving, a grid image can
be burnt into fixed samples which will cause gridlines.
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®

Multi-channel grid confocal images (Motorized Focus OptiGrid )
If you wish to acquire multi-channel grid confocal images, you must ensure that the grid is correctly
focused for all of your lightpaths before acquisition. See page 154 for more information about
lightpaths.
1. Open Volocity and select Show Video Preview from the Window menu.
2. Mount the specimen slide on the microscope and select an appropriate light path.
3. Expose the specimen slide to the light source and select a suitably powered lens.
4. Move to the field of view that interests you.
®

5. Ensure that the OptiGrid is in the “in” position in the microscope’s fieldstop location.
6. Direct all light to your camera and, if your camera supports it, select Auto-Exposure from the Video
Preview controls (or the AE button).

7. Set the Grid mode control in the Video Preview to Off. You should see clear horizontal lines
superimposed on your specimen.
®

®

8. Click Grid AF to focus the OptiGrid automatically or use the grid focus control to focus the OptiGrid .

November 2008 223

Using the OptiGrid®

Note: You can also adjust the grid position whilst the grid is in “Grid Confocal” mode. As you move
the grid, the signal-to-noise ratio of the grid confocal image will improve if the grid’s focus is improved.
9. Double click on the current light path’s button. The Light Path Properties dialog opens. Scroll through
the list of devices until you find Grid Focus.
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Click on the Grid Focus check box to associate the current grid focus position with the light path.

10. Repeat this process for each of the light paths that you wish to restore for your acquisition.
11. Set the Grid activation control to “Grid Confocal”.
12. You are now ready to acquire multi-channel grid confocal image sequences.
®

After acquisition, remember to move the OptiGrid to the “out” position in the microscope’s fieldstop
location or ensure that the shutter is closed. If a light source is left on with the grid inserted but not
moving, a grid image can be burnt into fixed samples which will cause gridlines.
®

Multi-channel grid confocal images (Manual Focus OptiGrid )
®

With the manual focus OptiGrid it is not possible to associate different grid focus positions with each
®
of your light paths. If your OptiGrid cannot be focused perfectly for each of your light paths, it may
be necessary to find a compromise grid focus position in which an adequate image of the grid can be
seen for all of your excitation wavelengths.
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Adjusting the aperture diaphragm
The position of the aperture diaphragm can have an important effect on the quality of your images;
you should always carefully consider its position before and during any imaging sessions. Closing
the aperture diaphragm tends to improve the contrast of the grid and, therefore, the contrast of the
grid confocal images. Closing the aperture diaphragm also increases the exposure times of your
images, so you should balance aperture position with acceptable exposure times.
1. Select the grid confocal mode from the Video Preview controls.

2. Adjust the aperture diaphragm on the microscope.
3. Select Auto-Exposure from the Video Preview controls (you will see the grid lines while Volocity
adjusts your exposure).

4. Assess whether the quality of the image and the exposure time will meet your experimental needs.
When you are happy with the position of the aperture diaphragm you can proceed with your
acquisition of grid confocal images. Acquisition of image sequences can be done as normal,
remember to select the grid confocal mode before starting acquisition.

Troubleshooting Grid Imaging
Once you become familiar with the way the grid is working, it becomes clear how artefacts may be
generated.
n

Vibration may alter the grid movement and prevent it from moving to the correct position for each
of the three raw images.

n

Inconsistent illumination or photobleaching can produce intensity differences between the raw
images. The algorithm will extract artefactual data from these illumination differences and grid
lines will appear in the final image.

n

A poorly focused (or out of focus) grid will produce little or no difference between the three raw
images and a blank confocal image will be generated.
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Little or no signal with the grid active
®

The OptiGrid relies on the grid “marking” in-focus parts of the sample. If the grid contrast in the
image is poor, no parts of the sample will be marked and little or no signal will be output.
Recalibrating the grid will not improve the brightness of the grid image – calibration only removes
gridlines.
Note: Increasing the camera exposure time will not make the confocal signal brighter – the
brightness of the confocal signal is determined purely by the contrast in the grid image.

Good grid contrast

Poor grid contrast

To correct for this:
1. Adjust the grid focus. First focus the sample with the grid off. Select “Grid Confocal” mode, then
adjust the grid focus until the confocal signal is as bright as possible.
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2. Adjust the imaging system to maximize grid contrast. Closing the aperture diaphragm to reduce stray
light will help.
3. It may be necessary to adjust the grid focus for different wavelengths (see page 304) and different
objectives.
4. Plan-Apochromat objectives will give better results with multiple wavelengths.

Gridlines in image
Gridlines in the image are caused by the three raw grid images not quite lining up with each other.
There are several possible reasons for this:
1. Poor calibration. If gridlines appear, try recalibrating the grid. The grid calibration can change as the
grid and microscope heat up in use. Recalibration will correct for this.
2. Vibration can cause grid lines. Isolate the microscope with an anti-vibration table if possible.
Equipment containing fans (e.g. camera controllers and light sources) must be isolated from the
microscope (e.g. by moving them onto a separate table or onto the floor).
3. Uneven or unstable illumination will cause gridlines. Use a stable light source that offers even
illumination. If flicker is a problem, attenuate the light using ND filters and increase exposure times.
4. If the light source is left on with the grid inserted but not moving, a grid image can be burnt into fixed
samples which will cause gridlines. Ensure that the fluorescence shutter is closed when possible or
that the grid is left running.
5. Fast bleaching samples may show gridlines more than slow bleaching samples. To solve this, reduce
the light intensity and increase exposure times.
®

6. Camera noise will be amplified by the OptiGrid process and will show as gridlines. Avoid using high
®
camera gain with the OptiGrid .
Once these factors are eliminated, recalibrate the grid.

Installing and Configuring Photonics Instruments MicroPoint ®
®

Volocity supports the Photonics Instruments MicroPoint Ablation Laser Unit as a bleaching device.
http://www.photonic-instruments.com/
®

Before you use the MicroPoint high-intensity laser unit for the first time with Volocity it must be
calibrated. You must calibrate the laser again should the laser unit be rotated relative to the
microscope, if the camera is moved relative to the microscope, if the dye cell is changed, or if the
microscope’s objective lens is changed.
Connect the Ablation Laser Unit to the microscope, as instructed in the Photonics Instruments
documentation.
®

Connect the MicroPoint control box to the computer via a free USB port.
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®

Although the MicroPoint control box connects to Volocity via a USB connection it will function as a
“Virtual COM Port” (VCP). In order for this to work you must download and install the driver
appropriate for your operating system from http://ftdichip.com/Drivers/VCP.com
1. Open Volocity and select Serial Ports from the preferences.
®

2. Set the usbserial-ELCBXAV5 port to the MicroPoint .

10. Select Devices from the preferences.
®

11. Ensure that all of the MicroPoint devices are selected.

Calibrating Photonics Instruments MicroPoint ®
Make sure that the laser unit is horizontal (relative to the microscope) before you start, focus and
align the laser as described in the Photonics Instruments documentation.
Ensure that your “Laser Safety Filter Block” is always in the light path when using the MicroPoint
laser.

®
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1. Mount your mirror slide on the microscope with the reflective surface nearest to the objective lens.
2. Select Show FRAP Preview from the Window menu.
3. Switch on your transmitted light lamp.
4. In order to focus on the mirror’s surface you should search for a scratch or pit on the surface and
focus the microscope on that.
5. Direct all light to the camera and adjust the camera exposure time if necessary.
6. Ensure that any shutters in the laser’s light path are open.
7. Select Calibrate MicroPoint… from the FRAP menu.
®

8. The MicroPoint Calibration wizard is opened.
9. Click Fire.
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®

10. The MicroPoint laser is fired. If the laser is correctly focused on the mirror a hole will be cut in the
mirror’s reflective surface allowing transmission of light and creating a spot. If you are unhappy with
the shape and size of the spot, adjust the focus or the intensity of the laser and click Fire again.
11. Once you are happy with the size and shape of the spots, click Next. A line of holes is fired onto the
mirror. Adjust the rotational position of your camera so that the line is horizontal relative to the FRAP
preview.
Tip: You may find it easier to judge whether the line is horizontal, if you move it (using the stage)
higher up or lower down the Preview window where you can align it with the top or bottom of the
screen.
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12. Click Next to calibrate the laser. A diagonal line of holes is fired across mirror.

13. Click Finish. The calibration wizard will close.
14. You should now check the result: use one of the ROI tools to draw a region of interest on the
®
Preview and click the MicroPoint Fire control within the video controls. The cut area should
correspond exactly to the ROI. If this is not the case repeat the calibration procedure.
Volocity Acquisition Worked Examples” on page 269 for examples of setting up this dialog.
15. Next to the UltraVIEW Emission Wheel click Options... to configure the filters held in the wheel. This
should be already configured correctly for a standard system.
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PhotoKinesis™ Accessory
If the optional PhotoKinesis accessory is included in the system there will also be check boxes for
the controls of that device.

Click Options... to set laser power for bleaching. This dialog is also accessed from video controls
while configuring an experiment.
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Preparing to Use the UltraVIEW in Volocity
In order to use the UltraVIEW with Volocity all hardware must be configured.
n

Components of the UltraVIEW which connect via the ProSync controller and serial ports must be
connected, switched on and configured in the Volocity preferences.

n

Camera drivers must be installed, the camera connected and switched on. The camera will then
be automatically recognized in the Devices list in the Volocity preferences.

If using a motorized microscope that must be connected to a serial port on the computer, use the
serial cable supplied by the manufacturer. If there are no spare serial ports, it may be necessary to
use a serial adapter.
Choose Show Video Preview... from the Window menu to see the image from the camera and the
controls for the devices.
To ensure images are correctly calibrated set calibrations for each lens position. Calibration is then
applied to each image according to the lens in position when it is acquired.
Light paths may be created for each of the laser lines to enable easy switching between excitation
and emission wavelengths for different fluorochromes. It is advisable to create light paths using the
Emission Discrimination mode of the UltraVIEW, and for each laser line set and store the laser line,
filter wheel position and set the laser shutter to open.
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These light paths will then work satisfactorily with both Emission Discrimination and Fast Sequential
modes. Storing other settings with these light paths are a matter of personal preference and will vary
depending on how the system is being used. See page 154 for information on configuring the light
path manager.
If the image generated by the confocal head does not fill the full field of view, adjust the CCD active
area using CCD Active Area... dialog accessed from the Video menu.

UltraVIEW Controls
When the UltraVIEW is correctly configured in the preferences the following controls will be visible in
the Video Controls. Select Show Video Preview... from the Window menu to see these controls and
the live video.
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Discrimination Mode
When experiments are carried out using multiple wavelengths two different methods of capture can
be used: emission discrimination or fast sequential.
Emission Discrimination mode will restore the emission filter wheel position associated with the light
path. Changing the emission filter provides better discrimination between different dyes in one
sample. The disadvantage of Emission Discrimination is a reduction in capture speed, due to the
time taken for the emission filter wheel to turn from one position to another.
In Fast Sequential mode the filter wheel is not moved during the experiment. Instead the wheel is
automatically turned to the position containing the appropriate broadband barrier filter for the current
dichroic to prevent laser breakthrough. Any emission filter wheel positions stored with light paths will
be ignored in fast sequential mode. Fast sequential provides the highest capture speed, as switching
between lasers is very quick. However, because the same broadband emission filter is used for all
images, there is an increased risk of crosstalk between the emissions of different dyes.
The emission filter wheel position must be stored in the light paths that are switched between by the
acquisition protocol for emission discrimination mode to work correctly.
Dichroic
Switch between the dichroics installed in the CSU head using this pop-up. Some dichroics are only
compatible with specific laser lines. This will be indicated in the interface as the lines that are not
compatible with the current dichroic are grayed out.

Laser Power
One laser power slider will be shown for each line configured in the preferences. The higher the
power used the more excitation light will be sent to the sample. This may increase the emission
signal allowing shorter exposures to be used, however it will also lead to faster photobleaching and
possible phototoxic effects.
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PhotoKinesis™ Accessory
Calibrating the PhotoKinesis Accessory
1. Select FRAP Preview from the Window menu.

16. Select Calibrate UltraVIEW PhotoKinesis Device… from the FRAP menu.
The calibration wizard runs.

17. Follow the instructions and the calibration will run automatically. A spot of laser light will be imaged
and moved to all edges of the field to complete a coarse calibration. The next step, fine calibration,
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requires a sample to image. This works best with a homogenous specimen such as ink from a
highlighter pen, allowed to dry. Stick a coverslip over the dried ink to best reproduce the imaging
conditions of the sample.

18. When the specimen is in focus and the image is clear on the screen, click Next.

19. To determine the laser power and number of cycles required to bleach the calibration sample it may
be necessary to test bleach by drawing an ROI and using the Fire button to see whether the sample
is bleached.

20. Do not be concerned if the ROI and the resultant bleach area are not perfectly aligned, fine
adjustment is performed in this step. Click Next. Volocity will bleach a specimen area and adjust
accordingly.

21. Click Finish. The calibration is completed and you may wish to perform a test bleach.
If the calibration is not able to run automatically you will be asked to adjust camera and laser settings
to achieve a well-formed spot and to ensure that the spot is approximately centered in the field. The
spot is formed by the laser light reflecting off the calibration mirror in the PhotoKinesis unit.
Double click on the bleaching device icon in the interface to access the dialog to insert attenuators
and move the position of the spot in the X and Y axes.
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Click Finish. The calibration wizard will close and you may wish to test the calibration.
If the system is fitted with a second camera the FRAP calibration process must be repeated for both
cameras so that both may be used for FRAP experiments. The FRAP calibration is stored with the
camera setting.

November 2008 239

PhotoKinesis™ Accessory

Testing Calibration
1. Draw an ROI in the FRAP preview, using the ROI drawing tools from the toolbar.
2. Click Fire and check the accuracy of the offset. If the region drawn is not matched by the bleached
shape you may need to repeat the calibration process using different settings.
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XY Stage, Multi-Point Acquisition Process
This section describes how to use Volocity to carry out multi-point acquisition using a motorized XY
stage.
There are several steps to this process:
n

Set up and calibrate the XY stage.

n

Create overlays and scans.

n

Find specimens of interest and record their positions as “Acquisition Points”.

n

Set up the acquisition protocol and capture the image sequences.

Set Up and Calibrate the XY Stage
The XY stage must first be configured as a device in the preferences. See page 142. Once the
stage is configured normal day to day operation will commence at step 5 below.
Note: Each time you start Volocity or turn the stage controller on, and are planning to use the two
together, calibrate the stage.
1. From the Edit menu select Preferences…Click once on the XY Stage option.

2. Select the appropriate XY Stage Device and correct Focus Device from the drop-down menus. The
focus drive that you select here will be used to store the positions of your acquisition points; you may
use a different focus drive for your acquisitions.
3. In the Devices section click on the Options… button and set the correct range of travel for the stage
model.
4. Use the checkboxes to set the X and Y axes correctly and click Save.
5. Clear the stage area and select Calibrate Stage… from the Stage menu.
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6. At the warning prompt, check the stage area is clear. When you are satisfied that neither your
specimens nor your microscope (in particular your lenses) will be damaged by large stage
movements, click Continue. Volocity moves the stage to the bottom right and top left positions to
establish the full range of travel and current position of the stage relative to the range of travel.

XY Stage View
Once the stage is calibrated, Volocity provides a choice of views: the XY Stage view and the live
Video Preview (described on page 157). In the XY Stage view the green area represents the full
working area of the stage. The gray crosshairs represent your current position on the stage.
If you move the stage manually you will see the position of the crosshair change to reflect the
movement; the X and Y coordinates of the stage will also be updated. You can quickly move the
stage by selecting the ROI tool (Shortcut key, R) and double clicking on the point on the XY Stage
work area to which you want the stage to move.
A small Video Preview is displayed in the bottom left hand corner of the XY Stage view. This allows
you to navigate around the stage whilst seeing the current Video Preview. The Video Preview can be
moved to any corner of the XY Stage view. To move the Video Preview to another corner of the XY
Stage view, click and drag the video preview to its new location.
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Stage working area

Video Preview

You may click and drag the
preview to another corner

stage X and Y
coordinates

You can toggle between the views by selecting the required view from the Video menu or by using
the shortcut keys.
n

On a Mac:
Shift+Apple+V for live video
Shift+ Apple+X for XY stage

n

On Windows:
Ctrl+Shift+V for live video
Ctrl+Shift+X for XY stage
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Adding Overlays
You can add overlays to your XY Stage view that will allow you to easily and quickly navigate around
your culture vessels or slides.
1. Select Make Well Overlay… from the Stage menu.

2. Select the type of slide or culture vessel from the drop-down menu and click Create… Volocity now
provides a wizard which guides you through the steps for setting the position of the XY stage.
In our example, we are making an overlay for a multi-well plate.
3. At each step of the wizard, move the stage to the requested position and click Next.
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After the last requested setting has been entered, the wizard closes and an overlay is shown on the
XY Stage view. Again, the cursor shows the current position of the stage.

current
position of
XY stage

Once you have set up the overlay you can:
n

Move to a specific well. Select the ROI tool and double click within a well to move quickly to that
well.

n

Select individual wells or groups of wells to work with. Use the ROI tool to select the required
well(s) and select Disable Selected Wells/Enable Selected Wells from the Stage menu, as
appropriate.
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The following example shows three wells disabled.

Saving and Restoring Overlays
To save overlays select Save Overlay… from the Stage menu. Enter a descriptive name for the
overlay in the dialog that opens and select Save.
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To restore a previously saved overlay select Restore Overlay… from the Stage menu. Select the
overlay that you wish to restore from the list and select Restore. The overlay will be displayed in the
XY Stage view.

Adding Points
Before adding acquisition points, we recommend that you focus on your specimen and select Set
Zero from your focus drive drop-down menu (if you have more than one focus drive in your imaging
system ensure that you reset the focus drive that you will use for your acquisition protocol).

You can add points manually or ask Volocity to create random points for you.
Manually Adding Points
1. Move the stage to the area of interest and focus on your specimen. You can do this by screening
your specimen using your microscope’s ocular lenses, or by using the Video Preview in Volocity to
scan your specimen.
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2. Select Add point from the stage menu or use the shortcut key:
On Mac: Shift+Apple+A
On WINDOWS: Ctrl+Shift+A
3. Move the stage and continue to add points manually, as required.
4. The point is shown as a cross on the XY Stage view. The X, Y and Z co-ordinates are recorded with
the point and displayed next to the point (you may have to zoom in to see the coordinates).

Creating Random Points
1. Select Create Points from Well Overlay from the Stage menu.

2. Select Multiple Random Points from the drop-down menu to add single acquisition points to
random positions within each enabled well. Select Multiple Tiled Points from the drop-down menu
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to add a matrix of multiple points at the centre of each well. Specify the required number of Points
per well.
3. Click Create…

Inspecting and Editing Points
1. Use the ROI tool to double click on a point. This moves the stage and focus drive to the X, Y, and Z
position of the point. You can use the Go to Next Point or Go to Previous Point commands or their
shortcuts from the Stage menu to cycle through your points.
2. If you change the focal position of a point, select Update Point from the Stage menu.
3. If you have created a lot of points, use the Review Points… command on the Stage menu. The
Review Points Wizard opens and takes you to each stored point.

4. At each point you can review and edit the focal position. The current focal position when you select
Next in the wizard will be stored with each point.
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Saving and Restoring Points
To save a set of acquisition points, select Save Points… from the Stage menu. Enter a descriptive
name for your points in the dialog that opens and select Save.

To restore previously saved acquisition points select Restore Points… from the Stage menu. Select
your points from the list and select Restore.

Scanning
Note: Always make sure that the lenses are calibrated accurately and that the camera head is
positioned squarely on the microscope before scanning. We also recommend that you enable
binning on your camera prior to scanning; this will allow Volocity to scan fields of view more quickly.
You can set up scanning areas in three ways. You can scan regions of interest, whole wells from
overlays, or you can scan acquisition points.
Scanning Regions of Interest
Set a region of interest by selecting the ROI tool, clicking and holding the mouse, and dragging out a
region of interest on the XY Stage view.
You can also set an ROI in several steps by moving the stage to opposite corners of your ROI.
n

Move the stage to the top left hand corner of you region of interest and select Set ROI Top-Left
from the Stage menu.

n

Move the stage to the bottom right-hand corner and select Set ROI Bottom-Right from the Stage
menu.

Once you have set a region of interest, select Scan Selected Area from the Stage menu.
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Scanning Enabled Wells
After making an overlay and ensuring that only the relevant wells are enabled, select Scan Enabled
Wells from the Stage menu. Volocity will scan all fields of view within the enabled wells.

Use the zoom tool to zoom on scanned areas. This will help you to find areas of interest in your
specimen.
Note: The shortcut key Z selects the zoom tool.
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Scanning Acquisition Points
After you have added your acquisition points (see page 247) select Scan Points from the Stage
menu. Volocity will scan your specimen and acquire a field of view for each of your acquisition points.

Capture snapshots of scanned areas by selecting Capture Snapshot from the Stage menu. Each
well that you have scanned will be captured as a separate snapshot.
Note: The shortcut key F5 captures a snapshot.
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Set Up and Run the Acquisition Protocol
After storing points in the stage area an acquisition protocol is used to image the points as required.
1. Select Acquisition Setup… from the Video menu or double-click on the acquisition protocol
feedback display on the Video Preview window.
n

You must select the appropriate focus drive and XY stage from the drop-down menus.

n

The focus drive that you select for acquisition may be different from the focus drive that you
selected to store the positions of acquisition points (see page 247). This will allow you to move
between acquisition points with a microscope focus drive, and to capture Z series with a piezo
drive.

n

Make other choices for change channels, duration, image order and shutter management as
appropriate.

Focus drive dropdown . This is the
focus drive that will
move to acquire a
stack
XY Stage
drop-down
Auto-focus
drop-down
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2. Auto-Focus
If you want Volocity to auto-focus on your points during the acquisition, select the light path that you
wish to use for auto-focusing from the drop-down menu.
If you choose to auto-focus during the acquisition, you can also set timing options by
selecting the “timing” icon.

You may choose to auto-focus at each point, or at each well. If you choose to auto-focus at each
point, each point will have its own focus point. If you choose to auto-focus for each well, all the points
within a well will share a common focus point.

You may also choose to auto-focus for every timepoint, to only auto-focus for the first timepoint, or to
auto-focus periodically.
3. If you have chosen to acquire multiple Z planes during your experiment, you now need to ensure that
the top and bottom focus limits are set correctly.
Each of your acquisition points will be treated as zero, regardless of its actual Z value. So the
distance between zero and your top and bottom position will be the same as the distances between
each of your points and their top and bottom positions (see the tables below for examples). You can
quickly check what values are set for top and bottom by inspecting the focus drive tool tip.
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Top and Bottom marks with top set to 5 and bottom set to -5
Position (Z) of
acquisition point
(µm)

Bottom mark
for acquisition
(µm)

Top mark for
acquisition
(µm)

0

-5

5

10

5

15

20

15

25

30

25

35

Top and Bottom marks with top set to 10 and bottom set to –10.
Position (Z) of
acquisition point
(µm)

Bottom mark
for acquisition
(µm)

Top mark for
acquisition (µm)

0

-10

10

10

0

20

20

10

30

30

20

40

If you wish to change the top and bottom positions, use the commands in the focus drive drop-down
menu.
Note: You should avoid re-setting the zero value of your focus drive after setting your acquisition
points. If you do so, you will invalidate the Z coordinates stored with each point.
4. Make sure a Volocity library is open and run the acquisition. If you have not set the top and bottom
positions either side of zero, you may get the following warning.
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We recommend that when this warning is generated you stop the acquisition and check your top and
bottom positions. In situations where the top and bottom are a long way from zero there is a danger
that the focus drive may move long distances during the acquisition. This may result in damage to
your microscope or specimen.
Volocity visits each acquisition point and conducts your acquisition protocol. The number of times
Volocity visits each point is determined by the duration option that you set with the protocol, the
frequency is determined by the time lapse option that was set on the Video Preview window.
Each acquisition point has its own image sequence. All the image sequences from a single multipoint acquisition are organized within a folder in your library.
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FRAP Acquisition
Volocity provides full support for observing and analyzing the movement of intracellular materials
after photobleaching of fluorescence. It supports both Fluorescence Recovery after Photobleaching
(FRAP) and Fluorescence Loss in Photobleaching (FLIP) analysis.
FRAP Acquisition and Analysis functionality are provided by the FRAP plugin. This is an additional
module available for purchase which extends the functionality of Volocity Acquisition to add features
specifically for FRAP acquisition and extends the functionality of Volocity Quantitation for analysis of
data acquired with the FRAP acquisition.
The FRAP plugin requires both Volocity Acquisition and Volocity Quantitation to function.

The FRAP Preview
This section describes features that are specific to the FRAP Preview window or are of particular
relevance to the FRAP Preview window. Details of more controls that are common to the FRAP
Preview and the Video Preview are described on page 157.
To display the FRAP preview select Show FRAP Preview from the Window menu or select the
FRAP Preview icon in the library view.

November 2008 257

FRAP Acquisition

Freeze
button

Bleaching
controls

Live intensity plot
n

Bleaching controls. These may differ depending upon the type of bleaching device that you are
using.

n

Live Intensity plot. This live plot shows the mean intensity of ROIs (or the mean intensity of the
whole image if no ROIs have been selected). Prior to acquisition the mean intensity of all ROIs
are shown in a single plot, during acquisition the mean intensity of each ROI is plotted individually.
The Intensity plot is useful for assessing the level of photobleaching from the low intensity light
source before acquisition, for adjusting the intensity of the high intensity light source, and for
monitoring the progress of your experiment during acquisition.

n

The Freeze button. This allows you to “freeze” the Preview when you find an area of interest.
Any shutters associated with the current light path are closed to prevent photobleaching, but the
last frame prior to closing the shutter is retained in the Preview. This allows you to select ROIs
(bleaching areas) without illuminating your specimen, reducing photobleaching.
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In the FRAP preview ROIs are used to mark regions that will be bleached during FRAP experiments.
If your bleaching device supports spot bleaching bleaching regions may also be marked using the
spot tool.

Preparing for FRAP Acquisition
FRAP Acquisition is a plugin to Volocity Acquisition. If you are not yet familiar with Volocity
Acquisition we suggest that you consult that part of the guide first.
Before you start your FRAP experiment:
n

Install and configure all devices that you wish to use for your FRAP acquisition.

n

Select Show FRAP Preview from the Window menu.

1. Calibrate each objective lens, if they are not already calibrated. See page 151 for details of the steps
necessary to calibrate images for magnification.
2. Configure any light paths that you require for FRAP acquisition. You will need one light path for each
of the channels that you're going to image during the experiment.

Preparing a FRAP Experiment
Mount your specimen and expose it to your low intensity light source.
1. With your specimen in focus ensure that the all light is directed to your camera. You should see your
specimen in the Video Preview. Adjust the camera controls until you are happy with your image.
2. You may wish to observe your specimen for a while to see whether you have an acceptable level of
photobleaching from your low intensity light source, using the live intensity plot should help you make
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this judgment. If you make adjustments to your light intensity, remember to adjust your camera
settings.
3. If possible, adjust the intensity of your bleaching device to the correct level. You should aim for
maximum photobleaching without damaging or excessively heating your specimen.
4. When you are happy with the intensity of both your low intensity light source and bleaching device
move to a new (unexposed) area of your specimen.
Select the Freeze button. The last frame previewed will be retained in the FRAP
Preview.
Ensure that the shutter management in the FRAP Acquisition protocol is set to any option other than
“Don’t manage” and the shutter associated with the currently selected lightpath will be closed while
the preview is frozen protecting the sample from illumination light while still allowing bleaching areas
to be drawn. See Creating a FRAP Acquisition Protocol.
5. With the FRAP Preview frozen you can set the bleaching area for your experiment without
photobleaching your sample. ROIs are used to mark bleaching areas. Use any ROI tool to draw an
ROI or restore an ROI by selecting ROI then Restore… from the Edit menu. To set an ROI of a
particular size we recommend the use of the ROI stamp tool. Information about drawing regions
using ROI tools may be found on page 413.
6. If your bleaching device supports spot bleaching you can use the Spot tool to add spot targets to the
video preview. You can add multiple spots by holding the SHIFT key whilst adding spots to the
preview. Each spot will be bleached sequentially. Set the properties of spots (size, bleach duration
etc.) using your bleaching device controls in the video preview.
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Creating a FRAP Acquisition Protocol
1. Select Acquisition Setup… from the FRAP menu.

2. The FRAP Setup dialog opens.

3. If you wish to restore one or more light paths for your pre-bleach and recovery phases, click on
the Change channels using light paths check box. If you wish to acquire more than one channel
for these phases click on the “+” button to add more light paths. Select the appropriate light paths
from the drop down menus. The same light paths will be used for both the pre-bleach and recovery
phases of your acquisition.
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4. If you want Volocity to set the exposure for each of your light paths check Use auto exposure for
each channel.

5. Select the bleaching device that you wish to use for the experiment from the Bleaching device to
use drop down menu.

6. Select the light path that you wish to use for the bleaching phase of the experiment from the
Bleaching device light path drop down menu.

You may need to select a light path that is different to the light path you have selected for the prebleach/recovery phases of your experiment. Doing so is likely to increase the time taken to acquire
your first frame following bleaching so we recommend that you try to avoid changing light paths
between bleaching and recovery phases.
7. For conventional FRAP acquisition and analysis you should acquire only a single plane. Ensure that
Change focus using is set to None.
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8. Select a shutter management option from the Manage shutters for drop down menu. This must be
set to something other than Don’t Manage for the Freeze preview button to work correctly (see page
259).

9. In, Acquire pre-bleach images for, specify the duration and the frame rate of the pre-bleach period.

10. In Acquire recovery images for, set the duration and frame rate of the recovery phase.
You may wish to set a very high frame rate for initial recovery period, but slow down the acquisition
as your recovery approaches plateau in order to reduce photobleaching of your specimen. This can
be achieved by setting a number of recovery phases.

To add an additional recovery phase click the “+” button. Set the duration and acquisition rate of the
new phase. You may add up to six different recovery phases as to your protocol. To remove a
recovery phase click on the “-“ button.
In the example shown above an initial recovery period of ten seconds in which images are acquired
at maximum speed is followed by a sixty second phase in which images are acquired every four
seconds, which is followed by a final recovery period of sixty seconds in which images are acquired
every 10 seconds.
11. Set the Number of bleach/recovery cycles. This will usually be set to 1 for FRAP experiments. With
the number of cycles set to 1 the protocol will finish after completing the recovery phases. You may
wish to repeatedly bleach your specimen, for FLIP experiments for example. With the number of
cycles set to greater than 1 the bleaching and all of the recovery phases will be repeated. Note: the
pre-bleach phase is never repeated.
12. When you are happy with your protocol click OK.
13. Click on the “Capture” video control to apply the acquisition protocol that you have just set up.
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Volocity will carry out the pre-bleach phase, fire the bleaching device according to its configuration
and continue with acquisition of the recovery images.

When acquisition begins ROIs change to colored “Bleach areas”, the intensity within a “Bleach area”
is plotted in a matching color on the live intensity plot.
If you have set multiple ROIs on the Preview, which become multiple “Bleaching areas”, each is
given its own color and plot when acquisition begins.
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You can study the intensity of the bleached areas in the live intensity plot over the course of the
recovery. When the protocol comes to an end the preview will be automatically frozen so that the
final image of the recovery and the intensity plot can be reviewed. The plot and the FRAP preview
will be overwritten when the preview is “unfrozen”.
Your bleaching/recovery data is stored as an image sequence in your Volocity library, a channel is
recorded for each of the light paths that you selected for the pre-bleach/recovery phases. Volocity
also adds a template channel which records the positions of your bleach areas for analysis. Areas
within the bleach area have a value of zero in the template channels, areas outside the bleach area
have a value of 255. Volocity also records the time of the last frame before bleaching, and the first
frame following bleaching as meta-data for analysis purposes. The experiment time is set to zero at
the end of the bleaching phase, any frames acquired before this will have negative time stamps.
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Data acquired with Volocity FRAP acquisition may be analyzed using the Volocity FRAP analysis.

3D Targeted Illumination Experiments
The FRAP acquisition protocol can be used to acquire volumes. You can run protocols that will
apply your high intensity light source to a region of interest in a single plane within your volume.
The plane at or closest to the zero mark of your focus drive is the only plane that will be illuminated
with the high intensity illumination.
We recommend that you set the plane to which you wish to apply targeted illumination to 0 (zero) in
the focus drive’s drop down menu on the Video Preview Window.
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The high intensity illumination will be applied between the pre-bleach and post bleach phases of your
protocol.
Remember to set the focus drive’s top and bottom limits to appropriate values.

In the FRAP setup dialog, you must select your Z drive from the Change focus using drop down
menu to acquire volumes.

FLIP Acquisition
FLIP is a technique that is also possible with the FRAP plugin. A FLIP experiment aims to determine
whether molecules are moving between two areas or compartments of the sample and a what rate.
To perform a FLIP experiment it is necessary to bleach one area and monitor another area which is
thought to be connected to the bleached area. A control area that cannot be connected to the bleach
area is also usually observed.
1. Select Show FRAP Preview from the Window menu.
2. Mount your specimen and expose it to your low intensity light source.
3. With your specimen in focus ensure that the all light is directed to your camera. You should see your
specimen in the Video Preview. Adjust the camera controls until you are happy with your image.
You may wish to observe your specimen for a while to see whether you have an acceptable level of
photobleaching from your low intensity light source, using the live intensity plot should help you make
this judgment. If you make adjustments to your light intensity, also adjust your camera settings.
4. If possible, adjust the intensity of your bleaching device to the correct level. You should aim for
maximum photobleaching without damaging or excessively heating your specimen.
5. When you are happy with the intensity of both your low intensity light source and bleaching device
move to a new (unexposed) area of your specimen.
6. Select the Freeze button. Any shutters associated with your currently selected light path will be
closed (provided you have opted to manage shutters in the FRAP preview). The last frame
previewed before the shutter was closed will be retained in the FRAP preview.
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7. With the FRAP preview frozen you can set your bleaching area for your experiment without
photobleaching your sample. ROIs are used to mark bleaching areas. Use any ROI tool to draw an
ROI or restore an ROI by selecting ROI then Restore… from the Edit menu. To set an ROI of a
particular size we recommend the use of the ROI stamp tool.
8. Select Acquisition Setup… from the FRAP menu and set up the acquisition protocol.

In this example, the bleach and recovery phase is repeated 10 times. Two images are acquired
during the recovery phase, one immediately following the bleach and a second a minute after the
bleach. Click OK.
9. The acquisition protocol is now stored and can be run by clicking the capture button on the FRAP
preview.
10. The pre-bleach images are acquired only once, but the bleach and recovery will be repeated, in this
case 10 times. These images may then be measured using the standard measurement tools in
Volocity. An example of this is described in “FLIP Analysis” on page 511.
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Ratio Acquisition
Volocity Ratiometric Acquisition is designed specifically for online ratiometric imaging. The
Ratiometric Acquisition functionality is provided by the Ratiometric plug-in. This is an additional
module available for purchase and extends the functionality of Volocity Acquisition to add features
specifically for online Ratiometric Acquisition. The ratio is always calculated as Channel A/ Channel
B and therefore it is important to specify the channels correctly in the Ratiometric dialog.
The Ratiometric plug-in requires both Volocity Acquisition and Volocity Quantitation to be installed to
function. Ratio acquisition is followed by generation of a measurement item, measuring all active
regions of interest in the experiment.

Preparing a Ratio Experiment
Ratiometric Acquisition is a plug-in to Volocity Acquisition. If you are not yet familiar with Volocity
Acquisition please refer to ‘Volocity Acquisition Installation and Reference’ on page 141.
Before starting a Ratiometric experiment:
11. Install and configure all devices that are required for Ratiometric acquisition.
12. Calibrate each objective lens, if they are not already calibrated
13. Mount your sample and view using your low intensity light source.
14. Select Ratiometric Preview from the Library view or Show Ratiometric Preview from the Window
menu.
15. Configure any light paths that you require for Ratiometric acquisition. You will need one light path for
Channel A and another for Channel B.
16. Configure any additional light paths you will need to image during the experiment.
17. To populate the background Subtract field for Channel A draw a ROI in the backround of the live
preview image of select Channel A and click the Get from ROI button next to the subtract field for
Channel A.
18. Similarly for Channel B draw an ROI in the background of the live preview image of Channel B and
click the Get from ROI icon next to the subtract field for Channel B.
19. Set the threshold values to ensure a black background.
20. Set Rmin/ Rmax to expected or known values for the experiment.
These settings will be used for this experiment but data acquired using the ratio acquisition may also
be reprocessed using the Ratio dialog in Volocity Quantitation.
After performing several experiments you may determine values for Rmin and Rmax which you use
for all experiments allowing them to be visually compared and avoiding the need for post processing.
21. Configure any additional light paths you will need to image during the experiment.
22. Create an acquisition protocol.
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The Ratio Preview
This section describes features that are specific to the Ratiometric Preview window. Details of more
controls that are common to the Ratiometric preview and the Video preview are described in the
section on the Video preview on page 157.
To display the Ratiometric preview select Show Ratiometric Preview from the Window menu. The
devices and device controls that were selected in the preferences are displayed on the right-hand
side of the Ratiometric Preview window.
Features that are specific to the Ratiometric Preview Window include:
n

Ability to display 2 captured channels and 2 calculated channels simultaneously in a 4 panel
preview

n

Ratiometric Preview mode selection buttons

n

Ratiometric Acquisition controls in addition to standard Video Preview device controls

n

The Live ratio plot
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Preview Mode
The ratiometric preview mode selection buttons allow live previews of Channels A, B, the Ratio A/B
Channel or the Intensity Modulated Display (IMD) channel, to be displayed either sequentially or
simultaneously in a four panel preview using the ‘Multiview’ selection button.

Selection of the IMD button generates an intensity modulated channel of A/B. Click and hold the
button to choose the modulator image from which the IMD channel is derived.

November 2008 271

Ratio Acquisition

Ratiometric Acquisition Controls
The ratiometric aquisition setup pane contains dropdown menus for the selection of the correct light
paths to be used for Channel A and B.

A constant background value may be subtracted from each voxel in every image of Channel A and/or
Channel B. This can be done by either entering a value in the Subtract field or drawing an ROI on
the appropriate image and clicking the get from ROI tool next to the Subtract field. Volocity will use
the mean intensity from that ROI for each channel as the value to subtract.
Thresholding allows the removal of unwanted signals setting a ratio value to 0 when one of the
source voxels has an intensity value at or below the threshold. Threshold values can be set for
Channels A and /or Channel B by entering a value in the Threshold field.
The Ratio value range can be set by entering values in the Rmin and Rmax fields. These set the
range over which the rainbow look up table for the image will be spread.

Live plot
The live ratio plot can show the mean intensity values of ROIs (or the mean intensity of the whole
image if no ROIs are present) of either Channel A, Channel B and the ratio plot A/B if these
respective channels are being previewed. The plots can be shown if the respective channels are
being previewed whether sequentially or simultaneously as in multi-view mode. The mean intensities
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of Channel A and Channel B and the ratio plot can also be shown in the live plot when the IMD
channel is being previewed.

During live preview and acquisition you can choose to hide or show the plots using the toggle buttons
to the left of the live plot panel.

For easy identification during live preview the plots are color-coded as follows:
n

Mean intensity Channel A- same color as configured in the light path setup for Channel

n

Mean Intensity Channel B- same color as configured in the light path setup for Channel

n

Ratio Plot- black line

n

Intensity plot lines are dashed and ratio plot lines are solid

The x axis of the live plot will rescale to ensure the full course of the experiment is displayed.
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Creating a Ratio Acquisition Protocol
23. Select Acquisition Setup… from the Ratio menu.

24. The Ratio Setup dialog opens.

25. If you want to acquire the ratio channel and /or IMD channel tick the appropriate channel check
boxes. You cannot collect an IMD channel without capturing the ratiometric channel.
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26. If you want to acquire any additional channels tick the Capture additional channels check box and
use the drop-down menu to select the additional light paths to be captured.

If you would like to acquire more than one additional channel click on the ‘+’ button and add more
light paths.
27. If you want Volocity to set the exposure for each of your light paths check Use auto exposure for
each channel.

28. To acquire multiple timepoints, select either the Until stop is clicked where Volocity acquires data
until it is manually stopped, or enter a number in the text field and select either ‘timepoints’, ‘ms’,
‘seconds’, ‘minutes’ or ‘hours’ from the drop-down menu.

29. Select a shutter management option from the Manage shutters for drop down menu.
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30. When you are happy with the ratio acquisition protocol click OK.
31. Click on the Capture video control in the Ratio preview to apply the acquisition protocol that you have
just set up.
Note: A Volocity library must be open to store the image sequences that are acquired.
Volocity will acquire the appropriate images, freeze the Video Preview so that the last frame acquired
is held on the screen, and then automatically start generating a measurements item. See Viewing
Results on page 277.

Events and Logs
If you would like to record events to an image sequence during acquisition (e.g. time of the addition
of a drug) click on either the Event flag or press the F7 shortcut key.

Enter the appropriate text to identify the event and click OK.
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The events are marked on the live plot in numerical order. The text is recorded in the chart view of
the measurements item created by the ratio acquisition and in the Experiment Log view.

.

Viewing Results
A ratiometric measurement item is automatically generated at the end of acquisition. This appears in
the library directly below the new image sequence. This records values of ROIs for each channel
during acquisition so that you do not need to re-analyze your data after acquisition.
When the measurement item is opened, the default view will be the ‘Chart View’. The Raw and
Analysis views are also accessible from the tabs next to the Chart View tab.
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For more information about Measurement Items and making measurements using Volocity
Quantitation see the chapter on Volocity Quantitation starting on page 408.

Reanalyzing Ratio Experiments
The analysis carried out as part of the ratio acquisition is not the only choice for final output. Ratio
images created during the acquisition may be measured using any of the tools available in Volocity
Quantitation. The raw A and B images may even be re-ratioed using the offline ratio tools. See
page 519.

Live Fast Restoration
Volocity Acquisition supports Fast Restoration deconvolution. This option is available in the Video
Preview window if you have purchased the Volocity Restoration extension product.
Fast Restoration should only be used with single plane acquisition protocols. If you have multiple
planes, you should capture them first and deconvolve them later using Volocity Restoration.
Important: You must create or import a PSF for each channel that will be captured before you can
set up the acquisition.
12. Make sure that Fast Restoration is selected in the Devices Preferences window.

13. You can configure the settings from the Options… button or by double clicking on the Fast
Restoration icon on the Video Preview window.
14. Ensure that you have the correct PSFs for the channels that you wish to acquire in your Volocity
library.
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15. Double click on the Fast Restoration icon.

The Fast Restoration dialog opens.

16. Select a PSF for each channel that will be captured from the drop-down menus.
17. Decide on the number of neighboring slices that will be included in the restoration algorithm and
enter the value in Capture this many slices above and below field. The more neighboring slices
you include, the longer the process will take.
18. Select the appropriate focus drive from the Change focus using drop-down menu.
19. Enter an appropriate value for Use this Z spacing.
20. Select the appropriate option for Generate result using.

Center Image displays only the deconvolved center image.
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Extended focus creates a single image by making a brightest-point merge of all the deconvolved Zslices of a volume.
21. Click OK.
22. Check the Fast Restoration box on the Video Preview window. The first time you do this after
configuring the settings can take some time as Volocity applies the algorithm and generates the
deconvolved image.

Spectral Separation
Overview
Spectral separation is a technology that allows the separation of images containing data from more
than one fluorophore into channels that contain data from only a single fluorophore. In order to
achieve this separation or “un-mixing”, sample images must be acquired at a minimum of two
different wavelengths. Color cameras lend themselves naturally to this multiple wavelength sampling
because they simultaneously sample at three different wavelengths (red, green and blue). However,
multiple wavelengths can just as effectively be acquired using monochrome cameras and
wavelength changing devices such as filter wheels.

Why Separate Color Images?
Acquiring a single color channel instead of separate blue, green and red channels is an effective
means of reducing acquisition time. You may still wish to analyse each of the fluorophores in your
experiment in a single monochrome channel. Spectral separation will allow you to acquire the data
for up to three fluorophores into a single color channel and separate each fluorophore into its own
monochrome channel post-acquisition.

Why Separate Monochrome Images?
Spectral separation can be used to un-mix the contribution of spectrally overlapping fluorophores
from a series of grayscale images sampled at different wavelengths (lambda stacks). You can
therefore improve the separation of dyes that you have found difficult to separate adequately by
more conventional means using filter sets.
Lambda stacks can be composed of a series of images in which the excitation wavelength is
constant and the emission wavelength is changed, reflecting the shape of the emission wavelengths
of fluorophores. Alternatively, the emission wavelength can be constant and the excitation
wavelength changed, reflecting the shape of the excitation wavelengths of fluorophores. It may also
be possible to successfully un-mix fluorophores from Lambda stacks in which both excitation and
emission wavelengths are varied.
There should be a minimum of two channels in a Lambda stack. The maximum number of
fluorophores that can be separated from a lambda stack is equal to the number of images in the
lambda stack.
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Creating Spectral Signatures from Color Images
In order to accurately separate your fluorophores into individual channels you must first create
accurate spectral signatures. A spectral signature allows Volocity to calculate how a sample of only a
single fluorophore contributes to the red, green and blue elements of color images.
To generate a spectral signature:
n

First prepare a sample that contains only a single fluorophore.

n

Acquire an image or image sequence of the sample.

n

Open your image or image sequence in the Image View and select a region brightly stained with
your fluorophore with a region of interest tool, such as the magic wand tool. You should ensure
that no pixels in this region are saturated.

7. Select Create New from the Actions menu.
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8. Select Spectral Signature…

9. The Create Spectral Signature dialog opens.

10. Volocity will assign a sample color and perceived peak wavelength to your new spectral
signature. Give the spectral signature a meaningful name and click OK to create the signature.
11. Spectral signatures are added to your library.

12. You may inspect a spectral signature by double clicking on its library item.

You should make a spectral signature for each of the fluorophores that you wish to include in your
experiments. You can un-mix up to three fluorophores in each experiment.
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Creating Spectral Signatures from Monochrome Images
Successful spectral separation is dependent on the creation of accurate spectral signatures. A
spectral signature allows Volocity to calculate how a single fluorophore contributes to each point of a
lambda stack.
To generate a spectral signature:
n

First prepare a sample that contains only a single fluorophore.

n

Acquire a lambda stack of the specimen into an image sequence.

n

Open your image or image sequence in the Image View and select a region brightly stained with
your fluorophore with a region of interest tool, such as the magic wand tool. You should ensure
that no pixels in this region are saturated.

7. Select Create New from the Actions menu.
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8. Select Spectral Signature…

9. The Create Spectral Signature dialog opens.

10. Enter a name for your spectral signature and click OK.
11. Spectral signatures are added to your library.

12. You may inspect a spectral signature by double clicking on the library item.
You should make a spectral signature for each of the fluorophores that you wish to include in your
experiments.

284 Improvision

VOLOCITY Acquisition Installation and Reference

Separating Color Images
In order to accurately separate each of the channels from your color image, Volocity will need to
calculate the contribution made by background. This can be done automatically or you can select a
region of interest that contains only background. Volocity can calculate the background directly from
this region of interest or you can create a background spectral signature, which you may re-use if
your background is consistent between multiple image sequences. To make a background spectral
signature:
n

With your region of interest selected, select Create New then Spectral Signature… from the
Actions menu.

n

Give the background spectral signature a name and click OK.

6. Select an image or image sequence of a multiply (two or three fluorophores) labeled color specimen.
7. Select Separate Spectra… from the Tools menu.

8. In the Separate Spectra dialog select the spectral signatures of the fluorophores in your color image
from the drop-down menus. Each of the spectral signatures in your library will be listed in the dropdown menus.
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9. Select one of the Calculate background from radio buttons.
n

If you want Volocity to automatically calculate the background, select the Default background
radio button.

n

If you have made a background spectral signature, select the This spectrum radio button and
select your spectral signature from the drop-down menu.

n

If you have specified a region of interest containing only background, choose the Current
Selection radio button. If your image sequence is time resolved, the background will be
calculated from the first timepoint only unless you select the Recalculate for each timepoint
checkbox.

When you select Recalculate for each timepoint the background is recalculated for every timepoint
from the same region of interest. You must be certain that your region of interest always contains
only background (and that no objects of interest stray into your region during the course of the time
series).
10. Click Separate.
New channels based on your selected spectral signatures will be added to your image
sequence. The new channels are monochrome and are colored based on the color of the spectral
signature from which they were derived.
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If you un-mix a color image, new monochrome images will be added to a folder of images beneath
your original image.

Separating Monochrome Images (Lambda Stacks)
Acquire lambda stacks of specimens labelled with the combination of fluorophores that you wish to
separate. You must acquire your experimental specimens at exactly the same wavelengths and
relative exposures as your spectral signatures.
In order to accurately separate each fluorophore into its own channel from your lambda stacks,
Volocity will need to calculate the contribution made by background. This can be done automatically
or you can select a region of interest that contains only background. Volocity can calculate the
background directly from this region of interest or you can create a background spectral signature,
which you may re-use if your background is consistent between image sequences. To make a
background spectral signature:
n

With your region of interest selected, select Create New then Spectral Signature… from the
Actions menu.

n

Give the background spectral signature a name and select OK.

6. Open an image sequence in the image view.
7. Select Separate Spectra… from the Tools menu.
8. In the Separate Spectra dialog select the spectral signatures from the drop-down menus of the
fluorophores that you wish to un-mix from your lambda stacks.
n

The number of drop-down menus will be equal to the number of images in your lambda stacks.
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n

Each menu contains a list of all the spectral signatures in your library that were derived from
lambda stacks containing the same number of images as the image sequence that you wish to
un-mix.

n

If you have over-sampled (i.e. the number of images in each lambda stack is greater than the
number of fluorophores in your experiment) then you may leave some of the drop-down menus
as the default (No spectrum).

9. Select one of the Calculate background from radio buttons.
n

If you want Volocity to automatically calculate the background, select the Default background
radio button.

n

If you have made a background spectral signature select the This spectrum radio button and
select your spectral signature from the drop-down menu.

n

If you have a region of interest containing only background selected (in the image view) choose
the Current Selection radio button. If your image sequence is time resolved the background will
be calculated from the first timepoint only unless you select the Recalculate for each timepoint
checkbox.

n

When you select the Recalculate for each timepoint, the background will be recalculated for
every timepoint from the same region of interest. You must be certain that your region of interest
always contains only background (and that no objects of interest stray into your region during the
course of the time series).
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10. Click Separate.
New channels, based on your selected spectral signatures, will be added to your image
sequence. The new channels will contain only information from a single fluorophore.
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OptiGrid ®
®

The OptiGrid is an optical sectioning technology that, when combined with image analysis software,
confers confocal capabilities to wide field microscopes.
®

The OptiGrid consists of two pieces of additional hardware:
®

n

The OptiGrid paddle, which is inserted into the microscope’s fieldstop location and is connected
to

n

The OptiGrid controller box

®

®

The OptiGrid is based on a technique called “Structured Light” (Neil et al 97).
This technique modifies the illumination system of a microscope to project a grid pattern onto the
specimen. The grid is moved into three different positions, and an image is acquired at each position.
An algorithm is then used to produce a single, derivative, confocal image from which the grid pattern
has been removed.
The algorithm takes advantage of the fact that in-focus information changes as the grid moves, whilst
out-of-focus information remains constant. Therefore, if information does not change between
images, it is out of focus and can be removed from the final image.
Please see the appendix on page 553 for more information about the algorithm and related
publications.
®

OptiGrid Models
With some models of microscope, chromatic aberration problems have made it difficult or impossible
®
to place the grid pattern in common focus for all excitation wavelengths in use. With earlier OptiGrid
models, this restricted the range of excitation wavelengths that could be used together to acquire
®
image sequences, and created a need for manual refocusing of the OptiGrid .
®

®

The second-generation OptiGrid , sometimes referred to as the ‘Focusing OptiGrid ’, incorporates a
motor that enables it to be moved axially into different focal positions in the light path of the
microscope. Once the correct focal position for an excitation wavelength is established it can be
consistently and automatically restored. This extends the range of excitation wavelengths that can be
sequentially acquired into a single image sequence.
®

All OptiGrid models are supported in versions 4.1 or higher for Mac OS X and Windows.
®

You need a free USB port in order to run an OptiGrid .
®

Note: Manual focus models of the OptiGrid are connected via the Improvision Acquisition Hub.
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Motorized Focus Model
®

This section describes how to connect the OptiGrid model that includes motorized focus control.
®

The following components are supplied with your OptiGrid and are required for installation:
®

n

OptiGrid paddle

n

OptiGrid controller box

n

USB cable

n

Focus motor cable

n

High voltage cable

®

®

®

1. The OptiGrid controller box has a high-voltage output. The OptiGrid controller box must be
®
switched off before you connect the OptiGrid paddle using the power switch which is on the front of
the controller box.
®

2. Connect one end of the high voltage cable to the OptiGrid paddle and the other end to the Hi
®
Voltage Output connector on the rear of the OptiGrid controller box.
3. Connect one end of the focus motor cable to the OptiGrid®® paddle and the other end to the
®
MOTOR connector on the rear of the OptiGrid controller box.
®

4. Connect one end of the USB cable to the USB connector on the rear of the OptiGrid controller box
and the other end to a spare USB port on your computer.

5. If you have a field stop (field diaphragm) installed in you microscope, remove it from the field stop
port.
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“Clickstop”
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®

®

6. Install your OptiGrid in the field stop port. Your OptiGrid “In” position can be found by pushing the
®
®
OptiGrid into the field stop port until the “clickstop” engages. In this position the OptiGrid should be
visible in the ocular lenses or with the camera when fluorescence images are observed. The “Out”
®
position can be found by withdrawing the OptiGrid from the field stop port (disengaging the
“clickstop”) until the grid is no longer in the light path, and no elements of the grid housing are in the
®
light path. In this position the OptiGrid can be left in the field stop port.
In

Out

®

7. Switch on the OptiGrid controller box and start Volocity. The message “Connected to Volocity” will
®
be displayed on the OptiGrid controller LCD display.
®

8. You must now set up the OptiGrid for use with Volocity. This requires you to set up the Device
®
Preferences in Volocity and calibrate the OptiGrid . See page 297.
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Manual Focus Model
®

The manual focus model of the OptiGrid is connected via the Improvision Acquisition Hub to the
computer system that is running Volocity.
The following components are required for installation:
®

n

OptiGrid paddle

n

OptiGrid controller box

n

Improvision Acquisition Hub

n

Blue BNC-RF cable

®

®

®

1. The OptiGrid controller box has a high-voltage output. The Acquisition Hub and the OptiGrid
®
controller box must both be switched off before you connect the OptiGrid paddle using the power
®
switch is on the front of the Acquisition Hub and the OptiGrid controller box.
®

®

6. Connect the OptiGrid paddle to the OUT HI VOLT connector on the rear of the OptiGrid controller
box.
®

7. Connect the BNC-RF cable to the INPUT connector on the rear of the OptiGrid controller box and
®
connect the other end of the BNC-RF cable to the OPTIGRID port on the rear of the Acquisition Hub.

®

Note: this cable will fit if connected the wrong way around, but the OptiGrid will only work if the
cable is connected in the orientation shown below.

OptiGrid® controller
connection

Acquisition hub
connection
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8. If you have a field stop (field diaphragm) installed in you microscope, remove it from the field stop
port.
“Clickstop”

®

®

9. Install your OptiGrid in the field stop port. Your OptiGrid “In” position can be found by pushing the
®
®
OptiGrid into the field stop port until the “clickstop” engages. In this position the OptiGrid should be
visible in the ocular lenses or with the camera when fluorescence images are observed. The “Out”
®
position can be found by withdrawing the OptiGrid from the field stop port (disengaging the
“clickstop”) until the grid is no longer in the light path, and no elements of the grid housing are in the
®
light path. In this position the OptiGrid can be left in the field stop port.

Out

In

®

9. Switch on the Acquisition Hub and the OptiGrid controller box. The USB, PWR and RDY lights on
®
the Acquisition Hub and the red light on the front of the OptiGrid controller should all be illuminated.
®

NOTE: If the LEDs on the Acquisition Hub or OptiGrid controller fail to illuminate, check the cabling
and make sure that none of the connecting pins are bent. For further information, see page 301.
®

10. You must now set up the OptiGrid for use with Volocity. This requires you to set up the device
®
preferences in Volocity and calibrate the OptiGrid . See page 11.
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Setting Volocity Preferences
1. Open the Volocity application.
4. Select Preferences... from the Edit menu (Windows) or the Volocity menu (Macintosh).
5. Click on the Devices icon in the left-hand panel. A list of devices that have been correctly connected
to your computer will appear in the right-hand panel. Each device has a subset of device controls
that are listed beneath the device.
®

Motorized Focus OptiGrid Models
®

Scroll through the list of devices until you find the Qioptiq OptiGrid Controller.
®

Check the box next to the Qioptiq OptiGrid Controller, check the boxes for all of its associated
devices.
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®

Manual Focus OptiGrid Models
Scroll through the list of devices until you find the Improvision Acquisition Hub.
Check the box next to the Improvision Acquisition Hub, check the box next to the Grid Calibrator.

Calibrating the OptiGrid ®
It is important to focus the grid manually the first time that you calibrate. The information in this
®
section applies to all OptiGrid models.
®

In order to calibrate the OptiGrid you must have a uniformly fluorescent sample against which the
grid can be imaged. Sealing a small amount of fluorescent ink between a slide and a cover slip can
make an ideal calibration slide. Highlighter pens are an excellent source of such ink. Alternatively,
you can use the Qioptiq calibration slide.

Calibration process
1. Open Volocity and select Show Video Preview from the Window menu.
2. Mount the calibration slide on the microscope and select an appropriate fluorescence filter. For
example, blue excitation and green emission works well with yellow ink.
3. Expose the calibration slide to the fluorescent light source. Calibration can be done with any lens but
you will get better grid contrast with low power lenses.
4. Use the microscope focus drive to focus on the fluorescent material. Air bubbles or the edge of the
“inked” area make good reference points.
5. Move to a field of view that is uniformly filled with fluorescent material.
®

6. Move the OptiGrid to the “in” position in the microscope’s fieldstop location.
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7. Adjust the aperture diaphragm on the microscope to improve the contrast if necessary.
8. Direct all light to your camera and, if your camera supports it, select Auto-Exposure from the Video
Preview controls (or the AE button).

Note: If the exposure is low (<20ms), you may see grid lines in your grid confocal images due to
lamp flicker. Avoid low exposures by reducing lamp intensity or using neutral density filters.
®

9. Use the grid focus control to adjust the position of the OptiGrid until the image of the grid is
maximally focused against the fluorescent material on the Video Preview.

®

NOTE: With manual focus model of the OptiGrid you must use the “hex wrench” focusing tool to
focus the grid. Insert the hex wrench in the middle of the three holes visible on the side of the
®
®
OptiGrid until it engages. Twisting the hex wrench tool changes the focal position of the OptiGrid .
®
Avoid using excessive force when focusing the OptiGrid as you can damage the grid focus
mechanism when the grid has reached the limit of its movement. If resistance is met you are likely to
have reached the focus limit and should twist the hex wrench tool in the opposite direction.
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10. It is important that the focus is consistent across the grid, see page 314.

11. Select Calibrate Confocal Grid… from the Video menu. A progress bar is displayed as the
®
OptiGrid is calibrated; this may take several minutes.

12. The calibration of the grid is now complete and the calibration slide can be removed and replaced
with the specimen that you wish to image.
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®

OptiGrid Installation and Calibration Troubleshooting
During calibration, you require an image where the focus is consistent across the grid. Here are
examples of good and poor grid images. Note the high grid contrast in the good image:

Good grid image

Poor grid image

If you are unable to focus your grid against your calibration slide, despite moving the grid through its
full focus range, check the manufacturer of you fluorescence filter set. Filters manufactured by
®
Semrock do not work with the OptiGrid and should be avoided.

Insufficient contrast warning or error 13901 during calibration (all models)
These errors indicate that the grid is not consistently in focus or that the grid contrast is not high
enough for imaging. To rectify this, follow these steps:
1. Ensure that the grid paddle is in the light path.
9. Turn off “Auto Contrast” if your camera supports this function. “Auto Contrast” can lead you to believe
that grid contrast is better than it actually is.
10. Use the microscope focus drive to focus on the calibration slide.
®

®

11. Adjust the focus of the OptiGrid , using the Grid Focus Control (motorized focus OptiGrid ) or the
®
hex wrench tool (manually focusing OptiGrid ).
It is important that the focus is consistent across the grid; use the focus adjustment to position the
grid such that contrast is as consistent as possible.
12. Repeat steps 2 and 3 to maximize the grid contrast. It can help to use the numerical readout of the
minimum and maximum pixel values in the “Video Preview” window to do this. See page 157.
13. Closing the aperture diaphragm will improve grid contrast.
14. Reducing the excitation light intensity and increasing the camera exposure time may improve
contrast.
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15. Different objectives may give better contrast. Calibration is best performed with a good-quality PlanApochromat air objective.

Grid does not move during calibration (all models)
During calibration the grid should move, first slowly in one direction, then more quickly in different
directions. If the grid does not move or the calibration fails with error 13902, follow these steps.
®

Motorized Focus OptiGrid Models
®

®

13. Switch off the OptiGrid controller. The OptiGrid controller must be switched off while connecting
and disconnecting cables because it has a high-voltage output.
®

12. Check that the cables are connected correctly. The OptiGrid paddle should be connected to the
®
OptiGrid controller via two cables; one to the Hi Voltage Output connector and the other to the
®
MOTOR connector on the OptiGrid controller. The host computer should be connected to the
®
OptiGrid controller via a USB cable to the USB connector.
13. Check both ends of the high-voltage cable and make sure that no pins are bent on the connectors. If
a pin is bent, carefully bend it back into position with a small screwdriver.
®

Manual Focus OptiGrid Models
®

®

1. Switch off the OptiGrid controller and the Acquisition Hub. The OptiGrid controller must be
switched off while connecting and disconnecting cables as it has a high-voltage output.
®

2. Check cables are connected correctly. The OptiGrid paddle (or microscope connection) should be
®
®
connected to the “hi volt” output of the black OptiGrid controller. The “input” on the OptiGrid
®
controller should be connected to the “OptiGrid ” port on the Acquisition Hub with the blue cable.
Note that the blue cable is not a standard BNC-BNC cable; it is a BNC-RF cable. A standard BNCBNC cable may physically fit, but will not work.
3. Check that no pins are bent on the high-voltage output of the OptiGrid® controller. There should be
®
four pins, two in the OptiGrid controller socket and two in the grey paddle cable. If a pin is bent,
carefully bend it back into position with a small screwdriver.

There are four pins, two on each side of the connector
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®

4. Check that no pins are bent on the low-voltage input of the OptiGrid controller. There should be two
®
pins, one in the blue cable and one in the OptiGrid controller socket. If a pin is bent, carefully bend it
back into position with a small screwdriver.

There are pins on both sides of the connector – the ones in this picture are OK.

5. Check that the pin is not bent at the Acquisition Hub end of the blue BNC-RF cable.

®

6. Check that the “OptiGrid ” socket on the Acquisition Hub is not damaged – it is possible for the
central part of the socket to get distorted if the pin in the blue cable is not central. If the socket is
damaged, it is normally possible to repair it using a pin to tease the metal parts of the socket back
into place.

®

This OptiGrid socket has been slightly damaged and the metal parts teased back into place.
Compare with the Piezo Z socket on the left.
®

7. Switch on both the Acquisition Hub and OptiGrid controller. The USB, PWR and RDY lights on the
®
Acquisition Hub and the red light on the front of the OptiGrid controller should all be illuminated.
8. Retry calibration. If calibration fails again, contact Improvision or the Improvision dealer that supplied
®
your OptiGrid .
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Using the OptiGrid ®
®

Once you have calibrated the OptiGrid , you are ready to use it for acquisition. If you intend to
acquire multi-channel image sequences you may need to ensure that the grid is correctly focused for
each of your excitation wavelengths. The worked examples in this chapter illustrate this process.

Grid controls
grid modes
focus
auto focus
®

All versions of the OptiGrid have the grid mode controls. The focus and auto-focus controls are not
®
available with manual focus models of the OptiGrid .

Auto focus
Click Grid AF to allow Volocity to auto focus the grid for you. Volocity will test a number of grid focus
positions until it finds the position in which grid confocal images with the best contrast are generated.
Auto focus will only work after your grid has been calibrated for the first time and provided you have
a specimen mounted and in focus.

Focus
Use this control to adjust the focus position of the grid. You can use this control as an alternative to
Grid AF, or to fine tune the result of Grid AF.
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Grid modes
There are three grid mode controls. From left to right:

n

Grid Off: Switches the grid off. There is a stationary grid pattern on the Video Preview and from
the ocular lenses of the microscope.
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n

306 Improvision

Grid Confocal: Activates the grid. There is a confocal image on the Video Preview and a moving
grid pattern from the ocular lenses of the microscope.
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n

Grid Wide Field: Activates the grid. There is a wide field image (without grid lines) on the Video
Preview and a moving grid pattern from the ocular lenses of the microscope.

Single-channel grid confocal images
1. Open Volocity and select Show Video Preview from the Window menu.
2. Mount your specimen slide on the microscope stage and select an appropriate fluorescence filter set.
3. Expose the specimen slide to the light source and select a suitably powered lens.
14. Move to the field of view that interests you.
®

15. Ensure that the OptiGrid is in the “in” position in the microscope’s fieldstop location.
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16. Direct all light to your camera and, if your camera supports it, select Auto-Exposure from the Video
Preview controls (or the AE button).

17. Set the Grid activation control in the Video Preview to Off. You should see clear horizontal lines
superimposed on your specimen.
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®

18. Click Grid AF to focus the OptiGrid automatically. Alternatively, use the grid Focus control to focus
®
the OptiGrid .

®

NOTE: With the manual focus model of the OptiGrid you must use the “hex wrench” focusing tool to
focus the grid. Insert the hex wrench in the middle of the three holes visible on the side of the
®
®
OptiGrid until it engages. Twisting the hex wrench tool changes the focal position of the OptiGrid .
Avoid using excessive force when focusing the OptiGrid® as you can damage the grid focus
mechanism when the grid has reached the limit of its movement. If resistance is met, you are likely to
have reached the focus limit and should twist the hex wrench tool in the opposite direction.
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Note: You can also adjust the grid position whilst the grid is in “Grid Confocal” mode. As you move
the grid, the signal-to-noise ratio of the grid confocal image will improve if the grid’s focus is improved.
19. Set the Grid activation control to “Grid Confocal”.
20. Change the slide or mount the slide in the first place.
21. You are now ready to acquire grid confocal images or image sequences.
®

After acquisition, remember to move the OptiGrid out of the microscope’s lightpath or ensure that
the shutter is closed. If a light source is left on with the grid inserted but not moving, a grid image can
be burnt into fixed samples which will cause gridlines.
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®

Multi-channel grid confocal images (Motorized Focus OptiGrid )
If you wish to acquire multi-channel grid confocal images, you must ensure that the grid is correctly
focused for all of your lightpaths before acquisition. See page 154 for more information about
lightpaths.
1. Open Volocity and select Show Video Preview from the Window menu.
2. Mount the specimen slide on the microscope and select an appropriate light path.
3. Expose the specimen slide to the light source and select a suitably powered lens.
4. Move to the field of view that interests you.
®

5. Ensure that the OptiGrid is in the “in” position in the microscope’s fieldstop location.
6. Direct all light to your camera and, if your camera supports it, select Auto-Exposure from the Video
Preview controls (or the AE button).

7. Set the Grid mode control in the Video Preview to Off. You should see clear horizontal lines
superimposed on your specimen.
®

®

8. Click Grid AF to focus the OptiGrid automatically or use the grid focus control to focus the OptiGrid .
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Note: You can also adjust the grid position whilst the grid is in “Grid Confocal” mode. As you move
the grid, the signal-to-noise ratio of the grid confocal image will improve if the grid’s focus is improved.
9. Double click on the current light path’s button. The Light Path Properties dialog opens. Scroll through
the list of devices until you find Grid Focus.
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Click on the Grid Focus check box to associate the current grid focus position with the light path.

10. Repeat this process for each of the light paths that you wish to restore for your acquisition.
11. Set the Grid activation control to “Grid Confocal”.
12. You are now ready to acquire multi-channel grid confocal image sequences.
®

After acquisition, remember to move the OptiGrid to the “out” position in the microscope’s fieldstop
location or ensure that the shutter is closed. If a light source is left on with the grid inserted but not
moving, a grid image can be burnt into fixed samples which will cause gridlines.
®

Multi-channel grid confocal images (Manual Focus OptiGrid )
®

With the manual focus OptiGrid it is not possible to associate different grid focus positions with each
®
of your light paths. If your OptiGrid cannot be focused perfectly for each of your light paths, it may
be necessary to find a compromise grid focus position in which an adequate image of the grid can be
seen for all of your excitation wavelengths.
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Adjusting the aperture diaphragm
The position of the aperture diaphragm can have an important effect on the quality of your images;
you should always carefully consider its position before and during any imaging sessions. Closing
the aperture diaphragm tends to improve the contrast of the grid and, therefore, the contrast of the
grid confocal images. Closing the aperture diaphragm also increases the exposure times of your
images, so you should balance aperture position with acceptable exposure times.
1. Select the grid confocal mode from the Video Preview controls.

2. Adjust the aperture diaphragm on the microscope.
3. Select Auto-Exposure from the Video Preview controls (you will see the grid lines while Volocity
adjusts your exposure).

4. Assess whether the quality of the image and the exposure time will meet your experimental needs.
When you are happy with the position of the aperture diaphragm you can proceed with your
acquisition of grid confocal images. Acquisition of image sequences can be done as normal,
remember to select the grid confocal mode before starting acquisition.

Troubleshooting Grid Imaging
Once you become familiar with the way the grid is working, it becomes clear how artefacts may be
generated.
n

Vibration may alter the grid movement and prevent it from moving to the correct position for each
of the three raw images.

n

Inconsistent illumination or photobleaching can produce intensity differences between the raw
images. The algorithm will extract artefactual data from these illumination differences and grid
lines will appear in the final image.

n

A poorly focused (or out of focus) grid will produce little or no difference between the three raw
images and a blank confocal image will be generated.
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Little or no signal with the grid active
®

The OptiGrid relies on the grid “marking” in-focus parts of the sample. If the grid contrast in the
image is poor, no parts of the sample will be marked and little or no signal will be output.
Recalibrating the grid will not improve the brightness of the grid image – calibration only removes
gridlines.
Note: Increasing the camera exposure time will not make the confocal signal brighter – the
brightness of the confocal signal is determined purely by the contrast in the grid image.

Good grid contrast

Poor grid contrast

To correct for this:
1. Adjust the grid focus. First focus the sample with the grid off. Select “Grid Confocal” mode, then
adjust the grid focus until the confocal signal is as bright as possible.
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2. Adjust the imaging system to maximize grid contrast. Closing the aperture diaphragm to reduce stray
light will help.
3. It may be necessary to adjust the grid focus for different wavelengths (see page 304) and different
objectives.
4. Plan-Apochromat objectives will give better results with multiple wavelengths.

Gridlines in image
Gridlines in the image are caused by the three raw grid images not quite lining up with each other.
There are several possible reasons for this:
1. Poor calibration. If gridlines appear, try recalibrating the grid. The grid calibration can change as the
grid and microscope heat up in use. Recalibration will correct for this.
7. Vibration can cause grid lines. Isolate the microscope with an anti-vibration table if possible.
Equipment containing fans (e.g. camera controllers and light sources) must be isolated from the
microscope (e.g. by moving them onto a separate table or onto the floor).
8. Uneven or unstable illumination will cause gridlines. Use a stable light source that offers even
illumination. If flicker is a problem, attenuate the light using ND filters and increase exposure times.
9. If the light source is left on with the grid inserted but not moving, a grid image can be burnt into fixed
samples which will cause gridlines. Ensure that the fluorescence shutter is closed when possible or
that the grid is left running.
10. Fast bleaching samples may show gridlines more than slow bleaching samples. To solve this, reduce
the light intensity and increase exposure times.
®

11. Camera noise will be amplified by the OptiGrid process and will show as gridlines. Avoid using high
®
camera gain with the OptiGrid .
Once these factors are eliminated, recalibrate the grid.

Installing and Configuring Photonics Instruments MicroPoint ®
®

Volocity supports the Photonics Instruments MicroPoint Ablation Laser Unit as a bleaching device.
http://www.photonic-instruments.com/
®

Before you use the MicroPoint high-intensity laser unit for the first time with Volocity it must be
calibrated. You must calibrate the laser again should the laser unit be rotated relative to the
microscope, if the camera is moved relative to the microscope, if the dye cell is changed, or if the
microscope’s objective lens is changed.
Connect the Ablation Laser Unit to the microscope, as instructed in the Photonics Instruments
documentation.
®

Connect the MicroPoint control box to the computer via a free USB port.
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®

Although the MicroPoint control box connects to Volocity via a USB connection it will function as a
“Virtual COM Port” (VCP). In order for this to work you must download and install the driver
appropriate for your operating system from http://ftdichip.com/Drivers/VCP.com
3. Open Volocity and select Serial Ports from the preferences.
®

4. Set the usbserial-ELCBXAV5 port to the MicroPoint .

32. Select Devices from the preferences.
®

33. Ensure that all of the MicroPoint devices are selected.

Calibrating Photonics Instruments MicroPoint ®
Make sure that the laser unit is horizontal (relative to the microscope) before you start, focus and
align the laser as described in the Photonics Instruments documentation.
Ensure that your “Laser Safety Filter Block” is always in the light path when using the MicroPoint
laser.

®
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5. Mount your mirror slide on the microscope with the reflective surface nearest to the objective lens.
6. Select Show FRAP Preview from the Window menu.
7. Switch on your transmitted light lamp.
8. In order to focus on the mirror’s surface you should search for a scratch or pit on the surface and
focus the microscope on that.
34. Direct all light to the camera and adjust the camera exposure time if necessary.
35. Ensure that any shutters in the laser’s light path are open.
36. Select Calibrate MicroPoint… from the FRAP menu.
®

37. The MicroPoint Calibration wizard is opened.
38. Click Fire.
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®

39. The MicroPoint laser is fired. If the laser is correctly focused on the mirror a hole will be cut in the
mirror’s reflective surface allowing transmission of light and creating a spot. If you are unhappy with
the shape and size of the spot, adjust the focus or the intensity of the laser and click Fire again.
40. Once you are happy with the size and shape of the spots, click Next. A line of holes is fired onto the
mirror. Adjust the rotational position of your camera so that the line is horizontal relative to the FRAP
preview.
Tip: You may find it easier to judge whether the line is horizontal, if you move it (using the stage)
higher up or lower down the Preview window where you can align it with the top or bottom of the
screen.
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41. Click Next to calibrate the laser. A diagonal line of holes is fired across mirror.

42. Click Finish. The calibration wizard will close.
43. You should now check the result: use one of the ROI tools to draw a region of interest on the
®
Preview and click the MicroPoint Fire control within the video controls. The cut area should
correspond exactly to the ROI. If this is not the case repeat the calibration procedure.
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Volocity Acquisition Worked Examples
Overview
Volocity Acquisition allows you to acquire single or multi-channel, 2D, 3D or 4D image sequences at
a single position or at multiple XY points. Before you start acquisition of your image sequences you
must configure the Video Preview window and the Acquisition Setup window. Once these steps are
complete you can repeatedly execute your acquisition protocol.
This chapter describes how to set up Volocity to carry out single-point and multi-point acquisition and
summarizes required settings for different acquisition protocols.
It assumes that you have installed and configured your acquisition device(s) correctly, and set up any
additional options, such as Fast Restoration, that you require for your experiment.
For comprehensive installation, configuration and reference information about Volocity Acquisition
see the separate chapter starting on page 135. In particular, you may like to review the two sections
that describe the Video Preview window, page 157, and how to control devices, page 146.
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Example Acquisition Protocols
Acquiring a Single Frame
When acquiring a single frame the image name will be taken from the title in the Acquisition Setup
dialog.
1. Adjust the camera settings until you are happy with the image.
2. On the Acquisition Setup dialog and operator name if required. Click OK.
3.
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Click the capture single image icon on the Video Preview window.
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Acquiring a Single Channel over Time
1. Adjust the camera settings until you are happy with the image.
2. In the Acquisition Setup dialog (Video, Acquisition Setup):
n

Ensure that Change channels using light paths is not selected

n

Set Change focus using to None

n

Set the Timelapse intervals i.e. how much time is to pass between timepoints

n

Choose the Duration for the experiment.

n

Set the Shutters.

3. Click OK to close the Acquisition Setup dialog, leaving the experiment ready to run, and return to the
Video Preview.
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4.

Click the capture image sequence icon on the Video Preview window.

5. While the protocol is running, capturing images the timelapse interval may be changed using the
options in the Video Preview.
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Acquiring Multiple Channels over Time
1. If you wish to use the same exposure for each channel, ensure that the
Auto Contrast option has been selected in the Video Preview window.
2. If you wish to manually set exposures for each channel ensure that exposure is stored in the light
path and that each is stored when the exposure is reading the desired value.
3. On the Acquisition Setup window, complete the upper information fields if required and:
n

Ensure that Change channels using light paths is selected. Add the correct number of
channels.

n

Set Change focus using to None.

n

Set the Timelapse options to reflect the desired interval between timepoints.

n

Choose how long the experiment is going to be by setting the Duration.

n

Choose to Manage shutters for Maximum Speed or Maximum Sample Protection depending on
the priority of the experiment.

4. Click OK to close the Acquisition Setup dialog leaving the experiment ready to run.
5.

Click the capture image sequence icon on the Video Preview window.
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6. While the protocol is running, capturing images the timelapse interval may be changed using the
options in the Video Preview.

Acquiring a Single Channel at Multiple Z-Planes and Single Timepoint
1. At the midpoint of your specimen adjust the camera settings until you are happy with the image.
2. In the Video Preview store top and bottom of the stack by moving the focus to the limits of the stack
and storing Top and Bottom values in the focus drive control.
3. On the Acquisition Setup window enter information fields and:
n

Ensure that Change channels using light paths is not selected

n

Select the appropriate device from the Change focus using drop-down menu and set an
appropriate Z spacing

n

Set the Duration = 1 timepoint

n

Choose to Manage shutters for Maximum Speed or Maximum Sample Protection depending on
the priority of the experiment.
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4. Click OK to close the Acquisition Setup dialog leaving the experiment ready to run.
5.

Click the capture image sequence icon on the Video Preview window.
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Acquiring Multiple Channels at Multiple Z-Planes and Single Timepoint
1. At the midpoint of your specimen adjust the camera settings for each channel until you are happy
with the image.
2. If you wish to use the same exposure for each channel, ensure that the Auto Contrast option has
been selected in the Video Preview window. This will ensure the optimum contrast settings to assist
setting one exposure for all channels.

3. If you wish to manually set exposures for each channel ensure that exposure is stored in the light
path and that each is stored when the exposure is reading the desired value.
4. In the Video Preview store top and bottom of the stack by moving the focus to the limits of the stack
and storing Top and Bottom values in the focus drive control.
5. On the Acquisition Setup window enter information fields and:
n

Ensure that Change channels using light paths is selected. Add the correct number channels.

n

Select the appropriate device from the Change focus using drop-down menu and set an
appropriate Z spacing.

n

Set the Duration = 1 timepoint.

n

Select the appropriate option from the Use this ordering for channels and Z sections dropdown menu.

n

Choose to Manage shutters for Maximum Speed or Maximum Sample Protection depending on
the priority of the experiment.
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5. Click OK to close the Acquisition Setup dialog leaving the experiment ready to run.
7.

Click the capture image sequence icon on the Video Preview window.
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Acquiring a Single Channel at Multiple Z-Planes Over Time
1. At the midpoint of your specimen adjust the camera settings until you are happy with the image.
2. In the Video Preview store top and bottom of the stack by moving the focus to the limits of the stack
and storing Top and Bottom values in the focus drive control.
3. On the Acquisition Setup window enter information fields and:
n

ensure that Change channels using light paths is not selected

n

select the appropriate device from the Change focus using drop-down menu and set an
appropriate Z spacing

n

enter a number in the Duration section and set the units

n

Choose to Manage shutters for Maximum Speed or Maximum Sample Protection depending on
the priority of the experiment.

4. Click OK to close the Acquisition Setup dialog, leaving the experiment protocol ready to run, and
return to the Video Preview.
5.
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Click the capture image sequence icon on the Video Preview window.
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Acquiring Multiple Channels at Multiple Z-Planes Over Time
1. At the midpoint of your specimen adjust the camera settings for each channel until you are happy
with the image.
2. If you wish to use the same exposure for each channel, ensure that the Auto Contrast option has
been selected in the Video Preview window. This will ensure the optimum contrast settings to assist
setting one exposure for all channels.

3. If you wish to manually set exposures for each channel ensure that exposure is stored in the light
path and that each is stored when the exposure is reading the desired value.
4. In the Video Preview store top and bottom of the stack by moving the focus to the limits of the stack
and storing Top and Bottom values in the focus drive control.
5. On the Acquisition Setup window enter information fields and:
n

Ensure that Change channels using light paths is selected. Add the correct number of
channels.

n

Select the appropriate device from the Change focus using drop-down menu and set an
appropriate Z spacing.

n

Enter a number in the Duration section and set the units
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n

Select the appropriate option from the Use this ordering for channels and Z sections dropdown menu

n

Choose to Manage shutters for Maximum Speed or Maximum Sample Protection depending on
the priority of the experiment.

5. Click OK to close the Acquisition Setup dialog, leaving the experiment protocol ready to run, and
return to the Video Preview.
6.

Click the capture image sequence icon on the Video Preview window.
While the experiment is running it is possible to adjust the timelapse settings using the control in the
Video Preview.
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Acquiring at Multiple XY Locations
Any of the previous examples may be performed at multiple XY locations using a motorized stage. It
is essential that locations at which acquisition is to take place are first stored on the stage area by
marking points or using a well overlay. See page 244 for more information.
1. In addition to the options for channels, focus, timelapse and duration. Select the XY stage to be
used in Change XY using.
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2. If you want Volocity to auto-focus on your points during the acquisition, select the light path that you
wish to use for auto-focusing from the drop-down menu.
3. If you have chosen to acquire multiple Z planes during your experiment, you now need to ensure that
the top and bottom focus limits are set correctly.
Note: You should avoid re-setting the zero value of your focus drive after setting your acquisition
points. If you do so, you will invalidate the Z coordinates stored with each point.
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Volocity Visualization
Overview
Volocity Visualization is a separate product in the Volocity family. The functionality described here
will only be available if Volocity Visualization is licensed on your system. See page 38 for
information about activating additional products on your system. Volocity Visualization permits
different ways of displaying the data in the Image view.
3D Opacity is an interactive high resolution renderer with options for how the data is
displayed. Resolution of the data is managed to maintain interactivity. 3D Opacity rendering can
also show feedback from selections. If Volocity Visualization is used in conjunction with Volocity
Quantitation measurements feedback can be shown in the 3D Opacity mode.
3D Ray tracing is a processor intensive rendering that requires more time to calculate the image and
is therefore not interactive. Different effects may be generated with the ray tracer but it does not
support measurements feedback or scale shown on the view.
3D Slice allows 3D or 4D data to be viewed at a different orientation of slicing and, if required, the
data may be re-sliced to create another version of the data at the new orientation.
Specific recommendations are made for the graphics cards. These are detailed in the System
Requirements technical note. This technical note will be updated as new graphics cards become
available and are tested.
If the installed graphics card does not meet this specification, 3D Opacity Rendering will not be
possible. Error messages including the term “OpenGL” are shown.
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3D in the Image View
Select the item in the library that you wish to view, or render, in 3D. Double click on the item
thumbnail to open it in a separate window.
1. Click on the Image tab if you are not already viewing this tab. Select a 3D rendering option from the
Mode pop-up in the tool bar or navigate to the Image menu, and the Mode submenu to select an
option. There is more detail on the individual Renderers used to produce the image shown on the
screen in the relevant sections.
2. The volume will be shown in 3D in the Image view.
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The following example shows a view generated by the 3D Opacity Renderer.

A progress bar will
be displayed here
as you work with
rendered data

Once you have selected the 3D rendered view you can use the tools in the toolbar to manipulate the
object in space (see page 357), the channel controls to adjust how individual channels appear and
the time navigation controls to step or play through timepoints (see page 344). Select Reset View
from the 3D menu to return the object to its default position. Volocity displays a progress bar in the
top left-hand corner of the view as it applies any changes that you make.

3D Modes in Image View
When Visualization is licensed on the system additional modes are available in the Image view.
n

3D Opacity
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n

3D Ray Tracer

n

3D Slice

Change the mode from either the tool bar or the image menu.
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3D Opacity
The 3D Opacity renderer is extremely versatile, many effects are possible within one mode of the
image view.

Channel Controls
If the channel controls are not visible select Image menu, Show Channel Controls. There is a panel
of controls for each channel in the data set. The first control is the Renderer mode. Within the same
view individual channels may be set to any one of these modes. The 3D Opacity renderer offers four
choices:
n

Fluorescence: applies direct opacity rendering, which is designed for use on data from
fluorescence microscopy. Control over brightness, density and black level is given on a per
channel basis.

n

Brightfield: applies direct opacity rendering, which is designed for use on data generated by
transmitted light microscopy. Control over brightness, density and black level is given on a
per channel basis.
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n

Max Intensity: applies direct maximum intensity projection rendering. The brightest intensity
in the view path to the screen will form the screen image. Max Intensity rendering will not be
visible against background colors lighter than the data so avoid using light colored
backgrounds with this mode. Control over brightness and black level is given on a per
channel basis.
One of two channels
in Max Intensity for a
transparent effect.
Also useful for fine
processes and data
with low numbers of z
slices. The second
channel is in
Isosurface mode and
is therefore
completely solid.

n
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Isosurface: applies indirect surface rendering, which identifies a surface around objects
where all voxel intensity values are the same. This intensity is determined by the black level
setting. The surface is made up of complex polygons. This generates apparently solid objects
which cannot be seen through. No signal from objects behind can pass through an isosurface.
Control over brightness and black level is given on a per channel basis. Light position, as
controlled by the light tool affects isosurfaces. Isosurfaces cannot be generated for RGB or
true color channels. The isosurface option will not be available for channels with millions of
colors depth.

VOLOCITY Visualization

A three channel dataset
where all three
channels are in the
isosurface mode
showing the use of the
scene light to change
the lighting of the
isosurfaces. The
isosurface option is not
available for millions of
colors depth channels.

Use the slider controls to control the brightness, density and black level of the rendered image.
n

Brightness: alters the brightness of the rendered voxels. A multiplication factor is applied to
the intensity values of the voxels. Moving the slider to the left reduces the brightness, moving
it to the right increases brightness.

n

Density: alters the density of the rendered voxels. This affects how much can be seen
through the structure. Denser voxels do not allow signal from the objects behind to pass
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through to the screen image. Moving the slider to the right increases voxel density, moving it
to the left decreases density.

Three channel data
with all three
channels set to
Fluorescence. One
channel, red, has
been made more
transparent by
reducing the density
control, just for that
channel.

n
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Black Level: sets a value at which voxels of that intensity or lower will not be rendered. The
remaining data is rescaled across the full display range of the screen. Increasing the black
level removes low intensity voxels from the image as illustrated below.

VOLOCITY Visualization

When choosing an appropriate black level, it may help to change the background color of the
rendering view. Choose View Options… from the Image menu and choose a different color for the
background (a lighter color usually helps the process). When the background color has been
changed a dark area may be visible around the rendered object. Adjust the black level until this
darkness is removed.
Leaving the cursor over any of the Renderer Controls momentarily brings up a tip showing their
current values.
Move the volume in space using the tools available in the tool bar (see page 357).
The show/hide button cloaks and uncloaks the channel in the Image View so you can choose to
work with a channel or not.
Target the channel for selection tools (see page 415).
The reset button resets the slider button for that channel to default (the values it had when first
opened).
The colored square reflects the color lookup table associated with the channel.
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Time Navigation
Move through time resolved data in an image view using the time navigation controls across the
bottom of the view. If these controls are not visible select Show Time Navigation from the Image
menu.

Play the sequence back at a fixed rate or a multiplier of the real time as indicated by the timestamps
of the data.
Set the mode of playback by selecting Loop Sequence or Shuttle Sequence from the Image menu.
Skip Timepoints will miss out timepoints as necessary to maintain the frame rated set by the slider.

Using Contrast Enhancement with 3D Views
Changes made using the Contrast Enhancement dialog (Tools menu) are carried through into the 3D
View. Remember that it is possible to alter the black point, white point and gamma of a dataset using
the Contrast Enhancement and this will affect the appearance in the rendered view.
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3D Ray Tracer
Unlike 3D Opacity which is a real time renderer that can be interacted with, the 3D Ray Tracer is not
an interactive renderer. The screen image is built up in tiles over multiple passes. A progress bar in
the top left-hand corner of the image shows progress to completion of the screen image. The quality
of the image produced and the effects possible are different to those possible with the 3D Opacity
renderer although the controls are similar. Please read the relevant section, starting on page 337.
The Ray Tracer is a software renderer, which uses the computer processor or CPU to generate the
results rather than graphics hardware.

Using the tools in the toolbar to change the position or the orientation of the view will not update the
view immediately; the view will switch to a wireframe representation of the volume that can be moved
as required.
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When the cursor is within the view a Render button is shown in the top right-hand corner. Click on
this button to prompt the building of the screen image in tiles over multiple passes.
There is no need to wait for the image to build if you wish to make further changes; it is possible to
interact with the menus, toolbar and channel controls while the image is being built. Click on the
Render button to update the image with your changes.

Channel Controls
If the channel controls are not visible select Image menu, Show Channel Controls. There is a panel
of controls for each channel in the data set. The first control is the Renderer mode. Within the same
view individual channels may be set to any one of these modes. The modes available are described
below:
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n

Fluorescence: applies direct opacity rendering, which is designed for use on data from
fluorescence microscopy.

n

Isosurface: applies indirect surface rendering, which identifies a surface around objects
where all voxel intensity values are the same. This intensity is determined by the black level
setting. The surface is made up of complex polygons. This generates apparently solid objects
which cannot be seen through. No signal from objects behind can pass through an isosurface.

Fluorescence and Isosurface rendering modes in the Ray Tracer ensure compatibility for data
which is also viewed using other renderers. The Ray Tracer offers further isosurface modes:
n

Matte: for a non-reflective surface.

n

Metal: gives the surface properties similar to that of metal, surfaces are shiny and may reflect
properties of the surrounding scene, for example the color of the floor.

n

Glass: generates a surface which mimics the properties of glass. Objects can be given a high
degree of transparency and there may be some reflection. Surfaces will be shiny.

Use the slider controls to control the brightness, density and black level of the rendered image.
n

Brightness: alters the brightness of the rendered voxels. A multiplication factor is applied to
the intensity values of the voxels. Moving the slider to the left reduces the brightness, moving
it to the right increases brightness.

n

Density: alters the density of the rendered voxels. This affects how much can be seen
through the structure. Denser voxels do not allow signal from the objects behind to pass
through to the screen image. Moving the slider to the right increases voxel density, moving it
to the left decreases density.

n

Black Level: sets a value at which voxels of that intensity or lower will not be rendered. The
remaining data is rescaled across the full display range of the screen. When choosing an
appropriate black level, it may help to change the background color of the Rendering view.
Choose View Options… from the Image menu and choose a different color for the
background (a lighter color usually helps the process). When the background color has been
changed a dark area may be visible around the rendered object. Adjust the black level until
this darkness is removed.

Leaving the cursor over any of the Renderer Controls momentarily brings up a tip showing their
current values.
The tools in the toolbar are described on page 357 an additional tool is available to you, the light
source position.
Select this tool and click in the view, move the light position control. Ray tracing has the
ability to cast shadows within the data and on the floor of the scene. It may be necessary to change
the floor color to best show shadows on the floor. Do this using the View Options… dialog selected
from the Image menu.
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Switching views during tracing will cause the image to be lost and it will have to be traced again.
Note: The Ray Tracer does not currently support measurements feedback display or drawing of the
scale grid in the Image view.
Improvision Computing Server
3D Ray Tracing may be accelerated using the Improvision Computing Server (ICS) to process the
component tiles of the image. The data set is sent to each node of the ICS and Volocity requests
processed tiles back.
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3D Slice
The XY plane in which the images from a sample have been acquired may not always provide the
best presentation of the structures being examined. It may be desirable to re-slice the image data in
a different orientation in order to get the required view. 3D Slice and associated tools allow the
reslicing of data sets in any chosen rotation of X, Y and Z.
Before reslicing data ensure that the X, Y, and Z calibrations are correct in the item properties dialog,
see page 63.
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Enter Values to Set Slicing Orientation
You may either enter values for the X, Y, and Z values or use the buttons to step up and down. In
order to achieve all possible orientations of the slice, the rotation should be considered to be first
around the X axis, then around the new Y axis and finally around the new Z axis.

Use Preset Slicing Orientation
Click the Preset buttons to immediately set an XY, XZ or YZ slicing orientation.
When a slice orientation has been chosen, use the depth slider to the right of the view to see the
slice moved through the volume. A tooltip for the slider will show the depth through the volume in
microns. This value requires accurate calibration of the volume in the Properties dialog, see page 63.

Slice moved to XZ orientation

Slice moved to YZ orientation

Tools to Set Slicing Orientation
Rotate Slice, shortcut key, S.
The volume remains stationary and the slice is moved. The data shown in the slice will, therefore, be
updated to show the changes in the slice.
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The slice may be rotated through 360 degrees about all axes. A preview of the slice may be
displayed in the top right-hand corner, select Show Preview from the Image menu.
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Rotate Volume, shortcut key, V.
Use this tool to rotate about the current slice (it is the volume that is rotated).

The slice remains stationary and the volume is moved. The data shown on the slice will update as
the volume is moved through it. This tool can be used to allow constant viewing of the slice face
while still changing the slice orientation.
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When a slice orientation has been chosen, use the depth slider to the right of the view to see the
slice moved through the volume. A tooltip for the slider will show the depth through the volume in
microns. This value requires accurate calibration of the volume in the Properties dialog, see page 63.

Channel Controls and Time Navigation
Channel controls and time navigation are used with the slice view in the same way as for any other
mode of the image view. If they are not visible select Image menu, Show Channels or Show Time
Navigation.

Show Preview
Choose Show Preview to preview new slices that would be created, if the volume were to be sliced
according to current settings. The slice preview is updated with the current slice when the depth
slider is moved. Choose Hide Preview to remove the preview pane from the top right-hand corner of
the Slice View.

To Create Data with New Slicing Orientation
Reslice Image from the Image menu creates a new volume or image sequence with each slice at
the new orientation. The volume will typically be larger than the original. Any offset slices will be
drawn around to avoid cutting off data.
n

Resliced volumes are interpolated using tri-cosine interpolation so that each axis has the same
calibration as the highest resolution axis in the original data. Calibration will be changed
accordingly. The overall dimensions of the data set will not change and calibrated measurements,
such as the volume in square microns, will be the same. Non-calibrated measurements, such as
voxel counts, will not be the same as the original data.

n

Calibrate data before slicing; corrections on sliced data will not be easy to calculate.

n

Rendered views of sliced and unsliced data will look identical.

n

The mean intensity of objects will not be changed. Individual voxels may have altered intensity
values because of interpolation.

Reslice Image to Folder creates a folder of images at the new slicing orientation.

Capture Snapshot
This option adds a new 2D image to the library showing the view as it appears when the snapshot is
captured.

Show/Hide Floor, Scale, Orientation
These options change the display of the Slice View. It is possible to show a scale grid and orientation
tool as in the Rendering View, see page 356.

View Options
These options change the color of the scale grid and Slice View background to clearly display data.
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Image Menu
Commands found in the Image menu, of particular reference to Volocity Visualization, are described
here. These include controls that allow you to show/hide elements of the view and to apply special
effects.

Mode
Allows selection of how the data is viewed in the Image view. The options added by Volocity
Visualization are:
n

3D Opacity

n

3D Ray Tracer

n

3D Slice

The mode is also set using the popup in the tool bar.

Stereo
This option allows selection of a stereo mode of viewing which will generate the image so that it is
viewed with specialized glasses to emphasize the 3D appearance.

Show/Hide Channels, Bookmarks, Movie, Time Navigation
These are parts of the view that may or may not be used depending on the work that you are doing
therefore you may wish to hide them from view to give more space to the image. Channel controls
and Time Navigation are shown by default. Bookmarks and Movie will need to be shown when they
are first required.

Capture Snapshot
This option creates a 2D image of the view as it currently appears. This image may then be exported.

Create QTVR Movie...
This option creates a specialized movie which can be viewed using a QuickTime player. Rather than
playing back frames through time, different orientations of the view are captured and viewers of a
QTVR movie may manipulate the object themselves within the limits of range of movement set when
making the movie. QuickTime must be installed on the system for this option to be available.
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Show/Hide Scale
Scale is shown using a grid behind the object. The grid moves to stay behind the object as it is
rotated. The distance represented by each square in the grid, the calibration information, is shown in
the bottom right corner of the screen.
Use the Scale tab in the View Options… dialog to change the color of the scale grid and switch
calibration information on or off.

Show/Hide Floor
A floor is shown below the object in the 3D View to emphasize the orientation of the object. Hide
Floor becomes Show Floor when the floor is not visible. Use the View Options… to change the
position and appearance of the floor.

Show/Hide Orientation
Orientation is a marker to identify x, y, and z axes. This multi colored pointer is shown in the bottom
left hand corner of the view

Show/Hide Time
Select Show Time from the 3D menu to display the volume timestamp. Change the color of the
timestamp or frame time in the View Options.

Always Show Ball
This option always displays the graphical ball which is used to move the object around in the view.

Reset View
This option resets the orientation of the object to the default position applied when the data is first
seen in the 3D View.

View Options
Use the View Options… command to change the setup of the 3D View. The dialog is tabbed for
different settings.
In the General tab change the background and/or floor color. Using different colors for these can
improve the visibility of details in the data being rendered. Floor position and also pattern can be
changed. The 3D Scale tab changes how the scale grid is drawn.
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Image Toolbar
Rotate Object

Shortcut key R

Use this tool to rotate the object. A ball outlines the object and the pointer
changes to a hand when you position it on the object. When you let go, the
object spins around the pivotal point.
Use Alt-click (Mac) or Ctrl-click (WINDOWS) and drag to zoom.
Use Shift-click to move the camera, or view, position.

Spin Object

Use the Spin tool to move the camera, or view, position.
Use Alt-click (Mac) or Ctrl-click (WINDOWS) and drag to zoom.

Shortcut key F

Use Shift-click to move the object.

Zoom

Use to zoom.

Shortcut key Z

Pan

Use the pan tool to move the object inside the ball control. For example, this
allows you to set the pivotal point for rotation, as described in the next
section.

Shortcut key H

Light Source

Use the light source tool to move the source of illumination in the scene.
Currently supported for Ray tracing and isosurfaces in 3D Opacity rendering.

Shortcut key G

Rotate Slice

Use the rotate slice tool when viewing data in the 3D slice mode to change
the orientation of the slice in the volume.

Shortcut key E
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Setting the Pivotal Point of Rotation
1. Click and drag within the ball with the hand tool to center the object on the first axis.
2. Change to the rotate tool to check the effect.
3. Continue to adjust for each axis, using the hand tool, until you have set the pivotal point of rotation,
as required.
Note: Select Reset View from the Image menu to return the object to its original position.

Free Flight Camera Control
It is possible to control the viewing point or camera position for free flight around and through the
volume. This is achieved using a USB joypad/gamepad with two analog joysticks and front face
buttons.

Joypad Preferences
It is important to enable the joypad and calibrate the sticks before using the joypad for the first time.
1. Select Preferences... from the Edit menu (Windows) or the Volocity menu (Mac).
2. Click on the Joypad icon.
3. Check to Enable Joypad Control, select the Device and Calibrate both sticks.
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Controlling the Joypad
The gamepad controls the camera or viewer position allowing completely free movement around and
through the volume. The gamepad is, therefore, not moving the object at all.

Left Analog Stick

Right Analog Stick

Move left, right, forwards and backwards

Turn left, right, up and down

Top Left Shoulder Button

Top Right Shoulder Button

Modifies action of left analog stick

Modifies action of right analog stick

Move up and down

Roll left and right

Numeric Buttons
1 Point at center of volume
2 Add bookmark
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3D Image Bookmarks
Bookmarks allow you to store information about the position of the volume and the rendering settings
being applied to it. Bookmarks operate in any mode of the Image view.
Bookmarks can be used to remember these settings so that they may be retrieved later. For
example, to return to a previous position and appearance after making changes or to use the position
and appearance of one data set to view another data set with exactly the same settings applied.

To Create a Bookmark
Bookmarks are kept in a Bookmark pane to the left of the Image View. If this pane is not visible,
select Show Bookmarks from the Image menu.
n

Position the volume as required and set the channel controls to produce the desired appearance.

n

Select Add Bookmark from the Image menu or use the shortcut Ctrl+ B on Windows, Apple+B
on Mac OS.

A thumbnail of the volume will be added to the bookmarks pane.
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To Use a Bookmark
Double click on the thumbnail of a bookmark in the bookmark pane to use the settings of that
bookmark to change the position and rendering settings of the current Image View to those stored by
the bookmark.
Alternatively use Next Bookmark or Previous Bookmark in the Image menu to step through
bookmarks in the order in which they were created.

To Edit a Bookmark
1. Select the bookmark in the bookmark pane, the borders of the bookmark will become highlighted.
2. Select Edit Bookmark... from the Image menu.
3. A dialog is opened showing the states of the view that are being stored.

4. Uncheck a state and that particular bookmark setting will not be applied to the Image View when the
bookmark is used.
Check the state again and the setting(s) stored when the bookmark was created will be applied again
when the bookmark is used.

To Move a Bookmark.
To use the settings of one Image View with another data set so that both data sets may be compared
move the bookmark from the first Image View to the second.
With both data sets open drag the bookmark from one bookmark pane to the other.
The bookmark thumbnail will update the first time it is used with the new dataset.

To Delete a Bookmark
Select the bookmark in the bookmark pane, the borders of the bookmark will become highlighted.
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Use the Delete (Windows) or Backspace (Mac OS) keys to delete the bookmark.
Overlays turned on or off by items in the Image menu, i.e. the ball control, scale, orientation and time,
are not stored by bookmarks.

3D Image Movie Interface
Bookmarks are the starting point for making movies to animate 3D images . The movie will be an
animation of the transition between the appearance of the volume in one bookmark and its
appearance in the next bookmark. Each transition takes place over a number of frames determined
by you. Select Show Bookmarks from the Image menu to view the bookmarks pane.
1. Choose Show Movie from the Image menu.

2. Drag a bookmark thumbnail from the bookmark pane to the movie pane to create a keyframe in the
movie. By default this keyframe will be 10 frames long. Keyframe length may be changed by clicking
and dragging the end of the keyframe.
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3. Drag a second bookmark into the movie pane. When the movie plays, the volume will be gradually
changed in appearance from the first bookmark to the second, this transition taking as long as the
number of frames over which the first keyframe extends.
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4. Continue dragging bookmarks in to make a series of keyframes/transitions. Preview the movie, in
the current Image view by using the lower set of controls on the view.
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5. To include switching between timepoints in a movie made for a time resolved sequence select Add
Timepoint Sequence... from the Movie menu.

Configure the dialog so that the timepoint sequence lasts the required number of frames, switching
between timepoints backwards or forwards and even switching between a subset of timepoints.
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This will add a time bar to the movie. Delete a keyframe from the movie by clicking on it once to
select it then using the Delete key (Windows) or the Backspace key (Macintosh)
6. Preview the movie on the current Image View using the lower set of playback controls.

Edit Keyframe
Double click on a keyframe or select Edit Keyframe... from the Movie menu to access the Edit
Keyframe dialog.

This dialog allows configuration of the length of the keyframe transition and also selection of the
bookmark properties which are used in that transition. It is, therefore, possible to use only the
positional information and not the rendering settings stored with a keyframe.
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Edit Timepoint Sequence
Double click on a timepoint sequence or select Edit Timepoint Sequence... from the Movie menu to
access the Edit Timepoint Sequence dialog.

Adjust the number of frames over which the timepoints will be played through, switch between
timepoints backwards or forwards.
You can also use this dialog to configure a timepoint sequence to switch between a subset (or range)
of timepoints. Additional timepoint sequences may be added to the movie to switch through
remaining timepoints.
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Resize Movie
Select Resize Movie... from the Movie menu to easily change the length of the movie. Movie length
may be changed to a percentage of its existing frame number, to a fixed number of frames or to last
a known length of time when played at a known frame rate.

Clear Movie
Select Clear Movie from the Movie menu to delete all the keyframes and timepoint sequences of a
movie.

Make Movie
Once a movie is created you may wish to generate the frames of the movie for the current Image
View to then be able to export them. Select Make Movie from the Movie menu to create the movie
frames and add them to the library as new image sequence. This new sequence will have the same
name as the source data with Movie appended. View and work with this sequence in the same way
as any other.
This folder may be exported as a movie by selecting it and choosing Export... from the File menu.

Save and Restore Movie
It may be relevant to save this movie for future use and for use with different data sets.
Save the movie keyframes by selecting Save Movie... from the Movie menu. Give the movie a name
and click Save. This will store the movie as a preference within the system.
To use a movie previously stored on the system Select Movie menu, Restore Movie…Select the
movie name from the list and click Restore.
To make standard movements such as rotation about an axis use one of the stored movies supplied
with Volocity. Select Movie menu, Restore Movie… to open one of these in your movie.
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Use existing movies with a data set by viewing the Image View and selecting Restore Movie... from
the Movie menu.

Creating QuickTime VR Movies
A QTVR file is an interactive movie that can be viewed in QuickTime player. If you have QuickTime
installed on your machine, you can render a volume and then create a QTVR movie of the rendered
view.
Note: A QuickTime VR movie is not a real movie, as such, rather an animation that is created by
displaying the object according to a map of user-defined co-ordinates.
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1. Select Create QTVR Movie… from the Image menu

2. Amend the settings as appropriate.
3. The panning and tilting values define the rotation that can be applied to the QuickTime object. These
values are used to build a map of all the co-ordinates that will be used to display the object on the
screen. In our example, you will be able to rotate the object 360 degrees in 18 steps and tilt it
through 60 degrees in 18 steps (this means the object will rotate 3 degrees for each step).
4. Select a compression format from the drop-down list and use the slider control to set the
compression factor.
5. The available compression options vary according to the version of QuickTime that is installed
6. Click on Create…
7. Select a folder and enter a name for the movie.
8. Click on Save.
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Aligning Volumes
The Volocity alignment tool is designed to compensate for rotational and translational shifts only
between the 2-dimensional planes that make up a volume.
When performing rotational correction the Alignment tool will search for correlation +/- 30 degrees
from the origin. The Alignment tool searches for correlation between slices in the data to match
features and establish where each slice should be in relation to the next. For alignment to be
successful features must be represented in neighboring slices. This means that the slices must be
similar.
The Alignment tool will not work on structures that are, or approximate to, spheres, since they show
rotational symmetry which makes feature matching impossible.
During rotation of images anti-aliasing is applied which has a smoothing effect on the data. The
original data is not overwritten, a new volume or volume sequence is created with the suffix (aligned).
The XY dimensions of an aligned volume will be the same as the original volume, areas of image
that have been shifted outside the original boundary to allow alignment will be cropped from the
result.
There is no benefit to be gained by repeatedly aligning the same data.
1. Select Align Volumes... from the Tools menu.
2.

If you are aligning images in an image sequence, a prompt will be shown offering options to align
volumes individually or using a selected channel in the sequence as a reference.

3. If no channel has been selected, or if you have selected more than one channel, only Individually is
available. If a channel has been selected, you can click on either button. Click Align.
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Volocity Quantitation Worked Examples
Overview
Volocity Quantitation is a separate product in the Volocity family. See page 38 for more information
about activating additional products after installation. Volocity Quantitation is designed to identify
biological structures automatically. These can then be measured and tracked in 2D, 3D and 4D,
analyzed and charted. Volocity Quantitation is an individual product and must be purchased
separately. See page 38 for more information about activating extension products.
Volocity Quantitation provides a powerful, easy-to-use interface that allows the user to build up
protocols of measurement tasks and then view the feedback as an overlay on the original image and
view a table of measurements – all from the same Measurements view.
The Measurements view provides all the tools required to identify objects and make a variety of
measurements from those objects. Measurements made in the Measurements view can also be
stored as a new item in the library by using Make Measurement Item… in the Measurements menu.
To assist users wishing to start working immediately, this chapter provides five worked examples
describing common applications using Volocity Quantitation:
n

Measure the mean volume of structures in a 2-channel data set at a single timepoint.

n

Measure multiple timepoints.

n

Measure multiple image sequences.

n

Measure and track multiple timepoints.

n

Colocalization.

For more detailed information on the tasks and tools available in Volocity Quantitation please see the
separate reference chapter, starting on page 408.
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Measuring a Single Timepoint
The process has three stages:
n

Create a protocol to locate objects of interest in your data set. A protocol is used to threshold
data to select areas of interest and, from that selection, include or exclude objects based on a
range of criteria.

n

Create a Measurement Item to store the measurements.

n

Review the results.

To obtain correct values for calibrated spatial measurements, it is important to ensure that the data is
calibrated correctly by setting the X, Y and Z pixel dimensions in the Properties dialog, see page 63.

Creating the Measurement Protocol
1. Open the required data set and view the Measurements tab. The Measurements View contains all
the tools and information needed for selecting objects.

Drag tasks to
this pane to
make
measurements
Image preview will
show feedback as
measurements are
made

Measurements are
shown here as a
table or histogram
Measurement
protocol tasks
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2. Start the protocol by using a Finding task such as Find Objects Using Intensity. There are other
Finding tasks which may be appropriate for different types of data. See instructions for each task
starting on page 432. If the dataset contains more than one channel, as in this example, make sure
that the correct channel is selected in the task.
Click cog to view secondary dialog

3. The task shows a histogram of the intensity values present within the data set and selected values
are shown as a shaded red area on the histogram. Drag the vertical, red lines to adjust the intensity
range selected.
4. The selected objects will be shown as a colored overlay in the image preview and standard
morphological and intensity measurements will be displayed in the measurements table. To change
the color of objects found use the Color Objects task, see page 450, and to change the
measurements made use the Measure Objects task, see page 448.
5. If the selected objects are not automatically shown, select Update Feedback from the
Measurements menu. To update feedback automatically after any change to the protocol turn on
Automatically Update Feedback in the Measurements menu.
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6. If too many or too few objects have been selected you may need to make adjustments to the
protocol.
n

Find Objects. The protocol will only select voxels if they are between the minimum and
maximum intensity set in the task. Drag the red bars to include more or fewer voxels. Click on the
cog icon on a task in the protocol to access the secondary dialog for the task.

This dialog shows a larger histogram and value entry fields for more precise setting of threshold
values. It is also possible to set the thresholds to the maximum and minimum intensity values
found within a region of interest drawn on the image. The ROI must be drawn before this dialog is
opened. Click Get From ROI.
n

Modify the Selection. It may be necessary to remove noise from the selection to avoid selecting
voxels that are not relevant to the objects required. Add a Remove Noise From Objects task to
the protocol and select the size of filter to be applied.

n

Exclude Objects. It is also possible to exclude objects based on certain characteristics such as
their size, shape or position relative to the edge of the image or an ROI. Use the table of
measurements to make decisions about this step. To order the measurements by size to help
choose sizes to exclude click on the column heading for Volume (or Area) and the column will be
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reordered by that value. Add an Exclude Objects by Size task to the protocol to exclude objects
larger or smaller than the size entered.

6. Adjust the protocol, as required, until the preview shows the required selection.
7. If the table does not show the measurements required, or shows too many, add task(s) from the
Measuring category to the protocol. Click on the cog icon in a Measure task to set up the
measurements required. For example the Measure Objects task dialog will look like this:

8. If you wish to save the protocol for future use, select Save Protocol… from the Measurements
menu.

Storing Measurements in a Measurement Item
1. The measurements visible in the Measurements View are present because a protocol is active in the
Measurements View. As soon as the protocol is changed the measurements will change. To store
measurements and work with them further, you must create a Measurement item.
2. Select Make Measurement Item… from the Measurements menu.
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3. Select to make a new measurement item and enter a name for it, or add these measurements to an
existing table, which may be made from the same data or from different data. Measurement items
may combine measurements from different sources. Measurements may be made all on timepoints
or selected timepoints. If no timepoints are selected the current timepoint is measured.
4. Click on OK.
A progress bar may be shown on screen while the measurements are being made. A new item will
be added to the library.

Viewing the results
1. Double click the Measurement item to open the Raw view showing the table of numbers.
This table may be sorted, re-organized and filtered. See page 459 for more information on working
with the Raw View.
If required, the measurements may be exported as tab or comma-delimited text. To do this, display
the Raw View and select Export… from the File menu.

Measuring Multiple Timepoints
The process has three stages:
n

Create a protocol to locate objects of interest in your data set. A protocol is used to threshold
data to select areas of interest and, from that selection, include or exclude objects based on a
range of criteria.

n

Create a Measurement Item to store the measurements.
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n

Review the results.

To obtain correct values for calibrated spatial measurements, it is important to ensure that the data is
calibrated correctly by setting the X, Y and Z pixel dimensions in the Properties dialog, see page 63.

Creating the Measurement Protocol
1. Open the required data set and view the Measurements tab. The Measurements View contains all
the tools and information needed for selecting objects.

Drag tasks to
this pane to
make
measurements
Image preview will
show feedback as
measurements are
made

Measurements are
shown here as a
table or histogram
Measurement
protocol tasks

2. Start the protocol by using a “Find Objects” task such as Find Objects Using Intensity. There are
other “Find Objects” tasks which may be more appropriate for time resolved data (for example, Find
Objects by % Intensity and Find Objects by SD Intensity). These tasks do not use absolute
intensity values and are, therefore, better suited to data where the range of intensity values does not
remain constant. See instructions for individual tasks starting on page 432. If the dataset contains
more than one channel, make sure the channel containing the objects required is selected in the
task.
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3. The task shows a histogram of the intensity values present within the data set; selected values are
shown as a shaded red area on the histogram. Drag the vertical, red lines to adjust the intensity
range selected.
4. The selected objects will be shown as a colored overlay in the image preview and standard
morphological and intensity measurements will be displayed in the Measurements table. To change
the color of objects found use the Color Objects task, see page 450, and to change the
Measurements made use the Measure Objects task, see page 448.
5. If the selected objects are not automatically shown, select Update Feedback from the
Measurements menu. To update feedback automatically after any change to the protocol, turn on
Automatically Update Feedback in the Measurements menu.
6. If too many or too few objects have been selected, you may need to make adjustments to the
protocol.
n

Find Objects. The protocol will only select voxels if they are between the minimum and
maximum intensity set in the task. Drag the red bars to include more or fewer voxels. Click on the
cog icon on the task in the protocol pane to view the secondary dialog.

This dialog shows a larger histogram and value entry fields for more precise setting of threshold
values. It is also possible to set the thresholds to the maximum and minimum intensity values
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found within a region of interest drawn on the image. The ROI must be drawn before this dialog is
opened. Choose Get From ROI.
n

Modify the Selection. It may be necessary to remove noise from the selection to avoid selecting
voxels that are not relevant to the objects required. Add a Remove Noise From Objects task to
the protocol and select the size of filter to be applied.

n

Exclude Objects. It is also possible to exclude objects based on certain characteristics such as
their size, shape or position relative to the edge of the image or an ROI. Use the table of
measurements to make decisions about this step. To order the measurements by size to help
choose sizes to exclude click on the column heading for Volume (or Area) and the column will be
reordered by that value. Add an Exclude Objects by Size task to the protocol to exclude objects
larger or smaller than the size entered.

n

Adjust the protocol, as required, until the preview shows the required selection.

Storing Measurements in a Measurement Item
1. The measurements visible in the Measurements view are present because a protocol is active in the
Measurements view. As soon as the protocol is changed, the measurements will change. To store
measurements and work with them further, you must create a Measurement item.
2. Select Make Measurement Item… from the Measurements menu.
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3. Select to make a new Measurement item and enter a name for it, or add these measurements to an
existing table, which may be made from the same data or from different data. Measurement items
can combine measurements from different sources. Measure all timepoints or a selected subset of
timepoints.
4. Choose to measure All timepoints and Click on OK.
A progress bar may be shown on screen while the measurements are being made. A new
measurement item will be added to the library.
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Viewing the Results
1. Double click the Measurement item to open the Raw View showing the table of numbers.
This table may be sorted, re-organized and filtered. See page 459 for more information on working
with the Raw View.
If required, the measurements may be exported as tab or comma-delimited text. To do this, display
the Raw View and select Export… from the File menu.
2. The Analysis View may be used to show relationships of data over time, for example the mean
intensity of measured objects for each timepoint. Click on the Analysis tab and select Analyze…
from the Analysis menu.

The data of interest is the mean intensity for each object. Therefore select the column heading for
the mean intensity of the channel of interest in Analyze these data:
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There are several objects per timepoint, so Summarized by: Mean will find the mean of the value for
each object. Organize the data by: Row set to Timepoint

The Analysis view now shows a table with the mean of the mean intensities arranged in rows
according to timepoint.
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This can easily be plotted as a chart by clicking on the Chart tab.
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There are many different chart types and options to configure the appearance of the chart, accessed
by clicking on the Chart Setup button or selecting Edit Chart… from the Chart menu.
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Measuring Multiple Image Sequences
Volocity supports batch processing of image sequences. One Measurements protocol is applied to
multiple selected sequences and the results are collected in a single Measurements item.
The process has four stages:
n

Create a protocol to locate objects of interest in your data set. A protocol is used to threshold
data to select areas of interest and, from that selection, include or exclude objects based on a
range of criteria.

n

Save the protocol.

n

Apply the saved protocol to selected image sequences in the library.

n

Review the results.

If you have a saved Measurements protocol that you would like to apply to multiple image sequences,
start at “Apply the Protocol to Selected Sequences” on page 390. Otherwise, you must first create a
protocol by opening one of the image sequences that you will measure and viewing the
Measurements tab.
To obtain correct values for calibrated spatial measurements, it is important to ensure that the data is
calibrated correctly by setting the X, Y and Z pixel dimensions in the Properties dialog, see page 63.
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Creating the Measurement Protocol
1. Open the required data set and view the Measurements tab. The Measurements View contains all
the tools and information needed for selecting objects.

Drag tasks to
this pane to
make
measurements
Image preview will
show feedback as
measurements are
made

Measurement
protocol tasks

Measurements are
shown here as a
table or histogram

2. Start the protocol by using a Finding task such as Find Objects by Intensity. There are other “Find
Objects” tasks that may be more appropriate when working with multiple data sets containing images
that have widely-varying intensity values (for example, Find Objects by % Intensity and Find
Objects by SD Intensity). These tasks do not use absolute intensity values and are, therefore,
better suited to data where the range of intensity values does not remain constant. Descriptions of
individual tasks begin on page 432.
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If the dataset contains more than one channel, make sure that the channel containing the objects
required is selected in the task.

3. The task shows a histogram of the intensity values present within the data set and selected values
are shown as a shaded red area on the histogram. Drag the vertical, red lines to adjust the intensity
range selected.
4. The selected objects are shown as a colored overlay in the image preview and standard
morphological and intensity measurements are displayed in the Measurements table. To change the
color of objects found use the Color Objects task, see page 450, and to change the measurements
made use the Measure Objects task, see page 448.
5. If the selected objects are not automatically shown, select Update Feedback from the
Measurements menu. To update feedback automatically after any change to the protocol, turn on
Automatically Update Feedback in the Measurements menu.
6. If too many or too few objects have been selected you may need to make adjustments to the
protocol.
n

Find Objects. The protocol will only select voxels if they are between the minimum and
maximum intensity set in the task. Drag the red bars to include more or fewer voxels. Click on the
cog icon in the task panel to access the secondary dialog for the task.

This dialog shows a larger histogram and value entry fields for more precise setting of threshold
values. It is also possible to set the thresholds to the maximum and minimum intensity values
found within a region of interest drawn on the image. The ROI must be drawn before this dialog is
opened. Click Get From ROI to populate the settings.
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n

Modify the Selection. It may be necessary to remove noise from the selection to avoid selecting
voxels that are not relevant to the objects required. Add a Remove Noise From Objects task to
the protocol and select the size of filter to be applied.

n

Exclude Objects. It is also possible to exclude objects based on certain characteristics such as
their size, shape or position relative to the edge of the image or an ROI. Use the table of
measurements to make decisions about this step. To order the measurements by size to help
choose sizes to exclude click on the column heading for Volume (or Area) and the column will be
reordered by that value. Add an Exclude Objects by Size task to the protocol to exclude objects
larger or smaller than the size entered.

Adjust the protocol, as required, until the preview shows the required selection.
7. Select Save Protocol… from the Measurements menu.

November 2008 389

Measuring Multiple Image Sequences

Apply the Protocol to Selected Sequences
1. In the Library View select the items to be batch processed.
2. Select Measure… from the Tools menu.

Select the protocol to be applied to the selected items from the drop-down menu, which lists all
saved protocols by name.
Either, select Store the measurements in a new measurement item called: and enter a name for
the Measurement item that will contain all the measurements made by the selected protocol on the
selected items. Or, select Add the measurements to this existing measurement item: and
choose from the measurement items that already exist in the library. In this case, all the
measurements from all the selected items will be added to the measurements already in the table.
For each task in the protocol that operates on a specific channel (i.e. the Protocol dialog contains a
drop-down for channel selection when the task is configured), there will be an entry under Apply the
protocol’s tasks to these channels: The drop-down lists the unique channel names found within
the selected items. Channels with the same name will all be processed.
3. Select the correct channel for each task in the list and click OK.
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4. A progress bar is shown as each of the selected items is measured with the protocol and the
Measurement item is created.
5. Double-click the Measurement item to view the Raw View of all the measured objects.
6. To perform further analysis of this large amount of data, go to the Analysis tab and select Edit
Analysis… from the Analysis menu.
7. To show the changing mean intensity over time, the Analysis dialog could be configured as shown
below:

Organized by: Column: Item Name will organize the data according to the name of the image
sequence. Since Item Name is selected for Column in the table, these will become individual series
in a chart allowing us to visually compare the data sets.
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Click on the Chart tab to view the chart. The default chart type is a bar chart. Select Edit Chart…
from the Chart menu to change the chart type. The following example shows a line chart.
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Measuring and Tracking Multiple Timepoints
Volocity’s unique time-based measurement architecture allows you to measure and track biological
objects as they move in time in both 2D and 3D.
Tracking uses the centroid measurement for each object to identify whether objects have moved
between timepoints. It does not use any of the other measurements.
The process has three stages:
n

Create a protocol to locate objects of interest in your data set. This protocol must locate objects
as accurately as possible in each timepoint.

n

Measure the objects found by the protocol and generate tracks based on the centroid position of
each object.

n

Review the results.

Creating the Measurement Protocol
1. Open the required data set and view the Measurements tab. The Measurements View contains all
the tools and information needed for selecting objects.

Drag tasks to
this pane to
make
measurements
Image preview will
show feedback as
measurements are
made

Measurement
protocol tasks

Measurements are
shown here as a
table or histogram
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2. Start the protocol by using a “Find Objects” task such as Find Objects by Intensity. There are other
Finding tasks that may be more appropriate for time resolved data, for example Find Objects by %
Intensity and Find Objects by SD Intensity. These tasks do not use absolute intensity values and
are, therefore, better suited to data where the range of intensity values does not remain constant.
See the detailed description of individual tasks starting on page 432 If the dataset contains more
than one channel make sure the channel containing the objects required is selected in the task.

3. The task shows a histogram of the intensity values present within the data set and selected values
are shown as a shaded red area on the histogram. Drag the vertical, red lines to adjust the intensity
range selected.
4. The selected objects are shown as a colored overlay in the image preview and standard
morphological and intensity measurements are displayed in the Measurements table. To change the
color of objects found use the Color Objects task, see page 450, and to change the measurements
made use the Measure Objects task, see page 448.
5. If the selected objects are not automatically shown, select Update Feedback from the
Measurements menu. To update feedback automatically after any change to the protocol, turn on
Automatically Update Feedback in the Measurements menu.
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6. If too many or too few objects have been selected, you may need to make adjustments to the
protocol.
n

Find Objects. The protocol will only select voxels if they are between the minimum and
maximum intensity set in the task. Drag the red bars to include more or fewer voxels. Click on the
cog icon on the task in the protocol to access the secondary dialog for the task.

This dialog shows a larger histogram and value entry fields for more precise setting of threshold
values. It is also possible to set the thresholds to the maximum and minimum intensity values
found within a region of interest drawn on the image. The ROI must be drawn before this dialog is
opened. Click Get From ROI to populate the fields.
n

Modify the Selection. It may be necessary to remove noise from the selection to avoid selecting
voxels that are not relevant to the objects required. Add a Remove Noise From Objects task to
the protocol and select the size of filter to be applied.

n

Exclude Objects. It is also possible to exclude objects based on certain characteristics such as
their size, shape or position relative to the edge of the image or an ROI. Use the table of
measurements to make decisions about this step. To order the measurements by size to help
choose sizes to exclude click on the column heading for Volume (or Area) and the column will be
reordered by that value. Add an Exclude Objects by Size task to the protocol to exclude objects
larger or smaller than the size entered.
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Adjust the protocol, as required, until the preview shows the required selection.
7. You should check the protocol on a number of different timepoints before storing the measurements.
This saves time and avoids making unnecessary measurements.
Set up the protocol, then use the Time Navigation controls to move between timepoints. Stop at
intervals and Automatically Update Feedback will apply the protocol to the new timepoint. If the
protocol is not applied when the timepoint changes, select Update Feedback from the
Measurements menu.
You can then see the effect on the Image View and adjust the protocol for a number of timepoints to
obtain the best fit.

Adding a Tracking Task to the Protocol
1. To make the protocol track object centroid position when more than one timepoint is measured, add
the Track Objects task to the protocol.

The Track Objects task will always go to the bottom of the list of tasks in the protocol. It is not
possible to add it between other tasks or to add other tasks after it.
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2. Click on the cog icon on the Track Objects task in the protocol pane to access the secondary dialog
for the Track Objects task.

3. Select the appropriate options. These are described fully on page 453. For this example, we will
select the Shortest Path and allow Volocity to calculate the Maximum distance between objects
automatically.
4. Click OK to close the dialog.
5. Tracking will only be carried out if all timepoints are being measured. Either turn on Measure All
Timepoints in the Measurements menu to see tracking in the Measurements View, or select Make a
Measurements Item in the Measurements menu and ensure Measure: All timepoints is selected;
this makes a Measurements item that contains tracks. New measurement items are added to the
bottom of the library.
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6. When all timepoints are measured Volocity will apply the protocol to all the timepoints and track the
centroid positions of the objects found. The Measurements table will show all the objects found in
each timepoint and the tracks made from them. Select individual tracks to check and adjust the
Track Objects task, if necessary.
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Viewing the Results
1. Open the Measurement item created by the steps above.
The Raw table shows objects found in each timepoint and the tracks made from them with
measurements relevant to each.
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2. Choose Tracks from the Filter: drop-down to quickly view just the tracks.
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3. Click directly on the Chart tab to show the tracks as plots of centroid position.
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Select Edit Chart… from the Chart menu to change the type of chart and customize many features
of its appearance.

402 Improvision

VOLOCITY Quantitation Worked Examples

Colocalization
Colocalization is part of the Volocity Quantitation product and is designed specifically for
Colocalization analysis as described by Manders et al (1993). See also page 497.

Using the Colocalization View
1. Open the image sequence containing the two channels to be analyzed. The two channels must be
the same color depth. It is much easier to visualize colocalization if each channel has a different
color. Colocalization does not operate on single volumes.
2. Select the Colocalization tab. Set Channel X and Channel Y using the drop-downs at the top of the
screen.

The preview image shows an extended focus merge of the two channels. Volocity calculates
statistics and displays them below the preview. Regions of interest can be drawn on the preview. If
a region of interest is present on the preview image the statistics will be based on only the voxels
within the thresholds within the region of interest. This allows the comparison of statistics generated
from individual cells or structures within the image. If no region of interest is present, the statistics
will be based upon voxels within the threshold within the whole image. Working with the scatter plot
on the right, set thresholds for each axis so that the lower threshold is above background. It may not
be necessary to change the upper threshold.
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There are three ways of setting thresholds.
n

Use the ROI tool to draw a region of interest on the Preview. Select Set Thresholds from ROI
from the Colocalization menu.

n

Enter the required values manually into the Threshold Maximum and Minimum boxes for each
channel or drag the slider controls on the scatter plot.

n

Select Automatic Thresholding from the Colocalization menu to generate thresholds
automatically.

See page 500 for further information. Any voxels of intensity outside thresholds will be removed from
the preview image for that channel. Any point on the scatter plot that is outside thresholds for either
channel will be removed from the scatter plot leaving only points that are within the thresholds for
both channels. If thresholds are not set, voxels where both images show background intensity levels
will contribute to the generation of colocalization statistics, this may make your channels appear to
have a better correlation coefficient than is actually the case.
4. Colocalized voxels are shown in an overlay on the preview.
5. You may select regions of interest in the preview. If regions are selected on the preview the
statistics and scatter plot will be generated only from the region. If no region is selected the statistics
and scatter plot will be based on the whole image.
If required, select sub-regions of the scatter plot for analysis. Use the ROI tools to draw a region of
interest on the scatter plot. Voxels selected on the scatter plot will be shown in an overlay on the
preview. The preview will update so the overlay shows the location of just the selected voxels. The
statistics will also update to reflect the selected voxels. The Edit menu, Select all command will
select the whole scatter plot.
6. Create the colocalization output.
Select Generate Colocalization from the Colocalization menu and choose the required output.

n
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your analysis. Each time point in your image sequence will have a row devoted to it in the field
statistics measurement item.

n

The scatter plots are saved to a folder in the current library. Each scatter plot is stored as a 2D
image and may be exported.
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n

If any voxels were selected in the scatter plot they are displayed in the Colocalization channel.
These voxels are marked in the Colocalization View preview with the colored overlay. The
channel is produced from a brightest point merge honoring the color and intensity of those voxels
in the original channels.

n

A merged channel is made by generating a color channel with contributions from each of your
analyzed channels. Merged channels such as this are often used for simple red plus green gives
yellow (in areas on colocalization) visual analysis of colocalization. We recommend that you only
use this channel for simple visual illustration purposes.
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n

PDM channels are generated by calculating the product of the difference from the mean for each
voxel from the two channels analyzed.
Volocity generates two PDM channels, a positive channel which is colored yellow, and a negative
channel which is colored purple.
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Volocity Quantitation Reference
Overview
This is the reference chapter for Volocity Quantitation. For worked, step-by-step examples on
measuring and analyzing data at a single timepoint and at multiple timepoints, please see page 162.
This chapter describes:
n

The Measurements View

n

How to draw points, lines and ROIs to create objects manually

n

How to create measurement protocols and use them to select objects

n

Raw Data, Analysis and Chart Views

n

How to visualize and quantify colocalization between pairs of images

n

FRAP and FLIP analysis

n

Ratioing

n

FRET analysis
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Measurements View
To measure objects, they must first be identified. The Measurements View provides all the tools
required to identify objects and make a variety of measurements from those objects. Use the Region
of Interest drawing tools to manually draw around objects (see page 410), or automatically detect
objects by creating a measurement protocol using the Measurement Protocol tasks (see page 428).

Build a
measurement
protocol in this
pane

Image view will
show object
feedback

Measurement
protocol tasks

Measurements are
shown here as a
table or histogram

Image View
This is an Image view within the Measurements view. Image view mode may be changed to the
option most useful when selecting objects using the popup. Options for showing overlays and
additional information in the Measurements menu allow you to configure this view in the same way
as you would configure the Image View, see page 79.

Measurements and Histogram
The Measurements table provides numerical information about the objects found in the image
directly above it. This numerical information is only shown for objects are selected in the image either
by a user-drawn ROI or a measurements protocol.
Click on the Histogram tab to display the numerical information as a simple histogram, one column
from the table at a time. Use the histogram to find patterns in a selected item property.
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Choose the data to be shown from the drop-down list of those available.

Using the Drawing Tools
Drawing Lines with the Line Tool
Lines are used to measure distances for example between two structures or along the length of a
boundary.
Use the Line tool to add lines in the Image View. Connect two or more points by
holding down the Shift key and clicking with the cursor. Release the Shift key to end a
line.
The total length of the line and an intensity profile are displayed as the line is drawn. Turn off this
display in the View Options... dialog found in the Measurements menu.
Once drawn, you can move the points along lines. To do this the line tool must be selected and the
cursor moved over the lines. The cursor changes shape over a control point indicating that you can
grab and move it.
To delete part of a line double click on a control point to highlight that section of the line and use the
Backspace (Mac) or Delete (WINDOWS) key. To delete all the lines active on the view, use the
Select None command in the Edit menu.
As lines are drawn automatic feedback updates the table below the image to show the measured
lengths. For each line a row is shown in the table below the image preview. The length of the line is
shown uncalibrated and as calibrated units.
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When working with 3D data the XYZ mode of the image will allow accurate positioning of the points
joined by the line. Use any part of the view to mark and reposition points.
Line measurements are also shown in the table below the Image View. Export this table as a text file
by selecting Export... from the File menu and selecting one of the options for exporting the view
rather than the item. Save this table in the library by selecting Make Measurement Item... from the
Measurements menu.
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Setting Up the Line Tool
Volocity will automatically assign a different color for each line or you can specify a color. Next to the
Line tool in the tool bar is an arrow. Click here to display the color picker dialog. Choose one of the
displayed colors or specify a color. Choose Automatic to return to colors assigned by Volocity. Note
how the line tool reflects the color selected.

Point Counting with the Point Tool
Use the Point tool to count objects in the image. Select the Point tool and click on objects of interest
in the image. For each click a point is marked on the image. These points are numbered and the
numbering increases by one with each click.

Count two populations of objects in the same image using the color of the points. Specify a new color
and therefore new population. Next to the Point tool in the tool bar is an arrow. Click here to display
the color picker dialog. Choose one of the displayed colors or specify a color. Choose Automatic to
return to colors assigned by Volocity. A new color will start a new count at one.
To delete a point, click on it to highlight it and use the Backspace (Mac) or Delete (Windows) keys.
Other points of the same color will be renumbered. To clear all points on the screen go to Edit menu,
Select None.

412 Improvision

VOLOCITY Quantitation Reference

For each point, a row is shown in the table below the image preview. The position of the point as X,
Y and Z coordinates is stored. All points of the same color are assigned the same population ID.
n

Export this table as a text file by selecting Export... from the File menu.

n

Save this table as an item in the library by selecting Make Measurement Item... from the
Measurements menu.

Drawing Regions Using ROI Tools
Use these tools to draw a region of interest. The selected area will be outlined with "marching ants",
a moving outline. Each object (i.e. contiguous block of voxels) within the ROI will be assigned a
different color. Regions of interest are shown in the Image View using a colored overlay. Select View
Options… from the Measurements menu to change this.
For each object a row is shown in the table below the image preview. Some default morpholocigal
and intensity information for each object is stored.
n

Export this table as a text file by selecting Export... from the File menu.

n

Save this table as an item in the library by selecting Make Measurement Item... from the
Measurements menu.

The Rectangular ROI selection tool allows you to draw rectangles or squares.
Shortcut key R

The Freehand tool allows you to make a freehand selection of an area on the
image.
Shortcut key F

Shortcut key S

The Lasso tool allows you to trace the outline of a selection. It selects regions
based upon the color similarities of adjacent pixels. The initial point clicked sets
the color to compare and the tool has the effect of shrinking around the pixels
that fall outside of the tolerance value.

Setting Up the Lasso Tool
Double-click on the Lasso Tool in the tool bar to display a dialog in which you may adjust the
Tolerance of the selection.
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Shortcut key W

The Magic Wand tool has the effect of expanding the selection outwards from
the original pixel clicked on until the threshold set by the Setup Magic Wand is
reached.

Setting Up the Magic Wand
Double click on the Magic Wand tool to display the Setup dialog.
click to select only contiguous voxels,
or all groups that meet criteria
click to select one of the threshold
criteria

if required, check to enable filter

Note: If you are trying to isolate regions of interest from background data, it may be easier to use the
Wand tool to select the background, use the All objects criterion and then apply the Reverse
Selection command in the Actions menu.
Filter out noise in the selection will apply a 3x3x3 median filter. This will remove very small objects
that are often described as noise and can add significantly to the time taken to make the
measurement.

The ROI stamp tool makes a selection by placing an ROI of a predetermined
shape and size on the image, centered on the cursor position. This is useful for
making ROIs of a known size and/or repeating a selection of a known size.
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Setting up the ROI Stamp Tool
Double click on the ROI Stamp Tool to display the Setup dialog.

The size of the ROI may be set in pixels or micrometers. An ROI size set by micrometers will vary in
the number of pixels depending on the calibration of the item.

Target Channel
The Magic Wand and Lasso tools work on voxel intensity. So, within multi-channel data sets in an
image sequence, the size and shape of the selection made by the tool can be very different
depending on which channel is targeted when the selection is drawn. Use the target channel button
in the channel controls to choose the channel on which the selections will be made. See page 77 for
more information about working with Channel Controls.

Target channel
button
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The following example shows the selection made if the magic wand is clicked when the red channel
is targeted.
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In the following example the magic wand is clicked at the same location, but the selection is different
because the green channel is now targeted.
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Working with Regions
Once you have created a region of interest (ROI), there are a number of options available.
Crop to Selection
From the Actions menu select Crop to Selection to create a new image sequence at the dimensions
of the ROI. Hold down Ctrl key (Windows) or Alt key (Mac OS) to crop to selection in place, without
creating a new image sequence.
ROI menu
The sub-menu ROI under the Edit menu contains commands for working with ROIs once they have
been drawn.
n

Undo to undo the last change made to an ROI

n

Redo to redo the last change made to an ROI

n

Save to store the currently active ROI as a settings file in the preferences

n

Restore to recall a previous stored ROI and apply it to the current view

n

Grow to expand the ROI by one voxel in all directions

n

Shrink to reduce the ROI by one voxel in all directions

Key combinations
The following key combinations also apply:
Mac OS key combinations
n

Control-drag on a selection centers the selection on the image.

n

Command-drag locks the dimensions, to make a square or circular selection rather than
rectangular or oval.

n

Shift allows you to add to the ROI or draw multiple ROIs.

n

Shift + alt (option) allows you to subtract from the ROI or subtract the whole of the existing ROI
by drawing around it.

n

Alt (option) carries out an AND operation leaving only the intersection of the two ROIs. This
allows you to select in one part of the XYZ view and refine the selection based on what can be
seen in another part.

Windows key combinations
n

Shift allows you to add to the ROI or draw multiple ROIs.

n

Shift + ctrl allows you to subtract from the ROI or subtract the whole of the existing ROI by
drawing around it.

n

Ctrl carries out an AND operation leaving only the intersection of the two ROIs. This allows you to
select in one part of the XYZ view and refine the selection based on what can be seen in another
part.
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Kymograph
A kymograph is created from a multi-timepoint image sequence and is a method of displaying time
dependent events. In a kymograph image one axis represents distance along a line and the other
time.
Use the Line tool, in any view that it is available, to specify the distance axis. The start point of the
line is considered the origin of the distance axis. On 3D data check and adjust the position of the line
using the XYZ mode. Movement along or across this line will be recorded in the kymograph. A
kymograph image will be generated for each line drawn.

Select Kymograph... from the Tools menu.

The intensity under the line will be sampled at intervals (at the smallest resolution out of the X,Y and
Z axes) to form the distance axis of the kymograph, the corresponding positions in all timepoints will
be sampled to form the other axis.
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A kymograph created from multi-channel data will be a multi-channel sequence, the display of
channels in a kymograph may therefore be controlled using the channel controls. The reference
image is a snapshot of the image data with the line(s) visible to record where they were drawn.
Kymograph images are not calibrated, calibrated measurements cannot automatically be made from
kymographs in Volocity.
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Object Feedback
As objects are selected in the image, feedback is shown both in the image preview and in the
measurements table below the image. You can relate measurement rows to objects shown in the
image.
n

To show which object in the image is represented by a row in the table, select the row. Visual
feedback for all other objects will be hidden, leaving just the selected object shown. Go to the
Edit menu and Select None to clear this individual feedback.
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n
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To find measurements for objects use the Select object tool from the tool bar. The cursor
changes to a pointing hand when it is over voxels which have been measured as part of an object,
click to select the object, and the relevant row will be highlighted in the table.
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Measurements Menu
Many of the options in the Measurements menu are identical to those in the Image View (see page
84. These allow you to configure the image to assist in object selection. You can change how the
image is displayed with the Mode option.

The rest of this section describes those menu options that are specific to measurement.
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Measurements Feedback Options
In the Measurements View the location of objects selected in the image is shown using feedback.
The updating of feedback is set by the Automatically Update Feedback option in the
Measurements menu. The visual appearance of the feedback is controlled by the Feedback
Options... in the same Measurements menu.
Change the feedback options to show feedback and images more clearly together and to illustrate
specific points.
The Feedback Options dialog is divided into tabs, one for each type of measured item that could be
shown and the changes that can be made to their display.
You may choose to show each type of feedback or not, and there are sub options within each tab.

n

Show in current timepoint only is an option for viewing feedback within time resolved data.
When this option is checked only feedback that relates to measurements made from the current
timepoint will be shown. Changing the timepoint using the time navigation will change the
feedback so that only objects in the new timepoint are shown.

n

Show measurement will allow any of the measured parameters to be shown alongside colored
overlay which represents the measured object.
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To change the appearance of an ROI that is drawn on a view use the ROI tab in the View Options
dialog for that view.

Measurement View Options
Change aspects of the view display using the View Options dialog.
The dialog is divided into tabs for the different features that can be displayed.

In the General tab line length and line profile refer to what is to be displayed if a line tool is used to
draw a line on the screen. The floor settings refer to a floor which is shown in some of the views.
The ROI tab shows setting applicable to regions of interest drawn on the Measurements view. To
change how objects selected by a measurements protocol are displayed in the view, use the
Feedback Options dialog also available from the Measurements menu.

Make Measurement Item
Go to the Measurements menu and select Make Measurement Item… to create a new table item in
the library containing the measurement rows as previewed in the Measurements View.
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A new measurement item may be created and named or the measurements may be added to an
existing measurement item to build up a table of data.
For time-resolved data you may select measure all timepoints in the Make Measurement Item dialog,
even if the measurements have only been previewed on one timepoint. To measure selected
timepoints the timepoints need to be selected in the image sequence timeline view or in the time
navigation bar, if no timepoints are selected the current timepoint is measured.

Measure All Timepoints
When this menu option is checked ROI or selections active in the view will be applied to all
timepoints in the dataset and the measurements previewed in the table will be from all timepoints.
Measuring all timepoints can take much longer than measuring a single timepoint. Measurement
operations that rely on the time component of the data will not be previewed in the Measurements
View unless Measure All Timepoints is checked.

Hide Measurements
Allow the image to be displayed in a larger window by hiding the Measurements table, if not required.
Hide measurements changes to Show measurements to allow the table to be revealed again.

Measurements Table or Histogram
The Measurements table provides numerical information about the objects found in the image above.
This numerical information can also be displayed as a simple histogram by clicking on the Histogram
tab.
This numerical information is only shown while objects are selected either by a user drawn ROI or a
Measurements protocol.
n
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Store measurement information by creating a measurement item; select Make Measurement
Item... from the Measurements menu.
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n

Choose to Hide or Show Measurements from the Measurements menu to hide this table.

n

Show only measurements of a particular type, objects, lines or points by selecting the
appropriate option from the drop-down at the top of the table.

n

Sort the table by the contents of one column by clicking on the column heading, click again to
reverse the sort. An arrow in the column header indicates that this column is sorting the data.

n

To change the columns shown select Columns… from the Measurements menu and check or
uncheck column titles in the list.

n

Rearrange columns by clicking on the column heading and dragging that heading to another
position, a red insertion line shows where the column will be placed.

n

Fit the column widths to the data enclosed by selecting Autosize Columns from the
Measurements menu.

Histogram Tab
Click on the histogram tab to switch to a histogram that displays one column from the table at a time.
Use the histogram to find patterns in a selected item property.
Choose the data to be shown from the drop-down list of those available.
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Creating Measurement Protocols
Measurement protocols are the most powerful way of selecting and measuring objects. Protocols are
made up of tasks and are built by dragging tasks from the list in the bottom left hand pane into the
protocol area. Feedback into the view shows where objects have been found and numerical
information is listed in a measurement table below the image. Measurements protocols start with
Finding tasks, after which the selection is refined by the addition of further tasks.
A selection of example protocols are installed with Volocity. Select from recently used protocols in
the Measurements view protocol pane or select Measurements menu Restore protocol... to view all
saved protocols.
The order of tasks in the protocol affects the result. Tasks lower down in the list work only on the
results of tasks higher up in the protocol. The task flow is indicated by an arrow.

A set of tasks starting with a “Find Objects” task is known as a series. It is possible to have more
than one series in a single protocol.
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Measurement Protocol Tasks
Protocol tasks are grouped by function. The functions are ordered according to the order they are
used in typical protocol creation. Within each function tasks are arranged alphabetically.
n

Drag and drop the appropriate task name from the list to the [ame; above to add to the protocol.
The insertion point shows where the task will go.

n

Double click on a task name in the list to add it straight to the bottom of the protocol.

n

Move tasks around by dragging and dropping, the insertion point is shown.

n

Remove a task from the list by clicking the cross.

Some information is in the primary task area and always displayed. There may be additional
information; this is accessed by clicking on the cog icon to show a secondary dialog.
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Click cog to view
secondary dialog
Click cross to remove task
from protocol
Primary task
dialog

Each of the available tasks is described in more detail below.
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Finding
Find 2D Nuclei
This task will detect nuclei in many images without the need to add any additional tasks to the
protocol. This task will operate on 2D images only. This task might be helpful if the channel in which
the nuclei are labelled has high and/or variable levels of background across the image since it is
independent of absolute intensity. Thesefactors may make the nuclei difficult to isolate with other
Find Objects tasks.
Although developed specifically for finding nuclei this task might also be useful for finding any object
with ovoid shape filled with staining.

Click on the cog to open the secondary dialog and adjust parameters of the task.

Separate touching nuclei with a separation guide of: Reducing this distance will increase the
number of nuclei found by increasing the amount of splitting.
Reject nuclei with an area of less than: Reject objects detected, or created by the splitting process,
by size. Objects smaller than the expected size of the nuclei of interest can be excluded this way.
If you wish to exclude objects greater than a given size use an Exclude Objects by Size task in the
protocol.
This task is not available on a PowerPC Macintosh system e.g. G5 or G4.

Find 2D Spots
This task will detect objects that can be identified as bright spots against a darker background i.e.
small objects with one well expressed intensity maximum This task will often find objects in images
where the background varies across the image and may be useful where other Find Objects tasks
have not been successful.
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Objects found by this task are marked as points centred on one voxel. This task therefore identifies
locations as coordinates, there is no morphological information available. Local intensity maxima are
found and then incorrectly classified spots removed.
Click on the cog icon to open the secondary dialog and configure the parameters of the task.

Find spots with a minimum separation of: A pixel intensity will count as an intensity maximum if it
has the highest intensity within this radius. Decreasing this distance will increase the number of
potential spots. Spots that are excluded by this parameter will not be included again regardless of
other setttings.
Select spots with a maximum intensity within a radius of: This parameter relates to the
approximate radius of each spot object. Increase this value when working with larger spots. This
radius also determines the radius within which contrast will be calculated.
Reject spots on the basis of peak/average intensity contrast:. Reject spots that are considered
noise by comparing peak intensity to local background intensity.
It might be necessary to use other tools to define the areas within which to search for spots. This
might be the only way to exclude spots that have been found in the background or cell compartments
that are not relevant to the study.
This task is not available on a PowerPC Macintosh system e.g. G5 or G4.

Find Objects Using % Intensity
Find Objects tasks select voxels according to intensity or color information. This task selects voxels
according to % intensity.
Intensities within the current volume are represented as a percentage considering the highest
intensity value in the volume as 100%. This removes the need to select by absolute intensity values
and may work better for time resolved data sets.
The primary task shows text entry boxes to set the lower and upper limit of the selection.
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Click on the cog icon to show the secondary dialog. This shows a histogram of the current volume.
Number of voxels is along the Y-axis; color or intensity values are along the X-axis.

Click on the vertical red lines in the histograms and drag them to change the selected range of
values.
Change the Y-axis of the histogram to see detail more clearly, cycling through four possible
resolutions; linear, log, base 10 and base 100. To do this:
Windows: Ctrl-click in the histogram area
Mac: Alt-click in the histogram area

Select all Values. Select this tool to display the maximum range of values for the threshold
mode that you have selected.
Invert Region of Selection. Select this tool to reverse the area of selection on the histogram.

Get From ROI will set the minimum and maximum thresholds to the minimum and maximum
intensity value found within an ROI active on the Image

November 2008 433

Measurement Protocol Tasks

Find Objects Using Intensity
This task selects voxels according to specified intensity threshold values.
The primary task shows a histogram of the current volume. Number of voxels is along the Y-axis;
intensity values are along the X-axis.

Click on the vertical red lines in the histogram and drag them to change the selected range of values.
Tooltips show the intensity values.

The secondary dialog shows a larger histogram of the current volume. Text boxes allow direct entry
of intensity values for the thresholds.

Click on the vertical red lines in the histograms and drag them to change the selected range
of values.
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To see detail in the histogram more clearly change the Y-axis, cycling through four possible
resolutions; linear, log, base 10 and base 100 with each click in the histogram area. To do this:
Windows: Ctrl-click in the histogram area
Mac: Alt-click in the histogram area
Select all Values. Select this tool to display the maximum range of values for the threshold
mode that you have selected.
Invert Region of Selection. Select this tool to reverse the area of selection on the histogram.

Get From ROI will set the minimum and maximum thresholds to the minimum and maximum
intensity value found within an ROI active on the Image

Find Objects in ROI
This task will incorporate the objects within an ROI into the protocol. This allows those objects to be
included in later processing.

Find Objects Using HSI
This task selects voxels according to hue, saturation and intensity color information.
The primary task shows three histograms of the current volume. Number of voxels is represented
along the Y-axis; hue, saturation and intensity values are along the X-axis in each histogram.

Click on the red vertical lines in the histograms and drag them to change the selected range
of values. Tooltips appear when the cursor is held over the histogram to show values.
The secondary dialog shows a larger histogram of the current volume.
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Text boxes allow entry of values as an alternative means of setting thresholds.

Click on the red vertical lines in the histograms and drag them to change the selected range
of values.
Select all Values. Select this tool to display the maximum range of values for the threshold
mode that you have selected.
Invert Region of Selection. Select this tool to reverse the area of selection on the histogram.

Get From ROI will set the minimum and maximum thresholds to the minimum and maximum
values found within an ROI active on the image.
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Find Objects Using RGB
This task selects voxels according to RGB color information.
The primary task shows three histograms of the current volume. Number of voxels is represented
along the Y-axis; red, green and blue intensity values are along the X-axis in each histogram
Click on the red vertical lines in the histograms and drag them to change the selected range of
values. Tooltips show values.

A secondary dialog shows larger histograms, which
because of the increased scale may be easier to use for
fine adjustments.

Number of voxels is shown along the Y-axis; color or
intensity values along the X-axis.

Text boxes allow entry of values as an alternative means of
setting thresholds.
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Click on the vertical red lines in the histograms and drag them to change the selected range of
values.
Select all Values. Select this tool to display the maximum range of values for the threshold
mode that you have selected.
Invert Region of Selection. Select this tool to reverse the area of selection on the histogram.

Get From ROI will set the minimum and maximum thresholds to the minimum and maximum
values found within an ROI active on the image.

Find Objects Using SD Intensity
This task selects voxels according to intensity information.
Intensities within the current volume are represented as standard deviations above or below the
mean intensity. This removes the need to select by absolute intensity values and may work better for
time resolved data sets.
The primary task shows text entry boxes to set the lower and upper limit of the selection in numbers
of standard deviations. Positive values are above the mean, negative values are below the mean.
Uncheck the upper or lower limit boxes to allow everything above or below a set point to be selected.

Click on the cog icon to open the secondary dialog for this task. The secondary dialog shows a
histogram of the current volume; with number of voxels shown along the Y-axis, color or intensity
values are along the X-axis. Superimposed over the histogram is a curve (in green) showing the
normalized intensity. Vertical green lines are shown at the mean intensity and at each standard
deviation above and below the mean. Data may therefore be thresholded based on a set number of
standard deviations around the mean.
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Set lower and upper limits by entering the value of standard deviation at which the limit is to be set.
The mean intensity is at 0 standard deviations and standard deviations below the mean intensity
have negative values.

Click on the red vertical lines in the histograms and drag them to change the selected range of
values .
Select all Values. Select this tool to display the maximum range of values for the threshold
mode that you have selected.
Invert Region of Selection. Select this tool to reverse the area of selection on the histogram.

Get From ROI will set the minimum and maximum thresholds to the minimum and maximum
values found within an ROI active on the image.

Processing
Close Objects

A close is a filtering operation performed on detected objects. A Close Objects task is used after
objects have been detected by one of the Finding tasks. A close is a dilation operation followed by
an erosion. Each iteration is a repetition of the dilate then close process. Close Objects will serve to
close gaps within or between objects.
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Dilate Objects

Dilation is a filtering operation performed on the objects detected by the measurement protocol up to
that point. A diamond shaped kernel is passed over the selection so that each voxel in the selection
is considered with 6 of its neighbors. In each case the central voxel is set to the highest value of
itself and its neighbors. This has the effect of making the objects found by the selection bigger.. The
dilation is repeated the specified number of times (iterations). This has the effect of expanding the
object by that many voxels.

Erode Objects

Erosion is a filtering operation performed on the objects detected by the measurement protocol up
to that point. A diamond shaped kernel is passed over the selection so that each voxel in the
selection is considered with 6 of its neighbors. In each case the central voxel is set to the lowest
value of itself and its neighbors. This has the effect of making the objects found by the selection
smaller. The erosion is repeated the specified number of times (iterations). This has the effect of
shrinking the object by that many voxels.

Fill Holes in Objects
Objects must have been found using any of the Find Objects tasks earlier in the protocol.
If any of the objects identified have holes in them, this task will fill those holes provided that they are
surrounded in all dimensions by a contiguous wall of voxels. For example, a hardboiled egg has a
white that completely surrounds the yolk. So, the yolk is completely surrounded on all sides.
Therefore, if you were to select the white and then fill holes, the whole volume of the boiled egg will
be selected including the yolk.

Open Objects

An open is a filtering operation performed on detected objects. An Open Objects task is used after
objects have been detected by one of the Finding tasks. An open is an erosion followed by a dilation.
Each iteration is a repetition of the erode then dilate process. Objects separated by the erosion part
of an open iteration will be prevented from joining together again by the following dilation.
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Open object s will serve to separate objects by reducing them in size until they no longer touch then
growing them again so they approximate their original sizes.

Remove Noise from Objects
Use this task to apply a median filter to the selection already made. The selection is made by a Find
Objects task earlier in the series.

The size of the filter applied is selected in the drop-down on the task.
From the smallest fine filter to the largest very coarse, the median filter matrix is increased in size.
The time taken to apply the filter and the degree of filtering also increase.

Separate Touching Objects
This function can assist in the separation of two or more objects that a Find Objects task has
identified as one. The distance of each voxel from the surface of the selection is examined and, if the
distribution of the voxels indicates that two or more objects are present, a one-pixel thick row of
voxels is removed between them to create separate objects.

The minimum size guide may be optionally set to the typical size of a single object. This refines the
task by preventing separation if the distance between two new objects would be too small.

Filtering
Clip Objects to ROI
Objects must have been found earlier in the protocol.

Drawing a region of interest in the image and using this task will clip the result to the bounds of the
ROI. This may mean some objects are cropped.
Use Exclude Objects not Touching ROI to ensure that any objects that intersect with the ROI are
included.
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Exclude Objects by Shape
Objects found earlier in the protocol can be removed if they do not meet criteria for shape. This task
would be used later than a Find objects task in a measurements protocol.
Select the required shape from the drop-down list: either one of the predefined shapes or the Custom
Shape.

Custom shape: Custom shape allows you to create bespoke shapes using the XY, XZ and YZ cross
sections through an ellipse, rectangle or triangle. The custom shape is saved when the protocol is
saved.
To create a custom shape, select Custom shape from the drop-down menu and click on the button
to launch the Shape Preview window. Select the axes and use the slider controls to adjust values
manually.

Ellipse and Rectangle: When the XY slider is set to the central point the ratio between the X and Y
axis (or X and Z) is 50-50. As the slider is moved towards X, the length of the X axis will reduce and
increase in Y and vice-versa. The same rules apply for the XZ sliders. The YZ ratio is taken from the
XY and XZ controls.
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Triangle: It is possible to skew the angles of the triangle to achieve all possible dimensions from an
equilateral triangle (the slider is set at the central point) to a right-angled isosceles triangle (the slider
is set to the extreme right or extreme left).

Exclude Objects by Size
Objects found earlier in the protocol can be removed if they do not meet criteria for size. This task
would be used later than a Find objects task in a measurements protocol.
The task excludes objects greater than or smaller than a defined size.

Exclude Objects not Touching ROI
Objects must have been found earlier in the protocol.
Drawing a region of interest in the image and using this task will show only objects that intersect with
the ROI.
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Exclude Objects Touching Edge of Image
Objects must already have been found by the protocol. This task will remove any of those objects
touching the edge of the sample in the X,Y or Z planes. On datasets with small Z dimensions, this
may remove too much from the selection.
When working with 2D data the Z dimension is not considered as the edge of the image because this
would mean every object would be excluded.

Combining
Combine Objects
This task merges the objects found by one series of measurements task with the objects found by
another series.
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The first series of objects must include a Retain Objects task that names the first set of objects so
that they can be specified in this task.

Exclude Non-Touching Objects
This task keeps only those objects in a second series that touch objects in a first series.
The first series of objects must include a Retain Objects task that names the first set of objects so
that they can be specified in this task.

Exclude Touching Objects
This task keeps only those objects in a second series that do touch objects in a first series.
Objects in a series must be retained for use in this task using the Retain Objects task which will give
each set of objects an identifier. Use two sets of retained objects or one set of retained objects and
the current selection.

Exclusively Combine Objects
The first series of objects must include a Retain Objects task that names the first set of objects so
that they can be specified in this task.
The result shows just those areas where the objects from one series are found, not both.
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Internalize Measured Objects
Objects found and measured in one series will be related to the objects found by another series by
identifying the objects that are found inside other objects with a parent ID. Objects from the second
series that are within the same object from the first series will be given the same parent ID. Objects
in a series must be retained for use in this task using the Retain Objects task. Use two sets of
retained objects or one set of retained objects and the current selection.Objects found by one series
will be related to the objects found by another series according to one set of objects being inside or
outside the other.

Objects from the second series that are within the same object from the first series will be given the
same parent ID.
The first series of objects must include a Retain Objects task which will name the first set of objects
to enable them to be specified in this task.

Intersect Objects
Objects are found by one series, a second series finds a different population. Intersect objects will
find just the areas where both sets of objects overlap.

A Retain Objects task must be used in the first series to name the first set of objects to enable them
to be specified in this task.

Invert Objects
This task will invert the selection made by the series so far. This may be useful in situations when it
is easier to select background or unwanted objects and reversing the selection serves to select the
required objects.

Subtract Objects
Subtract the area masked by the retained objects from one series from the objects found in the
current series.
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Measuring
Filter Measurements
Objects that have been found by the protocol are listed in the table below the image. If this table is
not visible choose Show Measurements from the Measurements menu.
The list of objects found may be further refined by filtering on any of the measured parameters.

Measure Line Profiles
Measure intensity values along a line drawn with the line tool. Intensity values are interpolated from
neighboring voxels. Intensity is sampled at intervals along the line to generate the table of intensity
values. Sample points are chosen at the highest resolution of the data out of X, Y and Z resolutions.
A measurement row is added for each line. Line length and width are recorded for each line. A
measurement row is added for each sample point along the line.

Branched lines cannot be measured for a line profile and are therefore ignored by this task..
When measuring line profiles in 3D data be careful of line placement. Use the XYZ mode of the
Measurements view to ensure the line is placed as desired it can appear to float to the top slice.

Measure Lines
This task ensures that line measurements are recorded.
Draw lines using the line tool available from the tool bar. As lines are drawn the line length is
displayed in the Measurements table below the image. This is the default display.
The default display may change as other objects are found and the line measurements will no longer
be displayed. If they are no longer displayed in the table below the image, they will not be recorded
in any measurement item created unless you include a Measure Lines task in your protocol.
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The secondary dialog of the Measure Lines task shows checkboxes to select the measurements to
be made. Currently, line length is the only measurement available for lines.

Measure Objects
Objects are selected either by using the ROI tools available from the tool bar or by using Find
Objects task in a measurement protocol.
As objects are selected, measurements are displayed in the Measurements table below the image.
This is the default display. For each object found the table will display:
n

Voxel/Pixel count

n

Volume (µm )/Area (µm )

n

Min, Max, Mean and Sum intensity values. Each channel in the data set will have a set of
intensity columns.

n

Centroid position in pixels and micrometers

n

Surface Area (µm )/Perimeter (µm )

3

2

3

2

The default display may change as other objects are found and the object measurements will no
longer be displayed. If they are no longer displayed in the table below the image, they will not be
recorded in any measurement item created. Add a Measure Objects task to make the required
measurements.
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Intensity measurements ignoring zero are useful when working with data where background values
are always zero. This occurs after certain processing steps, for example ratio and FRET calculations.
A Measure Objects task may also be used partway through a protocol to record measurements at
that point and again later to measure a new set of measurements.
Once the Measure Objects task is included, default measurements will not be generated.
The centroid of an object is the unweighted centre. It is calculated by taking the average position of
the voxels making up the object. Thus, the average x coordinate of the voxels determines the x
coordinate of the centroid and the average y coordinate of the voxels determines the y coordinate of
the centroid.
Surface area of objects is measured by fitting a “skin” to the surface of the mask layer identifying the
object at the voxel level. Triangles are then fitted to each cluster of voxels on the surface of the
object. The area of each triangle is measured; the sum of triangle areas for each object gives the
surface area. There is no surface simplification for measurement. It is important, when using any
measurement. to ensure that results are statistically significant compared to any measurement error
or noise. This is especially important with surface area measurements where noise and surface
features can have a considerable impact on the measurement.

Measure Points
Mark points using the point tool available from the tool bar.
As points are marked, the point location is displayed as a coordinate in the Measurements table
below the image. This is the default display.
The default display may change as other objects are found and the point positions will no longer be
displayed. If they are no longer displayed in the table below the image, they will not be recorded in
any measurement item created unless a Measure Points task is used.

The secondary dialog of the Measure Points task shows checkboxes to select the measurements to
be made. Currently, Position is the only measurement available for points.

Measure Skeletal Length
This is an additional measurement that may be made from objects.
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Skeletal length is calculated by first thinning or skeletonising the object from all sides until a single
voxel line is left. This measurement is best suited to elongated shapes. The direction of the line is
elongated to meet the edges of the object and the length of this line is the skeletal length. For objects
where the skeleton branches, the skeletal length is measured as the longest traverse across the
object without crossing a point more than once.
Skeletal diameter is the diameter that a cylinder would have if it had a length equal to the skeletal
length of the object (determined as above) and a volume equal to the object’s measured volume.
It is derived using the equation for the volume of a cylinder.
V=πr l
2

Measure skeletal length populates the measurement columns skeletal length and skeletal diameter
for each measured object. For each skeletal length a measurement row is added. This row is a line
measurement representing the skeletal length for the purpose of viewing feedback. The parent ID
column of the row representing the skeleton will reflect the ID of the source object.

Miscellaneous
Auto Analyze

Analysis may be performed on data to illustrate patterns and trends that are not immediately
apparent from the raw data. Analysis is performed in the Measurements item using the Analysis
dialog. Analysis protocols may be saved for reuse and Volocity is installed with some example
analysis protocols.
Use the Auto Analyze task at the end of a protocol to specify one of the saved analysis protocols to
use. When in place this task will generate the analysis selected when a Measurement item is
created. The command Make Measurement Item.... in the Measurements menu will generate a
Measurement item as will using a protocol containing the Auto Analyze task in the batch
measurement operation.
For more information on Analysis in Measurement items see page 475.

Calculate Object Colocalization
Colocalization in the context of digital fluorescence imaging can be described as the detection of
signal at the same voxel location in each of two channels. The two channels are made up of images
of two different fluorochromes taken from the same sample area.
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Calculate Object Colocalization will calculate the Pearson’s Correlation and colocalization
coefficients Mx and My for each object found by the series. Click on the cog icon to access the
secondary dialog and configure the task.

In the secondary dialog select the channels to be colocalized.
Thresholds are essential, enter the threshold intensity values for each channel. Voxels with intensity
values below the minimum threshold and voxels with intensity values above the maximum threshold
will be excluded from the calculations. Use minimum thresholds to remove intensities in each
channel that are not significant in determining colocalization.
Alternatively, configure the colocalization view for the data set before working with the
Measurements View and click Get settings from view to use these settings in the task.
To measure morphological and intensity information from objects include a Measure Objects task as
well as the Calculate Object Colocalization task. Configure the secondary dialog of the Measure
Objects task to record the required measurements.
See also the section on Colocalization starting on page 497.

Color Objects
When objects are found they are shown in the image area of the view using a colored overlay. By
default each separate object identified is given a different color. It may be useful when working with
objects to color them in a different way.

Use Color Objects in a series to apply a specific way of coloring a set of objects. Use anywhere
below a find object task but above any measure task.

Comment
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The comment task has no effect on object detection or measurement it may be used anywhere in a
measurement protocol to provide information. Use comments in saved protocols to explain to other
users what to do or why the protocol is created in a particular way.
Click on the cog to access the secondary dialog.

This allows the entry of free text. All the text entered here will be shown in the protocol, the task
resizes to fit.
For examples of the comment task in use see the saved measurements protocols available with
Volocity. Select Restore Protocol... from the Measurement menu and select any of the protocols in
square brackets.

Group Measurements
This task identifies a set of measured objects, points or lines by adding an additional measurement
column titled “Group” for each row of objects in the series. This column will be populated with
whatever is in the Name field. This column can be used to identify the measurements as a group,
even after tables have been exported as text.

Make ROI from Objects
This task can be used to convert a selection into a region.

Restore Objects
This task updates the selection to show any objects that have been retained as a set previously.

Retain Objects
This task retains the objects found by that point in the protocol in a temporary way solely during the
running of the protocol.
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Filling in the name field allows the set of objects to be used later, by for example Intersect and
Combine Objects tasks that process the output of one series of measurements tasks with the output
of a previous series that has been retained.

Track Objects
This task is unique to time resolved data. The Track Objects task will place itself at the bottom of
any protocol since objects must be found before they can be tracked.

The Measurements View only shows the protocol as applied to the current timepoint by default. It
may be useful to turn on Measure All Timepoints in the Measurements menu to preview all the
measurements over time and the tracks.
The Volocity tracking algorithms operate on centroid positions. A track is generated by connecting
centroids to trace the path of a moving object. Different models are used to identify the most likely
position for each object being followed in each timepoint.
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Click on the cog icon to access the secondary dialog for the Track Objects task. The Shortest Path
model attempts to create tracks based on the criterion that the chosen matches between the
populations of object centroids in any pair of timepoints have the minimum physical distance
between them.
The Trajectory Variation model uses the Shortest Path model to first establish a likely track for an
object between centroids in timepoint 1 and timepoint 2. The next centroid position of that object is
determined by that which is consistent in both direction and speed. This model should be effective for
objects that cross paths.
When the Trajectory Variation model is selected, the Trajectory Variation slider is used to alter the
sensitivity of the algorithm to variation. Restricting the algorithm to smooth tracks can result in no
tracks being found.
Other Options
n

If required, enable the Ignore static objects and Ignore new objects checkboxes.

n

Automatically join broken tracks is a feature that allows tracks to be continued, even if the
object was not detected in periods of up to two consecutive timepoints along the trajectory.
n

With Automatically join broken tracks off, the default setting, a track will terminate if a
timepoint is reached where no centroid can be found that is likely to be part of the track based
on the restrictions determined by the parameters entered in the Track Objects dialog.

n

When Automatically join broken tracks is on the tracking algorithm will join a partial track to
another partial track beyond the missing section as long as the whole track has a consistent
trajectory.

It may be appropriate to allow Volocity to Automatically join broken tracks where objects have
not been measured in all timepoints along their path length. An object may fail to be detected in a
timepoint because of factors such as noise or inconsistent illumination.
Users may also join tracks manually after the creation of a measurement item using the Join
Objects option in the Raw menu. See page 461.
n

Restrict track start position to ROI requires an ROI to be drawn on the image. When this
option is checked, tracks will only be measured if they start within the drawn ROI.

n

Maximum distance between objects must be set for both tracking models.
n

Estimate automatically: Volocity will calculate a maximum, effective matching distance to
use as an upper bound for possible motion tracking between timepoints in a sequence based
on the size of the dataset (¼ of the diagonal of the volume).
Volocity will then attempt to make a shortest path matching between the first two timepoints
using this calculated upper bound. The maximum distance between objects calculated for this
dataset is the average distance between all the matched object centroids in the first two
timepoints plus one standard deviation. This value is then used for the maximum distance
throughout the data set.
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n

Use this distance: Volocity will use the user-specified distance as the maximum limit for
matching object centroids between timepoints.

Tip: Establish a maximum distance to set by scanning the time series and choosing two timepoints
between which the greatest movement is apparent. Obtain a value to enter in the Track Objects
dialog by measuring this movement using the line tool. Adjustment to this distance can be made for
subsequent measurement, if required.
The tracking algorithm assigns a tracking ID to objects. If it determines that an object in a timepoint is
the same as an object in a previous timepoint, it gives that object the same ID. The track (or line
connecting all the objects with that ID) also has the same ID.

Manually Track Objects (Tools menu)
When it is not possible to use Volocity's automatic tracking algorithms to track moving objects within
a time-resolved data set, manual tracking will allow you to create track objects in a Measurement
item by manually marking the object location in each timepoint.
Open the image sequence containing the data you wish to track.
1. View the Image or Measurements View. These views allow use of the point and ROI tools which are
needed to mark object locations.
2. Select Manually Track Objects from the Tools menu.
3. Follow the instructions given by the Manual Tracking wizard.

Clear, Save, Restore and Export Protocol
n

Select Clear Protocol from the Measurements menu to remove a protocol from the
Measurements View without saving it.

n

Select Save Protocol… from the Measurements menu to save a protocol and use it again in the
future. Protocols are stored as preferences at user level.

n

Select Restore Protocol… from the Measurements menu to restore an existing protocol and use
it with the active Measurements View.
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You can also use this dialog to manage protocols. It allows renaming and deletion of existing
protocols. Use Import… to add a protocol exported as a settings file (.assf extension) to the
protocol on the system.
n

456 Improvision

To share protocols with other users, click Export… on either the Save Protocol dialog or the
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Import …button on the Restore Protocol dialog to bring in a protocol in the settings file format.
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Batch Processing Measurements
1. Select Measure… from the Tools menu.

2. Select the protocol to be applied to the selected items from the drop-down menu, which lists all
saved protocols by name.
3. Either, select Store the measurements in a new measurement item called: and enter a name for
the Measurement item that will contain all the measurements made by the selected protocol on the
selected items. Or, select Add the measurements to this existing measurement item: and
choose from the measurement items that already exist in the library. In this case, all the
measurements from all the selected items will be added to the measurements already in the table.
4. For each task in the protocol that operates on a specific channel (i.e. the Protocol dialog contains a
drop-down for channel selection when the task is configured), there will be an entry under Apply the
protocol’s tasks to these channels: The drop-down lists the unique channel names found within
the selected items. Channels with the same name will all be processed.
5. The Measurement item created will contain all the measurements made on all the selected items.
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Measurement Items
Make Measurement Item
Once you are happy with the measurements from points, lines and regions marked on the
Measurements View, use Make Measurement Item… from the Measurements menu to record
measurements.

Timepoints are selected in the image sequence timeline view or in the time navigation bar, if no
timepoints are selected the current timepoint is measured.
Volocity records measurements to the specified Measurement item. You can then view the
measurements as a table. This table has a number of views.
A Measurements item is also created when a saved protocol is applied to selected items in the
library (using the Measure dialog from the Tools menu).
Note: The FRAP Analysis... command in the Tools menu generates a measurement
item. Designed specifically for FRAP analysis this measurement item will appear different from one
created by other measurement actions in Volocity and you will interact with it differently. See “FRAP
Measurement Item” on page 516.
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There are now three stages that you can work through to extract patterns or trends from image data.
n

Organize and filter the raw data so that it is ready for analysis.

n

Analyze the raw data.

n

Chart the results.

Raw Data View
The initial table view shows the Raw measurement data.

There are a number of ways of organizing and filtering the raw data so that you can review it before
analysis.

Working with Columns
Column headings show which measurements were made. N/A in a column means the data is not
available. For example, if a session contains both line and region measurements, Total Length is
not a relevant measurement for a region so that column will have N/A against all region rows.
n

To reorganize columns click the column heading, drag it to its new position and release.

n

To sort columns click on the column heading—an arrow shows that the column is sorted and the
direction of the arrow indicates whether the sort order is ascending or descending. Click again to
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reverse the sort. For example: sort on the Name column to group together the same types of
measurement. Sort on the Voxel Count column to find the largest and smallest objects.
n

To change the width of a column click on the cell border and drag.

n

To resize all columns to fit contents, select Autosize Columns from the
Raw menu.

n

To hide/show columns select Columns… in the Raw menu.
All columns that can currently be shown will be displayed in the dialog.
To show a column, check the box corresponding to the column name
and click OK. (Click Hide All or Show All to uncheck/check all boxes
respectively.)

Filter
Set up filters to hide unwanted data. Quick filtering on the basis of type of measurement can be
achieved with the Filter drop-down. Choose to show just object measurements or just line
measurements.

For more advanced filtering select Filter... from the Raw menu or click on the filter button at the top
of the window.
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Filter out rows by selecting the column to filter on and entering values to select by. And/Or
expressions are permitted, as is the use of brackets.
Click on the Save... button to save a filter as a preference to easily access the same criteria again.
Once a filter is applied the number of filtered measurements is displayed. To cancel a filter open the
Filter dialog and click Clear.

Viewing Tracks
Tracks measured are added to the same Measurements item as the objects. Use the quick filter
drop-down to view only tracks.

Select a track row in the Measurements Item to show feedback of the track within the image data
that it came from. If that data is open to a view that supports feedback, the objects associated with
that track, objects with the same tracking ID, will also be shown as Measurements feedback.
Use the feedback options to show or hide the objects or to show the objects only in the current
timepoint. This is useful of you want to make a movie showing the objects moving along their tracks.

Extract or Merge Data
You can create new Measurements items from existing items by combining their contents.
Where applying a filter has created a new table that you would like to process further, use Extract
Filtered Data... from the Raw menu to create a new Measurement session containing just that data.
Name the new Measurement Item to be created.
To add the contents of the current table to a Measurement Item that already exists in the library use
Merge Data...This tool allows you create tables that are combinations of other data.
n

Remove duplicate rows will ensure that the same measurement is not repeated.

n

Merge similar rows will ensure that different measurement criteria, indicated by the column
heading, for the same object are kept in one row, not spread over two or more.

Join Objects
This feature can be used to join two or more objects, polylines or tracks. Any number of objects can
be joined.
Select the objects to be joined in the table and click Join Objects in the Raw menu. A new object will
be created in the table, consisting of the union of all selected objects.
Note that this object may be non-contiguous, that is, it may contain two distinct areas which do not
touch. However, for the purposes of measurement and feedback it is considered to be a single object.
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This new object will be re-measured, with all the appropriate measurements. Note that the previously
selected objects are not deleted or altered in any way.

Measured lines can also be joined using this command when two or more lines are selected in the
table. The ends of each line which are closest to each other are joined together, creating a single line.
This new line is added to the table and re-measured. Again, the previously selected lines are not
deleted or altered.
Finally tracks can also be joined, but only under certain circumstances. Two tracks which track an
object through the same timepoint cannot be joined. For example: if Track A tracks an object from
timepoint 1 to timepoint 5, and Track B tracks an object from timepoint 5 to timepoint 9, the tracks
cannot be joined, as they both track an object through timepoint 5.
If Track C tracks an object from timepoint 1 to timepoint 4, then it can be joined with Track B. The
tracks do not share a timepoint. If the tracks selected cannot be joined, the command will be disabled
in the Measurements menu. Any number of tracks can be joined, providing that no two selected
tracks share a timepoint.
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When two or more tracks are joined, a new track is created in the Tracking table. This track is
assigned a new Tracking ID, and is re-measured for length, velocity, etc. All objects which were
previously associated with the selected tracks are now only associated with the new track, and their
tracking IDs will all be reassigned to the new track.
Note that this does not delete or alter the tracks previously selected; however the objects previously
associated with them will now be associated with the new track instead.
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Exporting Measurements
Once you have created a Measurements table, you can also export the measurements. Select
Export from the File menu and select the required file format.

.

Feedback from the Raw View
If a row in the Raw View of a Measurement Item corresponds to a single measured object, its
location in the original image data can be shown using feedback. When the row is selected the object
will be shown using colored feedback in any open Image, Measurements or 3D View (if available) of
the data from which that measurement was made.
Select measurements in a view by clicking on a row, shift and click to select multiple rows.
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Open the corresponding image data, usually an image sequence, and the feedback will be shown.

To control how feedback is displayed:
n

Use the Feedback Options… command in the Measurements menu to define the feedback
display.

n

Use the Change Object Colors… command in the Raw menu to define the color of object
feedback.

November 2008 465

Feedback Options Dialog

Feedback Options Dialog
The Feedback Options dialog is tabbed, with one tab for each type of measurement object that may
be present in the table. The types available vary with different software products in the Volocity
family.
Each option changes how the feedback will be shown in views of the original data that support
feedback display.

Use these options to change how the feedback appears:
n

Show in current timepoint only is an option for viewing feedback within time resolved data.
When this option is checked only feedback that relates to measurements made from the current
timepoint will be shown. Changing the timepoint using the Navigation palette will change the
feedback so that only objects in the new timepoint are shown.

n

Show measurement will allow any of the measured parameters to be shown alongside the
colored shape that represents the measurement.

Note: Some options do not take effect for feedback shown in 3D views. All feedback in 3D views is
shown as solid isosurfaces.
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Change Object Colors
This dialog changes the color used to represent the selected objects with this dialog.
When Rainbow colors is applied, all selected objects or tracks will be colored according to their
position in the table. Objects at the top of the table will be colored red; objects further down the table
will step down through the visible spectrum, with objects at the bottom colored violet.
This feature can be used to color objects according to any attribute measured by Volocity. The
following example colors objects according to their measured volume.
1. Click on the header at the top of the Volume column to order all objects in the table by their
measured volume.
2. Select all the objects in the table that you wish to recolor and select Change Object Colors… in the
Measurements menu.
3. Select Use Rainbow Colors and click OK.
The color coding on the measurements feedback in the other views now reflects the objects’
measured volume.
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If Feedback is not Displayed
If feedback is not displayed as expected, check the item name column for the selected
measurements. The correct image data must be open.
Check the Feedback Options dialog to check that the feedback is prominent enough against the
image data.
Check the status of Show objects in current timepoint only. Use the Time Navigation controls to
move to the correct timepoint or uncheck this option to show all objects regardless of the timepoint in
which the object was measured.
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Measurement Definitions
To obtain measurements it may be necessary to add the relevant task to the measurement
protocol. To display measurements it may be necessary to change the columns that are
displayed. Select Columns... from the Measurements or Raw menu.
These measurements may be shown for any measurement type
Name

Name of the measurement

Type

Object, line, point or track

ID

Unique identifying number for this measurement.

Color

Color used to display this measurement in feedback.

Item
Name

Shown in Measurement items only. Records the name of the image or
image sequence from which the measurements were derived.

Timepoint

An indication of where in the time course of the image sequence the
measurement came from. Timepoints start at 1. Shown only when
multiple timepoints are measured.

Abs.
Time

Current time when the image (2D or 3D) was captured.

Rel. Time

Relative time for the image, the first timepoint is time 0:00.

The following measurements may be made or derived for objects measured.
Parent ID

Given to an object when a measurement operation is performed that
relates that object to another. The parent ID is the unique ID for the
associated object. Relate objects to the parent they are associated with
by organising by parent ID.

Track ID

Given to an object when the track objects task determines it to be part of
a track. The track ID reflects the unique ID for the track. Relate objects
to their track by organising by track ID.

Voxel
Count

Number of voxels which make up an object in 3D dataset.

Volume
(µm3)

Calibrated volume.
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Surface
Area
(µm2)

Total area of triangles fitted to the surface voxels of the data set.

Skeletal
length

This is the maximum length of the object. The selection is eroded evenly
from its border inwards until it consists of a one-voxel thick, skeletal
representation along its entire length. This "skeleton" is then measured.

Skeletal
diameter

The diameter of a cylinder if it had a length equal to the skeletal length of
the object and a volume equal to the object’s measured volume.

Pixel
Count

Number of pixels which make up an object in 2D dataset.

Area
(µm2)

Calibrated area.

Perimeter

Length of the boundary of the object.

Min

May be followed by channel name in brackets. Minimum intensity in gray
levels.

Max

May be followed by channel name in brackets. Maximum intensity in
gray levels.

Mean

May be followed by channel name in brackets. Mean intensity in gray
levels.

Sum

May be followed by channel name in brackets. Sum of intensity in gray
levels.

Min
(ignoring
zero
values)

Must be specified by a Measure Objects task. Will show minimum
grayscale intensity value ignoring any 0 values.

Max
(ignoring
zero
values)

Must be specified by a Measure Objects task. Will show
maximum grayscale intensity value ignoring any 0 values.

Mean
(ignoring
zero
values)

Must be specified by a Measure Objects task. Will show mean grayscale
intensity value ignoring any 0 values.
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Sum
(ignoring
zero
values)

Must be specified by a Measure Objects task. Will show sum
of grayscale intensity value ignoring any 0 values.

Centroid
X

Position of object centroid in X axis

Centroid
Y

Position of object centroid in Y axis

Centroid
Z

Position of object centroid in Z axis

Centroid
X (µm)

Calibrated position of object centroid in X axis.

Centroid
Y (µm)

Calibrated position of object centroid in Y axis.

Centroid
Z (µm)

Calibrated position of object centroid in Z axis.

Velocity

Measurement added by tracking. Speed of movement between previous
timepoint and current timepoint.

Velocity
(µm/s)

Calibrated velocity.

Distance

Measurement added by tracking. Distance moved by this object between
previous timepoint and current timepoint.

Distance
(µm)

Calibrated distance.

Delta2

Displacement squared. The square of the straightline distance between
the object position in this timepoint and the object position in the first
timepoint.

Delta2
(µm)

Calibrated displacement squared. Use with analysis tools to calculate
mean square displacement for all objects with the same track ID.
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Angle
(degrees)

Calculated for tracked objects only. A measure of the spatial relationship
between the vector of the straight line displacement between this point
and the start point of the track and the vector 0,-1,0 (up). The angle of the
shortest distance between these two vectors. Ranges from 0 to 180. 0
means pointing "up the screen", along the Y axis. 180 means pointing
"down" the screen.

Bearing
(degrees)

Calculated for tracked objects only. A measure of the spatial relationship
between the vector of the straight line displacement between this point
and the start point of the track and the vector 0,-1,0 (up). The angle
disregarding the Z component. Ranges from 0 to 360. 90 means pointing
"right", along the X axis. 270 means pointing "left", negatively along the X
axis.

Elevation
(degrees)

Calculated for tracked objects only. A measure of the spatial relationship
between the vector of the straight line displacement between this point
and the start point of the track and the vector 0,-1,0 (up). The angle in
relation to the XY plane. Ranges from -90 to 90. -90 means straight
down paraleel to the Z axis, 0 means parallel to the XY plane, 90 means
up, parallel to the Z axis.

The following measurements may be made or derived for tracks
Length

Total length of the track in pixels.

Length (µm)

Calibrated length of the track.

Time span

Number of timepoints over which the track extends.

Track
velocity

Average speed over the whole track.

Track
velocity
(µm/s)

Calibrated average speed over the track.

Displacement

Straight line distance from the first position in the track to the last.

Displacement
(µm)

Calibrated displacement.

Displacement
rate

Displacement/(time of the last time point in the track – time of the first
time point in the track)
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Displacement
rate (µm/s)

Calibrated displacement rate.

Meandering
index

This is the displacement rate / velocity, which provides a measure of
a track’s deviation from a straight line. The meandering index is
always a value less than or equal to 1. A meandering index of 1
indicates that the track is a perfect straight line; the smaller the value
of the meandering index, the greater the meandering of the track.

Angle
(degrees)

A measure of the spatial relationship between the vector of the
displacement of the track and the vector 0,-1,0 (up). The angle of the
shortest distance between these two vectors. Ranges from 0 to 180.
0 means pointing "up the screen", along the Y axis. 180 means
pointing "down" the screen.

Bearing
(degrees)

A measure of the spatial relationship between the vector of the
displacement of the track and the vector 0,-1,0 (up). The angle
disregarding the Z component. Ranges from 0 to 360. 90 means
pointing "right", along the X axis. 270 means pointing "left", negatively
along the X axis.

Elevation
(degrees)

A measure of the spatial relationship between the vector of the
displacement of the track and the vector 0,-1,0 (up). The angle in
relation to the XY plane. Ranges from -90 to 90. -90 means straight
down paraleel to the Z axis, 0 means parallel to the XY plane, 90
means up, parallel to the Z axis.

The following measurements may be made for lines
Length

Length of the line in pixels.

Length
(µm)

Calibrated line length.

Population
ID

Group that lines belong to. Lines of the same color have the same
population ID.

Start
position

Must be specified by a Measure Lines task. Records start position of
the line.

End
position

Must be specified by a Measure Lines task. Records end position of
the line
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Start
position
(µm)

Calibrated start position.

End
position
(µm)

Calibrated end position.

Parent ID

Specified by a Measure Line Profiles task. The ID number of the line to
which the sample point belongs. Relate sample points to the line they
are associated with by organizing by parent ID.

Intensity

Specified by a Measure Line Profiles task. The interpolated intensity
value at the sample point.

Distance

Distance from the start of the line in pixels.

Distance
(µm)

Calibrated distance.

Normalized
Distance

Specified by a Measure Line Profiles task. Distance from the start of
the line normalized to a total line length of 1.

Channel

Specified by a Measure Line Profiles task. Shown when measuring line
profiles on multi channel data sets only. This column contains the
name of the channel the intensity measurement was made from. In a
multi-channel data set there will be a complete set of sample points for
each channel.

The following measurements may be made for points
Position X

Position of the point in X axis.

Position Y

Position of the point in Y axis.

Position Z

Position of the point in Z axis.

Position X
(µm)

Calibrated position of the point in X axis.

Position Y
(µm)

Calibrated position of the point in Y axis.

Position Z
(µm)

Calibrated position of the point in Z axis.
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Analysis View
Click on the Analysis tab of a measurement item to work with the data and organize it in different
ways. The reorganized data will be shown in this view. Some saved analysis protocols are installed
with Volocity, select from the list in the view or click More protocols... to see all saved protocols.

Select Analyze... from the Analysis menu to open the dialog that will allow you to perform this
powerful organization.
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Analyze these data: The drop-down shows all the measured criteria available for the objects in the
Raw table, select one as the subject of analysis. If the analysis is to look at intensity over time, select
a column containing intensity values. Multiple items may be selected from the list.
Summarized by: Choose from Value, Mean, Sum, Product, Count, Min/Max, Variance/SD. Select
multiple summaries if required.
Organize the data by: Select other measured criteria from the raw table to show the relationship
between those criteria and the subject of the analysis selected in Analyze these data: If the analysis
is to look at intensity over time, select the time or timepoint column here.
It is possible to organize the data by up to three criteria, rows, columns and pages.
In the Organization tab Grouped into bins will allow you to divide the rows, columns and/or pages
into groups to best present the data.
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Data filtered out of the Raw View will not be included in analysis but the filter may be edited at any
time by selecting Filter... from the Analysis menu or clicking on the filter button at the top of the
screen.
Normalize
Once the analysis table has been populated it is possible to recalculate values using to be
normalized to values in the table. This means all values in all other rows will be recalculated as a
proportion of the corresponding value. Select the row or column to normalize to and whether this is
to be considered as 100% or 1.

The Analysis menu contains options for working with the analysis table created.
Extract Analyzed Data... creates a new Measurement item containing just the
analyzed or reorganized data, which can be analyzed further.
Merge Data... adds the analysis table to an existing measurement item.
Remove duplicate rows ensures that the same measurement is not repeated.
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Merge similar rows ensures that different measurement criteria, indicated by the column heading,
for the same object are kept in one row, not spread over two or more.
This could be used to combine two or more different analysis methods in one table. The result of one
way of organization is extracted to a new measurement item then the original item reorganized and
the result merged with the item created in the first step.
Change the appearance of the tables shown in this view by using the options for columns in the
Analysis menu.
n

To re-organize columns click the column heading, drag it to its new position and release.

n

To sort columns click on the column heading—an arrow shows that the column is sorted and the
direction of the arrow indicates whether the sort order is ascending or descending. Click again to
reverse the sort. For example: sort on the Name column to group together the same types of
measurement.

n

To change the width of a column click on the cell border and drag.

n

To resize all columns to fit contents, select Autosize Columns

n

To hide/show columns select Analysis or Raw Columns… in the Analysis menu.
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Analysis Examples
Find the Total Number of Objects Measured
A measurement item Raw View contains one row of information per object. In the following example
a protocol was applied to five image sequences and the table contains over 32000 measurements.

To find the total number of objects measured in each of the image sequences the Analysis dialog in
the Analysis View is configured as follows:
n

Analyze this data: ID. Anything that has been measured for each item could be used here.

n

Summarized by: Count. The total number of IDs and therefore the total number of objects.

n

Row: Item Name. Show the name of the library item to organize the data by image sequence.

n

Column: Not required.

n

Page: Not required.

November 2008 479

Analysis Examples

The Analysis View looks like this:
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The analysis table arranges the data for a chart. This table could be displayed as a bar chart:

Find the Total Number of Objects Measured per Timepoint
Using the same table of data as the previous example, to find the total number of objects measured
per timepoint. the Analysis dialog in the Analysis View is configured as follows:
n

Analyze this data: ID. Anything that has been measured for each item could be used here.

n

Summarized by: Count. Generate a count of the total number of unique IDs and therefore the
total number of objects.

n

Row: Timepoint.

n

Column: Not required.

n

Page: Not required.
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The Analysis View looks like this:
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Find the Mean Intensity of Objects per Timepoint per Image Sequence
Using the same table of data as the previous example, to find out whether there is a pattern to
intensities of objects dependent on timepoint and experiment, the Analysis dialog in the Analysis
View is configured as follows:
n

Analyze this data: Mean Intensity. Where more than one channel has been measured in the
data set choose the mean intensity column for the channel of interest.

n

Summarized by: Mean. If multiple objects have been measured in every timepoint this will
present the mean of the mean intensities.

n

Row: Timepoint.

n

Column: Item Name. The Item Name is the name of the image sequence so there will be one
column for each image sequence measured.

n

Page: Not required.
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The Analysis View looks like this:

Mean Number of Objects per Cell
Objects have been measured to identify those that are within measured cells. Objects have been
given a Parent ID according to the objects they are found within, using Internalize Measured
Objects in a measurement protocol.
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To find out how many objects are within each of the larger objects, the analysis dialog is configured
as follows:
n

Analyze this data: ID. Anything that has been measured for each item could be used here.

n

Summarized by: Count. The total number of IDs and therefore the total number of objects.

n

Row: Parent ID. Organize the objects by the ID of the object they were found within.

n

Column: Not required.

n

Page: Not required.
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The Analysis View looks like this:

486 Improvision

VOLOCITY Quantitation Reference

Chart Line Profiles
The Measure Line Profiles task creates a data table consisting of intensity measurements for each
sample point along each line.
In this example one line has been measured on a three channel dataset.

In the analysis we wish to see the intensity at each distance from the origin of the line in each of the
three channels. This example is available in the saved protocols. The analysis dialog is configured:
n

Analyze these data: Intensity

n

Summarized by: Value

n

Row: Distance

n

Column: Channel

This creates an analysis table which may be charted as below:
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If multiple lines had been drawn displaying the profile for all the lines on the same chart would be
achieved by configuring the analysis dialog as:
n

Analyze these data: Intensity

n

Summarized by: Value

n

Row: Distance

n

Column: Parent ID

If multiple channels are present in the data the profiles for all the lines could be compared per
channel by setting Page: Channel or display all channels for each line on a separate page in which
case Column: Channel and Page: Parent ID.
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Show Changes in Intensity with Object Volume
n

Analyze this data: Mean. For a single channel data set this represents the mean intensity of each
object.

n

Summarized by: Mean

n

Row: Volume. Since there are many volumes represented in the table, showing each one
individually will be excessive data to process. Rows, Columns and Pages may all be shown
grouped into bins to prepare data in the style of a histogram. In the Organization tab group rows
into bins, using a size appropriate for the data distribution.

n

Column: Not required.

n

Page: Not required.
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Show Changes in Object Velocity over Time
Track objects using a measurement protocol containing the Track Objects task. An example is
included in the saved protocols installed with Volocity. Object tracking measures not only an average
Velocity for the whole track, shown in the Raw View in the Track Velocity column but also each
object velocity from one timepoint to another. These velocities may be analyzed to illustrate the
nature of the object movement over the time course of the experiment. This example is also
included in the saved analysis protocols.

The Analysis dialog is configured as follows:
n

Analyze this data: Velocity.

n

Summarized by: Value.

n

Row: Relative Time. Time may be absolute, relative or by timepoint.

n

Column: Track ID. All the objects that make up a track are related to each other by the Track ID.
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n

Page: Not required.
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This could be illustrated in a line chart. The following chart indicates that the objects accelerate and
decelerate throughout the experiment.
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Chart View
The Chart View shows a graphical representation of the data in the analysis table. To generate a
chart:
n

First, set up an analysis table in the Analysis View.

n

Then click on the Chart tab.

To configure chart style and appearance select Chart... from the Chart menu or click on the chart
button at the top right of the window.

The chart will show only data that is not filtered out. Edit the filter from the Chart View by selecting
Filter... from the Chart menu or clicking on the filter button at the top right of the window.
The Analysis table which is being represented in the chart can also be changed without returning to
the Analysis tab. Choose Analyze... from the Chart menu or click on the analyze button at the top
right of the window.
Exceptions to this description are the Track Charts. These are examples of special case charts
where the information required to generate them is extracted directly from the raw data in the Raw
View. When working with tracks click directly on the Chart tab to view XY or XYZ Tracking Charts
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Available chart types are:
n

Bar - compare values across categories

n

Stacked Bar - compare contribution of a value to the total across categories

n

100% Stacked Bar - compare percentage contribution across categories

n

Line - display trend across categories

n

Stacked Line - display trend of contributions to the total across categories

n

100% Stacked Line - display trend of percentage contributions across categories.

n

XY (Scatter) - compare pairs of values

n

Pie - display contribution of each value to total

n

Horizon - compare values

n

XY Track - display XY positions over time

n

XYZ Track - display XYZ positions over time

To keep an image of the chart select Capture Snapshot from the Chart menu. A 2D image of the
chart will be added to the library. This may be exported in any of the formats for 2D images.
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Chart Examples
For each chart type configuration options are offered for style, series, category axis and value axis.
Style: A wide range of styles is available and each style has a number of user configurable options.
The following examples illustrates options for a bar chart.

Series: To change the series style, select Series from the Edit Chart dialog. Color and pattern may
be changed, as required.
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Category Axis: To change the categories, select Category Axis from the Edit Chart dialog. Axis
scale limits and divisions may be changed, as required.

Value axis: To change the categories, select Category Axis from the Edit Chart dialog. Axis scale
limits and divisions may be changed as required.
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Colocalization
Colocalization is part of the Volocity Quantitation product designed specifically for Colocalization
analysis as described by Manders et al (1993).
Colocalization in the context of digital fluorescence imaging can be described as the detection of
signal at the same voxel location in each of two channels. The two channels are made up of images
of two different fluorochromes taken from the same sample area.
Colocalization calculates measurement statistics based on the voxels and their intensity. It provides
the user with a tool for evaluating how similar the images from two channels are. It provides a
separate Colocalization view that shows:
n

An extended focus merge of the two channels as a preview

n

A scatter plot that represents the intensity values found within the images

n

Statistics, which consist of Pearson’s Correlation and Overlap Coefficients for the whole image
and Colocalization Coefficients for regions of interest drawn on the scatter plot

n

Any thresholds that have been applied to the data

The Colocalization View has a tool bar and a view specific menu. These are both used when working
with the view.

Colocalization menu

Colocalization tool bar
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The Colocalization View

scatter
plot
preview

statistics

thresholds

Preview
This is an extended focus merge of the two channels selected in the Channel X and Channel Y dropdowns. The current timepoint is shown and controlled by the time navigation controls.
Show the absolute or relative timestamp of the current timepoint in the preview by selecting Show
Time from the Colocalization menu.
The following tools from the tool bar may be used on the preview image: rectangular, freehand,
circular, magic wand and lasso ROI tools, zoom and pan.

498 Improvision

VOLOCITY Quantitation Reference

Colocalized voxels selected in the scatter plot are shown using colored feedback in the preview. Use
View Options… in the Colocalization menu to change the color and opacity of this feedback.

Scatter Plot
Each axis represents the ascending gray levels present within the two analyzed volumes. The axis is
assigned according to the drop-downs at the top of the view.
For example: if a voxel in image x has an intensity value of 100 and the corresponding voxel in
image y has an intensity value of 30, a point will be plotted at co-ordinates 100,30. It does not matter
how may voxels in the two channels have intensity values of 100,30; only one point will be plotted on
the scatter plot.
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Two perfectly colocalized images, i.e. identical, will generate a scatter plot where the points fall in a
line at 45 degrees to either axis.

Thresholds
There are three ways of setting thresholds:
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n

Use the ROI tool to draw a region of interest on the Preview. Select Set Thresholds from ROI
from the Colocalization menu. Volocity calculates the mean intensity of the ROI for each channel
and sets it as the minimum threshold value for that channel.

n

Enter the required values manually into the Threshold Maximum and Minimum boxes for each
channel or drag the slider controls on the scatter plot. You will be able to see where voxels have
been excluded on the scatter plot. As the thresholds are set voxels outside the threshold are
excluded from the image preview on the left. Set thresholds carefully so that background voxels
are excluded, leaving only voxels that include genuine signal.
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n

Select Automatic Thresholding from the Colocalization menu to generate thresholds
automatically. Volocity uses statistical tests to set thresholds objectively. Automatically calculating
thresholds will take time, and this time will increase with increasing dimensions of the data set.
Turning automatic thresholding on disables manual setting of thresholds and Set thresholds
from ROI. For multi-timepoint data sets, Volocity will recalculate thresholds for each timepoint
viewed. Change the current timepoint using the Navigation palette.

Any voxels of intensity outside threshold will be removed from the preview image for that channel.
Any point on the scatter plot that is outside threshold for either channel will be removed from the
scatter plot leaving only points that are positive for both x and y, i.e. colocalized.
If thresholds are not set, voxels where both images show background intensity levels will contribute
to the generation of colocalization statistics, this may make your channels appear be have a better
correlation coefficient than is actually the case.
Automatic Thresholding
The aim of the Automatic Thresholding is to determine thresholds that exclude voxels for which
Pearson’s Correlation between the two channels is less than, or equal to, 0. It is a two-step process.
First, a best-fit regression line of the Channel X and Channel Y intensities over all the voxels is found.
Second, the thresholds are moved along the regression line until the point is reached where
Pearson’s Correlation for voxels below threshold is less than, or equal to, 0. This technique is based
on the method proposed in:
S. V. Costes, D.Daelemans, E. H. Cho, Z. Dobbin, G. Pavlakis & S. Lockett
Automatic and Quantitative Measurement of Protein-Protein Colocalization in Live Cells
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Biophysical Journal 2004 Vol. 86, pp. 3339-4003
Automatic Thresholding is turned on or off by selecting Automatic Thresholding from the
Colocalization menu. It is possible that Automatic Thresholding may not be able to determine
thresholds for a data set, in which case a message is shown. Automatic Thresholding may determine
different thresholds depending on the data set; therefore, it should not be used if the same
thresholds are to be applied across a series of data sets or timepoints within the same data set.
Any voxels of intensity outside threshold will be removed from the preview image for that channel.
Any point on the scatter plot that is outside threshold for either channel will be removed from the
scatter plot leaving only points that are positive for both x and y, that is colocalized.
If thresholds are not set, voxels where both images show background intensity levels may be
interpreted as colocalized.
Restricting Analysis to Regions of Interest

An ROI, or multiple ROIs can be drawn on the preview. When ROIs are present the statistics
generated will be based on only those voxels that are both within the ROI and within the thresholds.
This allows you to compare different cells or structures within your image sequence.
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Statistics
While Volocity is generating the scatter plot and calculating statistics a progress indicator is shown in
the top right-hand corner of the view.
The statistics presented in the Colocalization window are calculated as follows:

xi = intensity of voxel i in image unless xi is outside threshold in which case xi = 0
yi

= intensity of voxel i in image y unless

yi

is outside threshold in which case

∑ (x − x
i

Pearson's Correlation =

yi =0

aver

) • (yi − yaver )

aver

)2 • (yi − yaver )2

i

∑ (x − x
i

i

Pearson’s Correlation is a statistical test for a linear relationship between two variables. Pearson’s
Correlation can vary between –1 and 1. A correlation of 0 means there is no linear relationship
between the variables. –1 and 1 indicate perfect negative and perfect positive linear relationships
respectively. Interpreting the degree of colocalization from negative values is difficult.
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The overlap coefficient will give a result between 0 and 1. The use of this coefficient may be limited
because it assumes intensities in both channels are the same.
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Each of the split overlap coefficients is sensitive to variation in intensity of the other channel.
Manders et al. defined two further overlap coefficients:
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∑x
∑x

i,coloc

Colocalization Coefficient (Mx) =

i

i

i

∑y
∑y

i,coloc

Colocalization Coefficient (My) =

i

i

i

Where

xi,coloc = xi if yi is within the intensity range defined by the ROI, xi,coloc = 0 if yi is

outside the intensity range and
ROI,

yi,coloc = yi if xi is within the intensity range defined by the

yi,coloc = 0 , if xi is outside the intensity range.

Colocalization Coefficients may be values between 0 and 1. 0 indicates that none of the signal within
thresholds in that channel exists as colocalized with the other channel. A value of 1 indicates that all
of the signal within thresholds in that channel exists as colocalized with the other channel.
The Measure Object Colocalization task calculates Mx and My for the voxels present within objects
selected by the rest of the protocol. The earlier stages of the protocol find objects. Mx and My are
calculated for those objects. The calculation on the voxels in each object is therefore:
sum of intensities of colocalized voxels within threshold range/ sum of intensities of voxels
(colocalized and not colocalized) within threshold range.
For further explanation of these statistics see the following references:
M.M. Manders, P. J. Verbeek & J. A. Aten
Measurement of co-localization of objects in dual colour confocal images
Journal of Microscopy 1993 Vol. 169, pp. 375-382

Generating Output
There are two methods for generating output using the principles of the Colocalization View:
n

Generate Colocalization, which can be set up to generate a field statistics measurement, a
scatter plot, a colocalization channel, a merged channel, and PDM channels for all timepoints.
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n

Calculate Object Colocalization task used in a measurement protocol, which measures the
Pearson’s correlation coefficient and colocalization coefficients Mx and My for each object and
displays them in the table area of the Measurements View.

Generate Colocalization
Select Generate Colocalization from the Colocalization menu and choose the required output. This
will be generated for all timepoints in the image sequence.

Field statistics are measurements recording the co-localisation statistics of the voxels included in
your analysis. Each time point in your image sequence will have a row devoted to it in the field
statistics measurement item.
n

The scatter plots are saved to a folder in the current library. Each scatter plot is stored as a 2D
image and may be exported.

n

A Colocalization channel is made from any voxels that are selected with a ROI on the scatter plot.
These voxels are marked in the Colocalization view preview with the colored overlay. The
channel is produced from a brightest point merge honoring the color and intensity of those voxels
in the original channels.

n

A merged channel is made by generating a color channel with contributions from each of your
analyzed channels. Merged channels such as this are often used for simple red plus green gives
yellow (in areas on colocalization) visual analysis of colocalization. We recommend that you only
use this channel for simple visual illustration purposes.

n

PDM channels are generated by calculating the product of the difference from the mean for each
voxel from the two channels analyzed. For two channels, X and Y the following calculation is
performed at each voxel:

PDM = (Xi – Xmean) • (Yi-Ymean) Where Xi is the intensity of the voxel for channel X and Yi is the
intensity of the voxel for channel Y.
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Volocity generates two PDM channels, a positive channel which is colored yellow, and a negative
channel which is colored purple.
Voxels for which both Xi and Yi are above the mean show positive correlation and are included the
positive (yellow) PDM channel.
Voxels for which either channel is below the mean whilst the other channel is above the mean show
negative correlation (exclusion) and are included in the negative (purple) PDM channel.
Voxels for which both channels are below the mean are not displayed in the PDM channels.
Although the negative PDM channel is derived from negative values, all the voxels in this channel
are displayed as positive values.
Both PDM channels are floating point channels, the highest possible PDM value is calculated by
performing the PDM calculation ((Xi – Xmean) • (Yi-Ymean)) with all possible combinations of the highest
and lowest voxel values in the two channels, regardless of whether the voxels with these extreme
values are actually co-localized or not. The greatest possible value generated from the extreme
values is normalized to 1, all the voxels in the PDM channels are displayed according to this scale.
The white point of both PDM channels is set to 1, the black points are set to 0.
The PDM channels are intended to give a clear visual display of areas and degree of positive
correlation (in yellow) and areas and degree of negative correlation in (in purple).
If both channels show random distributions both PDM channels should look dark.
A template channel is generated if your analysis was restricted to a ROI in the preview. The overlay
is intended to clearly illustrate which voxels were included in the analysis. Voxels with a value of 0 in
the template channel were included in the analysis, voxels with a value of 255 in the template
channel were excluded from the analysis.

Red and Green merged image

Positive PDM image
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Measure Object Colocalization
Use this task within a measurement protocol in the Measurement View. Find objects using tasks
added to the protocol and then add Measure Object Colocalization to find PCC, Mx and My for each.
As discussed above, it is essential to set thresholds for each channel and the Measure Object
Colocalization task allows thresholds to be set. Alternatively, after configuring the Colocalization
View the settings in the view may be read into the task.
Calculate Object Colocalization
Use this task within a measurement protocol in the Measurement View. Find objects using tasks
added to the protocol and then add Calculate Object Colocalization to generate Pearson’s
Correlation, Mx and My for each. As discussed above, it is essential to set thresholds for each
channel and the Measure Object Colocalization task allows thresholds to be set. Alternatively, after
configuring the Colocalization View the settings in the view may be read into the task.

Important Considerations
It is important to have adequate separation of the two fluorescence signals, with no overlap between
emission of one and excitation of the other. This affects choice of filters as well as fluorochromes
themselves.
Colocalization can only analyze the voxel values presented in the selected images. It is the user’s
responsibility to ensure the images are valid for the study they are carrying out.
Users may wish to deconvolve images before processing. Iterative Restoration is appropriate for this
application since it preserves voxel intensity values, see page 540.
Colocalization assumes that there has been no voxel shift between the capture of the two channels
and that they are perfectly aligned. Adequate controls are also essential to avoid the possibility of
false colocalization, for example generated by non-specific labeling.

FRAP Analysis
Carrying Out FRAP Analysis
Only data that has been acquired with Volocity FRAP Acquisition may be analyzed with Volocity
FRAP Analysis.
Prior to carrying out FRAP analysis you should consider applying the following corrections to your
FRAP recovery data:
n

Background correction

n

Photobleaching correction

Background Correction
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Volocity provides a flexible background correction tool that allows you to correct images based on
either division of images with a bright reference image, subtraction of a dark reference image or
subtraction of fixed offset values from images (for more details please Correcting Background).
If you wish to apply background correction to your FRAP image sequences, acquire any correction
images that you require and create your background correction item in your library. Select the
images that you wish to correct and apply background correction from the Tools menu.
Photobleaching Correction
The Volocity photobleaching correction tool corrects for photobleaching by applying correction
factors to images that restore their intensity to the intensity of the first image in an image sequence.
Without photobleaching correction it is likely that you will get an underestimation of the mobile
fraction from you FRAP analysis.
There are two methods of applying photobleaching correction. Apply whichever is appropriate for
your experiment.
n

Based on a region of interest. To apply a correction based on a region of interest you must
have your image sequence open in the Image View. Select an ROI and then select Correct
Photobleaching… from the Tools menu. Make sure that you select the appropriate channel for
correction.

When photobleaching correction based on an ROI is applied Volocity multiplies the whole image
by whatever correction factor is required for each time point to keep the ROI at 100% intensity
throughout the image sequence. Because it requires an ROI to be selected it cannot be used to
batch correct multiple channels.
n

Based on the whole image. Select Correct Photobleaching… from the Tools menu. Make
sure that you select the appropriate channel for correction. Volocity multiplies the whole image by
whatever correction factor is required for each time point to keep the whole image at 100%
intensity throughout the image sequence. Photobleaching correction based on the whole image
does support batch processing. To batch process several image sequences, select them in your
Volocity library before selecting Correct Photobleaching… from the Tools menu.

Normalization
You may include as many data sets as you wish in a single FRAP analysis. So that multiple data sets
can be pooled, Volocity normalizes FRAP data by setting the intensity of bleach areas in the last
frame before bleaching to 1 and by setting the intensity in the first frame after bleaching to 0, all
intensity measurements are then made according to this scale.
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Select the image sequences that you wish to include in your analysis and select FRAP Analysis…
from the Tools menu.
FRAP Analysis

1. Select the channel on which FRAP analysis is to be performed.
4. Select the appropriate bleaching mask channel; this is the FRAP template channel created when we
acquired the image sequence (the correct mask channel should be selected by default provided that
the channel names have not been changed).
5. Select the appropriate equation.
n

The Single Exponential equation is appropriate for a single binding state (see Sprague and
McNally (2005) for further information on single binding states).

n

The Single Constrained Exponential equation is appropriate for a single binding state where you
wish to constrain the curve fit to have a value of 0 at time 0, i.e. pass through the origin.

n

The Double Exponential equation is appropriate for two binding states or more complex transfer
barriers. However, be aware that this equation will fit almost all recovery curves and does not
necessarily indicate two binding states for your molecule of interest (see Spague and McNally
(2005) for further information on two independent binding states and the caution required to use
this equation).

n

The Soumpasis analytical solution (Soumpasis1983) provides a solution for pure diffusion.

n

Specify a name for the measurement item in which to store the result and click Analyze. When
analysis is complete your measurement item will automatically open in the Chart view.

References
Axelrod D, Koppel DE, Schlessinger J, Elson E and Webb WW (1976)
Mobility measurement by analysis of fluorescence photobleaching recovery kinetics. Biophys.

J.16:1055-1069
Soumpasis D.M. (1983)
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FRAP analysis of binding: proper and fitting. Trends in Cell Biology. 15:84-91

FLIP Analysis
As with FRAP analysis, you may wish to background correct and photobleaching correct your image
sequence before analysis.
. An image sequence making up a FLIP experiment consists of three elements:
n

a bleached area of interest

n

a non- bleached area of interest. The experiment is to determine whether the molecules are
moving between the two areas and at what rate.

n

A control cell or region of interest from a compartment that is not connected to the bleached
areas in any way.

1. Open your image sequence in the measurements view.
6. Select ROIs for analysis. In this case ROI A may be connected to the bleach area (mobile molecules
would be free to diffuse between the bleach area and ROI A), but ROI B can not possibly connected
to the bleach area. A dramatically higher bleach rate for ROI A than ROI B would demonstrate that
molecules are freely diffusing between ROI A and the bleach area.
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7. Select Measure all timepoints from the Measurements menu.
8. Select Create measurements item from the Measurements menu.
9. Name your measurements item and click OK.
10. Open the measurements item and select the Analysis tab. Select Analyze from the Analysis menu.
The Edit Analysis dialog opens.
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Set the Analysis dialog as follows:
n

Analyze these data = Mean

n

Summarize by = Value

n

Row = Timepoint

n

Column = Name

n

Page = None

11. In the Normalize tab check the Normalize to data, and select timepoint 1 from the drop down menu.
This results in intensity values being calculated as a percentage of their initial values. This makes
changes in intensity clearer, and makes comparison of the intensity changes in the two areas
possible.
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12. Click OK.

13. Your Analysis now contains four columns. Two with raw intensity values over time and two with
normalized intensity values over time. So that you plot only the normalized values hide the columns
containing raw values. Select Analysis Columns… from the Analysis menu and uncheck the boxes
corresponding to the raw values (leaving the boxes that correspond to normalized values checked)
and click OK.

14. Select the Chart Tab.
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15. Select the Setup Chart button
16. In the Edit chart dialog set the chart to “Line” and click OK.

In our example we can see that ROI A (plotted in Red) loses fluorescence in comparison to ROI B
(plotted in blue). This demonstrates that the fluorescence material in ROI A is able to move freely
into and out of the bleaching area, unlike the material in ROI B which can never enter the bleaching
area. In this case photobleaching was corrected based on a third ROI, which was unconnected to
ROI A or B.
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The same analysis without photobleaching correction is shown below. Even without photobleaching
correction fluorescence is clearly lost at a much higher rate in ROI A (red) than ROI B (blue).

FRAP Measurement Item
The FRAP Analysis... command in the Tools menu generates a measurement item. Designed
specifically for FRAP analysis the information in this measurement item will be laid out in a different
way compared to one created by other measurement actions in Volocity and you will interact with it
differently.
The Chart View provides the most accessible view of the results. The FRAP measurement item will
open to the Chart View by default.
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FRAP charts show the normalized recovery for each of your bleached areas (each recovery is
plotted in its own color and style), as well as the best fit curve (shown with a line joining each point by
default).
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Parameters that are displayed either graphically or in the legend are shown in the table below.
Parameter

Method of Calculation

Chart or Legend

T /2

Time taken for the intensity of the
bleached area to recover to half of
the plateau intensity

Both

Mobile
Fraction (Fm)

Normalized intensity at plateau

Both

Immobile
Fraction (Fi)

Normalized pre-bleach intensitynormalized intensity at plateau

Both

1

Diffusion
Coefficient (D)

Legend

Fitted
Equation

Equations are fitted to the raw data
using the least squares method

Legend

TD
(Characteristic
diffusion time,
Soumpassis
equation only)

Derived by fitting the Soumpassis
equation to the raw data

Legend

Reference

Axelrod et al 1976

Soumpassis 1983

For a more detailed view of the normalized intensity values from your recoveries as well as the curve
fitted recovery values select the Raw tab. Note the Rel Time column; this represents the time relative
to the first frame to be acquired after bleaching, which is set to 0.
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Ratio Analysis
Volocity ratioing allows you to carry out offline analysis of ratioed pairs of images. It requires an
image sequence containing at least two channels. The channels must be the same depth but may be
8-bit, 16-bit or floating point. The ratio is always calculated as Channel A / Channel B, therefore, it is
important to specify the channels correctly in the Ratio dialog.

Applying Ratio Calculation
1. Open an image sequence containing 2 or more channels.
2. Choose Ratio… from the Tools menu. The ratio option is available when any of the tabs in the image
sequence are active, but working from the Image View allows you to use an ROI drawn in that view
to set background values for subtraction.
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preview window
and multiple
timepoint play
controls

3. Select which channels in the image sequence should be used for Channel A and Channel B. A
constant background value may be subtracted from every voxel in every image of each channel, if
required. If source images are already background subtracted, go to step 4.
Note: Subtraction of a background constant is relevant only if the source images are evenly
illuminated.
Enter a value in the Subtract field or draw an ROI on the Image View before opening the Ratio
dialog and click Get from ROI next to the Subtract field. Volocity will use the mean intensity from that
ROI for each channel as the value to subtract. This value will be subtracted from the intensity value
of every voxel before processing the ratio calculation.
4. Set threshold values for each channel by typing a value in the Threshold field. Thresholds allow
removal of signals that would interfere with interpretation of results.
For example, there will be areas in the images where low intensities in each of the A and B channels
produce similar ratio values to higher intensities in other areas. Thresholds will mean a result of 0
(zero) is set when one of the source voxels has an intensity at or below the threshold.
Use the Voxel Spy to pick out an exact threshold value or ask Volocity to Calculate the value for you.
The calculate option determines the modal intensity value for the channel and uses it as the
threshold.
5. You may wish to apply rainbow colors to the ratioed channel. Check the Apply a rainbow LUT to
the ratio channel. To optimize the use of the rainbow across the range of ratio values present within
the results enter Display R minimum and Display R maximum values. This allows the finite range
of colors available in the lookup table to be used to illustrate most effectively any changes in the ratio
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values. Click Calculate and the maximum and minimum ratio values for the current timepoint will be
used. To easily compare ratio images with rainbow colors applied, they should all have the same
Display R minimum and Display R maximum set. In the rainbow LUT the minimum value is shown
as blue, the maximum as white. By setting Display R minimum and Display R maximum you are
setting the black and white point of the images. This is what is done automatically by the Auto
Contrast command in the Tools menu. Auto Contrast should, therefore, be used with caution if ratio
images are to be used comparatively.

6. If required, generate an intensity modulated channel that will appear as a new channel in the image
sequence. Select the modulator image from the Generate drop-down list. This generates a millions
of colors display channel and may show morphology more clearly at the same time as indicating ratio
values.

7. If a calibrated channel is required, select one of the two methods in the Generate a calibrated
channel using drop-down list and enter the appropriate values in the table.
n

Grynkiewicz: Edit the four constants, as appropriate. These values will be applied to the
Grynkiewicz equation (see page 523). The relevant constants for the current experiment must be
determined according to Grynkiewicz et al (1985).

n

Multi-point: Use the values previously obtained from a calibration experiment for known
correction of ion. Use the + button to create up to 11 (eleven) points in the table as required and
enter the Ratio value and corresponding Calibrated value. These points are fitted to a third
order polynomial or S-shaped curve. The preview graph provides a visual check that the
calibrated values entered are sensible.
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The preview shows a brightest point merge of the resultant ratioed image for the current timepoint. If
the sequence contains multiple timepoints, use the play controls to view the effect of the parameters
through the time series.
8. Click Ratio to apply the ratio calculation and create a ratio channel in the image sequence. If
specified, Volocity also creates a calibrated ratio and an intensity modulated channel. Channels may
be hidden using the controls on the Navigation palette.
Note: If appropriate, use the Save.. and Restore… buttons to save the settings for use in other
experiments.

Measuring Ratio Channels
Target the appropriate channel when carrying out measurements, so that you obtain the required
measurement units: ratio units or calibrated units. If drawing regions of interest to follow changes
over time it may be beneficial to use the intensity measurements that ignore 0.

Using Color Reference with Ratio Images
To display ratio or calibrated images it may be beneficial to show the color reference on the Image
View. This will show the values represented by the colors. Select Show Color Reference from the
Image menu.
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Grynkiewicz equation

[Ca ]i = K
2+

Ca

2+

D

* Β * ( R − R min)
R max − R

= intracellular Ca 2+ concentration

KD = dissociation constant of fura -2
-1

2+

-1

2+

B = fluorescence signal at 340 nm at 0µM.l Ca /fluorescence signal at 380 nm at 39.8µM.l Ca .
Grynkiewicz, G. Poenie, M. and Tsien, R. Y.
A new generation of Ca

2+

indicators with greatly improved fluorescence properties.

Journal of Biological Chemistry 1985 Vol. 260, pp. 3440-3450

FRET Analysis
FRET analysis allows accurate FRET measurements and generation of net FRET (or “corrected”
FRET) and normalized FRET images for publication.
The analysis currently offered by Volocity is the 3-image FRET technique, as described by Gordon et
al. (1998) and Xia and Liu (2001).
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References
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FRET
FRET (Fluorescence Resonance Energy Transfer) is the non-radiative transfer of energy from an
excited fluorophore (donor) to another fluorophore (acceptor). FRET only occurs when the molecules
concerned are in very close proximity (1-10nm). This makes it a valuable technique for studies where
distances and interactions between molecules are of interest.

Data Acquisition
Three images are required for each data point: a Donor image, an Acceptor image, and a FRET
image. For example, one typical donor/acceptor pair is CFP and YFP.
n

Donor image = Excite with CFP filter, CFP dichroic, emit with CFP filter

n

Acceptor image = Excite with YFP filter, YFP dichroic, emit with YFP filter

n

FRET image = Excite with CFP filter, CFP dichroic, emit with YFP filter

Volocity combines the three input images on a voxel-by-voxel basis according to the chosen FRET
method. The output is a floating-point value at each voxel.
n

All images should be in proper register before FRET analysis.

n

Images must be grayscale 8, 16 or floating bit depth.

n

All images must be the same depth.

Calculating Bleed-through Constants
Volocity requires two values that represent the bleed-through or cross-talk of each dye (Donor and
Acceptor) into the FRET filter set. These values are calculated at the start of the experiment and
should be recalculated if any change is made to the system that could affect transmission
characteristics or sensitivity to wavelengths of light.
Note: The FRET bleed-through dialog does not offer subtraction of any background values. If you
wish to subtract background from the images used to calculate bleed-through, this should be done

524 Improvision

VOLOCITY Quantitation Reference

before using the images in FRET analysis. Alternatively, calculate your own bleed-through using
values obtained by measuring appropriate ROIs in the images, as follows:

(intensity within cell(s) recipient-background intensity recipient) / (intensity within cell(s) sourcebackground intensity source)
1. First set up the constant for the Donor channel. An image sequence containing donor and FRET
channels from a sample containing only the donor fluorochrome is required.
2. Define an ROI or multiple ROIs on the Image View.
3. Select FRET Bleed-through… from the Tools menu.

4. Nominate a Source channel (where the bleed-through is coming from, in this case the donor
channel) and a Recipient channel (where the bleed-through is detected, in this case the FRET
channel). In a sample containing only donor fluorochrome any signal detected in the FRET channel
must be bleed-through.
5. Select the channel to which the bleed-through constant should be applied in the Use as default
bleed-through constant for drop-down list, in this case Donor.
6. Click on Save. The constant will be applied when you carry out the FRET calculation, as described in
the next section. The bleed-through value is a normalised percentage between 0.0 and 1.0.
n

The value is calculated as the mean intensity of the recipient divided by the mean intensity of the
source.

n

If you have defined multiple ROIs, Volocity calculates a mean of the mean values.
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7. Now create the constant for the Acceptor channel. An image sequence containing acceptor and
FRET channels from a sample containing only the acceptor fluorochrome is required. Repeat steps 2
to 6.

.

Using the FRET dialog
1. Open an image sequence containing 3 or more channels, which represent a Donor channel, an
Acceptor channel and a FRET channel.
2. Choose FRET… from the Tools menu.

preview window
and multiple
timepoint play
controls
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3. Select the Method of FRET calculation to be used from the drop-down list.

4. Select which channels should be used for Donor, FRET and Acceptor. A constant background
value may be subtracted from every voxel in every image of each channel, if required. If source
images are already background subtracted, go to step 5.
Note: Subtraction of a background constant is relevant only if the source images are evenly
illuminated.

Enter a value in the Subtract field or draw an ROI on the Image View before opening the FRET
dialog and click Get from ROI next to the Subtract field. Volocity will use the mean intensity from that
ROI for each channel as the value to subtract. This value will be subtracted from the intensity value
of every voxel before processing the FRET calculation.
5. Set threshold values for each channel by typing a value in the Threshold field. Thresholds allow
removal of signals that would interfere with interpretation of results.
For every voxel position for which one of the source voxels has an intensity value at or below
threshold, the value of that voxel position in the result image is set to 0 (zero).
Use the Voxel Spy to pick out an exact threshold value or ask Volocity to Calculate the value for you.
The calculate option determines the modal intensity value for the channel and uses it as the
threshold.
6. Enter bleed-through constants to be used. Click Restore Defaults to apply the Bleed–through
constants stored from the last bleed-through calculation.
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7. Preview the corrected FRET image. The preview shows a brightest point merge of the resultant
FRET image. If the sequence contains multiple timepoints, use the play controls to view the effect of
the parameters through the time series.
8. You may wish to apply rainbow colors to the output channel. Check the Apply a rainbow LUT to the
net FRET channel. To optimize the use of the rainbow across the range of values present within the
results enter Display minimum and Display maximum values.
This allows the finite range of colors available in the lookup table to be used to illustrate most
effectively any changes in the FRET values. Click Calculate and the maximum and minimum FRET
values for the current timepoint will be used. To easily compare FRET images with rainbow colors
applied, they should all have the same Display minimum and Display maximum set. In the
rainbow LUT the minimum value is shown as blue, the maximum as white. By setting Display
minimum and Display maximum you are setting the black and white point of the images. This is
what is done automatically by the Auto Contrast command in the Tools menu. Auto Contrast should,
therefore, be used with caution if FRET images are to be used comparatively.

9. If required, generate an intensity modulated channel that will appear as a new channel in the image
sequence. Select the modulator range from the Generate drop-down list. This generates a millions of
colors display channel and may show morphology more clearly at the same time as indicating FRET
values.

10. Click FRET to apply FRET calculation and create a corrected FRET channel in the image sequence.
If specified, Volocity also creates an intensity modulated channel. All channels are also visible in the
Navigation palettes and Voxel Spy palette. Channels may be hidden using the controls on the
Navigation palette.

Measuring Corrected FRET Channels
FRET channels in image sequences may be measured in the same way as any other channel. When
measurements are made on a FRET channel values for min, max, mean will be in the appropriate
FRET units. If drawing regions of interest to follow changes over time, it may be beneficial to use the
528 Improvision

VOLOCITY Quantitation Reference

intensity measurements that ignore 0. This will ensure that if background areas are included when
the ROIs are drawn, they will not influence the results.
See other sections of this chapter for details on how to use measurement tools and the classifier.

Using Color Reference with FRET images
To display corrected FRET images it may be beneficial to show the color reference on the Image
View. This will show the values represented by the colors. Select Show Color Reference from the
Image menu.

Intensity Modulated Images
The IM image uses pseudocolor and intensity to display a FRET output image. Color is used to
represent FRET values, intensity represents the intensity of one of the input images. This technique
helps reflect spatial information since the intensity of the original images is reflected in the resultant
image.
To produce the IM image the intensity of each voxel of the FRET output image is scaled based on
the range of intensities in the input images. The source image used for this is called the modulator
image. The modulator image can be one of the source images, the brightest of the source images or
the average of the source images.
The range of colors in the IM image is determined by the look up table applied to the FRET output
image.
The range of intensities in the IM image is determined by the range of intensities in the modulator
image.
The IM image is a millions of colors image. It is, therefore, a visualization tool not suitable for
quantitation.
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Volocity Restoration
Overview
Volocity Restoration is a separate product in the Volocity family that must be purchased separately.
See page 38 for more information about activating additional products.
Volocity Restoration offers two powerful techniques that allow you to apply deconvolution to an
image sequence or volume. These techniques are:
n

Iterative Restoration, which is a restorative technique that reassigns out-of-focus haze (it does
not subtract it from the data). It is designed to minimize out-of-focus haze and noise throughout
the volume. Iterative restoration not only gives improvement in resolution in X and Y, but most
significantly, also in Z. The results are applicable for 3D visualization and all 3D measurements
provided by Volocity Quantitation, including intensity measurement. The processing required to
achieve this is both time and memory intensive.

n

Fast Restoration, which is a rapid, single pass process that acts on the volume as a whole. Outof-focus It gives improvement in resolution in X and Y and, to a lesser extent, in Z.

Data Acquisition
Restoration is performed on z series of images that are managed within Volocity as either individual
volumes or within image sequences. The acquisition process requires careful consideration in order
to obtain optimum results from Volocity Restoration. In particular, the following acquisition issues
may affect the quality of the deconvolved image data:
n

Undersampling, particularly in the z axis

n

Saturation of the signal within images

n

Uneven illumination due to an unstable light source

n

Premature cropping of the signal by capturing too little in X, Y and Z around the sample

Please refer to Sampling Widefield Data for Deconvolutionon page 548 for a more detailed
discussion about the requirements for sampling wide field microscopy data for deconvolution.
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Point Spread Function (PSF)
In order to apply either fast or iterative restoration, you must first create a PSF item. This is used to
model the behavior of light in the optical system and must be appropriate for the data that is to be
deconvolved. You can create a PSF in two ways:
n

Calculated PSF, which is based on values entered into the Calculate PSF… dialog box. These
values should be the same as the parameters under which the data for deconvolution was
acquired. The application uses the values to calculate an appropriate PSF and create a new PSF
item.

n

Measured PSF, which is based on a volume (typically made from a z series of images of a subresolution, fluorescent bead) acquired under the same conditions as the experimental data. The
application measures the PSF in the bead volume and creates a new PSF item.

Note: See What Causes Axial Elongation of Structures in Optical Microscopy? on page 552 for a
discussion of the reasons why beads might appear as ellipses instead of spheres in optical
microscopy.
Creating PSF volumes can be time consuming. Improvision, therefore, recommends that you create
a library of PSF volumes for different objectives and camera settings, export them in the library
clipping format to a storage location and drag them into the active library as they are needed. If you
double click on a PSF icon in the library, it will open an Image View with an extra column on the right
of the window containing the PSF data.
Note: Please see the Glossary starting on page 544 for a definition of PSF parameters.

Data Calibration
The method of calculating and using point spread functions within Volocity 2.5 and later requires that
all data used within Volocity Restoration be correctly calibrated before use. This applies to raw data
for deconvolution as well as volumes from which a PSF is to be measured. Check the data
calibration before commencing by selecting Properties from the Edit menu. Correct the X, Y or Z
micron/pixel values, if necessary. See 63 for more information on item properties.
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Calculate PSF
This dialog is used to calculate all types of PSF available in Volocity, including Widefield, Confocal,
Two Photon and Spinning Disk Confocal PSFs.
1. From the Actions menu, select Create New and Calculated PSF…
2. In the dialog select the required type of PSF from the pop-up.

3. Enter the values relevant for the data that is going to be deconvolved with this PSF.
4. Click on Create or Calculate to create the PSF item.
The PSF calculated from the dialog is supersampled. Calculated PSFs may be used with images
acquired at any spatial resolution, the PSF is adjusted according to the calibration of the image data
during the process of deconvolution.
Note that when deconvolving the volume, Volocity requires the calibration values to be correctly set,
or the PSF used will not be accurate. If you attempt to deconvolve a volume for which the calibration
values appear not to have been set, you will be reminded to set these values before proceeding.
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The spinning disk is used in such systems as the PerkinElmer UltraView. This PSF is unique to a
spinning disk with the spiral pinhole configuration, pinhole size, and pinhole spacing of the
CSU10/CSU22/CSU X1 spinning disk and should not be used to calculate the PSF for any other type
of spinning disk.
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Measure PSF
This dialog is used to measure all types of PSF available in Volocity.
1. You will need a volume representative of a PSF, such as z sections taken of a sub resolution,
fluorescent labeled bead. Such images must be acquired from the system generating the
experimental image data. Volocity Acquisition may be used to acquire such a 3D stack.
2. Select the PSF bead volume in the library and, from the Actions menu, select Create New and
Measured PSF…

3. In the dialog select the required type of PSF from pop-up. All other values are optional. You may like
to record the other acquisition parameters for the PSF bead as a reminder, but they are not used to
create the PSF item.
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The following example shows the dialog for a widefield PSF.

4. Click on Measure.
Note that when deconvolving the volume, Volocity requires the calibration values to be correctly set,
or the PSF used will not be accurate. If you attempt to deconvolve a volume for which the calibration
values appear not to have been set, you will be reminded to set these values before proceeding.
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Applying Fast Restoration
You can apply Fast Restoration to a single volume, to an image sequence, or to multiple image
sequences selected in the library.
Make sure the library contains the required PSF volumes. You will need a PSF for each wavelength
and lens type.
1. Select items to be restored in the library. All items must be correctly calibrated, by setting X, Y and Z
properties, to ensure PSFs are used at the correct resolution.
2. Select Fast Restoration… from the Tools menu. The dialog will show a list of all the unique channel
names identified in the selected data. The restoration dialogs support batch processing. Where
multiple items have been selected channels in the different items can have the same names and
each name will only appear once in the dialog so will be processed using the same PSF.

3. For large data sets, you may like to check the Break the images into blocks checkbox.
Deconvolution is a very memory-intensive operation and the software needs to hold multiple copies
of the volume in memory at the same time so the space occupied in memory during restoration is
much greater than the physical space occupied by the data on disk.
Restoration will proceed fastest if all data required for the processing can be held in physical memory.
When the data set size exceeds the amount of physical memory Volocity can break the images down
into blocks which will fit, using the following calculation.
Memory per processor = physical RAM/number of processors.
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Block size will therefore vary, not only with the size of the data set but also with the hardware
configuration.
Based on this calculation the volume is divided into overlapping blocks. This overlap is used in the
processing of each block but not copied to the result to minimize the deterioration of quality caused
by breaking the images down.
Restoration will proceed more quickly since data will not have to be paged in and out of virtual
memory. On systems with multiple processors blocks may be processed simultaneously, further
increasing speed. Breaking images into blocks may lead to a slight deterioration in quality;
depending on the nature of the data it may be possible to detect the edges of the blocks the data
was broken down into.
Note: If it is calculated that the data fits into memory as a single block, it will be restored as a single
block, even if the checkbox is checked.
4. Click on Start to apply Fast Restoration.
The preview window shows each volume as restoration is applied. While the deconvolution is being
carried out the Start button will change to Pause. You can pause the process at any time, for
example if you want to interact with the preview. Click on the button (now labeled Start) a second
time to restart the processing. If you click Done while the deconvolution is paused, the deconvolved
data will not be saved.
The Status window shows progress details.
5. Once all the selected channels have been deconvolved, click Done. When deconvolution is
completed, each channel will have a deconvolved equivalent with a name indicating that Fast
Restoration was applied; the raw data is not replaced with deconvolved data.
For single volume(s) the name of the new volume includes the text ‘Fast DCI’ and the name of the
PSF used.
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For image sequences the results are added as new channels, so information about the type of
restoration applied is in the name of the new channels and the tooltip shown when the cursor is held
over the channel. If the data was broken down into blocks the number of blocks is recorded.
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Applying Iterative Restoration
You can apply Iterative Restoration to a single volume, to an image sequence, or to multiple image
sequences selected in the library. Iterative Restoration is a multiple step process; each cycle or
iteration increasing the quality of the resultant image and therefore confidence in the result. The
termination condition of the this process can be set by iteration limit (number of iterations) or
confidence limit (percentage).
Make sure the library contains the required PSF volumes. You will need a PSF for each wavelength
and lens type.
1. Select items to be restored in the library.
2. Select Iterative Restoration… from the Tools menu.

3. Select the appropriate PSF for each channel from the drop-down menu. Select the appropriate PSF
for each channel from the pull-down menu. The restoration dialogs support batch processing. Where
multiple items have been selected channels in the different items can have the same names and
each name will only appear once in the dialog so will be processed using the same PSF.
4. Either set a confidence limit or an iteration limit. The deconvolution will terminate when one of limit
conditions is met. Set 100% confidence to limit by iterations, set 100 iterations to limit by confidence.
Confidence is calculated after each iteration and is the result of testing the results of deconvolution
against the original data. 100% confidence indicates that restoration can offer no further
improvement to the image. This may take many iterations to reach. Many datasets can be
deconvolved extremely successfully with the confidence limit set to 98% or 99%. It may take a
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different number of iterations to reach the same confidence limits for different channels. We
recommend an iteration limit of 20 - 25 for widefield images, 10 for confocal images. You should not
need to change this for different data sets.
5. For large data sets, you may like to check the Break images into blocks checkbox. Deconvolution
is a very memory-intensive operation and Volocity needs to hold multiple copies of the volume in
memory at the same time so the space occupied in memory during restoration is much greater than
the physical space occupied by the original data.
Restoration will proceed fastest if all the data required for the processing can be held in physical
memory. When the data set size exceeds the amount of physical memory Volocity can break the
images down into blocks, which will fit, using the following calculation:
Memory per processor = physical RAM/number of processors
Block size will therefore vary not only with the size of the data set but also with hardware
configuration.
Based on this calculation the volume is divided into overlapping blocks. This overlap is used in the
processing of each block but not copied to the result to minimize the deterioration of quality that is
caused by breaking the images down.
Restoration will proceed more quickly since data will not have to be paged in and out of virtual
memory. On systems with multiple processors blocks may be processed simultaneously, further
increasing speed. Breaking images into blocks may lead to a slight deterioration in quality,
depending on the nature of the data it may be possible to detect the edges of the blocks the data
was broken down into.
Note: If it is calculated that the data fits into memory as a single block, it will be restored as a single
block, even if the checkbox is checked..
6. Click on Start to apply Iterative Restoration.
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Feedback on progress is different depending on the use of Break the images into blocks option.
When Break the images into blocks is not enabled the preview window shows a brightest point
merge, updated with each iteration as restoration progresses. It is normal for the results of the first
iterations to look worse than the original data since the first estimate of the true nature of the data in
the image is based on the image itself.
The confidence factor will rise significantly with each iteration, however, the rate of increase will slow
with successive iterations.
Note: While the deconvolution is being carried out the Start button will change to Pause. You can
pause the process at any time, for example if you want to interact with the preview. Click on the
button (now labeled Start) a second time to restart the processing. If you click Done while the
deconvolution is paused, the deconvolved data will not be saved.
If Break the images into blocks is enabled feedback on progress is provided less frequently. The
preview image, a brightest point merge of the volume is updated as each block is completed. The
status box will show the number of volumes of the total completed and the number of blocks of the
current volume completed. Progress will not be updated with each iteration.
7. Once all the selected channels have been deconvolved, click Done. When deconvolution is
completed, each channel will have a deconvolved equivalent; the raw data is not replaced with
deconvolved data.
After Iterative Restoration the result is meaningfully labeled, according to the processing it underwent.
For single volume(s) the name of the new volume includes the number of iterations, the confidence
limit reached, the number of blocks (if applicable) and the name of the PSF used.
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For image sequences the results are added as new channels, so the information about the type of
restoration applied is in the name of the new channels and the tooltip shown when the cursor is held
over the channel. If the data was broken down into blocks the number of blocks is also recorded.
Note: For both techniques, the first time a data set is deconvolved, it may take slightly longer than
the second and subsequent times a data set of the same dimensions is processed. This is because
one optimization present within Volocity Restoration is the storage of the method by which the Fast
Fourier Transform (FFT) of a data set will be calculated. The next time a data set of those
dimensions is encountered the method for calculating the FFT is already available, thus saving a
processing step.

Illumination Correction
Minor anomalies in excitation light intensity over time, such as lamp flicker, can lead to poor
deconvolution results. This will manifest itself as one or more inconsistently bright or dark layers in
the deconvolved volume. The flicker may not be apparent during inspection of the raw data.
Better results can be obtained by applying illumination correction, then deconvolving the data again.
Select the required volume(s) and select Correct Illumination from the Tools menu.
Correct Illumination operates within each individual volume and bases any intensity correction solely
on the trends shown within that volume. It does not normalize time resolved data to account for
bleaching and cannot correct severe problems with lighting during the experiment. Ideally, lamp
flicker should be avoided by using a stable light source.
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The definitions below explain the terminology used in this guide.
3D Opacity Renderer
Volocity calculates a projection—a screen image of how the volume appears from a specific
viewpoint—using direct rendering from the 3D stack.
Black Level
The Black Level is a channel control when rendering data in 3D. It adjusts the intensity threshold
below which renderers will treat data as transparent.
Detector Pinhole Size
This is a parameter in the calculation of a confocal PSF. It is the diameter of the pinhole used while
acquiring the optical sections. Note: this is measured in airy units not micrometers. Not all systems
display pinhole size in airy units and a conversion must be made.
Displacement
This is the straight line distance between the first centroid in a track and the last centroid.
Displacement rate
This is the displacement/(time of the last timepoint in the track – time of the first timepoint in the
track). Displacement rate may also be defined as the average displacement per second.
Duplicate
The duplicate command allows you to duplicate items in the library, so that you can include items in
a number of different folders.
Emission Wavelength
This is a parameter in the calculation of a PSF. It is the emission maximum of the fluorochrome
imaged in the data set.
Excitation Wavelength
This is a parameter in the calculation of a confocal PSF. It is the excitation laser wavelength.
Fast Restoration
This is a rapid, single-pass process that acts on the volume as a whole. It gives resolution
improvement in X and Y.
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Folder
The library may be organised into a number of different folders that best suit your archiving/sorting
requirements. Each folder may hold sub-folders or individual items. In this way you can organize your
images into a number of different categories, each with a number of different levels.
Gallery
If you have sub-folders in the library of files whose format supports multiple images, for example
Openlab LIFF files. The gallery view displays all the images in a single view.
Image
This relates to the bottom-level view of the library - the individual image, which may be 2D or 3D.
Image Sequencer
The Image Sequencer allows interaction with multiple channel, time resolved data by providing an
easy-to-use interface for this data.
Iterative Restoration
This is a restorative technique that reassigns out-of- focus haze (it does not subtract it from the data).
It is designed to minimize out-of-focus haze and noise throughout the volume. Iterative restoration
not only gives improvement in resolution in X and Y, but most significantly also in Z. The results are
applicable for 3D visualization and all 3D measurements provided by Volocity Classification,
including intensity.
Keywords
A keyword is an item property that you enter on the Properties dialog to provide additional data about
that item that can be used in the Find command.
Library
This is the structure within which the digital images are collected and organised. A library must be
open in order to acquire or view images.
Meandering index
This is the displacement rate / velocity, which provides a measure of a track’s deviation from a
straight line. The meandering index is always a value less than or equal to 1. A meandering index of
1 indicates that the track is a perfect straight line; the smaller the value of the meandering index, the
greater the meandering of the track.
Medium refractive index
This is a parameter in the calculation of a PSF. It is the refractive index of the medium between the
objective lens and the cover slip. Typical values are 1.0 for air, 1.33 for water and 1.515 for oil.
Numerical aperture
This is a parameter in the calculation of a PSF. It is the numerical aperture of the objective lens. It
can normally be found engraved on the objective lens.
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Properties
These describe an item in the library. There are fixed properties, such as image size, source location
and date details, which cannot be changed. Other properties, however, allow the user to add or edit
information, such as adding keywords or changing the name.
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PSF (Point Spread Function)
Images seen through a microscope contain information from the focal plane of interest plus out-offocus information from other focal planes on the image. Volocity Restoration uses a technique called
deconvolution to remove the out-of-focus information. This is a mathematical technique that
calculates the out-of-focus information from other images using the “point spread function”, or PSF,
and subtracts this from the image plane of interest. It processes the Z stack of images as a complete
data set, converting pixels to voxels (volume elements) to produce high-resolution, deconvolved
images.
Skeletal length
This is the maximum length in the selected object and is shown in the Measurements. The selection
is eroded evenly from its border inwards until it consists of a one-voxel thick, skeletal representation
along its entire length. This "skeleton" is then measured.
Smooth zoom
The Smooth Zoom command on the View menu applies interpolation to the view to give better quality
when viewing zoomed images and automatically sets the best quality for printing.
Thumbnail
The thumbnail is a representation of an item for quick display. The application automatically creates
a thumbnail for each image or each layer in a multi-layer image.
Time span
This is the number of timepoints spanned by a track.
Volume
A volume is the name for a 3Dl object within Volocity. It can exist as a single item within the library,
created from a series of 2D images related in the Z-dimension or within an image sequence, which is
a powerful tool for creating a collection of volumes arranged by channel and timepoint.
Voxel
This is the 3D equivalent of a pixel, the smallest discrete spatial component of a digital volume.
Volumes within Volocity consist of voxels, each with an associated color and /or intensity value.
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Appendices
Sampling Widefield Data for Deconvolution
Overview
This technical note contains a discussion of some of the requirements of data sampling to achieve
optimal deconvolution results when using Improvision deconvolution software. Deconvolution will
generate the best results when presented with the highest quality data.

Depth of Sample to Scan
Point spread of light sources from within a sample can extend above and beyond the limits of the
physical top and bottom of that sample. Deconvolution uses out of focus information to calculate true
sample data therefore it is important to capture the spread of light that extends beyond the sample
boundary. This means capturing a large enough image size in X and Y and taking sample slices
above below the object. As a rule of thumb, capture from darkness below the object to darkness
above or half the thickness of the object of interest above and below, so that the total scanned
distance is twice the thickness of sample object.

Measured PSFs
The acquisition of data for a measured PSF must be subjected to the same strict controls as the
experimental data. Effort must be taken to minimise artefacts or aberrations. If these cannot be
avoided then the data for the measured PSF should be collected with the same artefacts and
aberrations as the experimental data. The bead used for measuring PSFs must be a speck bead of a
size below the resolution of the microscope in order for the results to be valid. PSFs must be
measured from a point source of light.

Optics and Illumination
The illumination pathway must be clean, free from dust and correctly aligned. Refer to the
documentation supplied with the microscope to confirm how to align the epi-fluorescence light path.
Use high numerical aperture lenses. Try to match refractive indices through sample, cover slip and
immersion medium.
If the illumination source output varies during the collection of a data stack this will result in there
being differences in intensity between z planes which may be more apparent after deconvolution.
Volocity Restoration offers a Correct Illumination function which can alter the data to remove these
variations. It is always preferable to avoid introducing artefacts into images rather than correct for
them later. Use an illumination source with a stable power supply. Lamp flicker is worse towards the
end of the life of an arc lamp, replace bulbs if they show signs of flickering and always at the end of
their recommended life.
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Practical Considerations
The above information is for an ideal situation. In reality it may be necessary to compromise on some
of the recommendations to stay within the performance limits of the hardware and to ensure survival
of the specimen for the desired duration of the experiment.
Although operating the camera at its highest resolution will satisfy the Nyquist theorem for sampling
frequency, it may be necessary to use binning to minimise sample exposure to UV light. In many
cases the XY sampling will still be approximately half the size of the smallest resolvable object.
Imaging many stacks over time or imaging a sample which shows photo bleaching may require
compromise on the number and spacing of z slices. It may be worth considering a volume
deconvolution technique rather than an iterative restoration if the number of slices has to be reduced.

Sampling Frequency
A biological structure labeled with a fluorescent probe consists of continuous distribution of
fluorescence. Imaging a biological sample means taking samples of this continuous fluorescence at
discrete points in XYZ space (i.e. images). The frequency at which images are taken therefore
affects the quality of the final result.
Nyquist Theorem
The Nyquist theorem states that in order to fully describe objects they must be sampled at twice the
smallest resolvable object in the data.
For iterative restoration the Nyquist sampling rate is the minimum that is necessary; higher sampling
rates will lead to superior deconvolution results.
For volume deconvolution lower sampling rates in z may be acceptable.
Sampling frequency in X and Y is determined by pixel size of the camera and objective magnification.
Sampling frequency in z is determined by the distance between slices.
Sampling in x and y
Sampling frequency in x and y is determined by the spacing of the pixels on the camera.
sampling frequency = camera pixel size/total magnification
XY or lateral resolution: d = 0.61λ/NA
Where λ = wavelength and NA = numerical aperture of objective lens
Minimum sampling frequency in X and Y therefore = d/2.
If sampling frequency is less than or equal to d then sampling theory is obeyed.
Sampling in z
Find the depth of focus of the system and sample at half that distance.
A method of calculating DOF is:
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λ/2NA

2

Where λ = wavelength and NA = numerical aperture of objective lens.
Example
A sample labeled with GFP (emission wavelength 510nm) is imaged with a 63x oil immersion
objective with NA of 1.4. The immersion medium has a refractive index of 1.518. The camera has a
2
pixel size of 6.45 µm .
XY or lateral resolution = 222 nm or 0.222 µm
Z or axial resolution = 130 nm or 0.13 µm
To follow the Nyquist theorem:
XY sampling = 0.111 µm
Z sampling = 0.065 µm
Based on the description above the camera will sample at 0.102µm in X and Y therefore meeting the
requirement for the XY sampling.
It is as important to sample accurately as it is to sample at the correct frequency. Always use a
motorised stage, manual adjustment is not only tedious and slow, it is also not accurate enough.
Calculation of the optimum sampling rate will give results of very small values. If the equipment
available cannot reproduce such fine movement, compromise is necessary to maintain accuracy.
Sample at the smallest reproducible z step. Biological samples may not tolerate exposure to the
excitation wavelength for the time necessary for such intensive sampling, and sampling ideals will
again need to be compromised, as discussed below.
Avoid backlash in microscope focus mechanisms by moving against the load, or against gravity.
Move the focus in one direction only during the acquisition. Once started never reverse the direction.
To avoid backlash at the beginning of a stack focus to the first imaging point, move to below that
start point then, back up to the start to capture the first frame.

Signal to Noise
Maximise the signal to noise ratio in images, use longest exposure possible which the sample will
tolerate without bleaching.
Avoid pixel saturation; deconvolution will accentuate this and lead to blooming.
Perform background subtraction on images before deconvolution.

Spherical Aberration
Spherical aberration is asymmetry in the spread of light from a point source. It can be detected by
viewing fluorescently labeled beads with the system. Focus through the beads and look for
symmetrical spread of light on either side.
Use the correct cover slip. Lenses are designed for optimum performance when used with certain
cover slips. A lens will not perform to its specification if used with a different thickness of cover slip.
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Match refractive indices (RI) between sample, sample medium, immersion medium and lens.
Mismatched refractive indices can cause spherical aberration and can lead to optical z section size
varying from physical z step size, because the path of the emission light is changed at each
boundary between different RI.
Try to ensure that all the materials that the light passes through are closely matched for RI.
It may be preferential to use a lower NA, water immersion lens which more closely matches the RI of
a watery sample than an oil immersion lens. Also consider dipping objectives which are lowered into
the medium surrounding the sample.

Vibration
Vibration of the acquisition system will cause lateral and axial shifts in the image acquired which will
degrade the quality of the stack and the subsequent deconvolution. There is no way to correct for
this; therefore, systems must be protected against vibration.
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What Causes Axial Elongation of Structures in Optical Microscopy?
Overview
Fluorescently-labeled beads are used for a variety of purposes in optical microscopy, from
measuring a point spread function to assessing the performance and calibration of the system.
Beads supplied by manufacturers such as Molecular Probes are manufactured under strict controls
and can be considered as spheres. Why then do 3D visualisations of these beads, reconstructed
from 2D sections, appear not as spheres but as ovoid?
The reasons why beads might appear as ellipses instead of spheres in optical microscopy are
different depending on the size of the objects being observed.

Working with Small Objects
The z (axial) resolution of a widefield or confocal microscope is normally three to four times less than
its xy (lateral) resolution. In other words, the smallest object that can be resolved is approximately
200 nm in xy and 700 nm in z.
When working with small objects, such as 200 nm-point source beads for measuring a PSF, this
effect is significant. The beads will appear to be three to four times elongated in z.
The elongation effect caused by the difference in resolution in z is only significant on small structures
around the resolution limit of the microscope. It is a fact of optical microscopy and should be taken
into consideration when interpreting data.

Working with Larger Structures
When working with larger structures (>10 µm) you can sometimes also see elongation. The cause of
this is normally different. It is due to a mismatching of refractive indices, either between the
immersion medium of the objective and the sample medium or between the sample medium and the
sample itself.
If the refractive indices are mismatched then the physical distance moved by the focus drive is not
the same as the optical distance. This gets worse as you move deeper into the sample, away from
the cover slip. Optical distance is less than focus drive distance and the result is stretching in z.
To minimize this effect we recommend that refractive indices are matched as closely as possible. For
example if your specimen consists mainly of water and is mounted in an aqueous medium, it would
be preferable to use a water immersion lens of a slightly lower NA than an oil immersion lens of the
same magnification and higher NA.
Another factor which can also effect elongation is spherical aberration from high NA lenses. Most
microscope manufacturers have special flat-field objectives that will reduce this effect. Consider
evaluating lenses for spherical aberration before purchase.
These factors apply to structures within biological samples equally as to beads therefore they should
be taken into account when interpreting 3D data.
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OptiGrid® Structured Light Algorithm
Structured light illumination systems, such as the OptiGrid®, project a sinusoidal pattern onto
specimens by placing a one-dimensional grating in the microscope’s illumination path.
The grid is moved in the Y plane into three different positions and an image is acquired at each
position. The following algorithm is then used to produce a single, derivative, confocal image from
which the grid pattern has been removed.

Confocal Image= √ ((I1-I2)2+(I1-I3)2+(I2-I3)2)
I1 = Image with the grid in position 1
I2 = Image with the grid in position 2
I3 = Image with the grid in position 3
2

(I1-I3)

2

(I2-I3)

2

I1

I2

I3

(I1-I2)

Grid Image

Strongly
Focused

1

1

0

0

1

1

1.41

Weakly
Focused

0.8

0.8

0.2

0

0.36

0.36

0.84

Out of
focus

0.5

0.5

0.5

0

0

0

0

Other sources of information
Improvision
TN424: A study of fluorescence standards confirms that OptiGrid® confocal images are suitable for
quantitative microscopy
http://www.improvision.com/support/tech_notes/detail.php?id=424
Barlow and Guerin (2007)
Quantization of Widefield Fluorescence Images Using Structured Illumination and Image Analysis
Software.

Microscopy Research and Technique 70:76-84
Neil MAA, Juskaitis R and Wilson T (1997)
Method of obtaining optical sectioning by using structured light in a conventional microscope.

Optics Letters 22: 1905-1907

November 2008 553

OptiGrid® Structured Light Algorithm

Puch AC (2005)
Resolution Performance in Structured Illumination Microscopy: Comparison of OptiGrid® to
Traditional Confocal Microscopes. Independent Resolution Testing.

Thales Optem technical note.
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Index
2D items, 76

acquisition examples

3D FRAP, 273

FLIP, 274

3D Items, 77

FRAP, 268

3D menu, 363

multi-point, 245

3D toolbar, 365

single point, 166, 266

3D view

xy stage, 245

contrast enhancement, 352

acquisition protocols

create bookmark, 368

FRAP, 268

movie interface, 92

multiple channels over time, 333

scale, 364

multiple channels, multiple z-planes, 336

view options, 364

multiple channels, multiple z-planes over time, 339

acquiring data, 47

single channel over time, 331

acquisition

single channel, multiple z-planes, 334

adding points, 251

single channel, multiple z-planes over time, 338

auto-focus, 260, 342

single frame, 330

capturing multiple channels, 177

acquisition setup dialog, 166

data quality, 541

activating products, 39

device controls, 150

add data

devices, 146

drag and drop, 48

events and logs, 180

image sequence, 55

fast restoration, 195, 286

add points, 251

feedback, 179

adopt items command, 114

focus limits, 170, 260

align volumes, 379

optigrid, 214, 306

analysis examples

preferences, 146

changes in intensity with object volume, 498

scanning, 255

changes in object velocity over time, 499

set up protocol, 258

mean intensity of objects, 492
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mean number of objects per cell, 493

delete, 370

total number of objects measured, 488

edit, 369

total number of objects measured per timepoint,
490

move, 369

analysis view, 484
aperture diaphragm
adjusting, 230, 322

show, 363
use, 369
bright reference images, 124
calculate object colocalization, 458

auto analyze, 458

calculate psf, 543

auto contrast, 116

calibrate

auto contrast command, 114
auto-focus, 169

objective lens, 155
calibration

auto-focus, 260

FRAP acquisition example, 266

auto-focus, 342

MicroPoint, 233, 325

axial elongation, 562

optigrid, 214, 306

background corrections

photokinesis accessory, 241

creating, 123
FRAP, 518

spatial, 155
capture

inspecting, 126

image sequences, 177

why it is needed, 122

snapshot, 109

batch processing

CCD active area, 163

auto contrast, 114

centroid, 457

change colors, 117

change size command, 118

measurements, 466

changes in intensity with object volume, 498

photobleaching, 518

changes in object velocity over time, 499

restoration, 547, 550

channel

using ICS, 33
batch processing, 114
bleed-through constants
fret analysis, 533
bookmarks

compress, 105
target, 423
chart examples, 504
chart types, 503
chart view, 502

create, 368

clear movie, 97, 376

definition, 91

clip objects to ROI, 449
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cloak command, 119

manual focus model, 211, 303

close

motorized focus model, 208, 300

library, 47

contrast enhancement, 162, 352

close library, 47

contrast enhancement command, 120

close objects, 447

copy

colocalization, 458

between libraries, 66

considerations, 517

items, 68

generate, 515

timepoints, 102

measure object, 517

copy timepoints command, 102

scatter plot, 508

correct background command, 126

statistics, 513

correct registration command, 131

statistics, 513

create

thresholds, 509

background corrections, 123

worked example, 411

bookmark, 368

colocalization, 506

folders, 66

colocalization menu, 506

image sequence, 55

colocalization toolbar, 506

library, 43

colocalization view, 411, 507

protocol, 381

color balance command, 119

QTVR movie, 363, 377

color depth command, 116

registration corrections, 128

color objects, 459

spectral signatures, 198, 200, 289, 291

color reference

volume, 56

FRET, 538

crop to selection command, 134

ratio, 531

dark reference images, 125

colors command, 117

data calibration, 542

Columbus, 50

delete items, 69

combine objects, 452

device controls, 150

comment, 460

device latencies, 157

compact library command, 70

device preferences, 147

compress channels, 105

devices

Computing Server, 33

installing and configuring, 146

connecting optigrid

setup, 149
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devices, 239

fill holes in objects, 448

dichroic, 240

filter measurement data, 469

dilate objects, 448

filter measurements, 455

discrimination mode, 240

filters, 149

docking palettes, 110

find 2D nuclei, 439

dongle, 29

find 2D spots, 439

erode objects, 448

find command, 68

event flag, 180

find objects in roi, 443

exclude non-touching objects, 453

find objects using % intensity, 440

exclude objects by shape, 450

find objects using hsi, 443

exclude objects by size, 451

find objects using intensity, 442

exclude objects not touching roi, 451

find objects using rgb, 445

exclude objects touching edge, 452

find objects using sd intensity, 446

exclusively combine objects, 453

FLIP, 274, 520

export

FLIP acquisition example, 274

as AVI movie, 142

fly-around tool, 365

as QuickTime movie, 142

focus, 169

images, 139

focus controls, 152

measurements, 473

focus limits, 170, 260

exposure controls, 152
fast restoration
acquisition, 195, 286
applying, 547

folders
copy and move, 66
create, 66
FRAP

description, 541

acquisition protocol, 268

ICS, 33

background correction, 518

feedback

measurement item, 525

acquisition, 179

normalization, 519

change object colours, 474

photo-bleaching correction, 518

measurement objects, 429

FRAP, 185, 187, 191, 264, 266, 267, 268

options, 474

FRAP acquisition

raw view, 473
file formats, 59
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overview, 264
preparing experiment, 266

preparing for, 266

Illumination correction, 553

FRAP acquisition example, 268

image menu, 86

FRAP analysis, 517

image sequence, 42

FRAP analysis, 519

create new, 55

FRAP Preview, 264

measure multiple, 394

free flight camera control, 366

timeline view, 101

FRET, 533

image sequence view, 100

color reference, 538

image sequences

data acquisition, 533

capturing, 177

fret analysis

image view

applying calculation, 535

2D items, 76

bleed-through constants, 533

measurements, 417

fret analysis, 532
FRET analysis

import
preferences, 48

data acquisition, 533

import command, 57

measuring channels, 538

important concepts, 42

fret dialog, 535
gamepad, 366
genate colocalization, 515

install
MicroPoint, 232, 324
installation

grid AF, 220, 312

dongle, 29

grid confocal images

server systems, 30

capturing multi-channel, 227, 319

single license, 29

capturing single channel, 223, 315

starting after, 30

grid controls, 220, 312

intensity modulated images, 539

grid modes, 221, 313

intensity profile. See line profile

group measurements, 460

internalize measured objects, 454

grynkiewicz equation, 532

intersect objects, 454

hand tool, 83

invert objects, 454

hints

iterative restoration

enabling and disabling, 33
histogram, 417, 434
ICS, 33

applying, 550
description, 541
Iterative Restoration, 33
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join objects, 470

logs, 180

joypad, 366

magic wand tool, 84, 422

joypad preferences, 366

magnifying tool, 83

keyframe

make measurement item, 433, 467

create, 93, 372

make movie, 99, 376

edit, 95, 374

make roi from objects, 460

kymograph, 427

make volumes command, 56

lambda stacks, 204, 295

make well overlay, 248

laser power, 240

mean intensity of objects measured, 492

lasso tool, 83, 421

mean number of objects per cell, 493

library

measure

compact, 70

selected timepoints, 434

creating, 43

measure and track multiple timepoints, 401

definition of, 43

measure channels

format, 62

ratio, 531

menu, 63

measure device latencies command, 157

organizing data in, 61

measure FRET channels, 538

selecting items, 74

measure line profiles, 455

Library
opening, 46

measure lines, 455
measure multiple image sequences, 394

library thumbnails, 64

measure multiple timepoints, 385

library view, 42, 62, 72

measure object colocalization, 517

license server

measure objects, 456

change password, 32

measure objects command, 386

installing Volocity with, 30

measure points, 457

switching to individual license, 32

measure psf

switching to server, 32

sampling, 558

light path manager, 158

measure psf, 545

light path settings, 160

measure single timepoints, 381

line profile, 89

measure skeletal length, 458

line tool, 418

measurement item

live enhancement tool, 162
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FRAP, 525

measurement item, 384, 433, 467

resize, 97, 376

measurement protocol, 381

save and restore, 98, 377

measurements

movie interface, 92

count points, 420

multiple channels over time acquisition, 333

definitions, 478

multiple channels, multiple z-planes acquisition, 336

draw lines, 419
draw regions, 421

multiple channels, multiple z-planes over time
acquisition, 339

export, 473

multi-point acquisition example, 245

feedback, 473

navigation palette

filter data, 469

slice view, 361

histogram, 417, 434

navigation palette, 106

image view, 417

noise, 560

join objects, 470

Noise, 33

object feedback, 429

normalization

measurements menu, 431
measurements protocol, 436

FRAP, 519
notes view, 108

batch processing, 466

Nyquist theorem, 559

clear, save, restore,export, 464

objective lenses, 155

measurements protocol, 437

offsets, 126

measurements view

open

feedback options, 474

library, 46

measurements view, 417

open objects, 448

merge channels command, 102

optigrid

merge planes command, 135

calibration, 214, 306

MicroPoint, 232, 324

capturing multi-channel grid confocal images, 227,
319

minimum system requirements, 29
move

capturing single-channel grid confocal images,
223, 315

folders, 67

connecting manual focus model, 211, 303

items, 68

connecting motorized focus model, 208, 300

movie
clear, 97, 376

grid controls, 220, 312
how to use, 220, 312

make, 99, 376
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manual focus model preferences, 214, 306

joypad, 366

motorized focus model preferences, 213, 305

optigrid manual focus model, 214, 306

structured light algorithm, 563

optigrid motorized focus model, 213, 305

troubleshooting grid imaging, 230, 322

photokinesis accessory, 237

troubleshooting installation and calibration, 217,
309

UltraVIEW, 183
print command, 139

optigrid, 207

print preview command, 139

optigrid, 299

programming acquisition. See acquisition setup
dialog

overlays
save and restore, 250
overlays, 248
page setup command, 139
palette

properties, 65
protocols
setup and run, 258
psf

docking, 110

calculate, 543

navigation, 361

measure, 545

voxel spy, 106

psf items, 542

pan tool, 83

QTVR movie, 363, 377

photo-bleaching correction

quantitation

FRAP, 518

measure and track multiple timepoints, 401

PhotoKinesis accessory, 237

measure multiple image sequences, 394

pivotal point of rotation, 366

measure multiple timepoint, 385

point tool, 420

measure single timepoint, 381

points
inspect and edit, 253

quit Volocity, 37
ratio, 277

random, 252

acquisition protocol, 282

save and restore, 255

preparing experiment, 277

scanning, 257

preview, 278

points, 251
preferences

ratioing
apply calculation, 528

after installation, 32

measure channels, 531

for acquisition, 146

measuring channels, 531

import, 48
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ratioing, 528

raw data view, 468

sampling frequency, 559

reference images, 124

save and restore movie, 98, 377

registration corrections

Save settings. See Bookmarks

automatically create, 129

scan points, 257

inspecting, 130

scanning, 255

manually create, 129

scatter plot, 508

registration corrections, 128

selection tools, 83, 84

remove items command, 69

separate color images, 202, 293

remove noise command, 136

separate monochrome images, 204, 295

remove noise from objects, 449

separate touching objects, 449

renderers

serial ports preferences, 146

selecting, 345

session log, 36

rendering view, 344

shading defects, 122

resample timepoints command, 103

show color reference command, 87

resize movie, 97, 376

show data command, 109

restoration

show in library command, 70, 108

data quality, 541

show scale command, 89

types of, 541

show time command, 87

Restoration, 33

shutter, 154, 174

restore objects, 460

shutter controls, 154

retain objects, 461

single channel over time acquisition, 331

reveal in finder/explorer command, 70

single channel, multiple z-planes acquisition, 334

ROI

single channel, multiple z-planes over time
acquisition, 338

selecting on video preview, 164
roi options, 85

single frame acquisition, 330

roi options, 85

single point acquisition example, 166

roi tools, 83, 421

size

rotate slice tool, 358
rotate volume tool, 360
sampling
depth of scan, 558
sampling for deconvolution, 558

changing, 118
slice view
create data, 361
navigation palette, 361
slice view, 357
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slicing orientation, 358
sliders, 155

thumbnails
in library, 64

smooth zoom command, 87

thumbnails command, 63

snapshots, 109

timelapse, 172

software updates

timeline view

automatic check, 33, 37
license server, 38

zoom, 102
timepoint sequence

software updates, 37

add, 93, 373

sort by command, 109

edit, 96, 375

spectral separation, 197, 288
spectral signatures

timepoints
absolute or relative, 102

create from color, 198, 289

measure and track, 401

create from monochrome, 200, 291

measure multiple, 385

separating color, 202, 293

measure single, 381

separating monochrome, 204, 295

resample, 103

spherical aberration, 561

total number of objects measured, 488

spinning disk, 544

total number of objects measured per timepoint, 490

spinning disk illumination, 182

track multiple timepoints, 401

split multi-colored items command, 133, 137

track objects

split volumes command, 135, 137

automatically join broken tracks, 462

stage setup, 245

trajectory variation, 462

starting Volocity, 30

track objects, 461

statistics

track objects, 463

colocalization, 513
statistics, 513

track objects task, 404
troubleshooting

status bar (Windows), 74

grid imaging, 230, 322

subtract objects, 454

optigrid installation and calibration, 217, 309

supported file formats, 59

session log, 36

surface area, 457

UltraVIEW, 183, 238, 239

target channel, 423

UltraVIEW Vox confocal accessory, 181

technical support, 28

undo command, 114

thresholds, 509

unlock codes, 39
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using the optigrid, 220, 312

view tracks, 470

vibration, 561

visualization

video feedback, 165

bookmarks, 368

video preview

rendering and 3D view, 344

CCD active area, 163
centering XY stage, 164

set pivot for rotation, 366
Volocity

cropping, 163

important concepts, 42

selecting ROI, 164

quitting, 37

zooming, 163

volumes

video preview window, 161

align, 379

view

create, 56

3D, 344

split, 137

analysis, 484

voxel spy palette, 106

chart, 502

wells

colocalization, 411, 507

overlays, 248

export as AVI or QuickTime movie, 144

scanning, 256

image sequence, 100
library, 62, 72

XY stage
centering on video preview, 164

measurements, 417

XY stage, 245

notes, 108

xy stage example, 245

raw data, 468

xy stage view

rendering, 344

add overlays, 248

slice, 357

XY stage view, 246

xy stage, 246

zoom

view options
roi settings, 85

video preview, 163
zoom tool, 83

view options, 90
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